This document describes the R&S®NRP2 and its options.

- R&S®NRP-B1/-B7, Sensor Check Source
- R&S®NRP-B2, Second Sensor Input B
- R&S®NRP-B5, 3rd and 4th Sensor Input C and D
- R&S®NRP-B6, Rear Panel Sensor Input A and B

The following abbreviations are used throughout this manual: R&S®NRP2 is abbreviated as R&S NRP2, and the R&S®NRP-Zxx Power Sensors are abbreviated as R&S NRP-Zxx.
Always read through and comply with the following safety instructions!

All plants and locations of the Rohde & Schwarz group of companies make every effort to keep the safety standards of our products up to date and to offer our customers the highest possible degree of safety. Our products and the auxiliary equipment they require are designed, built and tested in accordance with the safety standards that apply in each case. Compliance with these standards is continuously monitored by our quality assurance system. The product described here has been designed, built and tested in accordance with the EC Certificate of Conformity and has left the manufacturer’s plant in a condition fully complying with safety standards. To maintain this condition and to ensure safe operation, you must observe all instructions and warnings provided in this manual. If you have any questions regarding these safety instructions, the Rohde & Schwarz group of companies will be happy to answer them.

Furthermore, it is your responsibility to use the product in an appropriate manner. This product is designed for use solely in industrial and laboratory environments or, if expressly permitted, also in the field and must not be used in any way that may cause personal injury or property damage. You are responsible if the product is used for any purpose other than its designated purpose or in disregard of the manufacturer’s instructions. The manufacturer shall assume no responsibility for such use of the product.

The product is used for its designated purpose if it is used in accordance with its product documentation and within its performance limits (see data sheet, documentation, the following safety instructions). Using the product requires technical skills and, in some cases, a basic knowledge of English. It is therefore essential that only skilled and specialized staff or thoroughly trained personnel with the required skills be allowed to use the product. If personal safety gear is required for using Rohde & Schwarz products, this will be indicated at the appropriate place in the product documentation. Keep the basic safety instructions and the product documentation in a safe place and pass them on to the subsequent users.

Observing the safety instructions will help prevent personal injury or damage of any kind caused by dangerous situations. Therefore, carefully read through and adhere to the following safety instructions before and when using the product. It is also absolutely essential to observe the additional safety instructions on personal safety, for example, that appear in relevant parts of the product documentation. In these safety instructions, the word “product” refers to all merchandise sold and distributed by the Rohde & Schwarz group of companies, including instruments, systems and all accessories. For product-specific information, see the data sheet and the product documentation.

Safety labels on products

The following safety labels are used on products to warn against risks and dangers.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Meaning</th>
<th>Symbol</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>!</td>
<td>Notice, general danger location</td>
<td>Ⓣ Ⓣ</td>
<td>ON/OFF Power</td>
</tr>
<tr>
<td></td>
<td>Observe product documentation</td>
<td>Ⓣ</td>
<td></td>
</tr>
<tr>
<td>⚠️ 10 kg</td>
<td>Caution when handling heavy equipment</td>
<td>Ⓣ</td>
<td>Standby indication</td>
</tr>
<tr>
<td>⚠️</td>
<td>Danger of electric shock</td>
<td>Ⓣ</td>
<td>Direct current (DC)</td>
</tr>
</tbody>
</table>
## Basic Safety Instructions

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Meaning</th>
<th>Symbol</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Symbol" /></td>
<td>Caution! Hot surface</td>
<td><img src="image" alt="Symbol" /></td>
<td>Alternating current (AC)</td>
</tr>
<tr>
<td><img src="image" alt="Symbol" /></td>
<td>Protective conductor terminal To identify any terminal which is intended for connection to an external conductor for protection against electric shock in case of a fault, or the terminal of a protective earth</td>
<td><img src="image" alt="Symbol" /></td>
<td>Direct/alternating current (DC/AC)</td>
</tr>
<tr>
<td><img src="image" alt="Symbol" /></td>
<td>Earth (Ground)</td>
<td><img src="image" alt="Symbol" /></td>
<td>Class II Equipment to identify equipment meeting the safety requirements specified for Class II equipment (device protected by double or reinforced insulation)</td>
</tr>
<tr>
<td><img src="image" alt="Symbol" /></td>
<td>Frame or chassis Ground terminal</td>
<td><img src="image" alt="Symbol" /></td>
<td>EU labeling for batteries and accumulators For additional information, see section &quot;Waste disposal/Environmental protection&quot;, item 1.</td>
</tr>
<tr>
<td><img src="image" alt="Symbol" /></td>
<td>Be careful when handling electrostatic sensitive devices</td>
<td><img src="image" alt="Symbol" /></td>
<td>EU labeling for separate collection of electrical and electronic devices For additional information, see section &quot;Waste disposal/Environmental protection&quot;, item 2.</td>
</tr>
<tr>
<td><img src="image" alt="Symbol" /></td>
<td>Warning! Laser radiation</td>
<td><img src="image" alt="Symbol" /></td>
<td></td>
</tr>
</tbody>
</table>

### Signal words and their meaning

The following signal words are used in the product documentation in order to warn the reader about risks and dangers.

- **DANGER**: Indicates a hazardous situation which, if not avoided, will result in death or serious injury.
- **WARNING**: Indicates a hazardous situation which, if not avoided, could result in death or serious injury.
- **CAUTION**: Indicates a hazardous situation which, if not avoided, could result in minor or moderate injury.
- **NOTICE**: Indicates information considered important, but not hazard-related, e.g. messages relating to property damage.

In the product documentation, the word ATTENTION is used synonymously.

These signal words are in accordance with the standard definition for civil applications in the European Economic Area. Definitions that deviate from the standard definition may also exist in other economic areas or military applications. It is therefore essential to make sure that the signal words described here are always used only in connection with the related product documentation and the related product. The use of signal words in connection with unrelated products or documentation can result in misinterpretation and in personal injury or material damage.
Basic Safety Instructions

Operating states and operating positions

The product may be operated only under the operating conditions and in the positions specified by the manufacturer, without the product's ventilation being obstructed. If the manufacturer's specifications are not observed, this can result in electric shock, fire and/or serious personal injury or death. Applicable local or national safety regulations and rules for the prevention of accidents must be observed in all work performed.

1. Unless otherwise specified, the following requirements apply to Rohde & Schwarz products: predefined operating position is always with the housing floor facing down, IP protection 2X, use only indoors, max. operating altitude 2000 m above sea level, max. transport altitude 4500 m above sea level. A tolerance of ±10 % shall apply to the nominal voltage and ±5 % to the nominal frequency, overvoltage category 2, pollution degree 2.

2. Do not place the product on surfaces, vehicles, cabinets or tables that for reasons of weight or stability are unsuitable for this purpose. Always follow the manufacturer's installation instructions when installing the product and fastening it to objects or structures (e.g. walls and shelves). An installation that is not carried out as described in the product documentation could result in personal injury or even death.

3. Do not place the product on heat-generating devices such as radiators or fan heaters. The ambient temperature must not exceed the maximum temperature specified in the product documentation or in the data sheet. Product overheating can cause electric shock, fire and/or serious personal injury or even death.

Electrical safety

If the information on electrical safety is not observed either at all or to the extent necessary, electric shock, fire and/or serious personal injury or death may occur.

1. Prior to switching on the product, always ensure that the nominal voltage setting on the product matches the nominal voltage of the mains-supply network. If a different voltage is to be set, the power fuse of the product may have to be changed accordingly.

2. In the case of products of safety class I with movable power cord and connector, operation is permitted only on sockets with a protective conductor contact and protective conductor.

3. Intentionally breaking the protective conductor either in the feed line or in the product itself is not permitted. Doing so can result in the danger of an electric shock from the product. If extension cords or connector strips are implemented, they must be checked on a regular basis to ensure that they are safe to use.

4. If there is no power switch for disconnecting the product from the mains, or if the power switch is not suitable for this purpose, use the plug of the connecting cable to disconnect the product from the mains. For example, if the power plug is the disconnecting device, the length of the connecting cable must not exceed 3 m. Functional or electronic switches are not suitable for providing disconnection from the AC supply network. If products without power switches are integrated into racks or systems, the disconnecting device must be provided at the system level.

5. Never use the product if the power cable is damaged. Check the power cables on a regular basis to ensure that they are in proper operating condition. By taking appropriate safety measures and carefully laying the power cable, ensure that the cable cannot be damaged and that no one can be hurt by, for example, tripping over the cable or suffering an electric shock.
Basic Safety Instructions

6. The product may be operated only from TN/TT supply networks fuse-protected with max. 16 A (higher fuse only after consulting with the Rohde & Schwarz group of companies).

7. Do not insert the plug into sockets that are dusty or dirty. Insert the plug firmly and all the way into the socket provided for this purpose. Otherwise, sparks that result in fire and/or injuries may occur.

8. Do not overload any sockets, extension cords or connector strips; doing so can cause fire or electric shocks.

9. For measurements in circuits with voltages \( V_{\text{rms}} > 30 \) V, suitable measures (e.g. appropriate measuring equipment, fuse protection, current limiting, electrical separation, insulation) should be taken to avoid any hazards.

10. Ensure that the connections with information technology equipment, e.g. PCs or other industrial computers, comply with the IEC 60950-1 / EN 60950-1 or IEC 61010-1 / EN 61010-1 standards that apply in each case.

11. Unless expressly permitted, never remove the cover or any part of the housing while the product is in operation. Doing so will expose circuits and components and can lead to injuries, fire or damage to the product.

12. If a product is to be permanently installed, the connection between the protective conductor terminal on site and the product's protective conductor must be made first before any other connection is made. The product may be installed and connected only by a licensed electrician.

13. For permanently installed equipment without built-in fuses, circuit breakers or similar protective devices, the supply circuit must be fuse-protected in such a way that anyone who has access to the product, as well as the product itself, is adequately protected from injury or damage.

14. Use suitable overvoltage protection to ensure that no overvoltage (such as that caused by a bolt of lightning) can reach the product. Otherwise, the person operating the product will be exposed to the danger of an electric shock.

15. Any object that is not designed to be placed in the openings of the housing must not be used for this purpose. Doing so can cause short circuits inside the product and/or electric shocks, fire or injuries.

16. Unless specified otherwise, products are not liquid-proof (see also section "Operating states and operating positions", item 1). Therefore, the equipment must be protected against penetration by liquids. If the necessary precautions are not taken, the user may suffer electric shock or the product itself may be damaged, which can also lead to personal injury.

17. Never use the product under conditions in which condensation has formed or can form in or on the product, e.g. if the product has been moved from a cold to a warm environment. Penetration by water increases the risk of electric shock.

18. Prior to cleaning the product, disconnect it completely from the power supply (e.g. AC supply network or battery). Use a soft, non-linting cloth to clean the product. Never use chemical cleaning agents such as alcohol, acetone or diluents for cellulose lacquers.

Operation

1. Operating the products requires special training and intense concentration. Make sure that persons who use the products are physically, mentally and emotionally fit enough to do so; otherwise, injuries or material damage may occur. It is the responsibility of the employer/operator to select suitable personnel for operating the products.
Basic Safety Instructions

2. Before you move or transport the product, read and observe the section titled "Transport".

3. As with all industrially manufactured goods, the use of substances that induce an allergic reaction (allergens) such as nickel cannot be generally excluded. If you develop an allergic reaction (such as a skin rash, frequent sneezing, red eyes or respiratory difficulties) when using a Rohde & Schwarz product, consult a physician immediately to determine the cause and to prevent health problems or stress.

4. Before you start processing the product mechanically and/or thermally, or before you take it apart, be sure to read and pay special attention to the section titled "Waste disposal/Environmental protection", item 1.

5. Depending on the function, certain products such as RF radio equipment can produce an elevated level of electromagnetic radiation. Considering that unborn babies require increased protection, pregnant women must be protected by appropriate measures. Persons with pacemakers may also be exposed to risks from electromagnetic radiation. The employer/operator must evaluate workplaces where there is a special risk of exposure to radiation and, if necessary, take measures to avert the potential danger.

6. Should a fire occur, the product may release hazardous substances (gases, fluids, etc.) that can cause health problems. Therefore, suitable measures must be taken, e.g. protective masks and protective clothing must be worn.

7. Laser products are given warning labels that are standardized according to their laser class. Lasers can cause biological harm due to the properties of their radiation and due to their extremely concentrated electromagnetic power. If a laser product (e.g. a CD/DVD drive) is integrated into a Rohde & Schwarz product, absolutely no other settings or functions may be used as described in the product documentation. The objective is to prevent personal injury (e.g. due to laser beams).

8. EMC classes (in line with EN 55011/CISPR 11, and analogously with EN 55022/CISPR 22, EN 55032/CISPR 32)
   - Class A equipment:
     Equipment suitable for use in all environments except residential environments and environments that are directly connected to a low-voltage supply network that supplies residential buildings
     Note: Class A equipment is intended for use in an industrial environment. This equipment may cause radio disturbances in residential environments, due to possible conducted as well as radiated disturbances. In this case, the operator may be required to take appropriate measures to eliminate these disturbances.
   - Class B equipment:
     Equipment suitable for use in residential environments and environments that are directly connected to a low-voltage supply network that supplies residential buildings

Repair and service

1. The product may be opened only by authorized, specially trained personnel. Before any work is performed on the product or before the product is opened, it must be disconnected from the AC supply network. Otherwise, personnel will be exposed to the risk of an electric shock.
Basic Safety Instructions

2. Adjustments, replacement of parts, maintenance and repair may be performed only by electrical experts authorized by Rohde & Schwarz. Only original parts may be used for replacing parts relevant to safety (e.g. power switches, power transformers, fuses). A safety test must always be performed after parts relevant to safety have been replaced (visual inspection, protective conductor test, insulation resistance measurement, leakage current measurement, functional test). This helps ensure the continued safety of the product.

Batteries and rechargeable batteries/cells

*If the information regarding batteries and rechargeable batteries/cells is not observed either at all or to the extent necessary, product users may be exposed to the risk of explosions, fire and/or serious personal injury, and, in some cases, death. Batteries and rechargeable batteries with alkaline electrolytes (e.g. lithium cells) must be handled in accordance with the EN 62133 standard.*

1. Cells must not be taken apart or crushed.

2. Cells or batteries must not be exposed to heat or fire. Storage in direct sunlight must be avoided. Keep cells and batteries clean and dry. Clean soiled connectors using a dry, clean cloth.

3. Cells or batteries must not be short-circuited. Cells or batteries must not be stored in a box or in a drawer where they can short-circuit each other, or where they can be short-circuited by other conductive materials. Cells and batteries must not be removed from their original packaging until they are ready to be used.

4. Cells and batteries must not be exposed to any mechanical shocks that are stronger than permitted.

5. If a cell develops a leak, the fluid must not be allowed to come into contact with the skin or eyes. If contact occurs, wash the affected area with plenty of water and seek medical aid.

6. Improperly replacing or charging cells or batteries that contain alkaline electrolytes (e.g. lithium cells) can cause explosions. Replace cells or batteries only with the matching Rohde & Schwarz type (see parts list) in order to ensure the safety of the product.

7. Cells and batteries must be recycled and kept separate from residual waste. Rechargeable batteries and normal batteries that contain lead, mercury or cadmium are hazardous waste. Observe the national regulations regarding waste disposal and recycling.

Transport

1. The product may be very heavy. Therefore, the product must be handled with care. In some cases, the user may require a suitable means of lifting or moving the product (e.g. with a lift-truck) to avoid back or other physical injuries.

2. Handles on the products are designed exclusively to enable personnel to transport the product. It is therefore not permissible to use handles to fasten the product to or on transport equipment such as cranes, fork lifts, wagons, etc. The user is responsible for securely fastening the products to or on the means of transport or lifting. Observe the safety regulations of the manufacturer of the means of transport or lifting. Noncompliance can result in personal injury or material damage.

3. If you use the product in a vehicle, it is the sole responsibility of the driver to drive the vehicle safely and properly. The manufacturer assumes no responsibility for accidents or collisions. Never use the product in a moving vehicle if doing so could distract the driver of the vehicle. Adequately secure the product in the vehicle to prevent injuries or other damage in the event of an accident.
Waste disposal/Environmental protection

1. Specially marked equipment has a battery or accumulator that must not be disposed of with unsorted municipal waste, but must be collected separately. It may only be disposed of at a suitable collection point or via a Rohde & Schwarz customer service center.

2. Waste electrical and electronic equipment must not be disposed of with unsorted municipal waste, but must be collected separately.
Rohde & Schwarz GmbH & Co. KG has developed a disposal concept and takes full responsibility for take-back obligations and disposal obligations for manufacturers within the EU. Contact your Rohde & Schwarz customer service center for environmentally responsible disposal of the product.

3. If products or their components are mechanically and/or thermally processed in a manner that goes beyond their intended use, hazardous substances (heavy-metal dust such as lead, beryllium, nickel) may be released. For this reason, the product may only be disassembled by specially trained personnel. Improper disassembly may be hazardous to your health. National waste disposal regulations must be observed.

4. If handling the product releases hazardous substances or fuels that must be disposed of in a special way, e.g. coolants or engine oils that must be replenished regularly, the safety instructions of the manufacturer of the hazardous substances or fuels and the applicable regional waste disposal regulations must be observed. Also observe the relevant safety instructions in the product documentation. The improper disposal of hazardous substances or fuels can cause health problems and lead to environmental damage.

For additional information about environmental protection, visit the Rohde & Schwarz website.

Instrucciones de seguridad elementales

¡Es imprescindible leer y cumplir las siguientes instrucciones e informaciones de seguridad!

El principio del grupo de empresas Rohde & Schwarz consiste en tener nuestros productos siempre al día con los estándares de seguridad y de ofrecer a nuestros clientes el máximo grado de seguridad. Nuestros productos y todos los equipos adicionales son siempre fabricados y examinados según las normas de seguridad vigentes. Nuestro sistema de garantía de calidad controla constantemente que sean cumplidas estas normas. El presente producto ha sido fabricado y examinado según el certificado de conformidad de la UE y ha salido de nuestra planta en estado impecable según los estándares técnicos de seguridad. Para poder preservar este estado y garantizar un funcionamiento libre de peligros, el usuario deberá atenerse a todas las indicaciones, informaciones de seguridad y notas de alerta. El grupo de empresas Rohde & Schwarz está siempre a su disposición en caso de que tengan preguntas referentes a estas informaciones de seguridad.

Además queda en la responsabilidad del usuario utilizar el producto en la forma debida. Este producto está destinado exclusivamente al uso en la industria y el laboratorio o, si ha sido expresamente autorizado, para aplicaciones de campo y de ninguna manera deberá ser utilizado de modo que alguna persona/cosa pueda sufrir daño. El uso del producto fuera de sus fines definidos o sin tener en cuenta las instrucciones del fabricante queda en la responsabilidad del usuario. El fabricante no se hace en ninguna forma responsable de consecuencias a causa del mal uso del producto.
Instrucciones de seguridad elementales

Se parte del uso correcto del producto para los fines definidos si el producto es utilizado conforme a las indicaciones de la correspondiente documentación del producto y dentro del margen de rendimiento definido (ver hoja de datos, documentación, informaciones de seguridad que siguen). El uso del producto hace necesarios conocimientos técnicos y ciertos conocimientos del idioma inglés. Por eso se debe tener en cuenta que el producto solo pueda ser operado por personal especializado o personas instruidas en profundidad con las capacidades correspondientes. Si fuera necesaria indumentaria de seguridad para el uso de productos de Rohde & Schwarz, encontraría la información debida en la documentación del producto en el capítulo correspondiente. Guarde bien las informaciones de seguridad elementales, así como la documentación del producto, y entréguelas a usuarios posteriores.

Tener en cuenta las informaciones de seguridad sirve para evitar en lo posible lesiones o daños por peligros de toda clase. Por eso es imprescindible leer detalladamente y comprender por completo las siguientes informaciones de seguridad antes de usar el producto, y respetarlas durante el uso del producto. Deberán tenerse en cuenta todas las demás informaciones de seguridad, como p. ej. las referentes a la protección de personas, que encontrarán en el capítulo correspondiente de la documentación del producto y que también son de obligado cumplimiento. En las presentes informaciones de seguridad se recogen todos los objetos que distribuye el grupo de empresas Rohde & Schwarz bajo la denominación de "producto", entre ellos también aparatos, instalaciones así como toda clase de accesorios. Los datos específicos del producto figuran en la hoja de datos y en la documentación del producto.

Señalización de seguridad de los productos

Las siguientes señales de seguridad se utilizan en los productos para advertir sobre riesgos y peligros.

<table>
<thead>
<tr>
<th>Símbolo</th>
<th>Significado</th>
<th>Símbolo</th>
<th>Significado</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Aviso: punto de peligro general" /></td>
<td>Aviso: punto de peligro general</td>
<td><img src="image" alt="Tensión de alimentación de PUESTA EN MARCHA / PARADA" /></td>
<td>Tensión de alimentación de PUESTA EN MARCHA / PARADA</td>
</tr>
<tr>
<td><img src="image" alt="Atención en el manejo de dispositivos de peso elevado" /></td>
<td>Atención en el manejo de dispositivos de peso elevado</td>
<td><img src="image" alt="Indicación de estado de espera (standby)" /></td>
<td>Indicación de estado de espera (standby)</td>
</tr>
<tr>
<td><img src="image" alt="Peligro de choque eléctrico" /></td>
<td>Peligro de choque eléctrico</td>
<td><img src="image" alt="Corriente continua (DC)" /></td>
<td>Corriente continua (DC)</td>
</tr>
<tr>
<td><img src="image" alt="Advertencia: superficie caliente" /></td>
<td>Advertencia: superficie caliente</td>
<td><img src="image" alt="Corriente alterna (AC)" /></td>
<td>Corriente alterna (AC)</td>
</tr>
<tr>
<td><img src="image" alt="Conexión a conductor de protección" /></td>
<td>Conexión a conductor de protección</td>
<td><img src="image" alt="Corriente continua / Corriente alterna (DC/AC)" /></td>
<td>Corriente continua / Corriente alterna (DC/AC)</td>
</tr>
<tr>
<td><img src="image" alt="Conexión a tierra" /></td>
<td>Conexión a tierra</td>
<td><img src="image" alt="El aparato está protegido en su totalidad por un aislamiento doble (reforzado)" /></td>
<td>El aparato está protegido en su totalidad por un aislamiento doble (reforzado)</td>
</tr>
<tr>
<td><img src="image" alt="Conexión a masa" /></td>
<td>Conexión a masa</td>
<td><img src="image" alt="Distintivo de la UE para baterías y acumuladores" /></td>
<td>Distintivo de la UE para baterías y acumuladores</td>
</tr>
<tr>
<td></td>
<td></td>
<td><img src="image" alt="Más información en la sección &quot;Eliminación/protección del medio ambiente&quot;, punto 1." /></td>
<td>Más información en la sección &quot;Eliminación/protección del medio ambiente&quot;, punto 1.</td>
</tr>
</tbody>
</table>
Instrucciones de seguridad elementales

<table>
<thead>
<tr>
<th>Símbolo</th>
<th>Significado</th>
</tr>
</thead>
<tbody>
<tr>
<td>⚠️</td>
<td>Aviso: Cuidado en el manejo de dispositivos sensibles a la electrostática (ESD)</td>
</tr>
<tr>
<td>🔴</td>
<td>Distintivo de la UE para la eliminación por separado de dispositivos eléctricos y electrónicos más información en la sección “Eliminación/protección del medio ambiente”, punto 2.</td>
</tr>
<tr>
<td>⚠️</td>
<td>Advertencia: rayo láser</td>
</tr>
<tr>
<td></td>
<td>Más información en la sección “Funcionamiento”, punto 7.</td>
</tr>
</tbody>
</table>

Palabras de señal y su significado

En la documentación del producto se utilizan las siguientes palabras de señal con el fin de advertir contra riesgos y peligros.

- **PELIGRO**: Indica una situación de peligro que, si no se evita, causa lesiones graves o incluso la muerte.
- **ADVERTENCIA**: Indica una situación de peligro que, si no se evita, puede causar lesiones graves o incluso la muerte.
- **ATENCIÓN**: Indica una situación de peligro que, si no se evita, puede causar lesiones leves o moderadas.
- **AVISO**: Indica información que se considera importante, pero no en relación con situaciones de peligro; p. ej., avisos sobre posibles daños materiales.

En la documentación del producto se emplea de forma sinónima el término CUIDADO.

Las palabras de señal corresponden a la definición habitual para aplicaciones civiles en el área económica europea. Pueden existir definiciones diferentes a esta definición en otras áreas económicas o en aplicaciones militares. Por eso se deberá tener en cuenta que las palabras de señal aquí descritas sean utilizadas siempre solamente en combinación con la correspondiente documentación del producto y solamente en combinación con el producto correspondiente. La utilización de las palabras de señal en combinación con productos o documentaciones que no les correspondan puede llevar a interpretaciones equivocadas y tener por consecuencia daños en personas u objetos.

Estados operativos y posiciones de funcionamiento

*El producto solamente debe ser utilizado según lo indicado por el fabricante respecto a los estados operativos y posiciones de funcionamiento sin que se obstruya la ventilación. Si no se siguen las indicaciones del fabricante, pueden producirse choques eléctricos, incendios y/o lesiones graves con posible consecuencia de muerte. En todos los trabajos deberán ser tenidas en cuenta las normas nacionales y locales de seguridad del trabajo y de prevención de accidentes.*
Instrucciones de seguridad elementales

1. Si no se convino de otra manera, es para los productos Rohde & Schwarz válido lo que sigue: como posición de funcionamiento se define por principio la posición con el suelo de la caja para abajo, modo de protección IP 2X, uso solamente en estancias interiores, utilización hasta 2000 m sobre el nivel del mar, transporte hasta 4500 m sobre el nivel del mar. Se aplicará una tolerancia de ±10% sobre el voltaje nominal y de ±5% sobre la frecuencia nominal. Categoría de sobrecarga eléctrica 2, índice de suciedad 2.

2. No sitúe el producto encima de superficies, vehículos, estantes o mesas, que por sus características de peso o de estabilidad no sean aptos para él. Siga siempre las instrucciones de instalación del fabricante cuando instale y asegure el producto en objetos o estructuras (p. ej. paredes y estantes). Si se realiza la instalación de modo distinto al indicado en la documentación del producto, se pueden causar lesiones o, en determinadas circunstancias, incluso la muerte.

3. No ponga el producto sobre aparatos que generen calor (p. ej. radiadores o calefactores). La temperatura ambiente no debe superar la temperatura máxima especificada en la documentación del producto o en la hoja de datos. En caso de sobrecalentamiento del producto, pueden producirse choques eléctricos, incendios y/o lesiones graves con posible consecuencia de muerte.

Seguridad eléctrica

Si no se siguen (o se siguen de modo insuficiente) las indicaciones del fabricante en cuanto a seguridad eléctrica, pueden producirse choques eléctricos, incendios y/o lesiones graves con posible consecuencia de muerte.

1. Antes de la puesta en marcha del producto se deberá comprobar siempre que la tensión preseleccionada en el producto coincida con la de la red de alimentación eléctrica. Si es necesario modificar el ajuste de tensión, también se deberán cambiar en caso dado los fusibles correspondientes del producto.

2. Los productos de la clase de protección I con alimentación móvil y enchufe individual solamente podrán enchufarse a tomas de corriente con contacto de seguridad y con conductor de protección conectado.

3. Queda prohibida la interrupción intencionada del conductor de protección, tanto en la toma de corriente como en el mismo producto. La interrupción puede tener como consecuencia el riesgo de que el producto sea fuente de choques eléctricos. Si se utilizan cables alargadores o regletas de enchufe, deberá garantizarse la realización de un examen regular de los mismos en cuanto a su estado técnico de seguridad.

4. Si el producto no está equipado con un interruptor para desconectarlo de la red, o bien si el interruptor existente no resulta apropiado para la desconexión de la red, el enchufe del cable de conexión se deberá considerar como un dispositivo de desconexión. El dispositivo de desconexión se debe poder alcanzar fácilmente y debe estar siempre bien accesible. Sí, p. ej., el enchufe de conexión a la red es el dispositivo de desconexión, la longitud del cable de conexión no debe superar 3 m). Los interruptores selectores o electrónicos no son aptos para el corte de la red eléctrica. Si se integran productos sin interruptor en bastidores o instalaciones, se deberá colocar el interruptor en el nivel de la instalación.

5. No utilice nunca el producto si está dañado el cable de conexión a red. Compruebe regularmente el correcto estado de los cables de conexión a red. Asegúrese, mediante las medidas de protección y de instalación adecuadas, de que el cable de conexión a red no pueda ser dañado o de que nadie pueda ser dañado por él, p. ej. al tropezar o por un choque eléctrico.
Instrucciones de seguridad elementales

6. Solamente está permitido el funcionamiento en redes de alimentación TN/TT aseguradas con fusibles de 16 A como máximo (utilización de fusibles de mayor amperaje solo previa consulta con el grupo de empresas Rohde & Schwarz).

7. Nunca conecte el enchufe en tomas de corriente sucias o llenas de polvo. Introduzca el enchufe por completo y fuertemente en la toma de corriente. La no observación de estas medidas puede provocar chispas, fuego y/o lesiones.

8. No sobrecargue las tomas de corriente, los cables alargadores o las regletas de enchufe ya que esto podría causar fuego o choques eléctricos.

9. En las mediciones en circuitos de corriente con una tensión $U_{\text{eff}} > 30$ V se deberán tomar las medidas apropiadas para impedir cualquier peligro (p. ej. medios de medición adecuados, seguros, limitación de tensión, corte protector, aislamiento etc.).

10. Para la conexión con dispositivos informáticos como un PC o un ordenador industrial, debe comprobarse que éstos cumplan los estándares IEC60950-1/EN60950-1 y IEC61010-1/EN 61010-1 válidos en cada caso.

11. A menos que esté permitido expresamente, no retire nunca la tapa ni componentes de la carcasa mientras el producto esté en servicio. Esto pone a descubierto los cables y componentes eléctricos y puede causar lesiones, fuego o daños en el producto.

12. Si un producto se instala en un lugar fijo, se deberá primero conectar el conductor de protección fijo con el conductor de protección del producto antes de hacer cualquier otra conexión. La instalación y la conexión deberán ser efectuadas por un electricista especializado.

13. En el caso de dispositivos fijos que no estén provistos de fusibles, interruptor automático ni otros mecanismos de seguridad similares, el circuito de alimentación debe estar protegido de modo que todas las personas que puedan acceder al producto, así como el producto mismo, estén a salvo de posibles daños.

14. Todo producto debe estar protegido contra sobretensión (debida p. ej. a una caída del rayo) mediante los correspondientes sistemas de protección. Si no, el personal que lo utilice quedará expuesto al peligro de choque eléctrico.

15. No debe introducirse en los orificios de la caja del aparato ningún objeto que no esté destinado a ello. Esto puede producir cortocircuitos en el producto y/o puede causar choques eléctricos, fuego o lesiones.

16. Salvo indicación contraria, los productos no están impermeabilizados (ver también el capítulo “Estados operativos y posiciones de funcionamiento”, punto 1). Por eso es necesario tomar las medidas necesarias para evitar la entrada de líquidos. En caso contrario, existe peligro de choque eléctrico para el usuario o de daños en el producto, que también pueden redundar en peligro para las personas.

17. No utilice el producto en condiciones en las que pueda producirse o ya se hayan producido condensaciones sobre el producto o en el interior de éste, como p. ej. al desplazarlo de un lugar frío a otro caliente. La entrada de agua aumenta el riesgo de choque eléctrico.

18. Antes de la limpieza, desconecte por completo el producto de la alimentación de tensión (p. ej. red de alimentación o batería). Realice la limpieza de los aparatos con un paño suave, que no se deshilache. No utilice bajo ningún concepto productos de limpieza químicos como alcohol, acetona o diluyentes para lacas nitrocelulósicas.
Instrucciones de seguridad elementales

Funcionamiento

1. El uso del producto requiere instrucciones especiales y una alta concentración durante el manejo. Debe asegurarse que las personas que manejen el producto estén a la altura de los requerimientos necesarios en cuanto a aptitudes físicas, psíquicas y emocionales, ya que de otra manera no se pueden excluir lesiones o daños de objetos. El empresario u operador es responsable de seleccionar el personal usuario apto para el manejo del producto.

2. Antes de desplazar o transportar el producto, lea y tenga en cuenta el capítulo “Transporte”.

3. Como con todo producto de fabricación industrial no puede quedar excluida en general la posibilidad de que se produzcan alergias provocadas por algunos materiales empleados —los llamados alérgenos (p. ej. el níquel)—. Si durante el manejo de productos Rohde & Schwarz se producen reacciones alérgicas, como p. ej. irritaciones cutáneas, estornudos continuos, enrojecimiento de la conjuntiva o dificultades respiratorias, debe avisarse inmediatamente a un médico para investigar las causas y evitar cualquier molestia o daño a la salud.

4. Antes de la manipulación mecánica y/o térmica o el desmontaje del producto, debe tenerse en cuenta imprescindiblemente el capítulo "Eliminación/protección del medio ambiente", punto 1.

5. Ciertos productos, como p. ej. las instalaciones de radiocomunicación RF, pueden a causa de su función natural, emitir una radiación electromagnética aumentada. Deben tomarse todas las medidas necesarias para la protección de las mujeres embarazadas. También las personas con marcapasos pueden correr peligro a causa de la radiación electromagnética. El empresario/operador tiene la obligación de evaluar y señalar las áreas de trabajo en las que exista un riesgo elevado de exposición a radiaciones.

6. Tenga en cuenta que en caso de incendio pueden desprenderse del producto sustancias tóxicas (gases, líquidos etc.) que pueden generar daños a la salud. Por eso, en caso de incendio deben usarse medidas adecuadas, como p. ej. máscaras antigás e indumentaria de protección.

7. Los productos con láser están provistos de indicaciones de advertencia normalizadas en función de la clase de láser del que se trate. Los rayos láser pueden provocar daños de tipo biológico a causa de las propiedades de su radiación y debido a su concentración extrema de potencia electromagnética. En caso de que un producto Rohde & Schwarz contenga un producto láser (p. ej. un lector de CD/DVD), no debe usarse ninguna otra configuración o función aparte de las descritas en la documentación del producto, a fin de evitar lesiones (p. ej. debidas a irradiación láser).

8. Clases de compatibilidad electromagnética (conforme a EN 55011 / CISPR 11; y en analogía con EN 55022 / CISPR 22, EN 55032 / CISPR 32)
   - Aparato de clase A:
     Aparato adecuado para su uso en todos los entornos excepto en los residenciales y en aquellos conectados directamente a una red de distribución de baja tensión que suministra corriente a edificios residenciales.
     Nota: Los aparatos de clase A están destinados al uso en entornos industriales. Estos aparatos pueden causar perturbaciones radioeléctricas en entornos residenciales debido a posibles perturbaciones guiadas o radiadas. En este caso, se le podrá solicitar al operador que tome las medidas adecuadas para eliminar estas perturbaciones.
   - Aparato de clase B:
     Aparato adecuado para su uso en entornos residenciales, así como en aquellos conectados directamente a una red de distribución de baja tensión que suministra corriente a edificios residenciales.
Instrucciones de seguridad elementales

Reparación y mantenimiento

1. El producto solamente debe ser abierto por personal especializado con autorización para ello. Antes de manipular el producto o abrirlo, es obligatorio desconectarlo de la tensión de alimentación, para evitar toda posibilidad de choque eléctrico.

2. El ajuste, el cambio de partes, el mantenimiento y la reparación deberán ser efectuadas solamente por electricistas autorizados por Rohde & Schwarz. Si se reponen partes con importancia para los aspectos de seguridad (p. ej. el enchufe, los transformadores o los fusibles), solamente podrán ser sustituidos por partes originales. Después de cada cambio de partes relevantes para la seguridad deberá realizarse un control de seguridad (control a primera vista, control del conductor de protección, medición de resistencia de aislamiento, medición de la corriente de fuga, control de funcionamiento). Con esto queda garantizada la seguridad del producto.

Baterías y acumuladores o celdas

*Sí no se siguen (o se siguen de modo insuficiente) las indicaciones en cuanto a las baterías y acumuladores o celdas, pueden producirse explosiones, incendios y/o lesiones graves con posible consecuencia de muerte. El manejo de baterías y acumuladores con electrolitos alcalinos (p. ej. celdas de litio) debe seguir el estándar EN 62133.*

1. No deben desmontarse, abrirse ni triturarse las celdas.

2. Las celdas o baterías no deben someterse a calor ni fuego. Debe evitarse el almacenamiento a la luz directa del sol. Las celdas y baterías deben mantenerse limpias y secas. Limpiar las conexiones sucias con un paño seco y limpio.

3. Las celdas o baterías no deben cortocircuitarse. Es peligroso almacenar las celdas o baterías en estuches o cajones en cuyo interior puedan cortocircuitarse por contacto recíproco o por contacto con otros materiales conductores. No deben extraerse las celdas o baterías de sus embalajes originales hasta el momento en que vayan a utilizarse.

4. Las celdas o baterías no deben someterse a impactos mecánicos fuertes indebidos.

5. En caso de falta de estanqueidad de una celda, el líquido vertido no debe entrar en contacto con la piel ni los ojos. Si se produce contacto, lavar con agua abundante la zona afectada y avisar a un médico.

6. En caso de cambio o recarga inadecuados, las celdas o baterías que contienen electrolitos alcalinos (p. ej. las celdas de litio) pueden explotar. Para garantizar la seguridad del producto, las celdas o baterías solo deben ser sustituidas por el tipo Rohde & Schwarz correspondiente (ver lista de recambios).

7. Las baterías y celdas deben reciclarse y no deben tirarse a la basura doméstica. Las baterías o acumuladores que contienen plomo, mercurio o cadmio deben tratarse como residuos especiales. Respeta en esta relación las normas nacionales de eliminación y reciclaje.

Transporte

1. El producto puede tener un peso elevado. Por eso es necesario desplazarlo o transportarlo con precaución y, si es necesario, usando un sistema de elevación adecuado (p. ej. una carretilla elevadora), a fin de evitar lesiones en la espalda u otros daños personales.
Instrucciones de seguridad elementales

2. Las asas instaladas en los productos sirven solamente de ayuda para el transporte del producto por personas. Por eso no está permitido utilizar las asas para la sujeción en o sobre medios de transporte como p. ej. grúas, carretillas elevadoras de horquilla, carros etc. Es responsabilidad suya fijar los productos de manera segura a los medios de transporte o elevación. Para evitar daños personales o daños en el producto, siga las instrucciones de seguridad del fabricante del medio de transporte o elevación utilizado.

3. Si se utiliza el producto dentro de un vehículo, recae de manera exclusiva en el conductor la responsabilidad de conducir el vehículo de manera segura y adecuada. El fabricante no asumirá ninguna responsabilidad por accidentes o colisiones. No utilice nunca el producto dentro de un vehículo en movimiento si esto pudiera distraer al conductor. Asegure el producto dentro del vehículo debidamente para evitar, en caso de un accidente, lesiones u otra clase de daños.

Eliminación/protección del medio ambiente

1. Los dispositivos marcados contienen una batería o un acumulador que no se debe desechar con los residuos domésticos sin clasificar, sino que debe ser recogido por separado. La eliminación se debe efectuar exclusivamente a través de un punto de recogida apropiado o del servicio de atención al cliente de Rohde & Schwarz.

2. Los dispositivos eléctricos usados no se deben desechar con los residuos domésticos sin clasificar, sino que deben ser recogidos por separado. Rohde & Schwarz GmbH & Co.KG ha elaborado un concepto de eliminación de residuos y asume plenamente los deberes de recogida y eliminación para los fabricantes dentro de la UE. Para desechar el producto de manera respetuosa con el medio ambiente, diríjase a su servicio de atención al cliente de Rohde & Schwarz.

3. Si se trabaja de manera mecánica y/o térmica cualquier producto o componente más allá del funcionamiento previsto, pueden liberarse sustancias peligrosas (polvos con contenido de metales pesados como p. ej. plomo, berilio o níquel). Por eso el producto solo debe ser desmontado por personal especializado con formación adecuada. Un desmontaje inadecuado puede ocasionar daños para la salud. Se deben tener en cuenta las directivas nacionales referentes a la eliminación de residuos.

4. En caso de que durante el trato del producto se formen sustancias peligrosas o combustibles que deban tratarse como residuos especiales (p. ej. refrigerantes o aceites de motor con intervalos de cambio definidos), deben tenerse en cuenta las indicaciones de seguridad del fabricante de dichas sustancias y las normas regionales de eliminación de residuos. Tenga en cuenta también en caso necesario las indicaciones de seguridad especiales contenidas en la documentación del producto. La eliminación incorrecta de sustancias peligrosas o combustibles puede causar daños a la salud o daños al medio ambiente.

Se puede encontrar más información sobre la protección del medio ambiente en la página web de Rohde & Schwarz.
Customer Support

Technical support – where and when you need it
For quick, expert help with any Rohde & Schwarz equipment, contact one of our Customer Support Centers. A team of highly qualified engineers provides telephone support and will work with you to find a solution to your query on any aspect of the operation, programming or applications of Rohde & Schwarz equipment.

Up-to-date information and upgrades
To keep your instrument up-to-date and to be informed about new application notes related to your instrument, please send an e-mail to the Customer Support Center stating your instrument and your wish. We will take care that you will get the right information.

<table>
<thead>
<tr>
<th>Region</th>
<th>Phone Information</th>
</tr>
</thead>
</table>
| Europe, Africa, Middle East | +49 89 4129 12345  
customersupport@rohde-schwarz.com |
| North America         | 1-888-TEST-RSA (1-888-837-8772)  
customer.support@rsa.rohde-schwarz.com |
| Latin America         | +1-410-910-7988  
customersupport.la@rohde-schwarz.com |
| Asia/Pacific          | +65 65 13 04 88  
customersupport.asia@rohde-schwarz.com |
| China                 | +86-800-810-8228 /+86-400-650-5896  
customersupport.china@rohde-schwarz.com |
Contents

1 Putting into Operation........................................................................................................7
  1.1 Notes on putting into operation...................................................................................7
  1.2 EMC............................................................................................................................8
  1.3 Unpacking the meter.................................................................................................8
  1.4 Setting up the meter....................................................................................................8
  1.5 Front panel tour..........................................................................................................9
  1.6 Rear Panel Tour.........................................................................................................15
  1.7 Connecting the instrument to the AC supply.........................................................17
  1.8 Starting the R&S NRP2...............................................................................................18

2 Getting Started.................................................................................................................23
  2.1 Requirements..............................................................................................................23
  2.2 Brief introduction to the operation............................................................................24
  2.3 Preset and zeroing......................................................................................................27
  2.4 Measuring average power (Cont Av mode)................................................................29
  2.5 Window handling.......................................................................................................36
  2.6 Setting measurement functions................................................................................41
  2.7 Graphically representing power versus time..........................................................43
  2.8 Measuring average burst power (Burst Av mode)...................................................47

3 Manual Operation.............................................................................................................49
  3.1 Keys...........................................................................................................................49
  3.2 Screen layout.............................................................................................................49
  3.3 Menu layout..............................................................................................................51
  3.4 Menu handling.........................................................................................................53
  3.5 Dialog boxes and their controls...............................................................................53
  3.6 Display windows......................................................................................................57

4 Instrument Functions......................................................................................................61
  4.1 Main Settings...........................................................................................................61
  4.2 Data acquisition and parameters..............................................................................64
  4.3 Displaying measurement results..............................................................................91
  4.4 Configuring measurements.......................................................................................97
4.5 Displaying traces................................................................. 113
4.6 Management of settings.................................................... 141
4.7 System settings................................................................. 145
4.8 Messages and alarms........................................................ 166

5 Remote Control Fundamentals............................................ 169
5.1 Differences between Remote Control and Manual Control........ 169
5.2 Connecting a Controller to the Base Unit......................... 170
5.3 Switchover to Remote Control (REMOTE)......................... 172
5.4 Return to Manual Operation (LOCAL)............................... 172
5.5 Automatic Settings when Switching between Local and Remote.. 173
5.6 Communication on Data Lines.......................................... 173
5.7 Structure and Syntax of device-dependent Messages.......... 175
5.8 Device Model and Command Processing......................... 183
5.9 Automatic Settings for Manual Selection of a Measurement Mode.. 184
5.10 Correspondence between Remote Control and Manual Control... 186

6 Remote Control - Commands.............................................. 193
6.1 Notation........................................................................... 193
6.2 Common Commands to IEEE 488.2.................................. 194
6.3 Overview of SCPI Command Systems............................. 206
6.4 High-Level Measurement Commands (CONFigure, MEASure, READ and FETCH) .. 208
6.5 CALCulate (Configuration of Calculate Blocks)............... 224
6.6 CALibration.................................................................... 237
6.7 DISPlay.......................................................................... 238
6.8 FORMat.......................................................................... 248
6.9 MEMory......................................................................... 249
6.10 OUTPut......................................................................... 255
6.11 SENSe (Sensor Commands)....................................... 260
6.12 SERVice....................................................................... 293
6.13 STATus......................................................................... 296
6.14 SYSTem........................................................................ 318
6.15 TRIGger....................................................................... 328
6.16 UNIT........................................................................... 335
7 Maintenance
    7.1 Sensor test
    7.2 Instrument selftest
    7.3 Cleaning the exterior
    7.4 Storage

8 Error Messages and Troubleshooting
    8.1 Status and Error Messages in Manual Control
    8.2 SCPI-Specific Error Messages
    8.3 Bootmenu

A Annex
    A.1 Volatile Mode
    A.2 Remote control interfaces
    A.3 Standard Configurations
    A.4 Programming Measurements
    A.5 Compatibility Information

List of Commands
Index
1 Putting into Operation

This section describes the basic steps to be taken when setting up the R&S NRP2 for the first time.

It contains the following topics:

● unpacking
● AC supply connection
● switching the meter on and off
● function testing and installing the meter
● preset or default settings
● front and rear views

1.1 Notes on putting into operation

**NOTICE**

Risk of instrument damage

Note that the general safety instructions also contain information on operating conditions that will prevent damage to the instrument. The instrument's data sheet may contain additional operating conditions.

**NOTICE**

Risk of instrument damage

Before putting the R&S NRP2 into operation, make sure that:

● the sensor inputs are not overloaded
● the meter's outputs are not overloaded or wrongly connected
● the ventilation holes are not obstructed

The meter may be damaged if these precautions are not observed.
1.2 EMC

EMI impact on measurement results
To prevent EMI, the meter must always be installed to meet the relevant EMC standards. Never operate the instrument with its enclosure removed. Only use shielded signal and control cables that meet the relevant EMC standards.

1.3 Unpacking the meter

When you have removed the meter from its packing, check that nothing is missing using the delivery note and the accessory lists.

If there is any damage, contact the carrier. Keep all the packing to support any claims for compensation.

Retain the original packing material. If the instrument needs to be transported or shipped at a later date, you can use the material to prevent control elements and connectors from being damaged.

1.4 Setting up the meter

The R&S NRP2 is designed for use under laboratory conditions, either on a bench top or in a rack.

1.4.1 Carrying handle

If the R&S NRP2 is not installed in a rack, it should be set up so that the viewing angle for the display is optimal. The carrying handle can be locked in a variety of positions to act as a stand.

To adjust the handle, pull the two side-pieces of the handle outwards so that the handle can be rotated.

The handle locks at angles which are multiples of 60°.
1.4.2 Bench top operation

If the R&S NRP2 is operated on a bench top, the surface should be flat. The instrument can be used in horizontal position, standing on its feet, or with the support feet on the bottom extended.

1.4.3 Mounting the instrument in a rack

The R&S NRP2 can be installed in a rack using a variety of rack adapters (order numbers see data sheet). The installation instructions are part of an adapter kit.

---

**NOTICE**

Risk of instrument damage

For rack installation, make sure that the airflow perforations are unimpeded. This helps to prevent the instruments from being overheated.

---

1.5 Front panel tour

The front panel of the R&S NRP2 consists of the VGA display with the softkey area, the connectors on the left side and the hardkeys and utility keys on the right side. The subsequent sections provide brief explanations on the controls and connectors, the hardkey area and the front panel.
1.5.1 Display

The R&S NRP2 displays results in windows. Depending on the measurement mode, values are displayed digitally, in a combined digital and analog mode, or graphically.

The display mode can be selected individually for each measurement, i.e. you can perform both graphical and numerical representations simultaneously.
Graphical display

![Graphical display](image)

*Fig. 1-2: Trace in Pulse display in 'Trace&Statistic' mode*

The meter shows the results in a measurement curve, i.e. as a function of time. This presentation is obtained in "Trace & Statistics" mode, see chapter 4.5, "Displaying traces", on page 113.

The window is tiled in several sections:

- **the status bar** on top of the screen indicates information concerning the measurement and instrument state.
- **the display area** shows the measurement curve, including markers, result and time axes information and further auxiliary values.
- **the control panel** on the right offers functions for direct setting of the screen, or the access of further subdialogs. Pressing the associated key (right next to the display) executes the function or opens the dialog box.
- **the info panel** underneath the graph shows auxiliary information.

Numerical display

<table>
<thead>
<tr>
<th>Sensor</th>
<th>Windows</th>
<th>Measurement</th>
<th>File</th>
<th>System</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>A</td>
<td>-9.99 dBm</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>C</td>
<td>13.22 dBm</td>
<td>50.000 MHz</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>D</td>
<td>9.19 dBm</td>
<td>50.000 MHz</td>
<td></td>
</tr>
</tbody>
</table>

*Fig. 1-3: Digital and analog display*
Numerical measuring windows indicate the readings digitally, or provide the values in form of an analog meter. A maximum of four windows can be displayed on the screen, while their size is determined by the number of windows. The R&S NRP2 indicates either all windows simultaneously, or individually expanded.

For detailed information concerning the screen layout see chapter 3.2, "Screen layout", on page 49.

1.5.2 Keys

The keys on the front panel of the meter are used to manually operate the instrument. Grouped by soft- and hardkeys, each group represents specific functions.

1.5.2.1 Softkeys

The six softkeys are rocker switches - in other words, they can be “rocked” backwards and forwards by pressing on the right or left side of the key. The softkey function is context-sensitive and is indicated by screen labeling.

For more information on the softkeys see also chapter 2.2, "Brief introduction to the operation", on page 24, chapter 3.5, "Dialog boxes and their controls", on page 53 and chapter 3.4, "Menu handling", on page 53.

1.5.2.2 Hardkeys

Hardkeys cause the R&S NRP2 to return to a definite instrument state, provide access to the main settings and activate functions. Hardkeys are always available for use.

For further information on using the hardkeys see also chapter 2.2, "Brief introduction to the operation", on page 24, and especially on the setup keys (PRE)SET, FREQ and ZERO see chapter 4.1, "Main Settings", on page 61.

![MENU]

- as the "" key (i.e. Enter key), it is used to confirm entries in text fields and dialog boxes and to confirm selections in the drop-down lists.
● as the MENU key, it is used to fold out and fold back the menus next to the softkeys.

The function of the key is determined according to context – in other words, the ENTER or MENU function is always selected automatically for the operator by the instrument.

**DEL / 1 TRIG**

● the DEL key is used to delete numbers or text in a field so that a completely new entry can be made.

● as the 1 TRIG key, it enables and triggers single-shot measurements in the trace mode.

The function of the key is selected automatically according to context.

**ESC / LOCAL**

● this key is used as an ESC key to escape from the entry mode in text boxes and drop-down lists. It is also used to close dialog boxes and menus without losing any entries that have been made, see chapter 3.2, "Screen layout", on page 49.

● as the LOCAL key, it is used to switch the R&S NRP2 from remote control mode (all controls disabled) to manual mode.

The key is automatically assigned its function according to context - in other words, there is no manual assignment by the operator.

**MODE**

MODE opens the "Mode" dialog box to select and configure the measurement mode.

See also chapter 4.2.1.1, "Mode dialog box", on page 65.

**(PRE)SET**

The (PRE)SET hardkey sets the R&S NRP2 to its default setting. Default settings are sensor specific.

The function can also be started with the "Preset" softkey in the file menu, see chapter 4.6.1, "Default setting", on page 141.

**FREQ**

FREQ sets the carrier frequency of the applied signal to obtain the specific measurement uncertainty.

Find more information on the frequency dialog box in the operating manual, chapter 4.1.2, "Frequency hardkey", on page 62.

**ZERO**

This function starts the autozero function, see also chapter 4.1.3, "Zero hardkey", on page 63.

### 1.5.2.3 Cursor keys

[Image of cursor keys]
The cursor-key functions are context-sensitive. They are used to:

- select a menu
- select the active window
- move the cursor in text boxes
- change the value of an entry in a text box
- select an element from a drop-down list

Except of moving the cursor, the above mentioned functions can also be activated using softkeys.

### 1.5.3 On/Standby key and standby LEDs

The standby LEDs and the ON/STANDBY key are located in the bottom right corner of the front panel. The ON/STANDBY key toggles the R&S NRP2 between standby and ready state, indicated by the standby LEDs.

The standby LEDs indicate the current instrument state:

- **Yellow LED (AC supply)**
  The yellow LED indicates that the R&S NRP2 is power supplied and in standby mode.

- **Green LED (ON)**
  The green LED indicates when the meter is on, i.e. ready for operation.

The possible operating states are:

- The meter is off and disconnected from the AC supply.
- The meter is on standby. The AC supply is connected and the power supply is operating correctly.
- The meter is on and is being powered from the AC supply.

### 1.5.4 Connectors

To the left of the display, the R&S NRP2 provides a power reference signal connector and two sensor connectors.

If option R&S NRP-B5 is installed, the R&S NRP2 offers two sensor ports at the rear. Thus, you can perform measurements with a maximum of 4 connected sensors simultaneously.

**POWER REF**

The POWER REF connector (option R&S NRP-B1/-B7, sensor check source) provides a high-precision sine signal with a power of 1 mW and a frequency of 50 MHz for checking the sensors. Option R&S NRP-B7 additionally comes with a pulse mode of the test signal with a modulation frequency of 10 kHz.

Chapter "Sensor Check Source" describes how the generator is turned on and off.
Sensor connectors
The front panel accommodates a maximum of two sensor connectors (for sensors A and B). Sensor connector B requires option R&S NRP-B2, second sensor input (B).

The power sensors are connected by inserting the male connector.

**Note:** You can not disconnect the sensor simply by pulling at the cable or the rear part of the connector. To disconnect pull the connector at its sleeve, which is marked with a red dot.

### 1.6 Rear Panel Tour

This section gives an overview of the control elements and the connectors on the rear panel of the R&S NRP2. Each element and connector is briefly described and a reference is given to the chapters containing detailed information.

**Fig. 1-4: Rear panel view**

1 = TRIG IN / OUT2 and OUT1 / TRIG OUT connectors  
2 = ETHERNET interface  
3 = USB interface  
4 = IEC 625/IEEE 488 interface  
5 = AC supply and power switch  
6 = Sensor connectors (option R&S NRP-B5 or R&S NRP-B6)
TRIG IN / OUT2 and OUT1 / TRIG OUT

The BNC connector OUT1 / TRIG OUT outputs an analog signal with a voltage between 0 V and 3.3 V. It can be used to output a voltage that is proportional to the measured value (e.g. for level regulation) or a digital signal for threshold monitoring. If configured as trigger output, the trigger signal of a power sensor can be supplied. In this case, the power sensor must be set as trigger master.

The BNC connector TRIG IN / OUT2 can be used either as an external trigger input or as a second analog output.

The inputs/outputs are configured in the “System” menu, see chapter 4.7.2, “Setting the analog outputs and the trigger input”, on page 151.

ETHERNET

The Ethernet connector is an RJ45 socket for remote controlling the R&S NRP2 via a network.

USB

USB (Universal Serial Bus) interface of type B. This connector is used for remote control of the instrument (see chapter 5.2, “Connecting a Controller to the Base Unit”, on page 170) and to update the firmware of the instrument by means of PC downloads (for more information, see the service manual, chapter 4).

IEC 625/IEEE 488

The IEC/IEEE bus connector to IEEE488 is used to remote control the R&S NRP2.

AC supply and power switch

For detailed information on the AC supply, see chapter 1.7, “Connecting the instrument to the AC supply”, on page 17.
Sensor connectors

Optional sensor connectors C and D (option R&S NRP-B5) can be installed at the rear panel. Alternatively, sensor connectors A and B can be retrofitted from front to rear panel (option R&S NRP-B6).

1.7 Connecting the instrument to the AC supply

The AC supply and power switch are at the rear of the unit.

When the R&S NRP2 is connected to the AC supply, it automatically sets itself to the correct range for the applied voltage (range: see type label). There is no need to set the voltage manually.

The power switch can be set to two positions:

- **0**: The instrument is disconnected from the mains.
- **I**: The instrument is power-supplied. It is either ready for operation (STANDBY) or in operating mode, which is indicated by the color of the Status LED on the front panel.

![Figure 1-5: AC supply connector at the rear of the meter](image)

Connect the instrument to the AC power source using the AC power cable delivered with the instrument.

**Note**: The instrument is in compliance with safety class EN61010-1. Connect the instrument only to a socket with earthing contact.

**AC supply voltage**

The R&S NRP2 can be operated from AC lines with a voltage range of 100 V to 240 V and a frequency range of 50 Hz to 60 Hz. Note that a restricted voltage range (100 V to 120 V) applies to 400 Hz networks.
1.8 Starting the R&S NRP2

1.8.1 Switching on

1. To turn the power on, press the main power switch at the rear to position I (On).

![Power switch](image1)

*Fig. 1-6: Power switch*

After power-up, the instrument is in standby or ready state, depending on the state of the ON/STANDBY key at the front panel of the instrument when the instrument was switched off for the last time.

2. Press the ON/STANDBY key to switch the instrument from the standby to ready state.

![ON / Standby key](image2)

*Fig. 1-7: ON / Standby key*

- green and yellow = ready for operation
- yellow = standby, AC supply is connected and power supply is operating correctly
- off = off and disconnected from the AC supply

1.8.2 Startup

Press the ON/STANDBY key to switch to ready state.

The R&S NRP2 initiates its startup procedure, i.e. it boots the operating system, automatically performs a selftest and starts the instrument firmware. If the previous session was terminated regularly, the instrument uses the last setup with the relevant instrument settings.

Use the (PRE)SET key to return the instrument to its definite reset/preset state, if the current setup is no longer relevant.

To customize the start settings use the “File” dialog box, see chapter 4.6, "Management of settings", on page 141.
1.8.2.1 Start screen

Immediately after turning on the start screen appears, and the R&S NRP2 provides short-term access to the boot menu and the firmware update menu.

The bootmenu provides service and system functions, e.g. resetting the internal memory, see chapter 8.3, "Bootmenu", on page 346

For further information on the firmware update see firmware release notes on the R&S website available for download: http://www.rohde-schwarz.com/product/NRP2.html.

1.8.2.2 Function check

After switch-on, the R&S NRP2 performs a function test. The contents of all non-volatile memories, the RAM and the addressability of the interfaces are checked. Messages indicate the options the instrument is equipped with.

The R&S NRP2 checks the following functions:

- Function test on the RAM
- Function test on the keyboard controller
- Addressability check on the keypad
- Addressability check on the test generator.
  This test is performed if the instrument is equipped with option R&S NRP-B1/B7, sensor check source.
- Addressability check of the sensor channels
  Depending on the number of installed sensors, the displayed icon varies:

  ![Connected sensors (symbols)](image)

  - One of the sensor boxes shown on the left bottom of the icon represents a sensor connected at channel A, i.e. the instrument is single channel.
– Two sensor boxes indicate that channels A and B are connected, fitted at the front panel (requires option NRP-B2, the second measurement input).
– Accordingly, one or two sensor boxes shown on top indicate that channels A and B are fitted at the rear panel with option NRP-B6, sensor connectors A (B).
– Four sensor boxes indicate that the meter supports channels A to D, option NRP-B5, 3rd and 4th measurement input.

- Addressability check on the USB interface
- Addressability check of the Ethernet interface

The instrument performs a test on the Ethernet interface, and displays the transmission rate, e.g. 100. When finished, the instrument displays the result under the network icon, i.e. "OK" indicates that the interface can be addressed. If the R&S NRP2 is not connected to a network hub or if a connection cannot be established during booting, the message (Not Connected) is displayed instead of "OK". It is however possible to establish a network connection later on at any time.

Results display of the function test

The R&S NRP2 shows the progress of the tests in a colored (orange) progress bar. The tests are completed when the bar has reached the end of the screen and all symbols are shown. The instrument indicates the result of each test underneath the respective symbol.

![Fig. 1-10: R&S NRP2 welcome screen with function test results and progress bar](image)

Mem = function test on the RAM
PCI = function test on the keyboard controller
Keys = addressability check on the keypad
% = addressability check on the test generator
(instrument icon) = addressability check on the interfaces for the sensor channels
USB = addressability check on the USB interface
Net = addressability check of the ethernet interface

Successful tests are confirmed with "OK" ("OK", orange colored), and recognized malfunctions with "Failed" ("Failed", red colored).
Some tests respond with further information, messages or actions:

- If any interface error occurred, the boot process stops after completion of all tests. It may be continued by pressing the ESC hardkey.

Press ESC to continue

- During the test of the network connection, additional information is provided, as described above.

- If an error is detected when the non-volatile memory containing instrument settings is checked, an error message is displayed when booting is completed.

The non-volatile memory is then re-initialized completely and the R&S NRP2 goes into the preset state. All instrument settings that have been saved are lost as a result of this procedure.

1.8.3 Shutting down the meter

Whenever the meter is switched off, its settings are saved. The next time it is switched on, these settings are automatically restored.

Press the ON/STANDBY key to save the current setup, shut down the operating system and set the instrument to standby state.

Switching off the AC power

You can leave the AC power on permanently to preserve your last instrument settings. Switching off is required only if the instrument must be completely disconnected from all power supplies.
2 Getting Started

This chapter introduces the main functions and settings of the R&S NRP2, by means of some basic power measurement examples.

Included topics:

- **Brief introduction to the operation, on page 24** provides a quick introduction on how to operate the instrument.
- **Preset and zeroing, on page 27** explains how to set the R&S NRP2 and the R&S Power Sensors to defined initial states.
- **Measuring average power (Cont Av mode), on page 29** introduces standard power measurement with the R&S NRP2.
- **Window handling, on page 36** and **Setting measurement functions, on page 41** explains the basic techniques for configuring result windows.
- **Graphically representing power versus time, on page 43** represents graphically the time characteristics in "Trace & Statistics" mode.
- **Measuring average burst power (Burst Av mode), on page 47.** enables you to perform a measurement of burst power without external triggering.

Some of the sections later on in this chapter assume familiarity with the basic operating techniques which are introduced in the first sections. It is, therefore, advisable to go through these sections first before considering other topics.

An in-depth description of the operation of the instrument is described in **chapter 3, "Manual Operation", on page 49.**

2.1 Requirements

- **Read the notes on putting the meter into operation in chapter 1.1, "Notes on putting into operation", on page 7.**
- A single-channel R&S NRP2 is sufficient for most of the examples used in the sequel. However, if you want to work through all the steps in **chapter 2.6, "Setting measurement functions", on page 41** you will need a dual-channel instrument.
- Any sensor of the R&S NRP-Zx series is suitable.
- A signal source is required for the following measurements. It is best to use a signal generator whose level can be adjusted. If a generator of this type is not available, the R&S NRP2’s integral power reference (option R&S NRP-B1/-B7) can be used instead.
2.2 Brief introduction to the operation

The R&S NRP2 can be operated intuitively via the hardkeys and the interactive display with the associated softkeys. All menus and dialog boxes are in the form of windows that can be operated in the same way. The hardkeys and softkeys allow direct and therefore convenient access to entries and settings.

The clear-cut display shows the power measurement results of up to 4 power measurements simultaneously. Results can be displayed digitally or graphically, either by an analog meter or, depending on the measurement mode, in a trace diagram.

This section briefly describes the concept of manual operation of the power meter in order to perform the test examples with the instrument, described later on in this chapter.

For a detailed description on the controls, the screen layout and how to operate the R&S NRP2, refer to chapter 3, "Manual Operation", on page 49.

Using the hardkeys

- hardkeys are always available for use.
- according to its label, a hardkey directly activates a function.
- if two functions are provided in one hardkey, e.g. "↑ Menu", the context determines the currently active function. The respective function is selected automatically by the instrument.
  See chapter 1.5.2.2, "Hardkeys", on page 12 for information concerning assignment and the respective functional description of the hardkeys.

A highlighted menu item corresponding to one of the hardkeys, indicates that the function can be started either by the softkey or the associated hardkey, as shown in the example with "Preset".
Using the softkeys

To quickly allocate the softkey to a menu item, all the menus open directly next to the softkey bar, i.e. on the right side of the display.

The six softkeys perform the functions that are indicated in the active menu or dialog box. Located at the right edge of the display, the functions in a line are assigned to the corresponding softkey.

As a special feature, sometimes two or more functions are assigned to one softkey. In this case the softkey operated as a rocker switch, see the following examples:

Two functions are associated with one softkey. In the example, the two functions are position ("Pos.") and scale ("Scale"). "Scale" is selected

1. To select function "Pos." press the left-hand side of the rocker switch.

Now setting the position with the cursor keys is possible

Several functions are associated with one softkey. In the example, the different sensor modes are offered, "T'slot Av" is selected.

1. To select another function to the left, e.g. "Trace & Statistics", press the left side of the softkey ↓.
2. or to select another function to the right, e.g. "Burst Av", press the right side of the softkey (in this case twice).

Check boxes

- To toggle between the two states of "Global" press the right side of the softkey.

Note: The left side of the softkey activates the entry of the "Global" value, see below 'Entry fields'.

Entry fields

1. Activate the entry field using the associated softkey.
   The activated entry field is marked by a yellow frame. The position in the value to be changed is inverted.
   
   2,000 dB Global
   
   A digit (or a letter) panel appears on the right side of the display.

2. Select the position to be changed using the cursor keys ⇦ ⇨.

3. To change the entry at the marked position, either
   a) select the digit in the panel using the associated softkey.
   or
   b) increase / decrease the value using the cursor keys ⇧ ⇩

4. Confirm the selection with the ↵ MENU hardkey or reject with ESC hardkey.

Lists

1. Select the function by selecting an item in a list using the associated softkey.
   The list folds out.
2. Select the item using the softkey associated with list or the ⇧ ⇩ cursor keys.
3. Confirm the selection with the MENU hardkey or reject with ESC hardkey.

### 2.3 Preset and zeroing

**Preset**

If the instrument is switched on, it is not the preset state that is active, but rather the instrument state that was set when the instrument was switched off. To prevent any previous settings from causing incorrect results, it is recommended that you set the R&S NRP2 and the R&S Power Sensors to defined initial states.

To preset the R&S NRP2

1. Press the (PRE)SET hardkey.

   The "File" menu appears.

   ![Fig. 2-1: File menu](image)

2. Press the (PRE)SET hardkey again or press the "Preset" softkey.

   All parameters and switching states are preset, also those of inactive operating modes. When the preset is completed, the "File" menu disappears and the meter is in the preset state. The preset settings provide a reproducible initial basis for all other settings.

For a detailed description of the R&S NRP2’s initial state including a list of the default parameters, see chapter 4.1.1, "Preset hardkey", on page 61.
Zeroing

Zeroing should be performed whenever necessary. As a rule of thumb, this is the case for measurements of power values less than a 1000 fold of the zero offset and after the sensor has reached its operating temperature.

Turn off all test signals before zeroing. An active test signal during zeroing causes an error.

To zero the meter

1. Connect the sensor to a signal source
2. Switch off the power
3. Press the ZERO hardkey.

The "Zero" dialog box is displayed.

4. Press the ZERO hardkey again to perform zeroing of all connected sensor channels ("Zero (All)") or press the appropriate softkey to select a specific sensor for zeroing.

Zeroing of all connected sensors is performed.

The correction measurement takes several seconds. When completed, the R&S NRP2 displays a message indicating success or failure of zeroing.
If zeroing fails, the most frequent cause for this error is a signal that is applied to the sensor and prevents zeroing.

### 2.4 Measuring average power (Cont Av mode)

In the following example for measuring the average power the following steps are performed:

- Setting up the measurement
- Setting the frequency
- Setting the unit for the measurement result
- Setting a fixed offset correction
- Performing a relative power measurement
- Checking the settings with full height window
- Selecting the display mode
- Selecting the indication of auxiliary values

#### Setting up the measurement

**To set up the measurement**

1. Put the R&S NRP2 into operation as described in chapter 1, "Putting into Operation", on page 7 and connect a sensor to connector A.

2. Preset the R&S NRP2 and execute Zero A.

   After preset, one result window indicates the result (in dBm) obtained with sensor A.

```
<table>
<thead>
<tr>
<th>Sensor</th>
<th>Windows</th>
<th>Measurement</th>
<th>File System</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>A</td>
<td>4.03 dBm</td>
<td>A 1.000 GHz</td>
</tr>
</tbody>
</table>
```

*Fig. 2-3: Result window (dBm)*

#### Setting the frequency

The R&S NRP2 must be set to the carrier frequency of the applied signal if the specified measurement accuracy is to be reached.
To set the frequency

1. Connect an unmodulated signal with a level between –10 dBm and +10 dBm to the sensor.

2. Press the FREQ hardkey.

The dialog box for entering the frequency appears.

3. Press the associated softkey to activate the entry of the frequency value.

A digit panel is displayed to insert the frequency. The panel also includes unit letters.

4. Clear the field with the DEL/1TRIG hardkey.

5. Enter the signal frequency by pressing the associated softkeys.

6. Select the unit by using the "UNIT" softkey.

Tip: Alternatively you can use the cursor keys to set a value. To get familiar with the editor, try the following steps. In this example the overwrite mode (default mode) is active:

- Use the LEFT/RIGHT cursor keys to move the block cursor and overwrite the digits with new values.
- Use the UP/DOWN cursor keys to increase/decrease the digit value at the cursor position.
- Move the insertion mark to the right onto the units. Use the UP/DOWN cursor keys to change the unit.

7. Press the MENU hardkey twice to confirm your entry and exit the "Frequency" dialog box.
Setting the unit for the measurement result

The measurement result is indicated in the result window. The unit of the measurement result can be changed.

To set the unit of the measurement result

1. Use the topmost softkey to select the "Measurement" menu.

   The menu opens. Post-processing of the measurement can be set in the "Measurement" menu.

   ![Fig. 2-5: Measurement menu]

2. Select the unit "W" using the associated softkey.

   The result is displayed in W.

   ![Fig. 2-6: Result window (W)]

Setting a fixed offset correction

The R&S NRP2 provides an offset correction to the displayed measurement result.

To set a fixed offset correction

1. Select the "Sensor" menu.

   The "Sensor" menu opens.
All sensor-related settings are made in the "Sensor" menu. It determines type and details of data acquisition.

2. Press the left side of the "Offset..." softkey.

   The "Offset" dialog box opens. Offsets in dB for compensating external signal losses or gains, for example by attenuator or amplifiers, can be set in this dialog box.

3. Activate the entry for the global offset.

   Positive values are for correcting losses and negative values for gains.

4. If you have an attenuator at hand, enter its value and connect the attenuator between the sensor and the signal source, otherwise just enter 10 dB.

5. Confirm the entry with \( \text{MENU} \).

6. Activate the global offset correction by pressing the right side of the associated softkey.
Fig. 2-9: Offset dialog box / Global activated

**Tip:** Factors which are not, or only minimally, depending on frequency can be corrected in this way.

7. Press the «MENU hardkey twice to exit the dialog box and the menu.

If you have connected an attenuator and entered its attenuation, the R&S NRP2 will display about the same value as before.

Fig. 2-10: Result window / Offset

In the note line of the result window, the Δ symbol indicates that global offset correction is active.

**Performing relative power measurements**

The R&S NRP2 calculates and displays also the relative difference between a measured value and a reference value. The reference value can be a measured value that has been saved or an arbitrary value that is entered.

1. Select the "Measurement" menu.

2. Open the "Measurement" menu with «MENU.
3. To activate the relative mode, press the right side of the softkey next to "Relative".

![Relative Off On Reset]

As the default setup was loaded in step 1, the value relative to 0 dBm is displayed.

![Result window / Relative]

4. Press the right side of the softkey next to "Relative" again.

"Reset" will set the current power result as new reference value. After the reset, relative measurement is automatically active again.

![Relative Off On Reset]

If the power has not changed in the meantime, the indicated value is close to 0 dB.

![Result window / Reset relative]

5. If an attenuator is still connected, remove it now and connect the sensor directly to the signal source.

The displayed value should now equal the offset that has been entered.

Checking the settings with full height window

1. Select and open the "Windows" menu.
The "Windows" menu contains all the functions required for opening, closing and configuring windows.

2. Check if window 1 has been selected.

3. Press the "Expand" softkey.

Window 1 now expands to full size below the menu bar and displays all relevant settings:
- measurement modes of contributing channels (A (ContAV))
- Trigger mode (auto)
- averaging number and mode (32 Auto)
- Offset (10 dB)
- S parameter device (none)
- duty cycle correction (none)

4. To return the window to its normal size, open the "Windows" menu with the \( \text{MENU} \) hardkey and press the "Arrange" softkey.
2.5 Window handling

Up to four windows can be indicated simultaneously on the R&S NRP2's display. Each window can be configured for a separate measurement. The following examples show how to handle windows.

Opening, expanding and closing windows.

1. Press the (PRE)SET hardkey twice.

![Fig. 2-16: Result window]

A display window indicating the result (in dBm) from sensor A appears.

2. Select the "Windows" menu with the topmost softkey or the cursor keys.

![Fig. 2-17: Windows menu]

The "Window" softkey selects the window. The settings in the "Windows" menu and in the "Measurement" menu are valid for the selected window.


The third softkey is now labeled "Close | Expand".

4. Press the right side of the softkey to expand the window.

The window expands to occupy the full display height and indicates all parameters relevant to the measurement.
5. Open the menu again.

"Arrange" now replaces "Expand". This function arranges all opened windows.

6. Press the "Arrange" softkey.

Window 1 returns to its previous size.

The following steps show the difference between the "Open" and "Init" functions. You first have to change two settings of window 1.

**Opening, creating and closing windows.**

1. Activate the analog display of results "D&A".

2. Switch to the "Measurement" menu and select "Relative On".

3. Return to the "Windows" menu.

Window 1 now displays the "A Rel" function on an analog scale.
4. Now, close window 1 with the "Close" softkey.

The "Window" menu shows that window "1" is still selected.
The labeling next to the third softkey is now "Open | Init".

5. Press the "Open" softkey.
The appearance of the window has not changed, and all window-specific settings have been maintained.

6. Close window "1" again with "Close".

7. Open it this time with "Init"
The window again displays the measurement function A in digital format. In contrast to "Open", where the settings remain unchanged, "Init" sets all the parameters to their default values. "Init" only resets the window settings made in the "Windows" and "Measurement" menus, but it does not affect the sensor settings!
Display options

1. The "Dig" and "D&A" softkeys are used to select the display mode.
   The standard display mode is "Dig"ital measurement result.

2. Select the "D&A" display mode.
   Window "1" now shows an analog scale and a digital reading.

The menu now includes the new item "Analog Meter…” for setting the scale limits.
3. Switch back to "Dig" display mode.

**Auxiliary values (Maximum, Minimum, Max, Min, ...).**

1. Select the "Measurement" menu.

2. Select "Function..." in this menu.

   - The measurement function, unit of the measurement result, sensors used and the auxiliary values can be selected in the "Function & Unit" dialog box.

3. Open the "Auxiliaries" drop-down list.
4. Select "Extremes".

5. Close the dialog box.

6. Select the "Measurement" menu and restart the search for the extreme values with "Aux Val Reset".

   The updated maximum, minimum and max-min are now displayed to the right of the measured value.

   Maximum and minimum should be close to the measurement result, the max-min value therefore slightly more than 0 dB.

   If you reduce the signal power, the maximum should remain the same, whereas the minimum value tracks the measurement result. The max-min values rise correspondingly. However, if the signal power is increased, the maximum value tracks the measurement result as soon as the stored maximum is exceeded.

2.6 Setting measurement functions

An R&S NRP2 with two sensors connected is required for this section. If only one sensor is available, you can only select the measurement function "Single".

Performing ratio measurements

1. Connect the two sensors to connectors A and B on the R&S NRP2 and apply an unmodulated signal with a level between –10 dBm and +10 dBm to each of the sensors.

2. Press the (PRE)SET key twice.

   A window for each sensor is opened with (PRE)SET. The windows indicate the results (in dBm) from sensors A and B.
3. Select the "Measurement" menu and then select "Function..." for window 1 of this menu.

4. Open the "Function & Unit" dialog box.

   ![Function & Unit dialog box](image)

   **Fig. 2-28: Function & Unit dialog box / ratio**

   In this dialog box, you can select the function used to calculate the result in the selected window. For example, "Ratio (A/B)" yields the quotient from the measured power values in channels A and B.

5. Select "Ratio (A/B)" from the drop-down list for the measurement function and close the drop-down list with ↓ MENU.

6. Now, press the "Unit" softkey.
2.7 Graphically representing power versus time

In the "Trace & Statistics" mode, power versus time can be represented graphically as with an oscilloscope. If you wish to carry out measurements on signals with modulated power envelope (in the Burst or Timeslot mode), initially displaying the signal in the Trace mode is always recommended. Stable triggering by the R&S NRP2 can more easily be accomplished in this mode.

Setting the "Trace & Statistics" mode.

1. Connect a power sensor of the R&S NRP-Z1x, R&S NRP-Z2x or R&S NRP-Z8x family to connector A of the R&S NRP2.
2. Apply an amplitude-modulated or pulsed signal having a modulation frequency or pulse frequency of approx. 1 kHz. The maximum level should be between −10 dBm and +10 dBm. A pulse with 250μs width, a period of 1ms, and 4dBm is used in the following example.
3. Press the (PRE)SET hardkey twice.
   A measurement window appears.
4. Change to the "Sensor" menu and select "Mode".

![Sensor menu]

5. Switch to the "Trace & Statistics" mode.

![Trace & Statistics measurement mode]

6. Close the "Mode" dialog box.
7. Close the "Sensor" menu.
   The window is now in the "Trace & Statistics" display mode and shows the "Trace" page.

![Trace representation of a pulsed signal]

The info panel at the bottom of the window shows all parameters relevant for the display.
Note: If you do not see a trace, the trigger threshold probably does not match the signal. In this case, a highlighted question mark appears in the info panel of the trace window. Continue with the next step to set the trigger threshold.

Further measurement modes can be selected via the "Display" softkey. Based upon the trace display, gates, timeslots, and markers can be added for further analysis. Automatic pulse measurements can be carried out and a statistic analysis of the power envelope can be performed.

Settings for reliable triggering

1. Press the "Trigger" softkey in the trace display.
   The "Trigger" dialog box opens.

   ![Trigger dialog box, page 1](image)

   A dotted line indicates the trigger threshold in the diagram.

   ![Trace display / trigger threshold](image)

2. Select the "Normal" trigger mode.
3. Select internal triggering ("Source" = "Internal")
4. Set the positive trigger slope.
5. Set the trigger threshold in the "Level" entry field.

   Tip: A question mark in the info panel shows, that the sensor doesn’t trigger. In this case use the DEL/1TRIG hardkey in order to manually trigger the sensor once, and set the trigger settings accordingly.
6. Open the second page of the "Trigger" dialog box.

![Trigger dialog box](image)

*Fig. 2-36: Trigger dialog box / page 2*

7. Set the trigger delay time. If you set a positive value, the trigger event will become effective only after the selected period of time. The displayed trace will be shifted to the left.

In the "Trace & Statistics" display, the physical and the delayed trigger time has been made visible in the form of small triangles, thus allowing an interactive adaptation of the "Delay" parameter to the signal, see chapter 3.6.2, “Special symbols”, on page 58.

8. Enter a "Dropout" value.

The dropout time prevents the trigger system from being activated by signal excursions prior to the trigger event targeted.

9. Scroll to the third page of the "Trigger" dialog box.

![Trigger dialog box](image)

*Fig. 2-37: Trigger dialog box / page 3*

10. Set a "Hysteresis" value.

Setting the trigger hysteresis to a value other than 0 dB will prevent triggering from occurring again until the measurement level has fallen below the trigger threshold by at least this value.

11. Define a "Holdoff" time.

This parameter allows you to set the period of time during which further trigger events (measured from the last successful triggering) should be ignored.
2.8 Measuring average burst power (Burst Av mode)

An R&S NRP-Z1x, R&S NRP-Z2x(x), or R&S NRP-Z8x sensor is required for this measurement.

To perform a burst-average power-measurement, you need a pulsed RF signal. If you use an R&S NRP-Z1x or R&S NRP-Z2x(x) sensor, the pulse repetition frequency of the signal should not exceed 10 kHz.

Setting the burst mode.

1. Connect the power sensor to connector A on the R&S NRP2 and apply a pulsed signal with a level between –10 dBm and +10 dBm.
2. Press the (PRE)SET hardkey twice.
   A measurement window is now available.
3. Change to the "Sensor" menu and select "Mode".
   The "Mode" dialog box opens.
4. Select "Trace & Statistics".
5. In the trace mode check that the sensor detects a signal and reliably triggers.
   For information concerning reliable triggering see chapter 2.7, "Graphically representing power versus time", on page 43.
6. Change back to the "Sensor" menu and select "Burst Av" in the "Mode" dialog box.

The burst mode parameters are displayed at the bottom of the dialog box.

To exclude the pulse build-up and decay phases from the measurement, you can set the "Excluded from Start" and "...from End" parameters accordingly.
The parameter "Dropout" helps to reliably detect the end of modulated-signal bursts (e.g. NADC). With unmodulated pulses as in this case, it should be set to 0.

Fig. 2-39: Burst av result window

For a detailed description of burst av power measurement, see chapter 4.2.1.3, "Measuring the average power of burst signals", on page 67.

The power of burst can be measured also by means of timegates (see chapter 4.2.1.5, "Measuring the average power in gates", on page 71 and chapter 4.5.4, "Gates display mode", on page 120). In contrast to the burst mode which automatically detects the burst end, the length and position of the gate over time must be exactly defined.
3 Manual Operation

This chapter describes the controls, displays, etc, the screen layout and how to operate the R&S NRP2.

3.1 Keys

Keys on the front panel of the meter are used to manually operate the instrument. There are several groups of keys, each group having a different function.

For more information on keys...
According to their functionality, keys are described in several sections of the R&S NRP2 documentation. See:
- Front panel - keys (hard-, soft- and cursor), page 12 for information on the keys located at the front panel.
- Brief introduction to the operation - key handling, page 24, providing a brief introduction on how to operate.
- Instrument functions - Main settings FREQ, PRESET, ZERO, page 61 for information on the setup keys FREQ, (PRE)SET and ZERO.
- Softkey - manual operation > Menu handling, page 53
- Dialog boxes and their control elements, page 53

3.2 Screen layout

The R&S NRP2 screen displays the menu bar with the menu names and at least one or more measurement result window. The folded-out menu and the setting dialog boxes may overlap the result windows.

Result window

![Result window](image-url)
The R&S NRP2 displays results in windows. A maximum of four windows can be displayed simultaneously on the screen. They are numbered 1 to 4. Windows have a title bar which contains the number (fixed) and, optionally, the window name (user-definable).

Windows do not have any control elements.

Menu bar

![Menu bar diagram](Image)

Fig. 3-2: Screen layout / menu bar

A menu bar is always displayed at the top of the screen. It contains the menu names. The active menu is highlighted.

Selecting the active menu

![Selecting active menu diagram](Image)

Fig. 3-3: Screen layout / selecting the active menu

Select the active menu:

- Press the right or left side of the topmost softkey one or more times. Alternatively you can also use the cursor keys ⇩ ⇨.

Folding menus out or in

![Folding menus out/in diagram](Image)

Fig. 3-4: Screen layout / measurement menu folded out

Fold out/in the active menu:

1. Press the ↑ MENU hardkey to fold the menu out.
2. Press the ↓ MENU hardkey again to fold the menu in.

The menu also folds out automatically if another menu is selected.
To quickly allocate the associated softkey to a menu item, all the menus open directly next to the softkey bar, i.e. on the right side of the display; this is against usual PC convention with menus drop-down directly below the menu name.

![Fig. 3-5: Screen layout / menus next to the rocker switches](image)

See chapter 3.4, "Menu handling", on page 53 for more information on operating the menu functions.

### Dialog boxes

![Fig. 3-6: Screen layout / dialog boxes](image)

Dialog boxes can be opened from the menus. The dialog boxes display a group of related parameters that can be set.

See chapter 3.5, "Dialog boxes and their controls", on page 53 for more information on operating the dialog box functions.

### 3.3 Menu layout

This section describes the menu provided by the R&S NRP2. The meter displays the menu names in the menu bar at the top of the screen. The menus are selected by the top-most rocker switch. The following figure shows the main menus of the R&S NRP2, which are then briefly summarized.

The menu functions are described in the operating manual, chapter 4, "Instrument Functions", on page 61.
Sensor menu

All sensor settings can be made using the "Sensor" menu. The type and details of data acquisition can be specified with this menu.

See chapter 4.2, "Data acquisition and parameters", on page 64 for a detailed description of the "Sensor" menu.

Windows menu

The "Windows" menu is used to configure windows and the result display in the windows.

See chapter 4.3, "Displaying measurement results", on page 91 for a detailed description of the "Windows" menu.

Measurement menu

The details of postprocessing are summarized in the "Measurement" menu.

See chapter 4.4, "Configuring measurements", on page 97 for a detailed description of the "Measurement" menu.

File menu

The "File" menu is used to handle the setup memories, window names and display information about errors.

See chapter 4.6, "Management of settings", on page 141 for a detailed description of the "File" menu.

System menu

The "System" menu is used to handle general functions that are not specifically used to perform measurements, i.e. to configure the remote interfaces and I/O sockets, to provide information about the meter and the connected sensors, and to trigger test measurements.

3.4 Menu handling

The menus can contain up to eight menu items which are used to perform an action, open a dialog box or set a parameter.

**Perform an action**

If the menu contains only one or two descriptive terms, an action is performed directly.

**Use a hardkey to perform an action**

If the name of the action to be performed is shown in a wide orange field, you can start the action by pressing the hardkey of the same name, e.g. (PRE)SET in this case.

**Open a dialog box**

If a menu item is followed by three dots “…”, it can be used to open a dialog box to set a variety of parameters.

**Set parameters**

Parameter setting options are provided in the menu. The currently selected option is highlighted in orange. Select the option by pressing the left or right side of the associated rocker switch.

**Use of softkeys with dual assignments**

Some softkeys are assigned two menu items. One is selected by pressing the left-hand side of the rocker switch, the other, the right-hand side.

The two menu items are separated by a vertical line.

3.5 Dialog boxes and their controls

Dialog boxes contain check boxes, option fields, editing fields and drop-down lists as control elements. They are activated using the appropriate rocker switch to their right. If two control elements are positioned side by side, the element on the left is operated with the left-hand side of the rocker switch and the element on the right with the right-hand side of the rocker switch.
3.5.1 Title bar

Dialog boxes have a title bar which displays the name of the dialog box and the « symbol which is a reminder that the dialog box can be closed with the «MENU hardkey.

Settings made in dialog boxes are immediately set on the R&S NRP2 - in other words you do not need to close the dialog box to activate the settings in the box.

3.5.2 Dialog boxes with tabs

Channel-specific settings are made in a special page in a super-ordinate dialog box. In the top row of the dialog box, there are tabs which you can use to switch between pages.

Channels which do not have a sensor connected and channels that have not been installed are shown in gray and cannot be selected.

3.5.3 Check boxes

Check boxes are used to activate and deactivate functions. You can toggle between the two states by pressing the appropriate softkey.

3.5.4 Option fields

Option fields contain groups of mutually exclusive operating modes.

When you press the left-hand side of the rocker switch, the next option on the left is selected. When you press the right-hand side of the rocker switch, the next option on the right is selected.

In the "System I/O" dialog box, option fields are assigned to only one side of a rocker switch. It is therefore only possible to scroll through in one direction.

3.5.5 Editing fields

Editing fields are used to enter or modify numbers and text.
The editor is activated by pressing the appropriate rocker switch.

Editing can be performed in overwrite mode, indicated by the marked character being in inverse video. Modifications can be made either with the ⇧ ⇩ cursor keys or numeric/digit softkeys which are provided in a digit or letter panel when the editor is activated.

The ⇧ ⇩ cursor keys are used to select the digit to be edited.

### 3.5.6 Editing fields (cont.)

In the editing fields for quantities with units, the ⇧ ⇩ cursor keys can be used to select the unit too; the ⇧ ⇩ cursor keys are used to edit it. Usually, the digit panel also contains a unit softkey which you can use to change the unit whenever you want.

If you want to make a completely new entry, the whole field can be cleared with the DEL/1TRIG hardkey. In the insert mode, you can enter digits and/or letters.

Any changes you make to a field can be confirmed with the ↵ MENU hardkey. When this hardkey is pressed, the new value is subjected to a validity check. If the check discovers an error, a warning message is output.

You can quit the editor by pressing the ESC hardkey; this leaves the old values unchanged. Any warning messages are cleared.

To set the maximum or minimum value permitted for a parameter, first move the insertion mark to the left edge of the entry field by using the ⇧ key. Then press the ⇩ key to set the maximum permissible value or the ⇧ key to set the minimum permissible value.

### 3.5.7 Editing fields of the Filter, Range and Trigger dialog boxes

The Filter, Range and Trigger dialog boxes are designed such that the result windows are still visible.
If you edit a value in a Filter, Range and Trigger dialog box using the cursor keys ⇧ ⇦, the new value is accepted immediately. This feature allows you to quickly assess the effect of value change and, thus, to perform interactive adjustment of settings.

If you enter a new value with the digit/letter panel (see below), the new value has to be confirmed before it is accepted. The symbol ↵ appears above the editing field to indicate that the new value is not accepted until you confirm it with the ↵MENU hardkey.

### 3.5.8 Drop-down lists

Drop-down lists are used to select an item from a list of predetermined values. When the drop-down list is activated, the list “folds out” upwards or downwards.

The up/down cursor keys, or one of the rocker switches next to the list, are used to select items from folded out pop-up menus. Confirm the selection with the ↵MENU hardkey or reject with the ESC hardkey.

### 3.5.9 Digit and letter panels

Panels which are displayed when an editing field is activated (see above) are used to enter digits, letters and units.

Entering letters with the letter panel is like entering letters on a phone keypad. "Caps" is used to select upper case for the next letter.
3.6 Display windows

3.6.1 Window sizes and types

Results are displayed in the main section of the screen in windows. Windows come in three sizes: half height, quarter height and full height. In windows, measurement results are displayed digitally, in a combined digital and analog mode, and graphically.

See chapter 4.3, "Displaying measurement results", on page 91 for instructions on selecting these modes.
You can expand all opened windows to full height by activating the "Expand" function from the "Windows" menu. In this state, the full-height windows can be displayed consecutively using the window "1 2 3 4" menu item. The opened windows can be reduced to their previous sizes with the "Arrange" menu item. Otherwise, it is not possible to change the size of the windows – the window size is determined by the number of windows.

### 3.6.2 Special symbols

**Table 3-1: Special symbols**

<table>
<thead>
<tr>
<th>Window</th>
<th>Auxiliary values</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>20.872 dB</td>
</tr>
<tr>
<td>burst_av</td>
<td>Max-Min</td>
</tr>
<tr>
<td>Confirm with the MEN key</td>
<td></td>
</tr>
</tbody>
</table>

#### Display values

- **A**: 1.000 GHz
  - Frequency in the primary and secondary channel

#### Measurement function

- **A/B**: Measurement function
- **A/B Rel**: Relative measurement active
- **A**: Timeslot or gate measurement
**Correction functions**

- Duty cycle correction ON
- Offset correction ON
- Twoport correction ON (S-parameter)

**Trigger**

- Trigger
- Free-running trigger
- Trigger event missing

**Filter**

- Averaging filter
- Filter size with auto-filter (normal mode) or for manual mode
- Noise component with auto-filter in "Fixed Noise" mode
- Noise ratio exceeded

**Other**

- Over limit
- Delayed trigger event (reference time)

**Table 3-2: Symbols for pulse parameters**

<table>
<thead>
<tr>
<th>Pulse Time Parameter</th>
<th>Pulse Power Parameter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pulse Width</td>
<td>Pulse Top</td>
</tr>
<tr>
<td>Duty Cycle</td>
<td>Trace Avg</td>
</tr>
<tr>
<td>Rise Time</td>
<td>Trace Min</td>
</tr>
<tr>
<td>Start Time</td>
<td>Pulse Base</td>
</tr>
<tr>
<td>Pulse Period</td>
<td>Trace Peak</td>
</tr>
<tr>
<td>Pulse Off Time</td>
<td>Pos. Overshoot</td>
</tr>
<tr>
<td>Fall Time</td>
<td>Neg. Overshoot</td>
</tr>
<tr>
<td>Stop Time</td>
<td></td>
</tr>
</tbody>
</table>
### Table 3-3: Symbols for time slot measurement

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Symbol" /></td>
<td>Time slot start of measurement</td>
</tr>
<tr>
<td><img src="image" alt="Symbol" /></td>
<td>Time slot length of measurement</td>
</tr>
<tr>
<td><img src="image" alt="Symbol" /></td>
<td>Time slot end of measurement</td>
</tr>
</tbody>
</table>
4 Instrument Functions

Chapter "Instrument functions" explains the functions of the R&S NRP2 and its options. The associated SCPI command is specified for each parameter (where applicable). The description starts with general instrument settings accessed by the SETUP hardkeys. The power meter functions are then described systematically, sorted by their occurrence in the menus.

The instrument settings include various functions, such as:
- chapter A.1, "Volatile Mode", on page 353
- chapter 4.1, "Main Settings", on page 61
  Setting a defined basic setup using the (PRE)SET key see chapter 4.1.1, "Preset hardkey", on page 61
- chapter 4.2, "Data acquisition and parameters", on page 64
- chapter 4.3, "Displaying measurement results", on page 91
- chapter 4.4, "Configuring measurements", on page 97
- chapter 4.5, "Displaying traces", on page 113
- chapter 4.6, "Management of settings", on page 141
- chapter 4.7, "System settings", on page 145
- chapter 4.8, "Messages and alarms", on page 166

4.1 Main Settings

The main settings for the R&S NRP2 are accessed via hardkeys.

4.1.1 Preset hardkey

(PRE)SET changes the instrument to its default state (Preset), to a predefined state for a mobile radio standard or to a user-defined (Setup) state. A maximum of 10 states are possible.

The highlighted background of the text indicates that the function can also be started by pressing the (PRE)SET hardkey if the "File" menu is open.

1. Pressing this key once opens the "File" menu. Refer to chapter 4.6, "Management of settings", on page 141 for description of the menu's topics.
2. Pressing the key a second time loads the preset settings.

When the preset state is selected, all default parameters are set - even those for operating modes that have not been activated. The following list gives an overview of the preset values for the most important meter settings. Further preset values can be found in the remote command description (\texttt{+RST} on page 198). Various parameters including the following will be reset:
• all channels in the Cont Av mode (continuous average power)
• absolute power measurement in dBm
• one window per channel opened
• offset: 0 dB
• automatic filtering (normal mode)

(PRE)SET does not reset the following settings:
• offset tables
• address of the remote interface
• SCPI error queue
• selection of the beeper
• brightness setting of the display
• test limits for sensor test

SCPI command:
*RST*RST on page 198 (Default state for remote-control operation)

or
SYSTem:PRESet on page 325 (Default state for manual operation)

4.1.2 Frequency hardkey

FREQ is used to set the carrier frequency of the applied signal. This corrects any frequency-dependent effects introduced by the sensor.

If the sensor is to reach the specified measurement accuracy, the signal frequency must be entered.

4.1.2.1 Frequency dialog box

![Frequency dialog box]

**Fig. 4-1: Frequency dialog box**

A | B | C | D

Tabs for selecting the sensor.

**Note:** In remote-control commands, select the sensor with the suffix in command SENSE<[1]..4>:..., i.e. choose suffix 1 for channel A, channel 2 for B, and so on.
**Frequency**
Field for frequency entries with the units kHz, MHz or GHz.
Remote command:
\[ \text{SENSe}[1..4]:\text{FREQuency}[\text{CW}] \] on page 269

### 4.1.3 Zero hardkey

ZERO starts the autozero function. Zeroing removes offset voltages from the analog circuitry of the sensors, so that there are only low powers displayed when there is no power applied.

Turn off all test signals before zeroing.

#### 4.1.3.1 Zero dialog box

![Zero dialog box](image)

The colored background of the text indicates that the function can also be started by pressing the ZERO hardkey (again).

**Zero All**
Zeroes all connected sensors.
Remote command:
CALibration:ALL:ZERO:AUTO on page 237

**Zero A | B | C | D**
Zeroes the selected channel.
Remote command:
CALibration<[1]..4>:ZERO:AUTO on page 237

### 4.1.3.2 Zeroing failure

If the power measured during zeroing is too large, the R&S NRP2 reports an error.
4.2 Data acquisition and parameters

Depending on the options that have been installed, up to four sensors can be connected to the R&S NRP2. The sensors perform the complete power measurement from the acquisition of the RF signal to every aspect of result processing. All important parameters for configuring data acquisition are therefore entered in the "Sensor" menu. The sensor menu provides access to all parameters concerning sensor settings like measuring mode, filter, offset, gamma correction, level range and trigger settings.

The Sensor menu contains the following items:

- Setting the measurement mode, on page 64
- Offset correction, on page 76 and Filter/averaging, on page 79
- Measurement ranges, on page 83
- Effect of the RF source, on page 84
- Trigger settings, on page 85
- Trigger sequence control, on page 89

Some of the parameters listed above are not available for certain types of sensor.

4.2.1 Setting the measurement mode

The measurement mode is selected and configured in the "Mode" dialog box.

Regarding power measurement modes, find some background information to the following topics at the end of this section (see chapter 4.2.1.7, "Background information on power measurement", on page 72):

- "Acquisition interval" on page 72.
- "Dropout tolerance" on page 74
- "Smoothing modulated signals" on page 73
- "Timing diagram of burst signals" on page 74
- "Timing diagram of T'Slot Av signals" on page 75
4.2.1.1 Mode dialog box

► Select "Mode..." in the "Sensor" menu.

In addition to the "Cont Av" mode (continuous average-power measurements) available for all sensors, further measurement modes can be used for most of the sensor types.

A | B | C | D
Tabs for selecting the sensor.

Note: In remote-control commands, select the sensor with the suffix in command 
SENSe<[1]..4>:... i.e. choose suffix 1 for channel A, channel 2 for B, and so on.

ContAv, Trace & ...
Measurement modes:

"Cont Av" In the Continuous Average mode, the average signal power is continuously measured without the acquisition interval and signal being in sync. (see chapter 4.2.1.2, "Continuous average-power measurements", on page 66).

"Trace&Statistics" In the Trace & Statistics mode, the R&S NRP2 analyzes the power envelope of the test signal and displays the power envelope either as a function of time or in its probability distribution and probability density distribution function (see chapter 4.2.1.6, "Trace & statistics measurements", on page 72).

"T'slot Av" In the Timeslot Average mode, the average power can be measured over defined time intervals of a signal with periodic envelope. The timeslot mode should be used preferably for signals with an equally spaced timeslot structure (see chapter 4.2.1.4, "Measuring the average power of TDMA signals", on page 68).

"T 'gate Av" In the Timegate Average mode, the average power can be measured over defined time intervals of a signal with periodic envelope. The timegate mode provides four user-configurable gates for the measurement (see chapter 4.2.1.5, "Measuring the average power in gates", on page 71).
“Burst Av” The **Burst Average** mode is used to measure the average burst power of pulsed signals. The acquisition interval is automatically derived from the signal (see chapter 4.2.1.3, "Measuring the average power of burst signals", on page 67).

Remote command:

```
[SENSe<1..4>]:FUNCtion[:ON] on page 269
```

### 4.2.1.2 Continuous average-power measurements

The "Cont Av" mode is the preferred measurement method if the measurement is not to be, or cannot be, synchronized with a specific signal event.

This is the only available measurement mode for thermal power sensors because they are too slow for the other measurement modes.

- Select "Cont Av" in the "Mode..." dialog box opened via the "Sensor" menu.

![Mode dialog box / Cont Av](image)

**Aperture**

Defines the aperture time (size of the acquisition interval). In the manual operating mode, the sensor-specific default setting combined with active smoothing (see below) is usually adequate. A different setting may be required if the result exhibits fluctuations due to modulation.

If the modulation frequency is known, the best results can be achieved with the aperture time set exactly to an integer multiple of the modulation period and smoothing switched off. If possible, choose the multiple such that the resulting aperture time is about as high as its sensor-specific default value.

If the modulation frequency is not known or not constant, or if a spread-spectrum modulation technique is used, smoothing should be switched on. With smoothing on, about five periods are enough to reduce fluctuations caused by modulation to an acceptable level. With more than nine periods, the fluctuations are imperceptible. With smoothing off, the situation is much less favorable as instead of just five periods as many as 300 are required; the fluctuations only completely disappear with more than 3000 periods.
It is not useful to select the aperture time longer than required, since it increases the noise component of the power sensor (chapter 4.2.1.7, "Background information on power measurement", on page 72).

Remote command:
[SENSe<1..4>][:POWer][:AVG]:APERture on page 272

**Sampling rate**
Sets the sampling rate. With the multipath power sensors R&S NRP-Z11/21/22/23/24/28/31/32, the sampling rate can be set to two different values to prevent aliasing effects for particular types of modulation signal. Aliasing can occur because the sampling frequency is located within the video bandwidth, which means that spectral components near the sampling frequency can cause beating effects. With changing the sampling rate, the beating effects usually disappear.

Remote command:
[SENSe<1..4>]:SAMPling on page 279

**Duty Cycle**
Using the duty cycle correction, the average power of RF bursts is calculated from the average power of the whole signal. Essentially, the average power of the whole signal is divided by the set duty cycle.

If thermal power sensors or R&S NRP-Z91/98 multipath power sensors are used, this procedure is the only way to determine the power of pulsed signals.

If multipath power sensors R&S NRP-Z11/21/22/23/24/28/31/32 are used, this method must be employed if the bursts are so short that their power cannot be measured in the "Burst Av" or "Timegate Av" modes.

Remote command:
[SENSe<1..4>]:CORRection:DCYCle:STATe on page 268
[SENSe<1..4>]:CORRection:DCYCle[:INPut][:MAGNitude] on page 267

**Smoothing of modulated signals**
To reduce result fluctuations caused by modulation, this parameter should always be activated if the aperture time cannot be exactly adjusted to the modulation period. If the aperture time is only 5 to 9 times larger than a modulation period, the display fluctuations are sufficiently reduced. With smoothing off, 300 to 3000 periods would be required to obtain the same effect ("Aperture" on page 66).

Remote command:
[SENSe<1..4>][:POWer][:AVG]:SMOothing:STATe on page 273

### 4.2.1.3 Measuring the average power of burst signals

The "Burst Av" mode is the simplest way of measuring the average burst power. It is available with the multipath power sensors (R&S NRP-Z11/21/22/23/24/28/31/32) and the R&S NRP-Z8x wideband power sensors.

When this mode is selected, the sensor itself detects the start and end of the burst; no external trigger signal is required. The parameter "Dropout" for detecting the falling edge and the parameters of the trigger menu, see chapter 4.2.6, "Trigger settings", on page 85, are different ways of providing a stable measurement. By using the
parameters "Excluded from Start" and "Excluded from End", the start and end of bursts can be excluded from the measurement. This means that signal overshoots can be omitted from measurements, for example.

Find some background information in sections "Dropout tolerance" on page 74 and "Timing diagram of burst signals" on page 74).

For the most common mobile radio standards, the required settings can directly be loaded via the "Recall Standard" dialog box in the "File" menu see chapter 4.6.4, "Loading settings for mobile radio standards", on page 142.

Select "Burst Av" in the "Mode..." dialog box opened via the "Sensor" menu.

![Fig. 4-6: Mode dialog box / Burst Av](image)

**Dropout**

Defines the end of the burst. If power keeps low for at least this time, the end of the burst is assumed. Modulation-specific power drops that are shorter than the set value are ignored.

**Note:** The "Dropout" parameter must not be longer than the interval between the end of the burst and the start of the next burst.

Remote command:

```
[SENSe<[1]..4>]:POWer]:BURSt:DTOLerance
```

**Excluded from Start/End**

Set the time interval at the beginning or end of the burst that is excluded from the measurement.

Remote command:

```
[SENSe<[1]..4>]:TIMing:EXCLude:STOP
[SENSe<[1]..4>]:TIMing:EXCLude:STARt
```

### 4.2.1.4 Measuring the average power of TDMA signals

The average power values of timeslots can be measured in the timeslot mode. The time resolution is determined by the sampling rate of the sensor. This mode is available in the multipath power sensors (R&S NRP-Z11/21/22/23/24/28/31/32) and in the R&S NRP-Z8x wideband power sensors.
This measurement mode can be used only if all timeslots of the TDMA signal are equal in length. A period to be excluded from the measurement can be defined at the beginning and end of each timeslot by using the "Excluded from Start/End" parameters. The R&S NRP-Z8x wideband power sensors can additionally define an exclusion interval in between, i.e. a "Fence". A midamble of the signal can thus be excluded from the measurement.

An external trigger signal or internal signal triggering is required for synchronization (see chapter 4.2.6, "Trigger settings", on page 85).

Find some background information concerning the timeslot mode in section “Timing diagram of T'Slot Av signals” on page 75).

For the most common mobile radio standards, the required settings can directly be loaded via the "Recall Standard" dialog box in the "File" menu (see chapter 4.6.4, "Loading settings for mobile radio standards", on page 142). In the "Graph" display mode, the timeslot parameters can also be set interactively in the Timeslots display mode (chapter 4.5.7, "Timeslot display mode", on page 131).

► Select "T'slot Av" in the "Mode..." dialog box opened via the "Sensor" menu.

No of Timeslots
Sets the number of subsequent timeslots within a frame, i.e. a period of the signal.

Remote command:
[SENSe<1..4>][:POWer]:TSLot:COUNt on page 277

Nominal Width
Defines the timeslot length.
Example:
When measurements are performed on TDMA signals (GSM/EDGE, PDC, NADC, PHS etc), the nominal timeslot length must be entered here, i.e. the frame length divided by the number of timeslots.

<table>
<thead>
<tr>
<th>Table 4-1: GSM signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frame length: 4.615 ms</td>
</tr>
<tr>
<td>No. timeslots: 8</td>
</tr>
<tr>
<td>⇒ Nominal width: 4.615 / 8 ms = 576.875 μs</td>
</tr>
</tbody>
</table>

Remote command:

\[
\text{[SENSe[1]..4]:POWer:TSLot[:AVG]:WIDTh on page 278}
\]

Excluded from Start/End
Defines the intervals at the start/end of the timeslot which are excluded from the measurement. The timeslot length is set with "Nominal Width". Measurement can thus be restricted to the relevant part of a timeslot.

Remote command:

\[
\text{[SENSe[1]..4]:TIMing:EXCLude:START on page 283} \\
\text{[SENSe[1]..4]:TIMing:EXCLude:STOP on page 283}
\]

Fence
Activates the "Fence" function.

In numeric T'slotAv mode, the "Fence" function is only available for the wideband power sensors of the R&S NRP-Z8x series. For all other sensors, a fence can be used in the "T'slots" display in the Trace&Statistics sensor mode.

Config Fence …
Opens the dialog box for setting start and length of the fence.

![Fig. 4-8: Fence dialog box](image)

Start/Length of Fence ← Config Fence …
Within the measurement period, a "fence", i.e. an exclusion interval, can be set. The fence is defined by its start time and length. The start time refers to the start of a timeslot.

Remote command:

\[
\text{[SENSe[1]..4]:POWer:TSLot[:EXCLude:MID:OFFSET][:TIME] on page 277} \\
\text{[SENSe[1]..4]:POWer:TSLot[:EXCLude:MID:TIME] on page 277}
\]
4.2.1.5 Measuring the average power in gates

The timegate mode is used to measure the average power in arbitrarily chosen time intervals (gates). The time resolution is determined by the sampling rate of the sensor. Up to four different gates can be defined, although measurement can be performed only in one of them at a time. The "T'gate Av" mode is set and configured in this dialog box. The active gate must be selected in the dialog box "Func & Unit", see chapter 4.4.3, "Selecting a measurement function", on page 98.

The R&S NRP-Z8x wideband power sensors can additionally define an exclusion interval within the gate (Fence). A midamble of the signal can thus be excluded from the measurement.

An external trigger signal or internal signal triggering is required for synchronization, see also chapter 4.2.6, "Trigger settings", on page 85.

► Select "T'gate Av" in the "Mode..." dialog box opened via the "Sensor" menu.

![Mode dialog box / T'gate Av](image)

**Gate**
Sets the number of the gate to be configured.

**Note:** In remote control, the gate to be configured is determined by the TGATe suffix, see commands for the following settings.

**Start/Length of Gate**
Start of the gate is referenced to the delayed trigger time, see Trigger settings > "Delay" on page 88.

The end of the gate is determined by the start time and the length of the gate.

Remote command:

```
[SENSe<1..4>]:POWer:TGATe<1..4>:OFFSet:TIME on page 275
[SENSe<1..4>]:POWer:TGATe<1..4>:TIME on page 276
```

**Fence**
Activates the "Fence" function.

In numeric T'slotAv mode, the "Fence" function is only available for the wideband power sensors of the R&S NRP-Z8x series. For all other sensors, a fence can be used in the "T'slots" display in the Trace&Statistics sensor mode.
Config Fence ...
Opens the dialog box for setting the parameters "Start" and "Length".

![Fence dialog box](image)

Fig. 4-10: Fence dialog box

Start/Length of Fence ← Config Fence ...
Within the measurement period, a "fence", i.e. an exclusion interval can be set. The fence is defined by its start time and length. The "Start of Fence" refers to the start of the gate.

Remote command:

\[ \text{SENSe}<\{1\}..4>[:\text{POWer}]:\text{TGATe}<\{1\}..4>[:\text{EXCLude}]:\text{MID}:\text{OFFSet}[:\text{TIME}] \]
on page 274

\[ \text{SENSe}<\{1\}..4>[:\text{POWer}]:\text{TGATe}<\{1\}..4>[:\text{EXCLude}]:\text{MID}:\text{TIME} \]
on page 275

4.2.1.6 Trace & statistics measurements

The "Trace & Statistics" mode is used to display the time characteristic of the envelope power and its statistical distribution. For further information on its configuration and operation, refer to chapter 4.5, "Displaying traces", on page 113.

4.2.1.7 Background information on power measurement

This chapter provides some background information on power measurement in "Cont Av", "T'slot Av", "T'gate Av" and "Burst Av" mode, smoothing, or what is the point of dropout tolerance. Additionally, timing diagrams explain visually the relation between trigger, acquisition intervals and excluded time segments in "T'gate" or "T'slot" measurement mode.

Acquisition interval

As the sensor amplifiers use chopping, a measurement always contains an integer multiple of a pair of acquisitions which are taken with opposite polarity of the detector output signal. Samples at equal time intervals over each acquisition interval are taken. From the sum of the samples partial measurement results are formed. By forming the difference from adjacent acquisitions, an improved result is achieved, that is, the DC offset voltage and 1/f noise of the sensor amplifiers are significantly reduced. Depending on the selected averaging number, a multiple of these results is averaged to further reduce noise, see chapter 4.2.3, "Filter / averaging", on page 79.

The length of the acquisition interval depends on the set measurement mode:
Table 4-2: Acquisition interval of the respective measurement modes

<table>
<thead>
<tr>
<th>Mode</th>
<th>Acquisition interval identical to ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cont Av</td>
<td>aperture time (default or user-specific)</td>
</tr>
<tr>
<td>T'slot Av</td>
<td>nominal width x number of slots</td>
</tr>
<tr>
<td>T'gate Av</td>
<td>gate length</td>
</tr>
<tr>
<td>Burst Av</td>
<td>burst length</td>
</tr>
</tbody>
</table>

After one acquisition has been completed, the output polarity of the detector output signal is inverted. The next acquisition does not start until a sensor-specific settling time has been passed. With the "T'slot Av", "T'gate Av" and "Burst Av" modes, where the start of an acquisition must additionally be synchronized with the signal, the trigger period or a multiple of it mainly determines the acquisition rate.

In "Cont Av" mode, the acquisition interval can arbitrarily be set by defining the aperture time. In most cases, the sensor-specific default value is sufficient for optimum performance. It is defined by the manufacturer as to effectively suppress 1/f noise. This means, that for a given integration time (= averaging number x 2 x aperture time), the noise content of the measurement result is minimal with the default setting.

Depending on the sensor, the default aperture time widely varies between 20 ms (for R&S NRP-Z11/21/22/23/24/31/32/28/98 multipath power sensors) and 10 µs (for R&S NRP-Z81/85/86 wideband power sensors). Thermal power sensor normally use a 5 ms default aperture time (20 ms in the past). Vastly differing averaging numbers when using different sensor types are thus quite normal.

There are two cases where the default aperture time may not be the best selection:

- if measuring signals with low-frequency modulation
- if very short measurement times are needed, e.g. with remote-controlled applications

With low-frequency modulation, the aperture time should match the modulation period to optimally suppress modulation-induced variations of the measurement result, see chapter 4.2.1.2, "Continuous average-power measurements", on page 66.

Since this may lead to acquisitions that vastly exceed the 10 µs default aperture time of wideband power sensors, a noticeable increase of fluctuations in the measurement result due to noise must be considered with these sensors. Eventually the sensor-specific lower measurement limit cannot be reached. The same applies for "T'slot Av", "T'gate Av" and "Burst Av" power measurements when the acquisition rate drops down below 10 kHz for these sensors. For details refer to the data sheet.

With R&S NRP-Z11/21/22/23/24/31/32/28/98 multipath power sensors, a reduction of the default aperture time may be essential when fast measurements - without averaging - are needed. Taking a 100 µs idle time of these sensors into consideration, a reduction of the aperture time even below 500 µs will merely speed up measurements but significantly increase noise.

Smoothing modulated signals

Continuous average-power measurements on signals with low-frequency modulation or on pulsed signals with low repetition rates may suffer from fluctuations in the mea-
surement result, which are due to the acquisition time not being matched to the modu-
lation (pulse) period. Although it is possible with R&S NRP-Zxx Power Sensors to set
the aperture time identical to a multiple integer of the period of the power envelope of
the signal, this approach fails with a varying or unknown period.

In these cases it is recommended to activate smoothing. Instead of simply summing up
the samples within the acquisition interval, the samples are individually weighted prior
to taking the mean. Samples at the beginning and at the end of the acquisition interval
are downscaled whereas the size of samples in the center of the acquisition interval is
increased (von Hann window). This way, fluctuations of the measurement result are
reduced almost independently from the degree of the aperture time being matched to
the modulation period. The only aspect that must be considered is that the aperture
time has to be set to at least two or three modulation (pulse) periods in order to reach
an efficient operation. Set aperture time accordingly, particularly if you are using
R&S NRP-Z81/85/86 wideband power sensors, which feature very low default aperture
times.

The noise content of the measurement result is enlarged by approximately 30 % when
smoothing is activated. To compensate for this, the averaging number should be dou-
bled compared to non-active smoothing. Therefore, smoothing may be not sufficient
when measuring very low powers.

**Dropout tolerance**

The "Dropout" parameter facilitates the identification of the burst end of modulated sig-
nals (e.g. NADC). Without this parameter, the end of the burst might erroneously be
detected within the burst owing to the considerable modulation-specific power drops of
such signals. "Dropout" is set at least for the duration of modulation-dependent power
drops within the burst; thus, the end of the burst cannot be detected until the set time
has elapsed after the power has dropped below the trigger threshold. If the trigger
threshold is exceeded again during the dropout time, the process restarts from the
beginning.

**Timing diagram of burst signals**

The timing diagram below shows the relation between the following parameters:

- Trigger threshold and trigger event
- Trigger event, exclude intervals and measurement interval

Although the signal frequently falls below the trigger threshold during the burst, an end
of the burst is not detected. The reason for this is that these drops are shorter than the
set dropout time.

The last falling edge in the burst is detected as the end of the burst since the trigger
threshold is no longer exceeded during the dropout time indicated below.
Timing diagram of T'Slot Av signals

The timing diagrams that differ by externally and internally triggered events, show the relation between the listed parameters:

- Trigger event, trigger delay and start of the first timeslot
- Nominal width, exclude intervals and measurement interval of the timeslots

Fig. 4-12: Measurement on timeslot signal with external triggering
4.2.2 Offset correction

The "Offset" dialog box is for activating and entering dB offsets to effect an increase or decrease in the measurement result which is not level-dependent. This way, the input power of any attenuator, directional coupler or amplifier that is connected at the sensor input (output) can be displayed.

"Global" is used to set and activate a fixed offset. Frequency-dependent corrections can be made with "Table". Both types of correction can be made simultaneously.

"S Parameter Device" is for correcting the effects of a two-port connected at the sensor input (output) in terms of its S-parameters. The S-parameters of the two-port must be stored in the sensor. For information on how to proceed refer to the operating manual of your R&S Power Sensor, section "Program module" > "Update S-Parameters".

With the R&S NRP-Z28/98 level control sensors, offset correction applies to the sensor's output. Therefore dB offsets with a positive sign lead to a reduction of the measurement result.

4.2.2.1 Offset dialog box

- Select "Offset..." in the "Sensor" menu.

Fig. 4-13: Measurement on timeslot signal with internal triggering
The Offset menu shows the calculated offset values. "Table Offset" is the offset calculated from the selected table and the current frequency. Its value does not depend on whether table offsets are active or not. "Sensor Offset" shows the effective offset value. This value takes into account the settings for "Global" and "Table" offset. However, it neglects any additional offsets, that arise from the S-Parameter setting, as this information is stored in the sensor.

A | B | C | D
Tabs for selecting the sensor.

Note: In remote-control commands, select the sensor with the suffix in command SENSE<[1]..4>:..., i.e. choose suffix 1 for channel A, channel 2 for B, and so on.

Global (value)
Enters the global dB offset (dB offset).
Positive values correspond to external losses, negative values to external gains.
Remote command: [SENSe<[1]..4>]:CORRection:OFFSet on page 267

Global (state)
Activates/deactivates the global offset correction.
Remote command: [SENSe<[1]..4>]:CORRection:OFFSet:STATe on page 267

Table (name)
Opens an item list containing correction tables.
The instrument provides 10 tables with up to 80 frequency / offset pairs each. The default labels are "Table 1" to "Table 10"; however, the names can be changed using the table editor.
Remote command: [SENSe<[1]..4>]:CORRection:FDOTable[:SELect] on page 268
Table (state)
Activates/deactivates the frequency-dependent offset correction specified in the selected table.

Remote command:
[SENSe<1..4>:CORRection:FDOTable:STATe] on page 268

Edit Table ...
Opens a dialog box for editing the selected offset correction table, see chapter 4.2.2.2, "Table editor for offset tables", on page 78.

Remote command:
MEMory:TABLE:FREQuency on page 253
MEMory:TABLE:GAIN[:MAGNitude] on page 253

S Parameter Device
Activates the S-parameter data set stored in the sensor for a two-port that is connected to the sensor input (output).

Remote command:
[SENSe<1..4>:CORRection:SPDevice:STATe] on page 269

4.2.2.2 Table editor for offset tables

The R&S NRP2 provides a list editor for defining the frequency / offset value pairs.

Two table-editor modes are available:

- Selection mode
  In this mode, using the cursor keys ⇧ ⇩ ⇦ ⇧, you can select the number field you want to "Edit", "Insert" or "Delete".
  Note: A long list can not be displayed in full length in the dialog box. The entries are, therefore, viewed in a "window" which automatically scrolls up or down, if the cursor moves outside the visible section. The position of the currently active field is shown by the scroll bar.

- Edit mode
  When you press the "Edit" rocker switch the value in the selected field can be edited. In this mode, the cursor keys cannot be used for selection, but can be used "normally" to edit values in the entry field.

  ▶ To open the table editor, select "Sensor" > "Mode" > "Offset", and then "Edit Table..." in the "Offset" dialog box.
Fig. 4-15: Table dialog box

The table editor displays the name of the table in its title bar, a two-column list with frequency and offset value pairs and provides softkeys for data management.

**Edit**
Activated the edit mode in the selected field.
The entry can be confirmed with the ✪MENU or aborted with the ESC/LOCAL key. Afterwards, the table editor is again in the selection mode.

**Insert**
Inserts a new row containing the values of the selected row.
The maximum table size provides 80 rows.

**Delete**
Deletes the marked row

**Sort**
Sorts the rows in the table so that the frequencies in the rows are in ascending order.

**Name**
Renames the selected table to identify it more easily. Use of the character editor is described in chapter 3.5.9, "Digit and letter panels", on page 56.

Remote command:
MEMory:TABLE:MAP on page 254

### 4.2.3 Filter / averaging

The averaging filter is used to reduce fluctuations in the measurement result to the extent wanted. Such fluctuations can be caused by inherent noise of the measuring instrument, modulation of the measurement signal or beats from the superposition of adjacent carriers. A more stable display has to be traded off against longer measurement times.
In manual mode, “longer measurement” does not mean that it takes longer to display a new result, but rather that it takes longer for the result to settle when the power changes.

The filter settings of the "Trace & Statistics" mode and the other modes, which exclusively provide average power values, differ significantly. The filter dialog box thus displays different parameters depending on the selected display mode. Filtering in the "Trace & Statistics" mode is described in chapter 4.5.3.3, "Filtering settings", on page 118.

All average power values are obtained from a three-stage averaging process. First, a mean value is formed for the acquisition interval given in table 4-2 - either by weighted or unweighted summation of samples.

A second measurement with reversed polarity of the detector output signal is then performed to suppress offset voltages and 1/f noise of the amplifier. A first result is formed by subtracting the second measured value from the first measured value. The sequence of two consecutive measurements is repeated N times. The average value, which is obtained from the individual measurement results, is output. The number N is the averaging number ("AvgNo"). To obtain a high output data rate, averaging in manual mode is performed continuously, i.e. a new result is fed into the averaging filter after two acquisitions have been evaluated. The oldest result is taken out of the averaging filter and a new average value is calculated.

The averaging number can be selected automatically or it can be manually set to a fixed value. As a starting point, automatic filtering should always be used. If the automatically selected filter setting proves to be not adequate, the averaging number can be in(de)creased manually.

Two autofilter operating modes are provided:

- "Normal"
  The "Normal" mode finds a balance between measurement time and display noise. As an additional parameter, display resolution can be used to adjust the filter setting. With increasing resolution, i.e. an increasing number of digits in the measurement results, the averaging number also increases.

- "Fixed Noise"
  In the "Fixed Noise" mode, the averaging number is selected so that the sensors intrinsic noise (2 standard deviations) does not exceed the specified "Noise Content". To avoid very long settling times when the power is low, the averaging number can be limited with the "Max Settling Time" parameter. If the display noise then exceeds the set noise content, the symbol "S/N" is displayed.
4.2.3.1 Filter dialog box

![Filter dialog box](image)

**Fig. 4-16: Filter dialog box**

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tabs for selecting the sensor.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Note:** In remote-control commands, select the sensor with the suffix in command `SENSe<[1]..4>:...`, i.e. choose suffix 1 for channel A, channel 2 for B, and so on.

**Auto**
Toggles between automatic and manual filter setting.
Remote command:
`[SENSe<[1]..4>]:AVERage:COUNt:AUTO` on page 264

**Avg No**
Sets the averaging number manually.
This entry field always shows the current averaging number. With automatic averaging, the displayed value is grayed out and cannot be changed manually. If manual filtering is selected, the desired averaging number can be set. Changes are immediately implemented when a key is pressed.
Remote command:
`[SENSe<[1]..4>]:AVERage:COUNt` on page 263

**Reset**
Initializes the currently measured averaging filter power value. Thus, the display can be updated quickly after a change in level, particularly in the case of a large averaging number.
Remote command:
`[SENSe<[1]..4>]:AVERage:RESet` on page 266

**Auto Once**
Determines a “one-off” optimal averaging number based on the instantaneously measured power value and enter this value in the "Avg No" field. This function is available when autofilter is off.
Remote command:
`[SENSe<[1]..4>]:AVERage:COUNt:AUTO` on page 264
**Auto Config...**

Opens the "Auto Filter" dialog box.

![Auto Filter Dialog Box](image)

**Note:** In remote-control commands, select the sensor with the suffix in command `SENSe<[1]..4>:...`, i.e. choose suffix 1 for channel A, channel 2 for B, and so on.

**A | B | C | D ← Auto Config...**

Tabs for selecting the sensor.

**Mode ← Auto Config...**

Selects the auto filter mode.

- "Normal" Selects the "Normal" autofilter mode.
- "Fixed Noise" Selects the "Fixed Noise" autofilter mode.

Remote command:

```
[SENSe<[1]..4>:]AVERage:COUNt:AUTO:TYPE
```

**Ref Timeslot ← Auto Config...**

Specifies the timeslot from which the autofilter setting, i.e. the averaging number, is derived for measurements in the "T'slot Av" mode. This parameter is not available in the other measurement modes.

Remote command:

```
[SENSe<[1]..4>:]AVERage:COUNt:AUTO:SLOT
```

**Noise Content ← Auto Config...**

Defines the proportion of intrinsic noise in the measured result (in dB). Specifically, this value gives the permitted relative deviation from the mean which may not be exceeded for 95% of the observation time.

Remote command:

```
[SENSe<[1]..4>:]AVERage:COUNt:AUTO:NSRatio
```

**Max Settling Time ← Auto Config...**

Specifies an upper limit for the settling time in the "Fixed Noise" mode.

Remote command:

```
[SENSe<[1]..4>:]AVERage:COUNt:AUTO:MTIMe
```
4.2.4 Measurement ranges

The power sensors of the R&S NRP series avoid range switching. Some of them, like
the thermal ones of the R&S NRP-Z5x series and the wideband power sensors of the
R&S NRP-Z8x series, have only one measurement range. All other sensors feature
two or three measurement ranges. These ranges are called measurement paths
because they are operated in parallel (simultaneously). With automatic range selection,
measurement paths which are neither overdriven nor underdriven are selected for
evaluation. No range switching occurs at all. Adjacent paths overlap by about 6 dB, the
so-called transition region. Therefore, the final result may be composed by the mea-
surement results of two paths within certain power ranges. Transition regions can be
offset from the default settings to meet the demands of signals with high peak-to-aver-
age ratio.

4.2.4.1 Sensor range dialog box

Automatic or manual path selection can be chosen in the "Range" dialog box,
accessed via the "Sensor" menu. No function is available for power sensors that use
only one measurement range.

The "Auto" range function always selects the most suitable paths. With "User def'd
transition" deactivated, the default overlap regions between adjacent paths are consid-
ered. The offset value can be modified at any time during "Auto" range operation, but it
is only considered with an activated "User def'd transition" checkbox.

Only offsets with a negative sign are allowed. This means that transition regions can
only be shifted to lower power levels. Thus, paths can be excluded from evaluation well
before they exhibit noticeable linearity errors with critical signals. Only the most insen-
sitive path cannot be protected by this measure.

The performance of the sensors can effectively be improved by this measure with
respect to linearity errors when applying signals with high peak-to-average ratios. How-
ever, there is a certain downside regarding speed and noise. If an offset value of e.g.
-10 dB is entered, this means that paths can be underdriven by an amount of 10 dB
with respect to the default setting. This way, the amount of inherent sensor noise will
become more evident or the settling time will increase if one counteracts with a higher
averaging number. That is why there is little point in entering offsets less than -10 dB.
As a rule of thumb, linearity errors introduced by signals with high peak-to-average
ratios, are reduced according to the offset value, e.g. by a factor of four when entering
-6 dB.

Manual path selection can be chosen by deactivating the "Auto" checkbox and select-
ing the preferred path in the "Path" selection box. Testing the drive range of an individ-
ual path or avoiding the noise contribution of the adjacent path may be a good reason
for selecting manual operation.
4.2.5 Effect of the RF source

Information related to the reflection coefficient $\Gamma$ of the signal source is provided in the "$\Gamma$ Correction" dialog box (gamma correction). $\Gamma$ Correction is used to increase measurement accuracy by correcting the effect of source mismatch on the measured value.
4.2.5.1 Sensor $\Gamma$ correction dialog box

► Open the $\Gamma$ correction dialog box in the "Sensor "menu

If "$\Gamma\mu$ correction" is activated, the measurement accuracy can be increased by specifying magnitude and phase of source $\Gamma$.

![Gamma Correction Dialog Box](image)

Fig. 4-19: $\Gamma$ Correction dialog box

A | B | C | D
Tabs for selecting the sensor.

**Note:** In remote-control commands, select the sensor with the suffix in command `SENSe<[1]..4>:...`, i.e. choose suffix 1 for channel A, channel 2 for B, and so on.

**Source $\Gamma$ Correction**
Activates gamma correction in order to achieve higher measurement accuracy.
Remote command:
`[SENSe<[1]..4>]:SGAMma:CORRection:STATe` on page 280

**Source $\Gamma$ Magnitude**
Magnitude of the source reflection coefficient $\Gamma$.
Remote command:
`[SENSe<[1]..4>]:SGAMma[:MAGNitude]` on page 279

**Source $\Gamma$ Phase**
Phase angle of the source reflection coefficient $\Gamma$ in degrees.
Remote command:
`[SENSe<[1]..4>]:SGAMma:PHASe` on page 279

4.2.6 Trigger settings

The trigger system is required for the "Trace & Statistics", "Timeslot Av", "Timegate Av", and "Burst Av" measurement modes.
Configure the trigger system in the "Trigger" dialog box which is opened via the "Sensor" menu, or via the control panel of the respective trace mode.

**Trigger dialog box, page 1**

The first page covers the parameters for defining a trigger mode, trigger source, and trigger level.

![Trigger dialog box](image)

**Tabs for selecting the sensor.**

**Note:** In remote-control commands, select the sensor with the suffix in command `SENSe<[1].4>:...`, i.e. choose suffix 1 for channel A, channel 2 for B, and so on.

**Mode**

Selects the trigger mode.

Selections "Single" and "Normal" are only available in "Trace&Statistics" measurement mode.

- **"Single"**  
  "Trace&Statistics" mode only. This setting disables continuous triggering so that only one trigger event at a time is executed. To enable triggering again, press the (DEL/1TRIG) key. The symbol `ITRG` appears in the display (see chapter 4.2.7, "Trigger sequence control", on page 89).

- **"Normal"**  
  Continuous triggering with regular trigger events.

- **"Auto"**  
  "Trace&Statistics" mode only. This setting automatically starts a measurement if no trigger event has occurred after 300 ms.

Remote command:
- `INITiate:ALL:CONTinuous` on page 329
- `TRIGger:ALL:ATRigger[:STATe]` on page 331

**Source**

Selects the trigger source for the selected sensor. The measured internal signal ("Internal") or an external signal is available for triggering. The external trigger signal is either input at the TRIG IN / OUT2 connector at the rear of the instrument ("External") or it is supplied by another power sensor which must be configured as a trigger master ("Int. Master").
**Note:** In addition to using an internal or external trigger source, a trigger event can be forced using the DEL/1TRIG hardkey, see chapter 4.2.7, “Trigger sequence control”, on page 89.

"Internal"  
The trigger event for the selected sensor is derived from the measured signal.

"External"  
The trigger event for the selected sensor is derived from the trigger bus. The trigger signal on the trigger bus is either input at the TRIG IN / OUT2 connector at the rear of the instrument or it is provided by another sensor.  
If the trigger signal is input at the TRIG IN / OUT2 connector, the connector must be configured for "Trigger In" in the "System" menu, see chapter 4.7.2.2, "I/O 2 interface", on page 155.  
If the trigger signal is provided by another sensor, this sensor must be configured as trigger master, see below, "Int. Master".

"Int. Master"  
The selected power sensor is automatically configured as trigger master and set to internal triggering. Any previously defined trigger master is disabled and an external trigger signal at the TRIG IN / OUT2 connector is ignored.  
The trigger master is used as the external trigger source for all other sensors.

Remote command:  
TRIGger:ALL:SOURce on page 334

**Slope**  
Sets the polarity of the active slope of the externally or internally applied trigger signal, see **Source**.  
- "Positive"  
The rising edge of the trigger signal is active.  
- "Negative"  
The falling edge of the trigger signal is active.

Remote command:  
TRIGger<[1]..4>:SLOPe on page 334

**Level**  
Sets the trigger threshold for internal triggering. Depending on the slope polarity, a rising or a falling edge will execute a trigger event when crossing the threshold. Modifications of the level are immediately effective (see chapter 3.5, "Dialog boxes and their controls", on page 53).

Remote command:  
TRIGger:ALL:LEVel on page 333

**Page**  
Switches to the next page of the dialog box.

**Trigger dialog box (2)**  
The second page covers the parameters for defining a trigger delay and a dropout time to prevent accidental triggering.
Fig. 4-21: Trigger dialog box, page 2

A | B | C | D ← Trigger dialog box (2)
Tabs for selecting the sensor.

Note: In remote-control commands, select the sensor with the suffix in command SENSe<[1]..4>:..., i.e. choose suffix 1 for channel A, channel 2 for B, and so on.

Delay ← Trigger dialog box (2)
Sets the trigger delay. Setting a positive value delays the effect of the trigger event until the set time has elapsed. Entering negative values allows pretriggering (limited to a few milliseconds, depending on the sensor).
Modifications of the trigger delay are immediately effective (see chapter 3.5, "Dialog boxes and their controls", on page 53).

Tip: Entering a correct value for the trigger delay is absolutely essential for accurate measurements in the "T'Slot Av" mode. For this reason, the setting should always be checked in the "Trace & Statistics mode" (timeslot display mode).
Remote command: TRIGger:ALL:DELay on page 331

Dropout ← Trigger dialog box (2)
Sets the dropout time. The dropout time prevents the trigger system from being activated by signal excursions prior to the trigger event targeted. The parameter is set to a value that is slightly higher than the maximum duration of power drops that are supposed to execute triggering.
In contrast to the "Holdoff" parameter which is referenced to the active slope (trigger event), the dropout time takes effect if the passive slope of the trigger signal crosses the trigger threshold.
Remote command: TRIGger:ALL:DTIMe on page 332

Page ← Trigger dialog box (2)
Switches to the next page of the dialog box.

Trigger dialog box (3)
The third page of the trigger dialog box covers the hysteresis and holdoff parameters.
Fig. 4-22: Trigger dialog box, page 3

A | B | C | D ← Trigger dialog box (3)
Tabs for selecting the sensor.

Note: In remote-control commands, select the sensor with the suffix in command SENSe<[1..4]>:..., i.e. choose suffix 1 for channel A, channel 2 for B, and so on.

Hysteresis ← Trigger dialog box (3)
Sets the trigger hysteresis. The trigger hysteresis prevents the trigger system from being activated too early if the trigger threshold is slightly underranged or exceeded. Before triggering can occur again, the signal level must be lower (higher) than the trigger level minus (plus) hysteresis.

Modifications of the trigger hysteresis are effective immediately (see chapter 3.5, "Dialog boxes and their controls", on page 53).

Remote command:
TRIGger:ALL:HYSTeresis on page 333

Holdoff ← Trigger dialog box (3)
Sets the holdoff time. The holdoff time starts with the trigger event. During holdoff time other trigger events are suppressed.

Modifications of the holdoff time are effective immediately (see chapter 3.5, "Dialog boxes and their controls", on page 53).

Page ← Trigger dialog box (3)
Switches to the next page of the dialog box.

4.2.7 Trigger sequence control

In "Trace & Statistics" measurement mode three trigger modes are available.

- Single
- Normal
- Auto

The trigger mode is selected in the "Sense Trigger" dialog box, see "Mode" on page 86.
Internal and external trigger signals are used for triggering. In addition, the trigger sequence can be manually controlled using the DEL/1TRIG key.

4.2.7.1 Controlling trigger sequence in normal mode

In normal (continuous) trigger mode measurements run continuously with regular trigger events.

The trigger events may be caused by internal or external trigger signals, see "Source" on page 86 in the "Sense Trigger" dialog box.

After the first trigger event **R** is indicated in the title bar.

The DEL/1TRIG hardkey can be used to stop and restart the measurement any time.

To stop the measurement

► Press the DEL/1TRIG hardkey.

**STOP** is indicated in the title bar.

To start the measurement again

► Press the DEL/1TRIG hardkey

**R** is indicated in the title bar.

If no trigger signal is active, you can force a measurement with the DEL/1TRIG hardkey at any time.

4.2.7.2 Controlling trigger sequence in single mode

In "Single" mode only one measurement is executed after a trigger event.

After a measurement is completed, the trigger system is inactive.

To start the measurement again

1. Press the DEL/1TRIG hardkey.

   Triggering is enabled and **1TRIG** is indicated in the title bar.

2. Execute a trigger event, either

   a) by signal triggering (internal or external)
   b) or manually by pressing the DEL/1TRIG hardkey.

   The measurement starts and **1TRIG** is indicated in the title bar. The measurement stops after one sweep. The trigger system turns inactive.

4.2.7.3 Controlling trigger sequence in auto mode

The measurements run continuously. **R** is indicated in the title bar.
To stop the measurement
► Press the DEL/1TRIG hardkey.
STOP is indicated in the title bar.

To start the measurement again
► Press the DEL/1TRIG hardkey.
RUN is indicated in the title bar.

### 4.3 Displaying measurement results

The R&S NRP2 provides a total of four windows for displaying results.

#### 4.3.1 Arranging windows

Windows are displayed in numerical order from the top to the bottom of the screen. The R&S NRP2 automatically selects the window size according to the number of displayed windows.

![Fig. 4-23: Arranging windows](image)

#### 4.3.2 Labeling windows

The windows are numbered from 1 to 4 and are therefore clearly identifiable. By default, they are labeled by the window’s number (1 to 4). The label is displayed in the top left of the title bar.

Windows can also be assigned a name, see "Window Name" in the "File" menu. The name is displayed in the window’s title bar. Assigning meaningful names to the windows makes it much easier to recognize the associated measurement. A name like “Amplifier output” is more informative than “Channel A” or "Window 2".

The names of the windows are also stored in the setups.
With remote control, the window is selected with suffix <[1]..4> in the WINDow keyword. For example, command SENSE:WINDow2:STAT ON activates window 2.

### 4.3.3 The Windows menu

The "Windows" menu is context-sensitive and displays only those menu items that are relevant to the current measurement scenario. The menu includes all window functions the instrument provides.

#### 4.3.3.1 Selecting a window

The window to be configured is selected by the tab.

**Window dialog box tabs**

Each window is assigned a tab. All the parameters settings in the "Window" dialog box act on the selected window.

Remote command: DISPlay[:WINDow]:SELECT on page 246

With remote command there is a distinction between selecting the active window and selecting the window to be configured. The active window is selected using command DISPlay:WINDows:SELECT. The window to be configured is selected with the suffix of the WINDows keyword. For example DISPLay:WINDow3:NAME defines the label of window 3.

#### 4.3.3.2 Using and arranging windows

The labeling of the second softkey in the "Windows" menu is context-sensitive and changes according to the status of the active window.
Open
Opens the selected window with its previous settings, i.e. "Open" restores a measurement that has been removed from the display.

Remote command:
```
DISPlay[:WINDow]<[1]..4>[:STATe] on page 247
```

Init
Initializes the selected window, i.e. "Init" configures a completely new measurement with preset values.

Close
Closes the selected window. The sizes of the remaining windows are adjusted accordingly.

Remote command:
```
DISPlay[:WINDow]<[1]..4>[:STATe] on page 247
```

Expand
Expands all open windows to the full display height. Only the selected window is displayed while the other windows are masked by the selected window. However, the masked windows are still open and can be selected in the sequence "1 2 3 4" in the windows menu or by means of the up/down cursor keys.

Full height windows display all relevant parameters. The enhanced control functions offered by the "Trace & Statistics" mode are available only if the windows are full height. For a graphical representation of the various window types and a description of symbols see chapter 3.6.1, "Window sizes and types", on page 57 and chapter 3.6.2, "Special symbols", on page 58.

Remote command:
```
DISPlay[:WINDow]:SIZE on page 246
```

Arrange
Reduces the full height windows to their normal size. The windows are displayed simultaneously again.

Remote command:
```
DISPlay[:WINDow]:SIZE on page 246
```

### 4.3.3.3 Selecting the result display mode

Three result display modes are available in the windows menu. The result display mode determines how the measured values are presented.

**Dig D&A Graph**

Selects the display mode.

The parameter settings below the display mode change according to the selected mode, see chapter 4.3.3.4, "Configuring the result display", on page 95.
"Dig" The *digital* display mode shows the measured value numerically. Additional information on the active settings is provided, e.g. signal frequency, sensor mode, trigger mode, etc.. For a description of the used symbols see chapter 3.6.2, "Special symbols", on page 58.

```
<table>
<thead>
<tr>
<th></th>
<th>A (T'slot 1)</th>
<th>System</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>4 Auto</td>
<td>-29.21 dBm</td>
</tr>
<tr>
<td></td>
<td>0.000 dB</td>
<td>50.000 MHz</td>
</tr>
</tbody>
</table>
```

"D&A" The hybrid *digital & analog* display mode shows the measured value on an analog scale and numerically.

```
<table>
<thead>
<tr>
<th></th>
<th>A (T'slot 1)</th>
<th>System</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>4 Auto</td>
<td>-29.21 dBm</td>
</tr>
<tr>
<td></td>
<td>0.000 dB</td>
<td>-70 dBm</td>
</tr>
</tbody>
</table>
```

Displaying measurement results
In the **graphical** display mode, the power meter displays the envelope power as a function of time or in its distribution and distribution density function (CCDF, CDF, PDF). Additional information on the active settings is below the graph in the info panel. See chapter 4.5, "Displaying traces", on page 113

In halfsize representation, selected measurement values are indicated on the left side of the graph.

Remote command:

```
DISPLAY[:WINDow]<[1]..4>:FORMAT
```

on page 242

### 4.3.3.4 Configuring the result display

Each of the display modes is configured individually.

The available configuration parameters depend on the selected display mode.

- **"Dig"**
  - In the **digital** display, the resolution is adjustable, see Setting the resolution.
  - For "TimeSlot AV" measurements, the timeslot to be displayed can be chosen.

- **"D&A"**
In the hybrid digital & analog mode, the resolution of the digital display ("Setting the resolution" on page 96) and the scaling for the analog meter are adjustable ("Setting the Analog Meter" on page 96).

- "Graph"
  In the graphical representation, all further settings are provided in the corresponding diagrams. Once the window has been expanded, as described in "Expand" on page 93, additional submenus provide trigger, marker or scale-setting parameters.

Setting the resolution

The resolution of a digital measurement result display can be set in 4 stages, designated as 1 dB, 0.1 dB, 0.01 dB and 0.001 dB. If dB, dBm or dBμV is selected as the unit, the number of places after the decimal point is set directly. In the linear mode (W, Δ%, 1), the number of digits after the decimal point depends on the selected resolution and the magnitude of the result. A digit is added or removed for each resolution stage that is added or removed.

The selected resolution also influences the automatic selection of the averaging number in the "Normal" mode (see chapter 4.2.3, "Filter / averaging", on page 79). The higher the selected resolution, the higher the averaging number to correspond to the number of digits.

Resolution (dB)

Sets the resolution for the measurement result display.

The resolution of the displayed result corresponds to the selected setting.

Remote command:
DISPlay[:WINDow]<[1]..4>:RESolution on page 245

Setting the Analog Meter

The analog scale in the hybrid digital & analog display mode ("D&A") is set in the "Meter Scaling" dialog box. The dialog box opens after pressing the "Analog Meter" softkey.

![Fig. 4-27: Meter Scaling dialog box](image)

Auto Once

Automatically selects the appropriate scaling so that the currently measured value is in the middle of the scale.

Remote command:
DISPlay[:WINDow]<[1]..4>:METer:AUTO on page 243
4.4 Configuring measurements

The R&S NRP2 can perform up to four measurements simultaneously. Each measurement is configured separately in a window. Measurement parameters are set in the "Measurement" menu.

For every window opened via the "Windows" menu, a measurement in the "Measurement" menu can be configured. The measurement channels (A, B, C and D), the processing of the measured values (ratio, difference), the result unit and additional information (measurement uncertainty, max, min) are defined.

Configuring a measurement does not change the sensor operating modes that have been set in the "Mode" menu.

In remote control mode, the instrument allows the configuration of a total of 8 measurements. However, only measurement 1 to 4 can be assigned a result window. Measurements number 5 to 8 can only be evaluated via remote control.

4.4.1 The Measurement menu

The "Measurement" menu contains the functions required to configure measurements.
4.4.2 Selecting a window

The window to be configured is selected by the tab.

**Window dialog box tabs**

Each window is assigned a tab. All the parameters settings in the "Window" dialog box act on the selected window.

Remote command:

```
DISPlay[:WINDow]:SELect
```

With remote command there is a distinction between selecting the active window and selecting the window to be configured. The active window is selected using command `DISPlay:WINDows:SELect`. The window to be configured is selected with the suffix of the `WINDows` keyword. For example `DISPlay:WINDow3:NAME` defines the label of window 3.

4.4.3 Selecting a measurement function

In this chapter, measurement function are discussed that can be displayed in numeric windows ("Dig", "D/A"). The functionality of the graphic windows is described in chapter 4.5, "Displaying traces", on page 113

The R&S NRP2 can display the measurement result of one channel (sensor) or combine measured values from two channels (sensors) using a mathematical function and display the result in the selected window. The necessary settings are made in the "Function..." dialog box.
The first step is to select the measurement function, i.e. the mode of combination for multi-channel measurements. Possible functions are the power ratio, the sum, or the difference of two channels, an impedance matching measurement function derived from the power ratio or the power in a single measurement channel. All or any of the connected sensors can be selected. A primary channel, and possibly a secondary channel, must be selected for each measurement window.

The simplest case is a measurement with just one sensor. To configure this measurement, first select this sensor in the "Prim. Channel" list. Then select "Single (x)" as function.

To make two-channel measurement, a "Sec. Channel" must be defined prior to selecting the measurement function.

For impedance matching measurement functions ("SWR (x,y)", "RCoeff (x,y)" and "RLoss (x,y)"), the first letter (x) is always referenced to the channel detecting the "Incident power" and the second letter (y) to the channel detecting the "Reflected power". "Prim. Channel" and "Sec. Channel" are replaced by "Incident" and "Reflected" in this case.

Any of the four channels A, B, C, and D can be assigned primary or secondary channel.

![Fig. 4-29: Function & Unit dialog box](image)

The parameters provided in the middle of the dialog box vary according to the selected measurement mode.

### 4.4.3.1 Functions and their use

In the "Function & Unit" dialog box of the "Measurement" menu, select the measurement function, the associated sensor channels, the unit, and additional readings for the display.
Impedance measurements "SWR", "RCoeff" and "RLoss"
If you work with the functions for the impedance measurement, i.e. "SWR", "RCoeff" and "RLoss", note that the incident power must be measured in the primary channel and the reflected power in the secondary channel.

Continuous Average and Burst Average power measurements
If Continuous Average and Burst Average power measurements have been selected for the channels that are used as arguments for the measurement function of the "Function & Unit" dialog box, no additional settings are required to define the measurement. Setting the unit and defining auxiliaries doesn't affect the measurement itself but tailors the measurement result in such a way that it is convenient for the user.

"Trace & Statistics" mode and "Graph" results window
If the primary channel is operating in the "Trace & Statistics" mode and the results window is set to "Graph", the envelope power of this channel is automatically shown as a function of time or in its distribution and distribution density function ("CCDF", "CDF", "PDF"). In this case, it is not possible to select another measurement function.

Function
The list of functions itemizes all the measurement functions provided by the R&S NRP2.
Any of the four channels can be assigned primary or secondary channel.
The available units depend on the selected function, see tables 4-3, 4-4, 4-5, 108.
For example, in trace mode, only "Single (A)" and "Ratio (A/B)" are available, and in statistics mode only one channel is available, which corresponds to "Single (A)".
"Single (A)" Power in the primary channel
"Ratio (A/B)" Ratio of the power in the primary channel to the power in the secondary channel.
"SWR (A,B)" Standing wave ratio.
"RCoeff (A,B)" Reflection coefficient.
"RLoss (A,B)" Return loss.
"Diff (A-B)" Power difference between the primary and secondary channel.
"Sum (A+B)" Sum of power in primary and secondary channel.
**Prim. / Sec. Channel**
Selects the primary channel for single channel measurement and selects the primary and secondary channel for two channel measurements.

![Fig. 4-31: Selection of the primary channel](image)

**Incident / Reflected**
Selects the channel referenced to the incident power or the reflecting power. These parameters appear instead of "Prim. / Sec. channel " if impedance measurement functions such as "SWR", "RCoef" and "RLoss" are selected.

### 4.4.3.2 Measuring power in gates

For time-gated power measurements the R&S NRP2 power meter offers two modes:
- **T'gate Av**
- **Trace & Statistics**

**T'gate Av**
In this mode, the average power (Av) within a user-definable gate can be measured. The time resolution is high and corresponds to the sampling rate of the sensor.

To configure the measurement:
1. Select "T'gate Av" in the "Mode" dialog box of the "Sensor" menu
2. Set the timing parameter for the gates
3. Select the gate number for the measurement in the "Function & Unit" dialog box of the "Measurement" menu.

   The average power within the selected gate is indicated.
Trace & Statistics

In this mode, the peak power (P_k) or the P_k/A_v ratio can be measured within a user-definable gate in addition to the average power (A_v). However, the time resolution is limited to the length of one point (pixel) of the display.

The measured values can either be output as additional numeric information in a graphic window or in a numeric window ("Dig", "D&A").

To configure the measurement of A_v, P_k and P_k/A_v ratio:
1. Select "Trace & Statistics" in the "Mode" dialog box of the "Sensor" menu
2. Select "Gate" mode in the "Display" control panel of the Trace display
3. Set the timing parameters in the "Config Gate" control panel of the Trace display

The gate is indicated graphically in the trace display. The power values within the selected gate are indicated in the info panel.

To display the results numerically continue as follows:
1. Select "Dig" or "Ana&Dig" display in the "Window" dialog of of the "Windows" menu
2. Open the "Function&Unit" dialog box of the of the "Measurement" menu.
3. Select the gate, the main value ("Eval"), and "Aux. = Normal"

The main value together with the auxiliary values is indicated numerically.
In "Dig"/"D&A" display modes, the results can be correlated to any other measured value ("Function").

If you want to combine the measurement results of different channels by using functions, not all combinations are supported. The "Ratio" function calls for measurands of the same dimension, e.g. two power levels or two "Pk/Av" ratios. The impedance measurement functions even require identical measurands, e.g. two average power values but not one average power value and one peak power value.
"Pk/Avg"  Ratio of peak power to average power in the gate (only in the "Trace & Statistics" mode)

Remote command:
Selection of display
DISPlay[:WINDow]<[1]..4>:AVALue on page 241
Reading out values
CALCulate<[1]..8>:DATA? on page 225

4.4.3.3 Measuring power in timeslots

As with time-gated power measurements, the R&S NRP2 power meter also offers two measurement modes for measurements within timeslots

- **T'Slot Av**
- **Trace & Statistics**

**T'Slot Av**

In this mode, the average power \((A_{v})\) within any timeslot of a user-definable timeslot structure can be measured. The time resolution is high and corresponds to the sampling rate of the sensor.

To configure the measurement:
1. Select "T'Slot Av" in the "Mode" dialog box of the "Sensor" menu
2. Set the timing parameter for the timeslots
3. Select the timeslot number for the measurement in the "Function & Unit" dialog box of the "Measurement" menu.

The average power within the selected timeslot is indicated.

<table>
<thead>
<tr>
<th>1</th>
<th>A (T'slot 1)</th>
<th>System</th>
</tr>
</thead>
<tbody>
<tr>
<td>[ائر]</td>
<td>8.981 dBm</td>
<td>1.000 GHz</td>
</tr>
</tbody>
</table>

Fig. 4-36: Measurement within a timeslot (T'Slot Av mode)

**Trace & Statistics**

In this mode, the peak power \((P_{k})\) or the \(P_{k}/A_{v}\) ratio can be measured within any timeslot of a user-definable timeslot structure in addition to the average power \((A_{v})\). However, the time resolution is limited to the length of one point (pixel) of the display.

The measured values can either be output as additional numeric information in a graphic window or in a numeric window ("Dig", "D&A").
To configure the measurement of $A_v$, $P_k$ and $P_k/A_v$ ratio:

1. Select "Trace & Statistics" in the "Mode" dialog box of the "Sensor" menu
2. Select "T'slot" mode in the "Display" control panel of the Trace display
3. Set the timing parameters in the "Config T'slot" control panel of the Trace display

The timeslot is indicated graphically in the trace display. The power values within the selected gate are indicated in the info panel.

![Fig. 4-37: Measurement within a timeslot (Trace&Statistics mode/Graph display mode)](image)

To display the results numerically continue as follows:

1. Select "Dig" or "Ana&Dig" display in the "Window" dialog of the "Windows" menu
2. Open the "Function&Unit" dialog box of the "Measurement" menu.
3. Select the timeslot, the main value ("Eval"), and "Aux. = Normal"

The main value together with the auxiliary values is indicated numerically.

![Fig. 4-38: Measurement within a timeslot (Trace&Statistics mode/ Dig display mode)](image)

In "Dig"/"D&A" display modes, the results can be correlated to any other measured value ("Function")

If you want to combine the measurement results of different channels by using functions, not all combinations are supported. The "Ratio" function calls for measurands of the same dimension, e.g. two power levels or two $P_k/A_v$ ratios. The impedance measurement functions even require identical measurands, e.g. two average power values but not one average power value and one peak power value. If both channels are set to timeslot measurements, only identical timeslot numbers are supported.
**Fig. 4-39: Function & Unit dialog box, sensors are operated in timeslot mode**

**Timeslot**  
Determines which timeslot is to be evaluated. Only one value for both channels can be selected.

**Eval.**  
This selection is only available in the "Trace & Statistics" mode. In the T'Slot Av mode, evaluation is fixed to ‘Avg’ = average power in the timeslot.

Selects the measurand:
- "Avg" Average power in the timeslot  
- "Pk" Peak power in the timeslot  
- "Pk/Avg" Ratio of peak power to average power in the timeslot

Remote command:  
Selection of display  
```
DISPLAY[:WINDow]<[1]..4>:AVALue
```
on page 241  
Reading out values  
```
CALCulate<[1]..8>:DATA?
```
on page 225

### 4.4.3.4 Setting the unit

**Combining channels which are operated in different measurement modes**

It is possible to define measurement functions based upon channels that are operated in different measurement modes. This way, the average power within a specific timeslot of a signal can be related to the average burst power of another signal. Many other combinations are possible. The "Function & Unit" dialog box reflects this situation by offering only those selection boxes that are needed to clearly define the measurands of the combined channels.

**Function & Unit dialog box / Units**

The unit for indicating the results can be selected either directly in the "Measurement" menu or in the "Function & Unit" dialog box.
Only the units which are compatible with the selected measurement function are provided for selection. I.e. absolute power values are displayed in W, dBm or dBμV, and relative values in 1, dB or Δ%, respectively.

The following tables show how the R&S NRP2 calculates the measurement results for the different units either in absolute notation or relative to a reference value, see chapter 4.4.4, "Relative measurement", on page 110 (for legend see table 4-7):

**Table 4-3: Formulas for absolute single channel power measurement**

<table>
<thead>
<tr>
<th>Function</th>
<th>Unit</th>
<th>W</th>
<th>dBm</th>
<th>dBμV</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single</td>
<td></td>
<td>$P$</td>
<td>$10 \log\left(\frac{P}{1\text{ mW}}\right)$</td>
<td>$20\log\left(\sqrt{P \cdot Z}\right)$</td>
</tr>
</tbody>
</table>

**Table 4-4: Formulas for power ratio measurement**

<table>
<thead>
<tr>
<th>Function</th>
<th>Unit</th>
<th>W</th>
<th>dBm</th>
<th>dBμV</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ratio (A,B)</td>
<td></td>
<td>$10 \log\left(\frac{P_A}{P_B}\right)$</td>
<td>$100\left(\frac{P_A}{P_B} - 1\right)$</td>
<td>$\frac{P_A}{P_B}$</td>
</tr>
<tr>
<td>SWR (A,B)</td>
<td></td>
<td>-</td>
<td>-</td>
<td>$\frac{1 + \frac{P_B}{P_A}}{1 - \frac{P_B}{P_A}}$</td>
</tr>
<tr>
<td>RCoeff (A,B)</td>
<td></td>
<td>-</td>
<td>-</td>
<td>$\frac{P_B}{\sqrt{P_A}}$</td>
</tr>
<tr>
<td>RLoss (A,B)</td>
<td></td>
<td>$10 \log\left(\frac{P_A}{P_B}\right)$</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>
### Table 4-5: Formulas for sum and difference of power

<table>
<thead>
<tr>
<th>Function</th>
<th>Unit</th>
<th>( P_a ) + ( P_b )</th>
<th>( P_a ) − ( P_b )</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sum (A+B)</td>
<td>W</td>
<td>( 10 \log \left( \frac{P_a + P_b}{1\text{mW}} \right) )</td>
<td>( 10 \log \left( \frac{P_a - P_b}{1\text{mW}} \right) )</td>
</tr>
<tr>
<td>Diff (A-B)</td>
<td>dBm</td>
<td>( 20 \log \left( \frac{P_a + P_b}{1\mu\text{V}} \right) )</td>
<td>( 20 \log \left( \frac{P_a - P_b}{1\mu\text{V}} \right) )</td>
</tr>
</tbody>
</table>

### Table 4-6: Formulas for relative measurement

<table>
<thead>
<tr>
<th>Function</th>
<th>Unit</th>
<th>( \frac{P}{P_R} )</th>
<th>( \frac{P_a \pm P_b}{P_R} )</th>
<th>( \frac{P_a}{P_b} )</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single</td>
<td>dB</td>
<td>( 10 \log \left( \frac{P}{P_R} \right) )</td>
<td>( 100 \left( \frac{P}{P_R} - 1 \right) )</td>
<td>( 100 \left( \frac{P_a \pm P_b}{P_R} - 1 \right) )</td>
</tr>
<tr>
<td>Sum</td>
<td>Δ%</td>
<td>( 10 \log \left( \frac{P_a \pm P_b}{P_R} \right) )</td>
<td>( 100 \left( \frac{P_a \pm P_b}{P_R} - 1 \right) )</td>
<td></td>
</tr>
<tr>
<td>Diff</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ratio</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Table 4-7: Legend for formula tables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>P</td>
<td>Power</td>
</tr>
<tr>
<td>( P_a )</td>
<td>Power in channel A (incident power)</td>
</tr>
<tr>
<td>( P_b )</td>
<td>Power in channel B (reflected power)</td>
</tr>
<tr>
<td>( P_R )</td>
<td>Reference (power)</td>
</tr>
<tr>
<td>( (P_X/P_Y)_R )</td>
<td>Reference (power ratio)</td>
</tr>
<tr>
<td>Z</td>
<td>Characteristic impedance, i.e. 50Ω</td>
</tr>
</tbody>
</table>

### Unit

The "Unit" drop-down list is used to set the result unit. Units that are provided for the selected measurement function:

- "W" Single, Diff, Sum
- "dBm | dBμV" Single, Diff, Sum
- "Δ% | dB | 1" Ratio
4.4.3.5 Displaying additional information

In display mode "Dig", up to three further values with helpful information can be displayed in the results window, in addition to the current measurement result.

![Function & Unit dialog box, Auxiliaries](image)

**Example:**

```
<table>
<thead>
<tr>
<th>Aux.</th>
<th>Rel.</th>
<th>1</th>
<th>2</th>
<th>3</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>dB</td>
<td>-1.46</td>
<td>-0.484</td>
<td>-2.458</td>
</tr>
<tr>
<td>2</td>
<td>dB</td>
<td>-1.46</td>
<td>1.974</td>
<td></td>
</tr>
</tbody>
</table>
```

In the example, the auxiliary function is set to "Extremes", i.e. the maximum, the minimum and the max-min value are indicated.

See also chapter 3.6.2, "Special symbols", on page 58 for information concerning the displayed symbols and values.

The R&S NRP2 continuously saves the data that is required for the display of extreme and statistic values. The data memory can be erased any time with "Aux Val Reset" in the "Measurement" menu, see also chapter 4.4.6, "Resetting auxiliary information", on page 112.

**Aux.**

- **Selects the additional information to be displayed**
  - "None" Displays no additional information.
"Normal" Displays the frequencies of the primary and, if used, secondary channel.
The following information is additionally displayed to single-channel power measurement results in time slots and time gates (with R&S NRP-Z78x wideband sensors only):

<table>
<thead>
<tr>
<th>Display</th>
<th>Main Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Pk, Pk/Av&quot;</td>
<td>main value Av</td>
</tr>
<tr>
<td>&quot;Av, Pk/Av&quot;</td>
<td>main value Pk</td>
</tr>
<tr>
<td>&quot;Av, Pk&quot;</td>
<td>main value Pk/Av</td>
</tr>
</tbody>
</table>

"Extremes" Displays the maximum, the minimum and the max-min values since the search for extreme values has been started.

```
<table>
<thead>
<tr>
<th>2</th>
<th>A Rel</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>-1.46 dB</td>
</tr>
</tbody>
</table>
```

"Statistics" Displays the longterm mean, the standard deviation and the total number of measurement results which have been evaluated since the search for statistic values has been started.

```
<table>
<thead>
<tr>
<th>2</th>
<th>A Rel</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>-1.46 dB</td>
</tr>
</tbody>
</table>
```

Remote command:
CALCulate<1..8>:DATA? on page 225
CALCulate<1..8>:MAXimum:DATA? on page 232
CALCulate<1..8>:MINimum:DATA? on page 232
CALCulate<1..8>:PTPeak:DATA? on page 233
CALCulate<1..8>:MEAN:DATA? on page 232
CALCulate<1..8>:SDEViation:DATA? on page 234
CALCulate<1..8>:COUNT:DATA? on page 225
DISPlay[:WINDow]<1..4>:AVALue on page 241

4.4.4 Relative measurement

The "Relative" function allows you to relate a power or a power ratio to a reference value. The reference value can be a previously stored reading or an entered value. The R&S NRP2 calculates the ratio of measurement result and reference value and the relative deviation of the measured value from the reference value and indicates the result.
4.4.4.1 Relative

The "Relative" settings activate or deactivate relative power measurement, or assign a measurement result as reference.

**Off**
- Absolute power measurement or measurement of the power ratio of two measurement channels using the "Ratio" function is performed.

**On**
- Relative power measurement or relative power ratio measurement.

**Reset**
- Assigns the current measurement result as reference value.

Remote command:

- `CALCulate<[1]..8>:RELative:STATe` on page 234
- `CALCulate<[1]..8>:RELative[:MAGNitude]:AUTO` on page 233

4.4.4.2 Setting the reference value manually

The reference value can be directly entered or edited using the "Reference Value" dialog box. Open the dialog box with the "RefVal" softkey.

- **Ref**
  - Enter a reference value or modify a previously set value.

Remote command:

- `CALCulate<[1]..8>:RELative[:MAGNitude]` on page 233

- **Reset**
  - The current measurement result is transferred to the reference value memory of the active window and is displayed. This function can also be started from the "Measurement" menu by using the "Reset" softkey.

Remote command:

- `CALCulate<[1]..8>:RELative[:MAGNitude]:AUTO` on page 233

4.4.5 Limit Monitoring

An upper and a lower limit for each window with digital ("Dig") or digital/analog ("D&A") result display can be set in the "Limits" dialog box. If either limit is violated, a warning is issued.

The warning may be one of the following:

- The "LIMIT FAIL" message is displayed on the screen (always).
A warning tone is output (optional, only when "Warning Beep" is activated, see below)

- A signal is issued on analog output "OUT1" (optional, chapter 4.7.2, "Setting the analog outputs and the trigger input", on page 151).

**Fig. 4-43: Limits dialog box**

### xx.xxxx dBm / Upper
Sets the upper limit value and turns monitoring on/off.

Remote command:
- `CALCulate<[1]..8>:LIMit:UPPer[:DATA]` on page 230
- `CALCulate<[1]..8>:LIMit:UPPer:STATe` on page 230

### xx.xxxx dBm / Lower
Sets the lower limit value and turns monitoring on/off.

Remote command:
- `CALCulate<[1]..8>:LIMit:LOWer[:DATA]` on page 228
- `CALCulate<[1]..8>:LIMit:LOWer:STATe` on page 229

### Warning Beep
Activates an acoustic alarm which is output if a limit has been exceeded.

Remote command:
- `CALCulate<[1]..8>:LIMit:BEEP` on page 227

### 4.4.6 Resetting auxiliary information

For each window, the R&S NRP2 continuously saves data that is required for displaying the extreme values and statistical values. These values can be reset any time.

To reset the auxiliary values press the lowest softkey in the "Measurement" menu.

**Aux Val Reset**
Restarts the search for extreme values and statistical evaluation (if activated in the "Auxiliaries" dialog box).

Remote command:
- `CALCulate<[1]..8>:EXTRemes:RESet` on page 226
4.5 Displaying traces

Many sensors allow you to graphically display the envelope power versus time, and some also allow you to display the amplitude distribution as CCDF, CDF or PDF.

Two waveforms or two amplitude distribution functions can be shown in the same diagram. A waveform may either be a representation of absolute envelope power for one channel over time or the ratio of the envelope powers of two channels over time.

4.5.1 Basic settings for trace display

The trace display can be quickly selected after a preset.

1. Connect a sensor to the R&S NRP2 (any channel). The sensor must support trace measurements (true for all sensors except for the R&S NRP-Z9x, R&S NRP-Z5x, and R&S NRP-Z27/-Z37 sensors)

2. Apply a pulsed signal to the sensor. The amplitude of the signal has to be sufficient for reliable triggering.

3. Perform a preset (PRESET hardkey)

4. Select "Mode" in the "Sensor" menu.

5. Select "Trace & Statistics".
   The trace window opens.
6. Only for R&S NRP-Z8x wideband power sensors and if a time resolution beyond the sample period is required:
   Enable automatic activation of "Equivalent Time Sampling".

7. Close the "Mode" dialog (MENU key).
   The trace window displays the waveform and the measurement results.

If the trace display is not visible check the trigger settings, see chapter 4.2.6, "Trigger settings", on page 85.

4.5.2 Trace window

A trace measurement is displayed graphically, either in full height or in a half height window.

In half height window the meter shows the waveform(s) and an info panel indicating selected measurement results or instrument settings. Control elements to directly change the settings are not available.

Fig. 4-44: Trace window, half height display
In full height window, the R&S NRP2 provides additional control elements such as trigger, marker or scale-setting parameters in the control panel on the right of the screen. At the bottom of the screen, info panels indicate measurement results or instrument settings.

![Trace window, full height window with control elements](Image)

Fig. 4-45: Trace window, full height window with control elements

The trace control panel covers various functions and parameters to configure the trace measurement result. It changes according to the specific display mode.

By default, the meter displays the "Trace" display mode with the corresponding control panel. Further display modes are set via the "Display" softkey.

**Display**

Opens the control panel for selecting the measurement mode for trace display.

See the following sections for more information:

- "Trace" shows the trace display mode and the corresponding control panel, on page 115.
- "Gates" Gates display mode, on page 120
- "Marker" Marker display mode, on page 124
- "Pulse" Pulse display mode, on page 126
- "T'Slots" T'Slots display mode, on page 131
- "Stat's" Stat's display mode, on page 135

### 4.5.3 Trace display mode

In the "Trace" mode, you can make all the settings that determine the position and the size of the screen window, the type of display ("Peak", "Max Hold" etc.), "Trig"gering and "Filt"ering.

- Select "Trace" in the control panel opened via the Window →Graph→ "Display" panel ("Trace&Statistics" sensor mode).
4.5.3.1 Controls in trace display mode

**Display**
Selects another view, see chapter 4.5.2, "Trace window", on page 114.

**Config Grid...**
Opens the subdialog box for configuring the diagram, see chapter 4.5.3.2, "Trace diagram settings", on page 117.

**Pos Scale**
Defines if the cursor keys position or scale the waveform.

- **"Pos"** The cursor keys shift the waveform in horizontal and vertical direction
- **"Scale"** The cursor keys expand and compress the waveform. When the horizontal scaling is modified, the points (pixels) at the left of the screen remain unchanged. When the vertical scaling is modified, the neutral zone depends on the unit selected: the points in the center of the screen remain unchanged when dBm, dB and dBµV are used. The points at the bottom of the screen remain unchanged in all other displays.

**Auto**
Selects a vertical scaling that suits the waveform.

**Trig...**
Opens the "Trigger" dialog box. For description refer to chapter 4.2.6, "Trigger settings", on page 85.

**Filt...**
Opens the "Filter" dialog box, see chapter 4.5.3.3, "Filtering settings", on page 118.
Trace Func ...
Opens the "Trace Function" subdialog, see chapter 4.5.3.4, "Trace function settings", on page 119. One or two waveforms can be selected for display. Each waveform represents either the absolute envelope power of one measurement channel over time or it represents the ratio of the envelope power of two channels over time. The selected function and display type is indicated below.

If a (dimensionless) power ratio is selected for graphic display in "Trace" mode, the same vertical scaling as with an absolute power display is shown. Simply skip the 'm' of dBm (with a log scaling) to interpret the vertical axis in dB or skip the 'W' (with a linear scaling) to interpret the vertical axis in terms of dimensionless numbers.

4.5.3.2 Trace diagram settings

Config Grid opens the subdialog to determine the position and the size of the screen window. In addition, the dialog box allows to enter a power reference value.

► Select "Config Grid..." in the control panel opened via the 'Window'→'Graph'→'Display'→"Trace" control panel ("Trace&Statistics" sensor mode).

![Config Grid in Trace display mode](image)

**Ref. Power**
Sets the reference value. The reference value is assigned to the top line of the grid.

**Power / div**
Sets the vertical scaling .

The combination of "Ref. Power" and "Power /div" defines the vertical orientation of the trace.

**Start Time**
Defines the position of the left screen edge relative to the delayed trigger.

The value may be negative so that signal components are displayed before the trigger event.

Remote command:

```
[SENSe<1..4>:TRACe:OFFSet:TIME
```
on page 292

**Time div**
Sets the time resolution of the results window.
Unit
Sets the result unit.

4.5.3.3 Filtering settings

You can smooth the trace in the "Average" display by means of an averaging filter. For this purpose, a number of sweeps are recorded and the power of points of the same position in time is averaged ("Trace Averaging"). The averaging process substantially improves zero offset and linearity of the measurement result.

In the "Peak" display, a maximum search is performed over the number of curves corresponding to the averaging number. If signals of stochastic envelope are applied, filtering may increase the measurement accuracy. The fluctuations of results caused by the inherent noise of the sensor will also be reduced, but this is unfavorable for a higher systematic deviation (measured values are too high). Remedy: Reduce the video bandwidth (see below).

The averaging filter does not affect the "Random" display.

To prevent results from being falsified due to instable trigger conditions, you should always check whether the trace is stable in its time axis. This should be done without averaging ("Trace Avg No = 1").

To meet the requirements for higher reproducibility and accuracy of numeric results, measured power values for gates can be averaged even more by "Numeric Averaging", irrespective of "Trace Averaging".

The measurement accuracy for the peak power, in particular for low power levels, can be increased by reducing the effect of the inherent noise. You can do this by using a smaller channel bandwidth ("Video Bw"). For the R&S NRP-Z8x wideband power sensors, this can be done in several steps between 300 kHz and 30 MHz (FULL). Reducing the video bandwidth also increases the trigger sensitivity. As a rule of thumb, the trigger threshold ("Level") can be reduced by 3 dB if the video bandwidth is reduced by a factor of 4.

The video bandwidth must never be smaller than the RF bandwidth of the signal.

► Select "Filt..." in the trace control panel opened via the Window→Graph→"Display" dialog box ("Trace&Statistics" sensor mode).
Gate Avg No
Selects the averaging number for averaging the gated measurement results.

Trace Avg No
Selects the averaging number for averaging the traces.
Remote command:
[SENSe<1..4>]:TRACe:AVERage:COUNt on page 284

Video BW
Selects the video filter bandwidth. This setting is available in the R&S NRP-Z8x wideband power sensors, otherwise it is fixed.
Available values are "Full", "5 MHz", "1.5 MHz", and "300 kHz".
Remote command:
[SENSe<1..4>]:BANDwidth:VIDeo on page 266

4.5.3.4 Trace function settings
The trace function settings are performed in the Window→Graph→"Display"→"Trace"→"Trace Function" dialog box ("Trace&Statistics" sensor mode).

Fig. 4-48: Filter dialog box in Trace display mode

A | B | C | D
Tabs for selecting the sensor.

Note: In remote-control commands, select the sensor with the suffix in command
SENSe<1..4>:..., i.e. choose suffix 1 for channel A, channel 2 for B, and so on.

Fig. 4-49: Trace function displaying traces
Trace 1 / 2
Selects the trace (waveform) to be configured.
Up to two traces can be selected. This is also true if only one measurement channel (sensor) is present. In this case, one trace for example can represent the average envelope power and the other trace the peak or random power (available for the R&S NRP-Z8x wideband sensors only).

Function
Selects the measurement function for the "Trace" mode. Only "Single" and "Ratio" functions are available for trace measurements. Refer to "Function" on page 100 for description.

Note: It is essential that the sensors of both channels support trace measurement, if the "Ratio" function is selected.

Prim. / Sec. Channel
Selects the primary and secondary channel.

Eval.
Select the type of display. Since each display point (pixel) represents a time interval and thus usually many samples, the R&S NRP-Z8x wideband power sensors allow you to select what is to be displayed.

"Average" Average power value, resulting in a flicker-free display and smooth trace.

**Note:** Average is fixed for all multipath power sensors.

"Random" Power of a randomly selected sample, i.e. a realistic display with signal details.

"Peak" Highest power measured (peak power).

Max. Hold
Displays the highest value measured for each point (pixel) of the selected display type ("Average", "Random ", "Peak").

"On / Off" Starts/stops "Max Hold".

"Reset" Resets the display and restarts recording.

4.5.4 Gates display mode
In the "Gate" mode, four separately configurable gates for signal evaluation are available. The active gate is indicated in the window, the info panel shows the measurement results and borders for this gate and the selected trace (waveform) . The settings for "Trig"gering, "Filt"ering, "Function", and "Unit" are taken from the "Trace" display mode and cannot be changed.

► Select "Gates" in the control panel opened via the Window→Graph→"Display" dialog box ("Trace&Statistics" sensor mode).
Fig. 4-50: Gates display mode

Gate = channel; measurement function; display type
Average = average power within gate
Peak = peak power within gate
Peak / Avg = peak power / average power (ratio) within gate
1 | 2 = limits of the active gate (start and stop time)
Δt = length of the active gate

The currently active gate is indicated in the info panel and marked by colored lines, as shown in the graph above.

"Select Trace" defines for which trace the parameters are indicated in the info panel, see graph below.

Table 4-8: Gates display mode with two traces

Gate measurement is performed for trace B ("Select Trace" = "Bav")
Gate measurement is performed for both traces ("Select Trace" = "B/A"), the ratio is indicated.

Note, that the power of each trace is averaged over the gate length before the power ratio of the two traces is calculated.

The start of the gate ("[1][2]") relates to the delayed trigger event (= 0s, white line).

The four available gates are common for all displayed waveforms. Individual gates for specific channels (sensors) can only be configured in numeric "T"gateAv" mode.

SCPI commands:

Select sensor function:

\[
\text{[SENSe[1]..4]:FUNCTION[ :ON]} \quad \text{on page 269}
\]
Define calculation of measurement result:

```
CALCulate<[1]..8>:FEED<[1]|2> on page 226
```

Read result:

```
FETCh? on page 211
```

### 4.5.4.1 Measurement results

The measured values for the selected gate and trace (waveform) are indicated in the info panel below the graph (see also "Select Trace ..." on page 123).

**Average / Peak / Peak/Avg**

Average power, peak power and the ratio peak power to average power.

- "1 | 2"  
  Start and stop time of gate.

- "Δt"  
  Duration of gate.

Remote command:

Configuring measurement:

```
CALCulate<[1]..8>:FEED<[1]|2> on page 226
```

Retrieving results:

```
FETCh? on page 211
```

### 4.5.4.2 Controls in gates display mode

**Display**

Selects another view, see chapter 4.5.2, "Trace window", on page 114.

**Config Gates ...**

Open the subdialog to configure the four available gates, see chapter 4.5.4.3, "Gate diagram settings", on page 123.

**Pos Scale**

Defines if the cursor keys position or scale the waveform.

- "Pos"  
  The cursor keys shift the waveform in horizontal and vertical direction.

- "Scale"  
  The cursor keys expand and compress the waveform. When the horizontal scaling is modified, the points (pixels) at the left of the screen remain unchanged. When the vertical scaling is modified, the neutral zone depends on the unit selected: the points in the center of the screen remain unchanged when dBm, dB and dBµV are used. The points at the bottom of the screen remain unchanged in all other displays.

**[1] [2] [3] [4]**

Switches the function of the cursor keys to altering the borders of a gate.

- "[1] [2]"  
  Shifts the start and stop time.
Sets the fence, provided "Fence" has been activated in the "Config Gates" dialog box, see chapter 4.5.4.3, "Gate diagram settings", on page 123. This setting applies to R&S NRP-Z8x wideband power sensors only.

**Gate**

Selects a gate. The gate is displayed graphically and the measurement results for the gate are shown in the info panel.

**Select Trace ...**

Switches between the traces to be evaluated for gate measurement.

### 4.5.4.3 Gate diagram settings

Select "Gates Config..." in the dialog box opened via the Window→Graph→"Display"→"Gates" control panel ("Trace&Statistics" sensor mode).

Configure the four available gates in the "Gates Config" dialog box.

![Gates Config dialog box](image)

**Fence**

Activates the "Fence" function.

---

The four available gates are common for all displayed waveforms. Individual gates for specific channels (sensors) can only be configured in numeric "TgateAV" mode.

**Gate**

Selects the gate to be configured.

**Note:** In remote-control, the gate to be configured is selected by the TGATe suffix.

**Start / Length of Gate**

Entry of start time and length of the gate.

Remote command:

[SENSE<1..4>][:POWer]:TGATe<1..4>:TIME on page 276

[SENSE<1..4>][:POWer]:TGATe<1..4>:OFFSET:TIME on page 275
Within the measurement period, a "fence", i.e. an exclusion interval, can be set. The fence is defined by its start time and its length. The start time refers to the start of the gate.

In contrast to the numeric "T\text{gateAv}" mode, the definition of fences in the "Gate" mode is not restricted to the wideband power sensors of the R&S NRP-Z8x series. Instead, all power sensors are supported that can be operated in "Trace" mode.

**Start / Length of Fence**

Sets the start time and the length of the fence.

Remote command:

```
[SENSe<1..4>:POWer]:TGATe<1..4>:EXCLude]:MID:TIME
```
on page 275

```
[SENSe<1..4>:POWer]:TGATe<1..4>:EXCLude]:MID:OFFSet[:TIME]
```
on page 274

### 4.5.5 Marker display mode

In the "Marker" mode you can display two markers in addition to the trace(s). The power/power ratio at the marker positions is displayed together with the marker time. The markers can be positioned automatically to measure the maximum and minimum power of the waveform(s). The settings for "Trig"gering, "Filt"ering, "Function", and "Unit" are taken from the "Trace" display mode and cannot be changed.

Markers are indicated by red arrows, see figure below.

- Select "Marker" in the control panel opened via the Window→Graph→"Display" dialog box ("Trace&Statistics" sensor mode).

![Fig. 4-52: Marker display mode](image)

(1st line) = measurement function, display type

- ▼ = position of first marker and associated power/power ratio
- ▲ = position of second marker and associated power/power ratio
- ▼-▲ = time spacing and power ratio of the two markers

**Note:** The marker positions ▼ and ▲ relate to the delayed trigger event.
4.5.5.1 Controls in Marker display mode

Display
Selects another view, see chapter 4.5.2, "Trace window", on page 114.

Config Marker...
Opens the subdialog to manually define the marker positions, see chapter 4.5.5.2, "Marker diagram settings", on page 125.

Pos Scale
Defines if the cursor keys position or scale the waveform.
- "Pos" The cursor keys shift the waveform in horizontal and vertical direction
- "Scale" The cursor keys expand and compress the waveform. When the horizontal scaling is modified, the points (pixels) at the left of the screen remain unchanged. When the vertical scaling is modified, the neutral zone depends on the unit selected: the points in the center of the screen remain unchanged when dBm, dB and dBµV are used. The points at the bottom of the screen remain unchanged in all other displays.

▼ / ▲
Defines the active marker which can be positioned by means of the cursor keys.

(Max/Min marker position)
Sets the two markers to the extreme values of the selected trace each time the key is pressed. If two traces are active, pressing the left side of the softkey selects trace 1 and pressing the right side select trace 2.

Trace Func...
Opens the "Trace Function" dialog box, see chapter 4.5.3.4, "Trace function settings", on page 119.

4.5.5.2 Marker diagram settings

Open the "Marker Config" dialog box open via the Window→Graph→"Display"→"Marker" control panel ("Trace&Statistics" sensor mode).
Marker Config

Marker1 Pos (▼) / Marker2 Pos (▲)
Defines the positions of marker 1 and 2. The positions are referenced to the delayed trigger event.

4.5.6 Pulse display mode

The R&S NRP2 performs automatic analysis of pulsed signals (with wideband power sensor R&S NRP-Z-Z8x only). The measurement is either performed over the visible portion of the trace (entire screen width), or within the active gate of the selected trace (waveform). The measurement results are shown in the info panel at the bottom of the screen. The settings for "Triggering, "Filtering, "Function", and "Unit" are taken from the "Trace" display mode and cannot be changed.

► Select "Pulse" in the control panel opened via the Window → Graph → "Display" dialog box ("Trace&Statistics" sensor mode).

Table 4-9: Legend of info panel:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>pulse width</td>
<td></td>
</tr>
<tr>
<td>positive overshoot</td>
<td></td>
</tr>
<tr>
<td>duty cycle</td>
<td></td>
</tr>
<tr>
<td>pulse top power</td>
<td></td>
</tr>
<tr>
<td>rise time</td>
<td></td>
</tr>
</tbody>
</table>
An active gate is indicated by colored lines, as shown in the graph.

The info panel in the pulse trace diagram indicates up to 6 parameters. The values to be indicated can be selected in the "Pulse Measurements" dialog box, see chapter 4.5.6.2, "Pulse diagram settings", on page 128. For a complete list of pulse symbols see table 3-2 Symbols for pulse parameters, page 59.

Fig. 4-55: Definition of the pulse analysis parameters

4.5.6.1 Controls in Pulse display mode

Display
Selects another view, see chapter 4.5.2, "Trace window", on page 114.

Config Pulse...
Opens the subdialog to configure the pulse analysis and to select the power/time parameters for the info panel display, see chapter 4.5.6.2, "Pulse diagram settings", on page 128.

Pos Scale
Defines if the cursor keys position or scale the waveform.

"Pos" The cursor keys shift the waveform in horizontal and vertical direction

"Scale" The cursor keys expand and compress the waveform. When the horizontal scaling is modified, the points (pixels) at the left of the screen remain unchanged. When the vertical scaling is modified, the neutral zone depends on the unit selected: the points in the center of the screen remain unchanged when dBm, dB and dBµV are used. The points at the bottom of the screen remain unchanged in all other displays.
Auto
Selects a vertical scaling that is suitable for the signal.

Gate
Selects if the pulse analysis is performed for the visible trace or within the selected gate.

- “[1] [2] 3 [4]” Pulse analysis is performed within the selected gate.
- “Trace” Pulse analysis is performed for the visible trace (entire screen width).

Select Trace
Switches between the traces available for pulse analysis (available only for waveforms representing absolute power of a wideband power sensor (R&S NRP-Z8x series)).

4.5.6.2 Pulse diagram settings

- Set the parameters of pulse analysis in the "Config Pulse..." dialog box opened via the Window→Graph→"Display"→"Pulse" control panel ("Trace&Statistics" sensor mode).

The R&S NRP2 indicates the total number of the activated parameters in the header of the dialog box. You can activate up to 6 items out of 15 for display.

As a prerequisite of pulse analysis, the parameters selected for display must be included in the analysis window. If for example the duty cycle of a pulsed signal is to be determined, at least one cycle of the waveform must be within the borders of the selected gate or must be part of the visible portion of the trace (if pulse analysis extends over the whole trace). If the analysis window contains several cycles, evaluation always applies to the first cycle.

Pulse Measurements / Time

The pulse time parameters to be displayed in the info panel are selected on the "Time" tab.

- "Pulse Width" Indication of pulse duration.
- "Pulse Period" Indication of the time the pulse signal needs to complete one cycle.
- "Duty Cycle" Indication of the duty cycle of the measured power.
"Pulse Off Time"  Indication of the gap between two pulses.

"Rise / Fall Time"  Indication of the times the signal requires to change from the power off to power on state.

"Start / Stop Time"  Indication of the start / stop point of the first power pulse within the analysis window, i.e. the time when the signal passes through the medial reference power level with rising or falling edge, referenced to the delayed trigger event.

**Pulse Measurements / Power**

<table>
<thead>
<tr>
<th>Parameter</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Top / Base Power&quot;</td>
</tr>
<tr>
<td>&quot;Average (1 period)&quot;</td>
</tr>
<tr>
<td>&quot;Max (Peak)&quot;</td>
</tr>
<tr>
<td>&quot;Minimum&quot;</td>
</tr>
<tr>
<td>&quot;Pos. / Neg. Overshoot&quot;</td>
</tr>
</tbody>
</table>

**Fig. 4-57: Pulse Measurements / Power tab**

The pulse power parameters to be displayed in the info panel are selected on the "Power" tab.

"Top / Base Power"  Indication of the power of the pulse top / base, defined in the Pulse Measurements / Config tab.

"Average (1 period)"  Indication of the average power of the signal. The visible trace length must exceed one cycle of the waveform. The gate length is arbitrary.

"Max (Peak)"  Indication of the maximum power measured within the analysis window.

"Minimum"  Indication of the minimum power measured within the analysis window.

"Pos. / Neg. Overshoot"  Indicates the relative amount of positive / negative overshoot. The indicates value depends on the "Related to" (Power / Voltage) setting in the pulse measurement "Config" menu.

**Pulse Measurements / Config**

<table>
<thead>
<tr>
<th>Parameter</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;High Ref. 90%&quot;</td>
</tr>
<tr>
<td>&quot;Reference 50%&quot;</td>
</tr>
<tr>
<td>&quot;Low Ref. 10%&quot;</td>
</tr>
</tbody>
</table>

**Fig. 4-58: Pulse Measurements / Config tab**
The "Config" tab contains the threshold parameters to define the high, mid and low reference levels which are used to determine the pulse timing. All values are specified in percent of the pulse amplitude, either expressed in terms of power (Watt) or voltage (Volt).

"Low Ref." The "Low Ref." level defines the start of the rising edge and the end of the falling edge of the pulse, needed for measurement of the rise / fall time.

"High Ref." The "High Ref." level defines the end of the rising edge and the start of the falling edge of the pulse, needed for measurement of the rise / fall time.

"Reference" This reference level is used to define the pulse width, pulse start time and pulse stop time.

"Ref's related to" Selects how the threshold parameters are to be interpreted, either voltage related or power related. Changing from a power based definition to a voltage based definition and vice versa affects the analysis, because different points of the waveform are analyzed.

The following table gives the % settings related to power and the dB figures if the same results are to be obtained as with a typical 10/50/90 definition in terms of voltage. The log values are shown for comparison only.

<table>
<thead>
<tr>
<th>Reference Level</th>
<th>Voltage related (%V)</th>
<th>Power related (%W)</th>
<th>Log. scale (dB)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low Ref.</td>
<td>10</td>
<td>1</td>
<td>-20</td>
</tr>
<tr>
<td>Ref.</td>
<td>50</td>
<td>25</td>
<td>-6</td>
</tr>
<tr>
<td>High Ref.</td>
<td>90</td>
<td>81</td>
<td>-0.9</td>
</tr>
</tbody>
</table>

The voltage related definition represents the normal case for analyzing the pulse parameters.
"Algorithm" Selects the analysis algorithm for detecting the pulse top and the pulse base power of a pulsed signal. From these two power levels the reference levels are derived.

- "Histogram" Computes the pulse top/base power by analyzing the histogram of the trace data. The pulse top level is taken on the mean value of all points representing the pulse top. Similarly the pulse base is determined from the points representing the pulse base.

  **Note:** This algorithm is recommended for analyzing most of the pulse signals

- "Integration" Computes the pulse top power by fitting a rectangle pulse of same energy into the pulse signal as a reference.

  **Note:** This algorithm is recommended for pulse signals with modulation or when the pulse energy must be taken into account, e.g. when comparing the measurement result with that of a thermal power sensor.

- "Peak" Assigns the pulse peak power to the pulse top level.

"Set to defaults" Presets all parameters in the "Pulse Measurement / Config tab" (10% / 50% / 90%, power related).

### 4.5.7 Timeslot display mode

The timeslot structure can be defined and displayed in this mode. You can additionally select one timeslot and measure the most important power parameters of the displayed waveform within this timeslot. The settings for "Trig"gering, "Filt"ering, "Func"tion", and "Unit" are taken from the "Trace" display mode and cannot be changed.

▶ Select "T'Slots" in the control panel opened via the Window→Graph→"Display" dialog box ("Trace&Statistics" sensor mode).

**Fig. 4-59: T'Slot display mode**

- **Slot** = channel, measurement function, display type
- **Average** = average power within the selected timeslot
- **Peak** = peak power within the selected timeslot
- **Peak/Avg** = peak power / average power (ratio) within the selected timeslot
Time slots are marked by dotted lines. The period of the currently selected time slot over which the signal is averaged is marked by a colored frame with a continuous lines. If exclude times have been set this period is shorter than the nominal time slot width.

The defined time slot structure is common for all displayed waveforms. Individual time slot structures for specific channels (sensors) can only be configured in numeric "T'slotAV" mode.

**Tips for power measurement in timeslots**

- Load mobile radio standard (chapter 4.6.4, "Loading settings for mobile radio standards", on page 142) or enter the parameters of the timeslot structure in the "Config T'Slots" menu.
- Set screen so that the envelope of a complete frame is displayed.
- Open "Trigger" dialog box and set "Delay" so that the timeslot structure coincides with the measured envelope.
- To increase the measurement accuracy,
  - expand the window horizontally to such an extent that the selected timeslot is displayed in adequate size
  - perform measurement in the numeric "Timeslot Av" mode. This mode operates with precisely the time resolution available from the sensor (sample period). In the graphic mode the time resolution is determined by the width of a point (pixel).

**SCPI commands:**

Select sensor function:

```
[SENSe<[1]..4>]:FUNCTION[:ON] on page 269
```

Define calculation of measurement result:

```
CALCulate<[1]..8>:FEED<[1]|2> on page 226
```

Read result:

```
FETCH? on page 211
```

**4.5.7.1 Measurement results**

The measured values for the selected time slot and trace (waveform) are indicated in the info panel below the graph.
Average / Peak / Peak/Avg
Average power, peak power and the ratio peak power to average power.

Remote command:
Configuring measurement:
CALCulate<[1]..8>:FEED<[1]|2> on page 226
Retrieving results:
FETCh? on page 211

4.5.7.2 Controls in T'Slot display mode

Display
Selects another view, see chapter 4.5.2, "Trace window", on page 114.

Config T'slots...
Opens the subdialog "Timeslot Config" to configure the timeslot structure, see chapter 4.5.7.3, "T'Slot diagram settings", on page 134.

See also chapter 4.2.1.4, "Measuring the average power of TDMA signals", on page 68, which describes the measurement of the average power of a TDMA signal.

Pos Scale
Defines if the cursor keys position or scale the waveform.

"Pos" The cursor keys shift the waveform in horizontal and vertical direction
"Scale" The cursor keys expand and compress the waveform. When the horizontal scaling is modified, the points (pixels) at the left of the screen remain unchanged. When the vertical scaling is modified, the neutral zone depends on the unit selected: the points in the center of the screen remain unchanged when dBm, dB and dBµV are used. The points at the bottom of the screen remain unchanged in all other displays.

Trigger
Opens the "Trigger" dialog box. For description refer to chapter 4.2.6, "Trigger settings", on page 85.

Slot
Selects a timeslot for which the power values in the info panel are displayed.

Trace Func ...
Opens the "Trace Function" subdialog, see chapter 4.5.3.4, "Trace function settings", on page 119.
4.5.7.3 T'Slot diagram settings

Configure timeslot measurement in the “Timeslot Config” dialog box which is opened via the Window→Graph→"Display"→"T'slot" control panel (“Trace&Statistics” sensor mode).

![Timeslot Config dialog box](image)

**No of Timeslots**
Defines the number of subsequent timeslots within a frame, i.e. a period of the signal.
Remote command: \[SENSe<\{1\}..4>[:POWer]:TSLot:COUNt\] on page 277

**Nominal Width**
Defines the length of a timeslot.

**Example:**
If measurements are performed on TDMA signals (GSM/EDGE, PDC, NADC, PHS etc), the nominal timeslot length must be entered here, i.e. the frame length divided by the number of timeslots.

**Table 4-10: GSM signal**

<table>
<thead>
<tr>
<th>Frame length</th>
<th>4.615 ms</th>
</tr>
</thead>
<tbody>
<tr>
<td>No. timeslots:</td>
<td>8</td>
</tr>
<tr>
<td>⇒ Nominal width:</td>
<td>4.615 / 8 ms = 576.875 μs</td>
</tr>
</tbody>
</table>

Remote command: \[SENSe<\{1\}..4>[:POWer]:TSLot:[AVG]:WIDTh\] on page 278

**Excluded from Start / End**
Defines the intervals at the start or end of the timeslot which are excluded from the measurement. Measurement can thus be restricted to the relevant part of a timeslot.
Remote command: \[SENSe<\{1\}..4>[:TIMing]:EXCLude:STARt\] on page 283
\[SENSe<\{1\}..4>[:TIMing]:EXCLude:STOP\] on page 283

**Fence**
Activates the "Fence" function.
Within the measurement period, a "fence", i.e. an exclusion interval, can be set. The fence is defined by its start time and its length.

In contrast to the numeric "T'slotAv" mode, the definition of fences in the "T'slot" mode is not restricted to the wideband power sensors of the R&S NRP-Z8x series. Instead, all power sensors are supported that can be operated in "Trace" mode.

**Start / Length of Fence**

Sets the start time and length of the fence. The start time refers to the start of the time-slot

Remote command:

```
[SENSe<[1]..4>][:POWer]:TSLot[:EXCLude]:MID:OFFSet[:TIME]
on page 277
```

```
[SENSe<[1]..4>][:POWer]:TSLot[:EXCLude]:MID:TIME on page 277
```

### 4.5.8 Statistics display mode

The R&S NRP-Z8x wideband power sensors allow you to statistically analyze the envelope power as CCDF, CDF or PDF. The measurement either covers one of the four gates or, if not synchronized with the signal, a user-selectable time interval. The measurement is repeated until the desired number of samples is attained. You can set the video bandwidth in the "Trace" display mode to reduce noise.

Two traces can be indicated in the same measurement window. The second trace - either from a second sensor or from an internal AWGN (Additional White Gaussian Noise) source - can be used as reference trace. For CCDF and CDF, the graphical display can be supplemented by a tabular indication of the statistic values.

► Select "Stat's" in the control panel opened via the Window→Graph→"Display" dialog box ("Trace&Statistics" sensor mode).

![Fig. 4-61: Statistics display mode with one trace](image-url)
Fig. 4-62: Statistics display mode with two traces (AWGN)

From the gathered samples, four parameters for each trace are indicated in the info panel:
- the peak power
- the average power
- the measurement result at the position of the power (x) marker
- the power value related to the result (y) marker

In case of AWGN only the measurement result at the position of the power (x) marker is indicated.

Only in the case of a non-synchronized acquisition interval ("Cont" mode), the indicated average power value relates to the complete signal. Otherwise, the average power within the selected gate is indicated.

4.5.8.1 Controls in statistics display mode

Display
Selects another view, see chapter 4.5.2, "Trace window", on page 114.

Config Grid...
Activates the additional tabular display of values or opens the subdialog to configure the diagram and to numerically set the marker positions, see chapter 4.5.8.2, "Statistics diagram settings", on page 137.

Pos Scale
Defines if the the cursor keys position or scale the displayed curve(s).

Note: There are restrictions on the use of these controls. The vertical scale ranges from 0% to 100% maximum for all statistic functions except for PDF. Similar restrictions apply to the horizontal axis, depending on the power range of the sensors.

"Pos" The cursor keys shift the curve(s) in horizontal and vertical direction
"Scale" The cursor keys expand and compress the curve(s).

(marker)
Selects a marker for positioning by means of the cursor keys.
the power (x) marker is positioned to a power value; the associated value of the distribution (distribution density) function is measured.

the result (y) marker is positioned to a measured value of the distribution (distribution density) function; the associated power value is indicated.

If there are several power values that coincide with the set value of the distribution (distribution density) function, the result marker can be positioned to the wanted value using the left/right cursor keys.

**Gate / Cont**

Defines the acquisition interval. Four gates and an unsynchronized time interval "Cont" can be selected. The selected acquisition interval is highlighted in the softkey display. Moreover, if a gate is selected, its number is enlarged.

"[1] [2] 3 [4]" Select one of four provided gates.

"Cont" Select the unsynchronized time interval.

**Note:** The length of the time interval can be set in the Aperture dialog box of the “Stat's function” dialog.

**Auto**

Scales the result and the power axis in such a way that the trace is optimally displayed.

**Statistic Functions**

Opens the "Statistics Functions" subdialog for selection of a distribution function and one or two traces for display. A statistical evaluation of combined results from different channels, e.g. power ratios, is not supported.

### 4.5.8.2 Statistics diagram settings

Activate indication of additional values or open menu for configuration of the statistics display in the "Stat's Config" dialog box, including markers.

**Activating tabular indication of statistical values for CDF and CCDF**

- Select "Stat's Config..." in the control panel opened via the Window→Graph→"Display"→"Stat's" → control panel ("Trace&Statistics" sensor mode).
The table always indicates the logarithmic values independent of the settings for the graph.

**Configuring the statistics display**

- Select "Stat's Config..." in the control panel opened via the Window→Graph→"Display"→"Stat's"→ control panel ("Trace&Statistics" sensor mode).

**Stat's Config / Scale**

- **Max. Power** ← Stat's Config / Scale
  Enters the maximum value of the power scale as reference.

- **Power / div** ← Stat's Config / Scale
  Defines the scaling of the power axis.

- **Y Start** ← Stat's Config / Scale
  Enters the start value of the Y axis. Depending on the distribution function only a restricted range of value or no entry at all is allowed.

- **Y Division** ← Stat's Config / Scale
  Defines the scaling of the Y axis.
Note: Start and division values of the Y axis (probability) are fixed in logarithmic displays and can not be modified (relating to CDF or CCDF functions). You can modify the y axis in linear displays (CDF, CCDF, PDF). Unit of the CCDF / CDF is %, while the PDF function is dimensionless.

Stat's Config / Marker

The "Marker" tab covers two markers, one for each axis. It enables you to numerically position the markers.

X Marker ← Stat's Config / Marker
Defines the position of the power marker in dBm or in dB; dB is used in the case of a normalized X axis.

Y Marker ← Stat's Config / Marker
Defines the position of the result marker in % ("CDF", "CCDF") or dimensionless ("PDF").

4.5.8.3 Statistic function settings

Set the function of the statistics measurement in the "Stat's Function" dialog box.

- Select "Stat's Func..." in the control panel opened via the Window→Graph→"Display"→"Stat's" control panel ("Trace&Statistics" sensor mode).

Fig. 4-66: Stat's Function dialog box
Statistics evaluation function

**Note:** A linear (lin) or logarithmic (log) scale is available for "CCDF" and "CDF". The "PDF" can only be displayed linearly.

"CCDF"  **Complementary Cumulative Distribution Function.** Displays the probability of the envelope power being higher than the corresponding X axis power value.

"CDF"  **Cumulative Distribution Function.** Displays the probability of the envelope power being lower than the corresponding X axis power value.

"PDF"  **Probability Density Function.** Displays a normalized distribution density of the envelope power. The measurement result is dimensionless and – in contrast to a non-normalized "PDF" – is independent of the magnitude of the average power value (Av). Integrating the normalized "PDF" over power provides the average power value (Av).

Remote command:

```
[SENSe<[1]..4>]:FUNCtion[:ON] on page 269
```

**Absolute X-Scaling**

Scales the X axis in terms of absolute power (dBm) if activated

Normalizes the X axis with respect to average power (dB) if deactivated.

**Trace 1 / 2**

Selects tab "Trace 1" or "Trace 2" to configure the statistic measurement for the 1st or 2nd trace.

An internal AWGN source is available for the second trace, thus providing a standard signal reference.

**Channel**

Selects the channel for the respective trace. A statistical evaluation of combined results from different channels, e.g. power ratios, is not supported.

**Aperture**

Sets the length of the acquisition interval with unsynchronized acquisition ("Cont", see "Gate / Cont" on page 137).

In addition to, and independent of, the setting of the aperture time for the measurement of an average power value (Av) (chapter 4.2.1.2, "Continuous average-power measurements", on page 66 ), you can use this parameter to set the length of the unsynchronized time interval for the statistical analysis of the signal.

Remote command:

```
[SENSe<[1]..4>]:STATistics:TIME on page 283
```

**Samples**

Enters the required minimum number of samples.
If the acquired number of samples within a gate or a time interval defined by "Aperture" is less than the required minimum number of samples, then this gate or time interval is repeated until the minimum number of samples is attained.

Remote command:
[SENSe<[1]..4>]:STATistics:SAMPles[:MINimum] on page 281

4.6 Management of settings

The general settings are performed in the File menu.

- Default settings, on page 141
- Loading user-defined settings, on page 142
- Saving user-defined settings, on page 141
- Loading settings for mobile radio standards, on page 142
- Programming aids, on page 144
- Assigning names to windows, on page 144

4.6.1 Default setting

The "Preset" softkey in the "File" menu and the (PRE)SET hardkey change the R&S NRP2 to its default setting.

After "Preset", the sensors operate in "Cont Av" mode with sensor-specific aperture time.

4.6.2 Storing user-defined settings

The R&S NRP2 provides 19 memory spaces in which complete device settings can be stored (Setup memory). Settings can be stored by using the "Save Setup" dialog box of the "File" menu. The memory spaces can be labeled with a name for identification.

![Save Setup dialog box](image)

Select setting
Selects a memory space.
Setup Name
Names or renames the selected memory space. A letter panel opens after pressing the associated softkey.

Remote command:
MEMory:STATe:MAP on page 252

Save
Saves the current settings under the selected name. After the settings are stored successfully, the dialog box closes automatically.
Former settings saved in this memory space are overwritten.
Another way to save the settings and close the dialog box is to press the ↵MENU key.
Remote command:
*SAV on page 204

4.6.3 Loading user-defined settings

The "Recall Setup" dialog box in the "File" menu is used to load stored settings.

Fig. 4-68: Recall Setup dialog box

Select setting
Selects a setting.

Recall
Loads the selected setting. After the settings are loaded successfully, the dialog box closes automatically.
The same effect can be achieved by pressing the ↵MENU key.
Remote command:
*RCL on page 198

4.6.4 Loading settings for mobile radio standards

Predefined settings for the most common mobile radio standards can be loaded in the "Recall Standard" dialog box of the "File" menu for quick configuration of the different measurement modes. The name of the set standard appears in the title bar of all open windows and is treated like any other window name (chapter 4.6.6, "Assigning names
to windows", on page 144). The name can therefore be changed and deleted as desired, but above all it is not automatically deleted when one of the preset parameters is changed and the instrument setting no longer corresponds to the loaded standard.

A table of sensor parameter values for the different standards can be found in chapter A.3, "Standard Configurations", on page 368.

<table>
<thead>
<tr>
<th>Recall Standard</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bluetooth DH5</td>
</tr>
<tr>
<td>Preserve Window Settings</td>
</tr>
<tr>
<td>External Trigger</td>
</tr>
<tr>
<td>Recall</td>
</tr>
</tbody>
</table>

*Fig. 4-69: Recall Standard dialog box*

**(Select standard setting)**
Selects a mobile radio standard.
Remote command:

SYSTem:STANdard:CATalog? on page 327
SYSTem:STANdard:PRESet on page 327

**Preserve Window Settings**
If enabled, the measurement windows are not reconfigured.
Remote command:

SYSTem:STANdard:PWSettings on page 327

**External Trigger**
If enabled, an external trigger is required. If disabled, the internal trigger is used.
External triggering should be selected if the test signal yields no clearly defined or only an unstable trigger event.

**Note:** If external triggering is used in the timeslot mode, make sure that the trigger delay setting is such that the start of the first timeslot coincides with the delayed trigger, see also chapter 4.2.6, "Trigger settings", on page 85.
Remote command:

SYSTem:STANdard:TRIGger:SOURce on page 327

**Recall**
Loads the selected standard settings.
The same effect can be achieved by pressing the →MENU key.
Remote command:

SYSTem:STANdard:PRESet on page 327
4.6.5 Programming aids

If you are developing remote control programs, you can display the contents of the SCPI error queue in the "Error List" dialog box of the "File" menu. In addition to the error, the command line that triggered the error is displayed, along with a question mark highlighted in black at the point where the command interpreter detected the error.

![Error List dialog box](image)

Fig. 4-70: Error List dialog box

The dialog box can be left permanently open, its contents are continuously updated. If the device is already in the remote state, the menu bar is replaced and the error list can be opened with the topmost softkey.

DEL

If the "Error List" is open, the error queue of the R&S NRP2 can be deleted by pressing the DEL/1TRIG hardkey.

Remote command:

`DISPlay:ERRorlist` on page 239

To activate extended error messages:

`SYSTem:ERRor:EXTended[:STATe]` on page 323

4.6.6 Assigning names to windows

Each display window is automatically labeled with a number (1, 2, 3, 4). In addition, you can enter a name for each window to indicate the type of measurement result. This is particularly recommended for settings to be stored in a setup memory. The "Window Name" dialog box in the "File" menu is used to assign names to windows.
4.7 System settings

System settings are configured in the "System" menu.

The menu provides access to the following settings:

- Configuring the remote control interfaces, on page 145
- Setting analog outputs, on page 151
- Power Reference, on page 158
- System information, on page 158
- Miscellaneous, on page 160
- Test measurement, on page 161

4.7.1 Configuring the remote control interfaces

The R&S NRP2 provides different interfaces for remote control. The settings are configured in the "Remote Interfaces" dialog box.
In addition, the R&S NRP2 supports command sets of power meters from other manufacturers. Thus, it is possible for example, to conveniently replace a power meter by the R&S NRP2.

**Overview of the remote control interfaces**

The following table gives a detailed overview on the supported interfaces.

<table>
<thead>
<tr>
<th>Interface</th>
<th>Protocols, VISA(^1) address string</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>GPIB (IEC/IEEE Bus Interface)</td>
<td>VISA(^1) address string:</td>
<td>The GPIB bus interface according to standard IEC 625.1/IEEE 488.1 is located at the rear panel of the instrument.</td>
</tr>
<tr>
<td></td>
<td>GPIB::primary address[::INSTR]</td>
<td>Define the address in the GPIB dialog box, described in chapter 4.7.1.2, &quot;GPIB settings&quot;, on page 148.</td>
</tr>
<tr>
<td></td>
<td>(no secondary address)</td>
<td>For a description of the interface refer to chapter A.2.1, &quot;GPIB Bus Interface&quot;, on page 355.</td>
</tr>
<tr>
<td>USB</td>
<td>VISA(^1) address string:</td>
<td>The instrument provides a USB connector at the rear panel.</td>
</tr>
<tr>
<td></td>
<td>USB::&lt;vendor ID&gt;::&lt;product ID&gt;::&lt;serial number&gt;[::INSTR]</td>
<td>Refer to chapter 4.7.1.3, &quot;USB settings&quot;, on page 148.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For a description of the interface refer to chapter A.2.4, &quot;USB interface&quot;, on page 386.</td>
</tr>
<tr>
<td>Local Area Network (LAN)</td>
<td>VXI-11</td>
<td>A LAN connector is located at the rear panel of the instrument.</td>
</tr>
<tr>
<td></td>
<td>VISA(^1) address string:</td>
<td>The interface is based on TCP/IP and supports VXI-11 protocol, see chapter 4.7.1.4, &quot;VXI11 settings&quot;, on page 149 for setting the IP address.</td>
</tr>
<tr>
<td></td>
<td>TCPPIP::&lt;LAN device name&gt;::[::INSTR]</td>
<td>For description of the interface refer to chapter A.2.2.1, &quot;VXI11 protocol&quot;, on page 358.</td>
</tr>
<tr>
<td>Local Area Network (LAN)</td>
<td>Ethernet, socket communication (e.g.Raw Ethernet, simple telnet)</td>
<td>A LAN connector is located at the rear panel of the instrument.</td>
</tr>
<tr>
<td></td>
<td>VISA(^1) address string:</td>
<td>The interface is based on TCP/IP and supports Ethernet, socket communication, see chapter 4.7.1.5, &quot;Raw Ethernet (socket communication) settings&quot;, on page 150 for setting the IP address.</td>
</tr>
<tr>
<td></td>
<td>TCPPIP::&lt;LAN device name&gt;::[::INSTR]</td>
<td>For description of the interface refer to chapter A.2.2.2, &quot;Connection setup&quot;, on page 359.</td>
</tr>
</tbody>
</table>

\(^1\) VISA is a standardized software interface library providing input and output functions to communicate with instruments. A VISA installation on the controller is a prerequisite for remote control over USB or LAN when using VXI-11 protocol. However, no VISA installation is necessary to remote control while using Ethernet (socket communication), see also chapter A.2.2.2, "Connection setup", on page 359.

### 4.7.1.1 Selecting the remote control interface

This section describes the configuration of the remote control interfaces.

For information on how to set up a remote control connection via the different interfaces, see chapter 5.2, "Connecting a Controller to the Base Unit", on page 170.

For background information on the interfaces, see chapter A.2, "Remote control interfaces", on page 354.
Remote Interfaces

Select one of the available remote control interfaces or turn them off.

"Off" Deactivates all remote control interfaces.

"GPIB" Activates the GPIB interface for remote control via the IEC 625/IEEE 488 bus. See chapter 4.7.1.2, "GPIB settings", on page 148 for the addressing.

"USB" Activates the USB interface for remote control, see chapter 4.7.1.3, "USB settings", on page 148.

"VXI11" Activates remote control via Ethernet using VXI-11 protocol, see chapter 4.7.1.4, "VXI11 settings", on page 149 for information in detail.

"Ethernet" Activates remote control via "Ethernet" using socket communication, see chapter 4.7.1.5, "Raw Ethernet (socket communication) settings", on page 150.

Command Set

Selects the instrument type whose remote command set is emulated by the R&S NRP2.

Note: The number of supported emulations is limited with the current firmware version (V07.01).

Fig. 4-73: List of instruments emulated by the R&S NRP2

The available instrument types are listed. This feature allows to replace a power meter by an R&S NRP2 in existing test setups. Refer to Application Note 1G83 at the download area of the product site on the Internet for details and up-to-date information (http://www.rohde-schwarz.com/product/nrp2.html).
4.7.1.2 GPIB settings

For configuring the R&S NRP2 for remote control using the GPIB interface, just enter its GPIB address.

**GPIB Address**
Selects the address in the range 0 to 30 (factory preset is 20). The set GPIB address is unchanged after a reset of the instrument settings.

Remote command:
`SYSTem:COMMunicate:GPIB[:SELF]:ADDResS` on page 320

**Command Set**
Selects the instrument type for emulation, see "Command Set" on page 147.

4.7.1.3 USB settings

Remote control of the R&S NRP2 via the USB is performed according to the USBTMC standard. For this purpose, a VISA library that supports remote control via the USB is required by the remote-control computer.

**VISA Resource Identifier**
Displays the VISA address string of the instrument. This identifier is automatically assigned for remote control via USB, therefore the address cannot be configured for remote control.
Command Set
Select the instrument type for emulation, see "Command Set" on page 147.

4.7.1.4 VXI11 settings

For remote control according to the VXI-11 standard, the R&S NRP2 is equipped with an RJ45 connector at its rear panel. Due to the complexity of the protocol, it is recommended that you use a VISA library that supports VXI-11.

**Fig. 4-76: Remote Interfaces / VXI11**

**IP Address (Manual / DHCP)**
Shows the IP address and indicates whether it is assigned manually or automatically. Set the address in the IP Config dialog box.

**IP Config**
Assigns the IP address either manually or automatically.

**Manual ← IP Config**
Sets address, mask and gateway.

**Fig. 4-77: IP Config dialog box / Manual**

For the manual configuration mode, the static IP address, subnet mask, and default gateway are used to configure the LAN. Obtain the IP address and subnet mask for the R&S NRP2 and the IP address for the local default gateway from your network administrator.

If the network consists only of the R&S NRP2 and the control computer, the two units can be connected with each other directly using a special network crossover cable. The IP addresses can be selected according to the following table:
Table 4-12: Example of a network configuration for a direct R&S NRP2 – PC connection using a crossover cable.

<table>
<thead>
<tr>
<th></th>
<th>R&amp;S NRP2</th>
<th>PC</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;IP Address&quot;</td>
<td>192.168.0.2</td>
<td>192.168.0.1</td>
</tr>
<tr>
<td>&quot;Mask&quot;</td>
<td>255.255.255.0</td>
<td>255.255.255.0</td>
</tr>
<tr>
<td>&quot;Gateway&quot;</td>
<td>192.168.0.3</td>
<td>192.168.0.3</td>
</tr>
</tbody>
</table>

DHCP → IP Config

Fig. 4-78: IP Config dialog box / DHCP

Note: For automatic assignment, a DHCP server must be available in the network. If the R&S NRP2 is to be integrated into a larger network, contact your network administrator regarding the data to be set.

The instrument assigns address and gateway automatically. The automatic configuration mode uses DHCP server to obtain the instrument IP address.

Command Set

Selects the instrument type for emulation, see "Command Set" on page 147.

4.7.1.5 Raw Ethernet (socket communication) settings

An alternative way for remote control of the software is to establish a simple network communication using sockets. The socket communication, also referred as “Raw Ethernet communication”, does not require a VISA installation on the remote controller side.

The simplest way to establish socket communication is to use the build-in telnet program. The telnet program is part of every operating system and supports a communication with the software on a command-by-command basis. For better utilization and to enable automation by means of programs, user defined sockets can be programmed.

Socket connections are established on a specially defined port. The socket address is a combination of the IP address or the host name of the instrument and the number of the port configured for remote-control. The R&S NRP2 uses port number 4002 for this purpose. The port is configured for communication on a command-to-command basis and for remote control from a program.

For a description on how to set up the connection for remote control, see chapter 5.2, "Connecting a Controller to the Base Unit", on page 170.
If the R&S NRP2 is to be integrated into a larger network, contact your network administrator regarding the data to be set.

![Remote Interfaces dialog box](image)

**IEEE Mode**
Selects the level of standardization of the IEEE bus interface. The R&S NRP2 supports all versions of "IEEE 488.0, *.1 and *.2".

**IP Address (Manual / DHCP)**
Shows the IP address and indicates whether it is assigned manually or automatically. Set the address in the "IP Config" dialog box.

**IP Config...**
Opens the subdialog for configuring the IP address, see "IP Address (Manual / DHCP)" on page 149.

**PortNo**
Inserts the port number configured for remote-control.

**Command Set**
Selects the instrument type for emulation, see "Command Set" on page 147.

### 4.7.2 Setting the analog outputs and the trigger input

There are two multifunction BNC connectors at the rear of the R&S NRP2 (TRIG IN / OUT2 and OUT1 / TRIG OUT). They can be used as either trigger input or trigger output, or as analog output. If used as analog output they either output a signal that is proportional to the measured value or a TTL signal for threshold monitoring. The functions of these connectors are specified in the "I/O" dialog box.

► To open the "I/O" dialog box, select "I/O..." in the "System" menu.
For background information on the analog outputs see chapter 4.7.2.3, "Voltage at the analog outputs", on page 157.

4.7.2.1 Out1 interface

This section describes the functions of the analog signal output at the "OUT1 / TRIG OUT" connector and their settings.

**Mode**
Selects the function of the "OUT1 / TRIG OUT" connector. "Analog", "Pass/Fail", "Trig-Out" and "Off" are available.

**Note:** For remote control, only suffix 1 or no suffix is allowed in the command header for the setting the OUT 1 / TRIG OUT connector functions.

**Analog → Mode**
The output provides an analog voltage which is proportional to the value displayed in the selected window, e.g. "Window 1".
Remote command:  
OUTPut:RECorder<[1]..2>[ :STATe] on page 258

Window 1 2 3 4 ← Analog ← Mode  
Selects the window the output refers to.  
Only windows that are operated in "Dig" or "D&A" window mode are available for selection. See chapter 4.3.3.3, "Selecting the result display mode", on page 93 for the setting the display mode.

Remote command:  
OUTPut:RECorder<[1]..2>:FEED on page 255  
OUTPut:TTL:FEED on page 259

0 V Equivalent - Analog ← Analog ← Mode  
Enter the measurement value that corresponds to the output voltage of 0 V.

Remote command:  
OUTPut:RECorder<[1]..2>:LIMit:LOWer on page 256  
OUTPut:RECorder<[1]..2>:LIMit:LOWer:POWer on page 256  
OUTPut:RECorder<[1]..2>:LIMit:LOWer:RATio on page 256

3 V Equivalent - Analog ← Analog ← Mode  
Enter the measurement value that corresponds to the output voltage of 3 V.

Remote command:  
OUTPut:RECorder<[1]..2>:LIMit:UPPer on page 257  
OUTPut:RECorder<[1]..2>:LIMit:UPPer:POWer on page 257  
OUTPut:RECorder<[1]..2>:LIMit:UPPer:RATio on page 257

Pass/Fail ← Mode  
The output provides a logic signal in the selected window to indicate that a limit value has been exceeded.
Remote command: 

\texttt{OUTPut:TTL[:STATe]} on page 260

\textbf{Window 1 2 3 4 ← Pass/Fail ← Mode}

Selects the window the output refers to.

Only windows that are operated in "Dig" or "D&A" window mode are available for selection. See \textit{chapter 4.3.3.3, "Selecting the result display mode"}, on page 93 for the setting the display mode.

Remote command:

\texttt{OUTPut:RECorder<[1]..2]:FEED} on page 255
\texttt{OUTPut:TTL:FEED} on page 259

\textbf{Pass ← Pass/Fail ← Mode}

Sets the logic output level for measurement results within the set limits. The value range is 0 V to 3.3 V.

Remote command:

The setting is achieved by a combination of the following commands. The example is for \texttt{OUTPut:TTL:FAIL} set to \texttt{HIGH}.

\texttt{OUTPut:TTL:FAIL} on page 258
\texttt{OUTPut:TTL:HVOLtage} on page 259
\texttt{OUTPut:TTL:ACTive} on page 258

\textbf{Fail ← Pass/Fail ← Mode}

Sets the logic output level for limit violation of measurement results. The value range is 0 V to 3.3 V.

Remote command:

The setting is achieved by a combination of the following commands. The example is for \texttt{OUTPut:TTL:FAIL} set to \texttt{HIGH}.

\texttt{OUTPut:TTL:FAIL} on page 258
\texttt{OUTPut:TTL:LVOLtage} on page 259
\texttt{OUTPut:TTL:ACTive} on page 258

\textbf{TrigOut ← Mode}

The output provides a logic signal, which represents the state of the internal trigger bus.
The trigger signal is either supplied by one of the connected sensors, i.e. the trigger master, or via the "TRIG IN / OUT2" socket, see chapter 4.2.6, "Trigger settings", on page 85.

Use the signal for example to synchronize externally connected instruments.

Remote command:

```
OUTPut:TRIGger[:STATe] on page 260
```

**Off ← Mode**

Deactivates port "OUT1 / TRIG OUT".

Remote command:

```
Both states have to be set OFF.

OUTPut:RECorder<[1]..2>[:STATe] on page 258
OUTPut:TTL[:STATe] on page 260
```

### 4.7.2.2 I/O 2 interface

This section describes the functions and settings of the analog trigger input / analog output at the "TRIG IN / OUT2" connector.
Mode
Selects the function of the TRIG IN / OUT2 connector. "Analog Out" and "Trigger In" are available.

Note: For remote control, only suffix 2 is allowed in the command header for the setting the TRIG IN / OUT2 connector functions.

Analog Out ← Mode
The output provides an analog voltage, which is proportional to the value displayed in the selected window, e.g. "Window 1".

Remote command:
The state must be set to ON.

\[ \text{OUTPut:RECorder<[1,2]>[:STATe]} \]
on page 258

Window 1 2 3 4 ← Analog Out ← Mode
Selects the window the output refers to.

Only windows that are operated in "Dig" or "D&A" window mode are available for selection. See chapter 4.3.3.3, "Selecting the result display mode", on page 93 for the setting the display mode.

Remote command:

\[ \text{OUTPut:RECorder<[1..2]>:FEED} \]
on page 255
**0 V Equivalent - Analog ← Analog Out ← Mode**
Entry of the measurement value that corresponds to the output voltage of 0 V.

Remote command:
- OUTPut:RECorder<[1]..2>:LIMit:LOWer on page 256
- OUTPut:RECorder<[1]..2>:LIMit:LOWer:POWer on page 256
- OUTPut:RECorder<[1]..2>:LIMit:LOWer:RATio on page 256

**3 V Equivalent - Analog ← Analog Out ← Mode**
Entry of the measurement value that corresponds to the output voltage of 3 V.

Remote command:
- OUTPut:RECorder<[1]..2>:LIMit:UPPer on page 257
- OUTPut:RECorder<[1]..2>:LIMit:UPPer:POWer on page 257
- OUTPut:RECorder<[1]..2>:LIMit:UPPer:RATio on page 257

**Trigger In ← Mode**
The connector is used as input. An external trigger signal can be applied.

![Fig. 4-88: I/O 2 mode / Trigger In](image)

Use the external trigger signal, e.g. to start the measurement in all sensors simultaneously. Provided the R&S NRP2 is configured accordingly, it passes the signal directly through to the sensors. Refer to chapter 4.2.6, "Trigger settings", on page 85 for information on the respective settings.

Remote command:
The state must be set to OFF.
- OUTPut:RECorder<[1]..2>[:STATe] on page 258

### 4.7.2.3 Voltage at the analog outputs

The voltage at the analog outputs does not track the power fed to the sensor continuously but rather at discrete points of time. Every time the sensor has transmitted a new measured value to the base unit, i.e. after an acquisition has been completed (chapter 4.2.3, "Filter / averaging", on page 79), the analog output voltage is adjusted to the new value.

In the ContAv mode, you can influence the rate at which the voltage is updated by setting the aperture time to a convenient value, see chapter 4.2.1.2, "Continuous average-power measurements", on page 66. The time between two updates of the output voltage is approximately twice the length of the aperture time. The lower limit of this length...
of time, during which the R&S NRP2 can still regularly update the output voltage, depends on the number of sensors connected and their measurement modes. With one sensor connected, operated in the ContAv mode, it is about 1 ms.

Switching on the averaging filter does not affect the refresh rate, but the speed at which the output voltage changes can be expected to slow down as a result of the filter effect.

For applications having high requirements on the dynamic behavior of the analog outputs, for example leveling loops, it is advisable to freeze the screen of the R&S NRP2 to avoid interruptions caused by writing to the display memory (chapter 4.7.5, "Miscellaneous", on page 160).

4.7.3 Sensor Check Source

The Sensor Check Source, option R&S NRP-B1/-B7, supplies an accurate 1 mW test signal at 50 MHz. Option R&S NRP-B7 comes with an additional pulse mode of the test signal with a modulation frequency of 10 kHz. It can arbitrarily be switched on and off or be used in course of automatic test measurements, see chapter 4.7.6, "Test measurements", on page 161.

- The signal is activated in the "System" menu.

![Fig. 4-89: Power Ref Selection for R&S NRP-B1 (left) and R&S NRP-B7 (right)]

Power Ref

Switches on/off the sensor check source.

Remote command:

OUTPut:ROSCillator[:STATe] on page 258

4.7.4 System information

This section describes how you retrieve information on the instrument like part number, serial number, firmware version, etc. and installed options, as well as on connected power sensors.
4.7.4.1 Information on sensors

► Select "Sensor Info..." in the "System" menu.

![Sensor info dialog](image)

Note: In remote-control commands, select the sensor with the suffix in command
`SENSe<1..4>:...`, i.e. choose suffix 1 for channel A, channel 2 for B, and so on.

(Sensor info)
The sensor info dialog shows the information on the selected sensor.

Remote command:
`SYSTem:SENSor<1..4>:INFO?` on page 326

4.7.4.2 Information on the R&S NRP2

► Select "System Info..." in the "System" menu.

![System info dialog](image)

(System info)
The system info dialog displays information concerning hardware and firmware of your R&S NRP2.
Remote command:
SYSTem:INFO? on page 322

4.7.5 Miscellaneous

The "Misc" dialog box covers useful parameters for manual measurements, such as the display update rate or acoustic alarms.

► Select "Misc..." in the "System" menu.

Fig. 4-92: Miscellaneous dialog box
Limit warnings may be configured separately for each window. Therefore, the checkbox "Limit Warning" may show a grayed checkmark, if the settings differ for different windows.

**Beep - Overload**
Activates an acoustic feedback when the sensor is overloaded (overload condition, see chapter 4.8, "Messages and alarms", on page 166).
Remote command:
`SYSTem:BEEPer:NOTify:OVERload` on page 319

**Beep - Key Click**
Activates an acoustic alarm to indicate when a key is pressed.
Remote command:
`SYSTem:BEEPer:NOTify:KEY` on page 320

**Beep - Limit Warning**
Activates an acoustic alarm when there is a violation of user-defined limits.
Activation applies to all windows. If a warning beep in conjunction with a violation of user-defined limits is not desired, it can explicitly and exclusively for any window be switched off in the limits dialog, see chapter 4.4.5, "Limit Monitoring", on page 111.

**Display Update**
Selects the display refresh rate.
At very low ambient temperatures, the display becomes sluggish. To improve readability under these circumstances, you can reduce the display update rate.

"Normal" standard display update rate.
"Slow" preferred setting rate at very low ambient temperatures.
"Frozen" for interruption-free update of analog outputs, see chapter 4.7.2.3, "Voltage at the analog outputs", on page 157. The meter indicates "frozen" in the info line of the results window.

Remote command:
`DISPlay:UPDate` on page 241

**Brightness**
Set the display brightness.
Remote command:
`DISPlay:ILLumination` on page 239

### 4.7.6 Test measurements

Since the scope of testing is limited, test measurements cannot replace a regular recalibration of the sensor.
The "Test..." function offers tests for the internal circuitry of the sensor (selftest 1) as well as simple tests with applied RF (option R&S NRP-B1/-B7 required).

### 4.7.6.1 Internal sensor selftest

- Open the "Sensortest" dialog box in the "System"->"Test..." menu.

The first page of the "Sensortest" dialog box covers the settings for performing an internal selftest of the sensor without using the reference signal.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tabs for selecting the sensor.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong> In remote-control commands, select the sensor with the suffix in command <code>SENSe&lt;[1]..4&gt;:...</code>, i.e. choose suffix 1 for channel A, channel 2 for B, and so on.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Selftest internal (with no signal)**

- Starts a selftest of the sensor. A signal must not be applied.
- The instrument indicates the corresponding states to internal self-test directly in the menu:
  - "...not tested" (prior to testing)
  - "...running" (in progress)
  - "...successful" (outcome)
  - "...failed" (outcome)

**Test Report...**

- Opens the "Sensor Selftest Report" window displaying the results of the internal selftest.
- The status bar of the report window shows type and serial number of the tested sensor, and the overall test result. The results of the individual tests are indicated below.
4.7.6.2 Sensor test with applied RF

Testing the sensor with the RF reference signal requires option R&S NRP-B1/-B7, Sensor Check Source.

- Open the "Sensortest" dialog box in the "System"->"Test..." menu and select the second page.

This page of the "Sensortest" dialog box provides testing the sensors with the reference signal supplied by the R&S NRP-B1/-B7 test generator option.

In the case of sensors with a lead-in attenuator (pad) (R&S NRP-Z22, R&S NRP-Z23 and R&S NRP-Z24), the test measurement can be made with or without an attenuator. Since the power sensors of the R&S NRP-Z series are absolutely calibrated, a regular calibration measurement after switching on the instrument is not necessary and also not planned.

The outcome of the tests is not considered during subsequent measurements.

Test at Power Ref
Starts a test measurement for a sensor. The sensor must be connected to the sensor check source.

If an attenuator is present, it must first be removed.
This way, you can test all measurement paths of R&S NRP-Zxx multi-path sensors. Additionally you can test an attenuator in the "... with pad" setting.

During test procedure, the instrument indicates that the test is currently running.

![Sensor Test in progress...](image)

*Fig. 4-96: Sensor test running*

After completion, the instrument shows a results message.

![Sensor Test A successful](image)

*Fig. 4-97: Sensor test results message*

... with pad
Performs a test measurement for a sensor with an attached attenuator. The padded sensor must be connected to the sensor check source. With multipath sensors, only one path can be used for the measurement. For testing all paths, remove the attenuator, connect the sensor section alone and start the test by pressing "Test at Power Ref".

Report...
Opens the dialog box displaying the results of the test measurement.

The test report shows the type and the serial number of the tested sensor and the detailed test results.

When the dialog box opens, it shows the data of the sensor last tested. The measured values are lost when the R&S NRP2 is switched off.

![Sensor Test Report](image)

*Fig. 4-98: Sensor test report, page 1*

Page 1 shows the test results for the sensor section.
Page 2 shows the results with attached attenuator, if applicable. Differences up to 0.02 dB at room temperature are absolutely normal and are due to the uncertainty in the calibration of the sensor and the power reference. Greater differences can be caused by high/low ambient temperatures but also by a damage to the sensor.

With multipath power sensors (R&S NRP-Z11, R&S NRP-Z21/22/23/24/28, R&S NRP-Z31 and R&S NRP-Z91/92/98), the R&S NRP2 displays the test result of each individual path separately.

**Config...**
Open the dialog box for entering tolerance limits.

![Config Test dialog box](image)

Exceeding the tolerance limits will result in a test failure. The factory-set default settings depend on the sensor and are in line with the data sheet values. They are applicable in the entire ambient temperature range. If the base unit and the sensors are not used at temperature extremes, the tolerance limits can be restricted so that any damage to the sensor can be detected even more quickly.

**Test Limits ← Config...**
Defines the test limit range.

- "Sensor" Tolerance limits for the sensor section only.
- "Sensor & Pad" Tolerance limits for the combination of the sensor section with attached attenuator.

**Set to defaults ← Config...**
Resets the factory-set default settings.
Settings locked ← Config...
Protects the settings against being changed by mistake.

4.8 Messages and alarms

The R&S NRP2 displays a variety of different messages such as status messages, error messages, warnings or information on the screen, some in separate windows, or in the header.

4.8.1 Errors and warnings

Overload

Fig. 4-101: Error message / Overload

One or more sensors are subjected to overload.

NOTICE! Overload can destroy the sensor (depending on the amount of power and the duration of the overload condition).

The upper measurement limit is specified in the data sheet for the sensor and can be displayed in the "Sensor Info" dialog box, see chapter 4.7.4, "System information", on page 158.

An alarm sounds when the message is displayed. The alarm can be disabled in the "Misc" dialog box, see chapter 4.7.5, "Miscellaneous", on page 160.

Overrange

Fig. 4-102: Error message / Overrange

This message is displayed only if the "Auto" range function is off and the operating range of the set path has been exceeded (only with R&S NRP-Zxx multi-path sensors), see chapter 4.2.4, "Measurement ranges", on page 83.
Sample Error

The message indicates that samples were lost while sampling the signal. The measured value can thus be incorrect.

Trunc. Meas.

“Trunc. Meas.” is displayed in Burst Av mode, when there is an overflow of the sensor internal buffer for samples. Overflow occurs if a burst is too long. The measurement is aborted.

HW Error

A sensor has detected a hardware error.
4.8.2 Interactive messages

The R&S NRP2 provides a lot of interactive messages, as shown in the following example. Since the information is self-explanatory, these messages are not explicitly listed in this manual.

Automatic window initialization

[Fig. 4-106: Information / New Window]

If an additional sensor is connected to the R&S NRP2 during operation and if no currently open window displays the values measured in the channel concerned, the R&S NRP2 automatically offers to open a window and to configure it for measurements with the additional sensor connected.

The previous settings of the newly opened window are lost. To prevent this, we recommend you to cancel with the ESC key and to manually configure a window.
5 Remote Control Fundamentals

The Power Meter R&S NRP2 is equipped with various interfaces that can be connected to a controller for remote control.

- IEC/IEEE-bus interface (standard equipment) in line with the standards IEC 60625.1 (IEEE 488.1) and IEC 60625.2 (IEEE 488.2)
- Ethernet 10/100 BASE T interface.
- USB1.1 interface for remote control and firmware update.

Connectors are installed at the rear of the power meter. The interfaces support the SCPI (Standard Commands for Programmable Instruments) standard, version 1999.0 of May 1999. The SCPI standard is based on the IEEE 488.2 standard and defines a standardized command language for controlling measuring and test instruments with functions beyond the scope of the IEEE 488.2 standard. In addition to the commands, error handling and status management are also described.

The present chapter explains the differences between remote control and manual control, familiarizes the user with fundamentals of remote control and describes the status reporting system as well as the procedure for connecting a PC for remote control.

5.1 Differences between Remote Control and Manual Control

The manual control of the R&S NRP2 is designed for ergonomic operation. This means, among other things, that certain parameters are assigned default values that cannot be changed and that specific changes of device settings influence other settings. In the remote control mode, all settings can be changed and the user has to make sure that the device is correctly set for the measurement to be performed. We therefore recommend performing a reset (*RST on page 198 or SYSTem:PRESet on page 325) prior to a remote control measurement so that the device is placed in a defined state.

5.1.1 Display

In the remote mode, the display of measured values can be disabled (set SYSTem:SPEed to FAST); the display is cleared except for a status line at the top of the screen. Blanking of menu elements that need not be continually updated increases the data processing speed. The display can be reactivated by setting the SCPI command SYSTem:SPEed to NORM. The backlighting can also be completely switched off by setting command DISPlay:ILLumination to OFF, but this does not affect the speed.

In the remote mode, the menu line at the upper screen edge is blanked and replaced by the indication "Remote Mode". The R&S NRP2 is able to emulate different power meters with alternative command sets. The currently used command set is indicated in the middle of the status line. The SCPI error queue can be displayed using the topmost softkey (labeled "Error List..."). If the LLO character is displayed in the upper status
line, the keyboard including ESC/LOCAL has been disabled via the $\text{LLO}$ command. In this case, returning to local mode is only possible with the remote control command $\text{GTL}$ or by a power-on reset.

5.1.2 Measurement Modes

To simplify operation in the manual mode, preset values are used in some cases for the trigger system ($\text{TRIGger}$ command) and the timing of the measurement ($\text{SENSe[1..4]:TIMing:EXCLude:STARt and :STOP}$) when a measurement mode such as "ContAv", "Burst", "Timeslot" or "Trace" is selected, see table 5-3, Automatic settings for manual selection of a measurement mode. This is not the case in the remote control mode. Here the trigger system and the timing can be configured by the user as required.

5.1.3 Calculate Blocks

The R&S NRP2 manages 8 internal calculate blocks. Each calculate block has two input channels (primary and secondary channel) to which one of up to 4 power sensors can be assigned. The channels can be processed together by means of a selectable function. The result is available at the output of the calculate block. In the manual mode, the measurement results of the first four calculate blocks (chapter 6.5, "CALCu-late (Configuration of Calculate Blocks)", on page 224) are shown in windows 1 to 4, while 8 calculate blocks are available in the remote control mode.

5.2 Connecting a Controller to the Base Unit

5.2.1 Settings in Base Unit

Before a link can be established between the controller and the R&S NRP2, the R&S NRP2 must be assigned a corresponding address.

In the manual control mode, the address is set in the "System" > "Remote" dialog box, see chapter 4.7.1, "Configuring the remote control interfaces", on page 145.

In remote control mode, the $\text{SYSTem:COMMunication:..}$ commands serve this purpose.

**GPIB configuration (IEC/IEEE bus):**

1. Select "GPIB" as the active interface.
2. Enter the GPIB address. Any value between 0 and 30 is permissible.

**USB configuration:**

- Select "USB" as the active interface.
The "VISA address string" suitable for the instrument is displayed in the dialog box. The R&S NRP2 has a fixed, unchangeable address comprising the manufacturer number, an instrument number and the serial number of the instrument.

USB::<vendor ID>::<product ID>::<serial number>::INSTR

**VXI11 configuration:**
1. Select "VXI11" as the active interface.
2. Choose "Manual" or "DHCP" IP address configuration.
   If "DHCP" is chosen, IP address, subnet mask and gateway address are retrieved from a DHCP server. The DCHP server must be available in the network. No further steps are required.
3. If "Manual" is selected, enter the "IP address" assigned by the network administrator to the R&S NRP2.
   In large networks, specification of additional addresses may be required for link setup, e.g. gateway and subnet mask, which are known to the network administrator.

**Ethernet configuration:**
1. Select "Ethernet" as the active interface.
2. Choose "Manual" or "DHCP" IP address configuration.
   If "DHCP" is chosen, IP address, subnet mask and gateway address are retrieved from a DHCP server. The DCHP server must be available in the network. No further steps are required.
3. If "Manual" is selected, enter the "IP address" assigned by the network administrator to the R&S NRP2.
   In large networks, specification of additional addresses may be required for link setup, for example. gateway and subnet mask, which are known to the network administrator.
4. Enter the port address ("PortNo"). Incoming connections from a controller have to use this port number in order to establish a connection to the R&S NRP2.
5. Define the IEEE protocol mode. For example select "IEEE 488.0" mode in order to use raw socket communication. See also chapter A.2.3, "Ethernet Interface", on page 361.
5.2.2 Hardware Requirements

**NOTICE**

Risk of network failure
Before connecting the instrument to the network or configuring the network, consult your network administrator. Errors may affect the entire network.

**GPIB (IEC/IEEE bus)**
In order to remote control the R&S NRP2 via the GPIB bus, a controller with the respective bus interface and the bus cable is required.

**USB**
The R&S NRP2 automatically recognizes a controller connected to the USB1.1 interface.

**Ethernet/ VXI11**
Controlling the R&S NRP2 via the Ethernet interface requires a computer with network card and LAN cables to connect the computer and the R&S NRP2 controller with the Ethernet.

5.3 Switchover to Remote Control (REMOTE)

It is assumed that a link has been established between the controller and the R&S NRP2 has been correctly configured.

After power up, the R&S NRP2 is always in manual control mode "LOCAL". The R&S NRP2 switches to remote control irrespective of the selected interface as soon as it receives a SCPI command. All settings are maintained when the device switches to remote mode, except for the setting listed in table 5-1.

5.4 Return to Manual Operation (LOCAL)

In the remote mode, all front-panel controls are disabled, except for the ESC/LOCAL key and the topmost softkey. The softkey used to open the window with the SCPI error queue. The device remains in remote mode until it is switched back to manual control either by using the front panel ESC/LOCAL or with the remote control command GTL.
The remote control command `LLO` also allows the ESC/LOCAL key to be disabled. In this case, return to manual operation is only possible by remote control or by switching the R&S NRP2 off and on again (Power On Reset).

## 5.5 Automatic Settings when Switching between Local and Remote

The table below lists the settings automatically performed when switching between the remote and local modes.

**Table 5-1: Automatic Settings when switching between Local and Remote**

<table>
<thead>
<tr>
<th>Local to Remote</th>
<th>Remote to Local</th>
</tr>
</thead>
<tbody>
<tr>
<td>SENS:AVER:TCON REP</td>
<td>SENS:AVER:TCON MOV</td>
</tr>
<tr>
<td>-</td>
<td>ABORT:ALL</td>
</tr>
<tr>
<td>DISP:MESS OFF</td>
<td>INIT:ALL:CONT ON</td>
</tr>
<tr>
<td>-</td>
<td>DISP:MESS OFF</td>
</tr>
<tr>
<td>-</td>
<td></td>
</tr>
</tbody>
</table>

In each CALCulate block, where % is set as an output unit (UNIT:POWER:RATio DPCT), UNIT:POWER:RATio O is set.

In each CALCulate block, where % is set as an output unit (UNIT:POWER:RATio DPCT), UNIT:POWER:RATio O is set.

The automatic storage of the instrument settings is deactivated in the nonvolatile memory.

The automatic storage of the instrument settings is reactivated in the nonvolatile memory.

<table>
<thead>
<tr>
<th>Local to Remote</th>
<th>Remote to Local</th>
</tr>
</thead>
<tbody>
<tr>
<td>-</td>
<td>SYST:SPEED NORMal</td>
</tr>
<tr>
<td>-</td>
<td>SENS:BUFF:STAT OFF</td>
</tr>
<tr>
<td>-</td>
<td>SENS:AVER:STAT ON</td>
</tr>
<tr>
<td>-</td>
<td>SENS:TRACE:AVER:STAT ON</td>
</tr>
<tr>
<td>-</td>
<td>SENS:AVER:COUNT:AUTO OFF</td>
</tr>
<tr>
<td>ContAv:</td>
<td></td>
</tr>
<tr>
<td>TRIG:DEL 0</td>
<td>TRIG:DEL:AUTO OFF</td>
</tr>
<tr>
<td>TRIG:HOLD 0</td>
<td>TRIG:COUNt 1</td>
</tr>
<tr>
<td>TRIG:SOUR IMM</td>
<td>TRIG:ATR OFF</td>
</tr>
</tbody>
</table>

| Burst, timegate, timeslot and trace: | |
| TRIG:DEL:AUTO OFF | |
| TRIG:COUNt 1 | |
| TRIG:ATR OFF | |

## 5.6 Communication on Data Lines

The GPIB bus is the most common remote interface for measuring instruments. It has also been implemented in the R&S NRP2. The remote controller and the R&S NRP2
communicate by means of messages. The messages sent on the data lines (chapter A.2, "Remote control interfaces", on page 354) can be divided into two groups:

- Interface messages
- Device-dependent messages

5.6.1 Interface Messages

Interface messages are transmitted on the data lines of the IEC/IEEE bus when the ATN control line is active. Interface messages allow the controller and the instrument to communicate and can only be sent by a controller which serves as the IEC/IEEE-bus controller. Interface commands can be further classified as:

- common commands
- addressed commands

Common commands affect all devices connected to the IEC/IEEE bus without requiring an address, whereas addressed commands only affect devices addressed as a listener. The interface messages relevant for the instrument are described in chapter A.2.1.5, "Interface messages", on page 357.

5.6.2 Device-Dependent Messages (Commands and Responses)

Device-dependent messages are transmitted on the data lines of the IEC/IEEE bus when the ATN control line is not active. The ASCII code is used. Device-dependent messages are classified according to the direction in which they are sent:

5.6.2.1 Commands

Commands are messages sent by the controller to the R&S NRP2. They control the device functions and request information. The commands are classified according to the effect they have on the device:

- Setting commands
  trigger device settings, e.g. an device reset or a configuration of the trigger system.
- Queries
  cause device data to be provided in the output queue, where they can be fetched via the IEC/IEEE bus. Queries are available for most of the setting commands. They are obtained by adding a question mark to the setting command.

according to their definition in the IEEE 488.2 and SCPI 1999.0 standard:

- Common commands
  are precisely defined in the IEEE 488.2 standard in terms of function and notation. They relate to functions such as the management of standardized status registers, resetting and self test.
- Device-specific commands
  relate to functions that depend on device characteristics such as the frequency setting. Many of these commands are also standardized by the SCPI Consortium.
Parallelism

- Overlapping commands can be executed while another command is being executed.
- Sequential commands can only be executed when the execution of all other commands is completed.

In the R&S NRP2, only the remote control commands INIT:IMM and CAL:ZERO:AUTO ONCE can overlap with other commands.

5.6.2.2 Responses

Responses are messages sent by the device to the controller after a query. This may be measurement results, for instance, or device status information.

5.7 Structure and Syntax of device-dependent Messages

5.7.1 SCPI Standard

SCPI (Standard Commands for Programmable Instruments) describes a standardized command set for the programming of instruments regardless of the type of instrument or manufacturer. The objective of the SCPI Consortium is to standardize device-specific commands as far as possible. For this purpose, a device model has been developed which defines identical functions within a device or between different devices. Command systems have been created and assigned to these functions so that it is possible to address identical functions with the same commands. The command systems have an hierarchical structure. The SCPI command tree, figure 5-1 shows this tree structure, using details from the SENSe command system which selects the measurement to be performed by the device. Most of the other examples of command syntax and structure are taken from this command system. SCPI is based on the IEEE 488.2 standard, i.e. it uses the same syntax elements and the common commands defined in IEEE 488.2. The syntax of the responses is subjected to somewhat stricter rules than those specified by the IEEE 488.2 standard (chapter 5.7.4, "Responses to Queries", on page 179).

5.7.2 Command Structure

Commands consist of a header and usually one or several parameters. Header and parameters are separated by a white space (ASCII code 0 to 9, 11 to 32 decimal, e.g.
space). The headers may be composed of several keywords. The query is created by appending a question mark directly to the header.

### 5.7.2.1 Common Commands

Device-independent commands consist of a header preceded by an asterisk (*). The header may be followed by one or several parameters.

**Example:**

<table>
<thead>
<tr>
<th>Header</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>*RST</td>
<td>RESET</td>
</tr>
<tr>
<td>*ESE 253</td>
<td>EVENT STATUS ENABLE</td>
</tr>
<tr>
<td>*ESR?</td>
<td>EVENT STATUS QUERY</td>
</tr>
</tbody>
</table>

- \*RST: Resets the instrument.
- \*ESE 253: Sets the bits of the standard event status enable register.
- \*ESR?: Queries the contents of the standard event status register.

### 5.7.2.2 Device-specific Commands

**Hierarchy**

Device-specific commands have a hierarchical structure, see SCPI command tree, figure 5-1. The various levels are represented by compound headers. Headers at the highest level (root level) have one keyword only. This keyword describes an entire command system.

**Example:**

SENSe[1..4]

This keyword denotes the command system SENSe<n>.

For lower-level commands, the full path has to be specified, starting with the highest level in the left-most position. The individual keywords are separated by a colon ":".

Example:
SENSe[1..4]:TRACe:POINts <int_value>
This command is at the third level of the SENSe system and sets the number of test points for the Trace mode.

![Fig. 5-1: SCPI command tree](image)

Some keywords are used at several levels within a command system. Their effect depends on the command structure, i.e. on their position in the command header.

Example:
SENSe1:TRACe:POINts <int_value>
This command contains the POINts keyword in the third level.
SENSe1:TRACe:OFFSet:POINts <int_value>
This command contains the POINts keyword in the fourth level. It defines the time offset for the display of points in the Trace mode.

Optional keywords

In some command systems certain keywords can be inserted into or removed from the header. These keywords are shown in the manual in square brackets. For reasons of compatibility with the SCPI standard, the device must be able to recognize the full length of the command. Some of the commands become considerably shorter when the optional keywords are omitted.

Example:
[SSENSe:]POWer:TSLot:COUNt 6
This command sets for sensor 1 the number of timeslots in the Timeslot mode to 6. The following command has the same effect.
POWer:TSLot:COUNt 6

An optional keyword cannot be omitted if its effect is specified in more detail by a numeric suffix.
Example:
SENSe2:POWer:TSLot:COUNt 6
This command sets for sensor 2 the number of timeslots in the Timeslot mode to 6.
Keyword SENSe cannot be omitted.

Long and short form
The keywords have a long and a short form. The keyword may be entered in short or in
long form; other abbreviations are not allowed. The short form uses the first four char-
acters of the long form. If the fourth character is a vowel and the long form consists of
more than four characters, only the first three characters are used for the short form.
The short form is shown by upper-case characters, and the long form is the entire key-
word.
Upper case and lower case notation only serves to distinguish the two forms in the
manual, the instrument itself is case-insensitive.

Example:
STATus:QUEStionable:ENABle 1 and STAT:QUES:ENAB 1

Parameters
The parameter must be separated from the header by a white space. If a command
contains several parameters, they have to be separated by a comma (,). Some of the
commands allow the specification of the parameters MINimum, MAXimum and
DEFault. For a description of the parameter types chapter 5.7.5, "Parameters",
on page 180.

Example:
TIMing:EXCLude:STARt? MINimum
Response: 0
This query asks for the minimum setting value.

Numeric suffix
If a device has several identical functions or features, e.g. inputs, the desired function
can be selected by a suffix to the command. Commands without a suffix are interpre-
ted as having a suffix of 1.

Example:
SENSe2:FUNCtion "POWer:AVG"
This command sets the measurement mode of sensor 2 to the ContAv mode.

5.7.3 Structure of a Program Message
A program message may contain one or several commands. Several commands in a
program message are separated by a semicolon (;). If the next command belongs to a
different command system, the semicolon is followed by a colon. The colon stands for the root node of the command tree.

**Example:**

```
SYSTem:TIME 20,30,00;:SENSe:FUNCtion "POWer:AVG"
```

This program message contains two commands. The first command belongs to the SYSTem system and is used to set the time of the system clock. The second command belongs to the SENSe system and must be preceded by a colon. Otherwise confusion might be caused if the SYSTem tree also had a subordinate SENSe node. In this case, it would be possible to omit the introductory keyword SYSTem. (see the following explanation).

If the successive commands belong to the same system and therefore have one or several common levels, the program message may be abbreviated. The second command following the semicolon then starts at the level that is below the common levels. The colon after the semicolon must be omitted in this case.

**Example:**

```
SENSe2:TIMing:STARt 10; SENSe2:TIMing:STOP 10
```

This program message contains two commands separated by a semicolon. Both commands belong to the SENSe system and its TIMing subsystem, i.e. they have two common levels.

In the abbreviated program message the second command starts at the level below SENSe:TIMing. The colon after the semicolon has to be omitted.

The short form of the program message is:

```
SENSe2:TIMing:STARt 10; STOP 10
```

A new program message always starts with the full path however.

**Example:**

```
SENSe2:TIMing:STARt 10
SENSe2:TIMing:STOP 10
```

Processing of a program message is aborted if an error occurs. If only sensor 2 is connected to a multichannel device, for example, the program message

```
SENS1:FREQ 50 GHZ;:SENS2:FREQ 50 GHZ
```

will be aborted after the first command and a second frequency setting will not be performed.

### 5.7.4 Responses to Queries

Unless otherwise expressly specified, a query is defined for each command. The query is created by appending a question mark to the associated command.
Some of the SCPI rules for query responses are stricter than those of the IEEE 488.2 standard:

- The required value is sent without header.
  
  **Example:**
  
  `SENSe:AVERage:TCONTrol?`
  
  `Response: MOV`

- Maximum and minimum values as well as all other quantities queried by a special text parameter are returned as numeric values
  
  **Example:**
  
  `SENSe:POWer:TSLot:COUNt? MAXimum`
  
  `Response: 26`

- Numeric values are output without a unit. Physical quantities refer to the basic units or to the units set with the UNIT command.
  
  **Example:**
  
  `SENSe3:FREQuency?`
  
  `Response: 1.000000E06 (for 1 MHz)`

- Boolean values are returned as 0 (for OFF) and 1 (for ON).
  
  **Example:**
  
  `SYSTem:BEEPer:STATe?`
  
  `Response: 1`

- Character data is returned in short form (chapter 5.7.5, "Parameters", on page 180).
  
  **Example:**
  
  `UNIT2:POWer?`
  
  `Response: DBM`

### 5.7.5 Parameters

Most commands require the specification of a parameter. Parameters must be separated from the header by a white space. Parameters may be specified as numeric values, Boolean parameters, character data, strings or block data. The type of parameter required for the specific command as well as the permissible value range are described together with the commands.

#### Numeric values

Numeric values may be entered in any customary form, i.e. with sign, decimal point and exponent. If the values exceed the resolution of the device, they will be rounded off. Values between -9.9E37 and +9.9E37 can be entered. The exponent is denoted by "E" or "e". The exponent alone must not be used.

#### Units

Physical quantities may be stated with the unit. Permissible prefixes for the unit are G (Giga), M (Mega, MHZ is also allowed), K (kilo), m (milli), μ (micro) and n (nano). If no unit is specified, the basic unit will be used.
Example:

SENSe1:FREQuency 1.5 GHZ is equivalent to SENSe1:FREQuency 1.5E9

Some settings allow relative values to be stated in "One" and percent. According to SCPI, these units are represented by the strings O or DPCT.

The unit DPCT designates the deviation of a measurand from 100%. A power ratio of 95% thus corresponds to -5Δ%.

<table>
<thead>
<tr>
<th>Unit used in the R&amp;S NRP2</th>
<th>SCPI notation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Watt</td>
<td>W</td>
</tr>
<tr>
<td>dBm</td>
<td>DBM</td>
</tr>
<tr>
<td>dBµV</td>
<td>DBUV</td>
</tr>
<tr>
<td>dB</td>
<td>DB</td>
</tr>
<tr>
<td>1</td>
<td>O (as in One)</td>
</tr>
<tr>
<td>Δ%</td>
<td>DPCT</td>
</tr>
<tr>
<td>Hertz</td>
<td>HZ</td>
</tr>
<tr>
<td>Second</td>
<td>S</td>
</tr>
</tbody>
</table>

Special numeric values

The parameters MINimum, MAXimum, and DEFault are interpreted as special numeric values. The numeric value is returned in response to a query.

Example:

Command: SENSe2:POWer:APERture MAXimum
Query: SENSe2:POWer:APERture?
Response: 1.000000E02

<table>
<thead>
<tr>
<th>MIN/MAX</th>
<th>MINimum and MAXimum denote the minimum and maximum value.</th>
</tr>
</thead>
<tbody>
<tr>
<td>DEF</td>
<td>DEFault denotes a preset value. This value is identical to the basic setting called by the *RST command.</td>
</tr>
<tr>
<td>NAN</td>
<td>Not A Number (NAN) stands for 9.91E37. NAN is only sent as a device response. This value is not defined. NAN is typically returned for dividing by zero, subtracting a value from infinity and representing missing data.</td>
</tr>
</tbody>
</table>

Boolean parameters

Boolean parameters represent two states. The ON state (logical true) is represented by ON or a numeric value other than 0. The OFF state (logical false) is represented by OFF or the numeric value 0. Queries yield 0 or 1.
Example:
Command: SENSE:POWer:BUFFered ON
Query: SENSE:POWer:BUFFered?
Response: 1

Character data
Character data follows the syntax rules for keywords, i.e. it also has both a short and a long form. They must be separated from the header by a white space same as any parameter. A query returns the short form of the character data.

Example:
Command: SENSE2:AVERage:TCONTrol MOVing
Query: SENSE2:AVERage:TCONTrol?
Response: MOV

Strings
Strings must always be indicated in single or double quotes.

Example:
SENSe1:FUNCtion:ON "POWer:AVG" or
SENSe1:FUNCtion:ON 'POWer:AVG'

Block data
The block data format is suitable for the transmission of large data volumes. A command with a block data parameter has the following structure:

Example:
DISPlay:PIXMap?
Response: #49600xxxxxxxx.....

The ASCII character # denotes the beginning of the data block. The next numeral specifies the number of subsequent digits defining the length of the data block. In the example above, the four digits specify a length of 9600 bytes. The data bytes follow next. During transmission of these data bytes, all terminators and other control data are ignored.

Coupled commands
Setting one command influences the value of another command. According to SCPI 1999, this should be avoided but it makes sense when user-friendly high-level measurement commands are to be provided to configure an entire section of the device at once. The high-level commands CONFIGure, FETCH, READ and MEASure are therefore an exception to this rule.
5.8 Device Model and Command Processing

The device model shown in figure 5-2 was prepared from the point of view of the processing of remote control commands. The individual components operate independently of each other and simultaneously. They communicate with each other by means of messages.

![Device model for remote control](image)

**Fig. 5-2: Device model for remote control**

5.8.1 Input Unit

The input unit receives the commands in the form of characters from the remote control interface and collects them in the input buffer. The input unit sends a message to the command identification as soon as the input buffer is full or as soon as it receives a delimiter. The received data is processed in the parser (command identification).

5.8.2 Command Identification (Parser)

The parser analyzes the data received from the input unit. Data is processed in the sequence in which it was received. Syntax errors in the command are recognized and passed on to the status reporting system. Following the syntax test, the value range of the data is verified and the setting is adapted. Only after the command has been completely executed will the next command be processed.

5.8.3 Data Base and Device Hardware

The term "device hardware" refers to that part of the device which performs the measurement function.

The data base contains all parameters required for setting the device hardware. Setting commands cause a modification of the data set. Before the data is entered in the data set, it is verified for compatibility both with the other data and with the device hardware. If the setting is not possible, an error message will be sent to the status reporting system and the setting will be ignored. After successful completion of the verification, the setting will immediately be performed.

If the setting influences the result calculation, the **MEASuring** bit is set in the status operation register until new measured values are available. The **MEASuring** bit is described in more detail in the Status Reporting System section that follows. This bit may be used for the synchronization of command processing. Queries cause the data-set management to send the desired data to the output unit.
5.8.4 Status Reporting System

The status reporting system collects information on the device status and makes it available to the output unit on request. Structure and function of this system are described in the following section.

5.8.5 Output Unit

The data output unit collects the information requested by the controller from the data set management. It processes the information in line with the SCPI rules and makes it available in the output buffer.

5.8.6 Command Sequence and Command Synchronization

All commands are executed in the order in which they are sent. There is no overlapping of command processing. (Exception: the commands \texttt{INITiate and CALibrate:ZERO:AUTO ONCE}). The user therefore can determine the sequence of execution.

If a long program message is terminated by *OPC or *OPC?, the end of command processing is signalled to the controller, provided the controller has been adequately programmed (see following table 5-2 Synchronization with *OPC, *OPC? and *WAI).

Table 5-2: Synchronization with *OPC, *OPC? and *WAI

<table>
<thead>
<tr>
<th>Command</th>
<th>Effect</th>
<th>Programming of controller</th>
</tr>
</thead>
<tbody>
<tr>
<td>*OPC</td>
<td>Sets the Operation Complete bit in the ESR after all commands sent prior to *OPC have been processed.</td>
<td>Set bit 0 in the ESE of the R&amp;S NRP2.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Set bit 5 in the SRE of the R&amp;S NRP2.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Wait for service request (SRQ).</td>
</tr>
<tr>
<td>*OPC?</td>
<td>Writes 1 in the output buffer after all commands sent prior to *OPC? have been processed.</td>
<td>IEC/IEEE bus: the R&amp;S NRP2 is addressed as a talker.</td>
</tr>
<tr>
<td>*WAI</td>
<td>Commands can be sent but they are only executed after completion of all commands sent prior to *WAI.</td>
<td>*WAI is sent directly after the command that should be completed before other commands can be executed.</td>
</tr>
</tbody>
</table>

5.9 Automatic Settings for Manual Selection of a Measurement Mode

When the measurement mode of a sensor is manually selected ("Sensor"→"Mode"), automatic settings are made for the trigger system and timing, which cannot be changed by manual control. This considerably simplifies operation. These settings are not changed when the measurement mode is selected by remote control (SENSe: FUNCTION) and have to be set to the desired value by appropriate SCPI commands.
The following table lists the respective setting capabilities and the values that are automatically set in manual control.

Table 5-3: Automatic settings for manual selection of a measurement mode

<table>
<thead>
<tr>
<th>SCPI command</th>
<th>Value</th>
<th>Remark</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Mode Cont Avg</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TRIGger[1..4]:SOURce</td>
<td>IMMEDIATE</td>
<td>Cannot be modified in manual mode.</td>
</tr>
<tr>
<td>TRIGger[1..4]:SLOPe</td>
<td>-</td>
<td>Unchanged, is irrelevant.</td>
</tr>
<tr>
<td>TRIGger[1..4]:COUNTt</td>
<td>1</td>
<td>Cannot be modified in manual mode.</td>
</tr>
<tr>
<td>TRIGger[1..4]:DELAY</td>
<td>-</td>
<td>Unchanged, is irrelevant.</td>
</tr>
<tr>
<td>TRIGger[1..4]:HOLDoff</td>
<td>1 NS</td>
<td>Cannot be modified in manual mode.</td>
</tr>
<tr>
<td>TRIGger[1..4]:LEVEL</td>
<td>-</td>
<td>Unchanged, is irrelevant.</td>
</tr>
<tr>
<td>[SENSe[1..4]]:TIMing:EXCLude:STARt</td>
<td>-</td>
<td>Unchanged, is irrelevant.</td>
</tr>
<tr>
<td>[SENSe[1..4]]:TIMing:EXCLude:STOP</td>
<td>-</td>
<td>Unchanged, is irrelevant.</td>
</tr>
<tr>
<td>INITiate[1..4]:CONTinuous</td>
<td>ON</td>
<td>Cannot be modified in manual mode.</td>
</tr>
<tr>
<td><strong>Mode Burst Av</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TRIGger[1..4]:SOURce</td>
<td>-</td>
<td>Unchanged, is irrelevant.</td>
</tr>
<tr>
<td>TRIGger[1..4]:SLOPe</td>
<td>-</td>
<td>Unchanged, is irrelevant.</td>
</tr>
<tr>
<td>TRIGger[1..4]:COUNTt</td>
<td>1</td>
<td>Cannot be modified in manual mode.</td>
</tr>
<tr>
<td>TRIGger[1..4]:DELAY</td>
<td>-</td>
<td>Unchanged, is irrelevant.</td>
</tr>
<tr>
<td>TRIGger[1..4]:HOLDoff</td>
<td>Depends on sensor</td>
<td>User-selectable.</td>
</tr>
<tr>
<td>TRIGger[1..4]:LEVEL</td>
<td>Depends on sensor</td>
<td>User-selectable.</td>
</tr>
<tr>
<td>[SENSe[1..4]]:TIMing:EXCLude:STARt</td>
<td>Depends on sensor</td>
<td>User-selectable.</td>
</tr>
<tr>
<td>[SENSe[1..4]]:TIMing:EXCLude:STOP</td>
<td>Depends on sensor</td>
<td>User-selectable.</td>
</tr>
<tr>
<td>INITiate[1..4]:CONTinuous</td>
<td>ON</td>
<td>Cannot be modified in manual mode.</td>
</tr>
<tr>
<td><strong>Mode Timegate Av</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TRIGger[1..4]:SOURce</td>
<td>EXTERNAL</td>
<td>User-selectable.</td>
</tr>
<tr>
<td>TRIGger[1..4]:SLOPe</td>
<td>POSITIVE</td>
<td>User-selectable.</td>
</tr>
<tr>
<td>TRIGger[1..4]:COUNTt</td>
<td>1</td>
<td>Cannot be modified in manual mode.</td>
</tr>
<tr>
<td>TRIGger[1..4]:DELAY</td>
<td>Depends on sensor</td>
<td>User-selectable.</td>
</tr>
<tr>
<td>TRIGger[1..4]:HOLDoff</td>
<td>Depends on sensor</td>
<td>User-selectable.</td>
</tr>
<tr>
<td>TRIGger[1..4]:LEVEL</td>
<td>Depends on sensor</td>
<td>User-selectable.</td>
</tr>
<tr>
<td>[SENSe[1..4]]:TIMing:EXCLude:STARt</td>
<td>-</td>
<td>Unchanged, is irrelevant.</td>
</tr>
</tbody>
</table>
5.10 Correspondence between Remote Control and Manual Control

The following table compares the control elements of the graphical user interface for manual control with the SCPI commands for remote control in order to simplify the transfer of manual control procedures to a remote control program.
<table>
<thead>
<tr>
<th>Menu item in manual control</th>
<th>SCPI command in short form</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sensor→Mode</td>
<td>SENS[1..4]:Functiion</td>
</tr>
<tr>
<td>Sensor→Mode→ContAv→Aperture</td>
<td>SENS[1..4]:APER</td>
</tr>
<tr>
<td>Sensor→Mode→ContAv→Sampling Rate</td>
<td>SENS[1..4]:SAMP</td>
</tr>
<tr>
<td>Sensor→Mode→ContAv→DutyCycle</td>
<td>SENS[1..4]:CORR:DCYC</td>
</tr>
<tr>
<td>Sensor→Mode→ContAv→DutyCycle</td>
<td>SENS[1..4]:CORR:DCYC:STAT</td>
</tr>
<tr>
<td>Sensor→Mode→ContAv→Smoothing of Modulated Signals</td>
<td>SENS[1..4]:SMO:STAT</td>
</tr>
<tr>
<td>Sensor→Mode→Burst→Dropout</td>
<td>SENS[1..4]:BURSt:DTOL</td>
</tr>
<tr>
<td>Sensor→Mode→Burst→Exclude Start</td>
<td>SENS[1..4]:TIM:EXCL:STAR</td>
</tr>
<tr>
<td>Sensor→Mode→Burst→Exclude Stop</td>
<td>SENS[1..4]:TIM:EXCL:STOP</td>
</tr>
<tr>
<td>Sensor→Mode→Timeslot→No. of Timeslots</td>
<td>SENS[1..4]:POW:TSL:COUN</td>
</tr>
<tr>
<td>Sensor→Mode→Timeslot→Nominal Width</td>
<td>SENS[1..4]:POW:TSL:WIDT</td>
</tr>
<tr>
<td>Sensor→Mode→Timeslot→Exclude Start</td>
<td>SENS[1..4]:TIM:EXCL:STAR</td>
</tr>
<tr>
<td>Sensor→Mode→Timeslot→Exclude Stop</td>
<td>SENS[1..4]:TIM:EXCL:STOP</td>
</tr>
<tr>
<td>Sensor→Mode→Timeslot→Fence→Start</td>
<td>SENS[1..4]:TSL:EXCL:MID:OFFS</td>
</tr>
<tr>
<td>Sensor→Mode→Timeslot→Fence→Length</td>
<td>SENS[1..4]:TSL:EXCL:MID:TIME</td>
</tr>
<tr>
<td>Sensor→Mode→T'gate→Gate #</td>
<td>SENS[1..4]:TGAT:SEL</td>
</tr>
<tr>
<td>Sensor→Mode→T'gate→Start of Gate</td>
<td>SENS[1..4]:TGAT[1..4]:OFFS:TIME</td>
</tr>
<tr>
<td>Sensor→Mode→T'gate→Length</td>
<td>SENS[1..4]:TGAT[1..4]:TIME</td>
</tr>
<tr>
<td>Sensor→Mode→T'gate→Fence→Start</td>
<td>SENS[1..4]:TGAT[1..4]:EXCL:MID:OFFS</td>
</tr>
<tr>
<td>Sensor→Mode→T'gate→Fence→Length</td>
<td>SENS[1..4]:TGAT[1..4]:EXCL:MID:TIME</td>
</tr>
<tr>
<td>Sensor→Mode→Trace &amp; Statistics→Points</td>
<td>SENS[1..4]:TRAC:POIN</td>
</tr>
<tr>
<td>Sensor→Offset→Global</td>
<td>SENS[1..4]:CORR:OFFS</td>
</tr>
<tr>
<td>Sensor→Offset→Global→State</td>
<td>SENS[1..4]:CORR:OFFS:STAT</td>
</tr>
<tr>
<td>Sensor→Offset→Table</td>
<td>SENS[1..4]:CORR:FDOT</td>
</tr>
<tr>
<td>Sensor→Offset→Table→State</td>
<td>SENS[1..4]:CORR:FDOT:STAT</td>
</tr>
<tr>
<td>Sensor→Offset→Edit Table...</td>
<td>see MEMORY</td>
</tr>
<tr>
<td>Sensor→Offset→S Parameter Device</td>
<td>SENS[1..4]:CORR:SPD:STAT</td>
</tr>
<tr>
<td>Sensor→Filter→Auto</td>
<td>SENS[1..4]:AVER:COUN:AUTO</td>
</tr>
<tr>
<td>In Trace mode:</td>
<td>SENS[1..4]:TRAC:AVER:COUN:AUTO</td>
</tr>
<tr>
<td>Sensor→Filter→Avg No</td>
<td>SENS[1..4]:AVER:COUN</td>
</tr>
<tr>
<td>In Trace mode:</td>
<td>SENS[1..4]:TRAC:AVER:COUN</td>
</tr>
</tbody>
</table>
### Correspondence between Remote Control and Manual Control

<table>
<thead>
<tr>
<th>Menu item in manual control</th>
<th>SCPI command in short form</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sensor→Filter→Reset</td>
<td>SENS[1..4]:AVER:RES</td>
</tr>
<tr>
<td></td>
<td>In Trace mode:</td>
</tr>
<tr>
<td></td>
<td>SENS[1..4]:TRAC:AVER:RES</td>
</tr>
<tr>
<td>Sensor→Filter→Auto Once</td>
<td>SENS[1..4]:AVER:COUN:AUTO ONCE</td>
</tr>
<tr>
<td></td>
<td>In Trace mode:</td>
</tr>
<tr>
<td></td>
<td>SENS[1..4]:TRAC:AVER:COUN:AUTO ONCE</td>
</tr>
<tr>
<td>Sensor→Filter→Auto Config,...→Normal</td>
<td>SENS[1..4]:AVER:COUN:AUTO:TYPE RES</td>
</tr>
<tr>
<td></td>
<td>In Trace mode:</td>
</tr>
<tr>
<td></td>
<td>SENS[1..4]:TRAC:AVER:COUN:AUTO:TYPE RES</td>
</tr>
<tr>
<td>Sensor→Filter→VideoBW</td>
<td>SENS:BWID:VID</td>
</tr>
<tr>
<td></td>
<td>SENS:BWID:VID:LIST?</td>
</tr>
<tr>
<td>Sensor→Filter→Auto Config,...→Fixed Noise→Ref Timeslot #</td>
<td>SENS[1..4]:AVER:COUN:AUTO:TYPE NSR</td>
</tr>
<tr>
<td></td>
<td>In Trace mode:</td>
</tr>
<tr>
<td></td>
<td>SENS[1..4]:TRAC:AVER:COUN:AUTO:TYPE NSR</td>
</tr>
<tr>
<td>Sensor→Filter→Auto Config,...→Fixed Noise→Noise Content</td>
<td>SENS[1..4]:AVER:COUN:AUTO:NSR</td>
</tr>
<tr>
<td></td>
<td>In Trace mode:</td>
</tr>
<tr>
<td></td>
<td>SENS[1..4]:TRAC:AVER:COUN:AUTO:NSR</td>
</tr>
<tr>
<td></td>
<td>In Trace mode:</td>
</tr>
<tr>
<td></td>
<td>SENS[1..4]:TRAC:AVER:COUN:AUTO:MTIM</td>
</tr>
<tr>
<td>Sensor→Range→Auto</td>
<td>SENS[1..4]:RANG:AUTO</td>
</tr>
<tr>
<td>Sensor→Range→Path</td>
<td>SENS[1..4]:RANG</td>
</tr>
<tr>
<td>Sensor→Range→User def'd Transition</td>
<td>SENS[1..4]:RANG:CLEV</td>
</tr>
<tr>
<td>Sensor→Range→Level</td>
<td>SENS[1..4]:RANG:CLEV</td>
</tr>
<tr>
<td>Sensor→RF Source→Source Γ considered</td>
<td>SENS[1..4]:SGAM:CORR:STAT</td>
</tr>
<tr>
<td>Sensor→RF Source→SPhase of Source Γ</td>
<td>SENS[1..4]:SGAM:PHAS</td>
</tr>
<tr>
<td>Sensor→RF Source→Magnitude of Source Γ</td>
<td>SENS[1..4]:SGAM</td>
</tr>
<tr>
<td>Sensor→Trigger→Mode</td>
<td>No individual remote-control command is available; the trigger system has to be configured in such a way that the function can be implemented (e.g. INIT:CONT ON;TRIG:SOUR BUS and triggering with TRG).</td>
</tr>
<tr>
<td>Sensor→Trigger→Delay</td>
<td>TRIG[1..4]:DEL</td>
</tr>
<tr>
<td>Sensor→Trigger→Source</td>
<td>TRIG[1..4]:SOUR</td>
</tr>
<tr>
<td>Sensor→Trigger→Level</td>
<td>TRIG[1..4]:LEV</td>
</tr>
</tbody>
</table>
## Menu item in manual control vs. SCPI command in short form

<table>
<thead>
<tr>
<th>Menu item in manual control</th>
<th>SCPI command in short form</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sensor→Trigger→Holdoff</td>
<td>TRIG[1..4]:HOLD</td>
</tr>
<tr>
<td>Sensor→Trigger→Hysteresis</td>
<td>TRIG[1..4]:HYST</td>
</tr>
<tr>
<td>Sensor→Trigger→Dropout</td>
<td>TRIG[1..4]:DTIMe</td>
</tr>
<tr>
<td>Windows→Window 1234</td>
<td>DISP:SEL</td>
</tr>
<tr>
<td>Windows→Open/Close</td>
<td>DISP[1..4][:STAT]</td>
</tr>
<tr>
<td>Windows→Expand/Restore</td>
<td>DISP:SIZE</td>
</tr>
<tr>
<td>Windows→Dig/D&amp;A/Graph</td>
<td>DISP[1..4]:FORM</td>
</tr>
<tr>
<td>Windows→Resolution</td>
<td>DISP[1..4]:RES</td>
</tr>
<tr>
<td>Windows→Timeslot #</td>
<td>DISP[1..4]:TSLot</td>
</tr>
<tr>
<td>Windows→T'slot</td>
<td></td>
</tr>
<tr>
<td>Windows→Analog Meter...→Auto Once</td>
<td>DISP[1..4]:MET:AUTO ONCE</td>
</tr>
<tr>
<td>Windows→Analog Meter...→Left</td>
<td>DISP[1..4]:MET:LOW</td>
</tr>
<tr>
<td>Windows→Analog Meter...→Right</td>
<td>DISP[1..4]:MET:UPP</td>
</tr>
<tr>
<td>Measurement→Function...→Primary Channel</td>
<td>CALC[1..8]:MATH:EXPR</td>
</tr>
<tr>
<td>Measurement→Function...→Secondary Channel</td>
<td></td>
</tr>
<tr>
<td>Measurement→Function...→Function</td>
<td></td>
</tr>
<tr>
<td>Measurement→Function...→Unit</td>
<td>UNIT:POW and UNIT:POW:RAT</td>
</tr>
<tr>
<td>Measurement→Function...→Auxiliary Value</td>
<td>DISP[1..8]:AVAL</td>
</tr>
<tr>
<td>= Max</td>
<td>CALC[1..8]:MAX:DATA?</td>
</tr>
<tr>
<td>= Min</td>
<td>CALC[1..8]:MIN:DATA?</td>
</tr>
<tr>
<td>= Max - Min</td>
<td>CALC[1..8]:PTP:DATA?</td>
</tr>
<tr>
<td>Measurement→W / dBm / dByV</td>
<td>UNIT:POW</td>
</tr>
<tr>
<td>Measurement→dB / Δ% / 1</td>
<td>UNIT:POW:RAT</td>
</tr>
<tr>
<td>Measurement→Rel On / Off</td>
<td>CALC[1..8]:REL:STAT and CALC[1..8]:REL:AUTO ONCE</td>
</tr>
<tr>
<td>Measurement→Rel Reset</td>
<td></td>
</tr>
<tr>
<td>Measurement→Ref. Val...→Ref. Value</td>
<td>CALC[1..8]:REL</td>
</tr>
<tr>
<td>Measurement→Ref. Val...→Ref. Value→Reset</td>
<td>CALC[1..8]:REL:AUTO ONCE</td>
</tr>
<tr>
<td>Measurement→Limits...→Warning Sound</td>
<td>CALC[1..8]:LIM:BEEP</td>
</tr>
<tr>
<td>Measurement→Limits...→Upper Limit On</td>
<td>CALC[1..8]:LIM:UPP:STAT</td>
</tr>
<tr>
<td>Measurement→Limits...→Upper Limit</td>
<td>CALC[1..8]:LIM:UPP[:DATA]</td>
</tr>
</tbody>
</table>
## Correspondence between Remote Control and Manual Control

<table>
<thead>
<tr>
<th>Menu item in manual control</th>
<th>SCPI command in short form</th>
</tr>
</thead>
<tbody>
<tr>
<td>Measurement→Limits...→Lower Limit On</td>
<td>CALC[1..8]:LIM:LOW:STAT</td>
</tr>
<tr>
<td>Measurement→Limits...→Lower Limit</td>
<td>CALC[1..8]:LIM:LOW[:DATA]</td>
</tr>
<tr>
<td>Measurement→Aux Val Reset</td>
<td>CALC[1..8]:EXTR:RES</td>
</tr>
<tr>
<td>File→Preset</td>
<td>SYST:PRES or *RST</td>
</tr>
<tr>
<td>File→Setup Recall→Recall</td>
<td>*RCL</td>
</tr>
<tr>
<td>File→Setup Save→Save</td>
<td>*SAV</td>
</tr>
<tr>
<td>File→Setup Save→Edit Name</td>
<td>MEM:STAT:DEF</td>
</tr>
<tr>
<td>File→Standard Recall→Preserve Window Settings</td>
<td>SYST:STAN:PWS</td>
</tr>
<tr>
<td>File→Standard Recall→Trigger Source</td>
<td>SYST:STAN:TRIG:SOUR</td>
</tr>
<tr>
<td>File→Standard Recall→Recall</td>
<td>SYST:STAN:PRES</td>
</tr>
<tr>
<td>File→Sensor Info...</td>
<td>SYSTem:SENS[1..4]:INFO?</td>
</tr>
<tr>
<td>File→System Info...</td>
<td>SYSTem:INFO?</td>
</tr>
<tr>
<td>File→Window Name</td>
<td>DISP:NAME</td>
</tr>
<tr>
<td>System→Remote...→GPIB→GPIB Address</td>
<td>SYST:COMM:GPIB:ADDR</td>
</tr>
<tr>
<td>System→I/O...→Out 1 1234</td>
<td>OUTP:REC1:FEED or OUTP:TTL:FEED</td>
</tr>
<tr>
<td>System→I/O...→Out 1→Analog</td>
<td>OUTP:REC1:STAT ON</td>
</tr>
<tr>
<td>System→I/O...→Out 1→Pass/Fail</td>
<td>OUTP:TTL:STAT ON</td>
</tr>
<tr>
<td>System→I/O...→Out 1→Off</td>
<td>OUTP:REC1:STAT ON OUTP:TTL:STAT ON</td>
</tr>
<tr>
<td>System→I/O...→Out 1→0 V Equivalent (if Analog is selected)</td>
<td>OUTP:REC1:LIM:LOW...</td>
</tr>
<tr>
<td>System→I/O...→Out 1→3 V Equivalent (if Analog is selected)</td>
<td>OUTP:REC1:LIM:UPP...</td>
</tr>
<tr>
<td>System→I/O...→Out 1→Fail (if Pass/Fail is selected)</td>
<td>OUTP:TTL:FAIL HIGH and OUTP:TTL:HVOLT</td>
</tr>
<tr>
<td>System→I/O...→Out 1→Pass (if Pass/Fail is selected)</td>
<td>OUTP:TTL:FAIL HIGH and OUTP:TTL:LVOLT</td>
</tr>
<tr>
<td>System→I/O...→I/O 2 1234</td>
<td>OUTP:REC2:FEED</td>
</tr>
<tr>
<td>System→I/O...→I/O 2→Analog Out</td>
<td>OUTP:REC2:STAT ON</td>
</tr>
<tr>
<td>System→I/O...→I/O 2→ATrigger In</td>
<td>OUTP:REC2:STAT OFF</td>
</tr>
<tr>
<td>System→I/O...→I/O 2→A0 V Equivalent (if Analog Out is selected)</td>
<td>OUTP:REC2:LIM:LOW...</td>
</tr>
</tbody>
</table>
## Menu item in manual control vs. SCPI command in short form

<table>
<thead>
<tr>
<th>Menu item in manual control</th>
<th>SCPI command in short form</th>
</tr>
</thead>
<tbody>
<tr>
<td>System→I/O...→I/O 2→A3 V Equivalent (if Analog Out is selected)</td>
<td>OUTP:REC2:LIM:UPP...</td>
</tr>
<tr>
<td>System→Test...→Sensor ABCD / Init. Test</td>
<td>SYST:SENS[1..4]:TEST? *TST?</td>
</tr>
<tr>
<td>System→Power Ref</td>
<td>OUTP:ROSC</td>
</tr>
<tr>
<td>System→Display Update</td>
<td>DISP:UPD</td>
</tr>
<tr>
<td>System→Misc...→Beeper→Key</td>
<td>SYST:BEEP:NOT:KEY</td>
</tr>
<tr>
<td>System→Misc...→Overload</td>
<td>SYST:BEEP:NOT:OVER</td>
</tr>
<tr>
<td>System→Misc...→Brightness</td>
<td>DISP:ILL</td>
</tr>
<tr>
<td>DEL/1TRIG</td>
<td>If the &quot;Single&quot; check box was enabled in the Trace mode, pressing DEL/1TRIG sends a *TRG to the sensor.</td>
</tr>
<tr>
<td>(PRE)SET</td>
<td>Opens the File menu</td>
</tr>
<tr>
<td>FREQ</td>
<td>SENS[1..4]:FREQ</td>
</tr>
<tr>
<td>ZERO/CAL</td>
<td>CAL:ZERO:_AUTO</td>
</tr>
<tr>
<td>Sensor→Mode→Trace&amp;Statistics Windows→Graph Trace→Config...→Display</td>
<td>SENS[1..4]:AUX</td>
</tr>
<tr>
<td>Sensor→Mode→Trace&amp;Statistics Windows→Graph Stats→Config...→Scale/x/Max</td>
<td>SENS[1..4]:STAT:SCAL:X:RLEV and SENS[1..4]:STAT:SCAL:X:RANG</td>
</tr>
<tr>
<td>Sensor→Mode→Trace&amp;Statistics Windows→Graph Stats→Config...→Scale/x/Min</td>
<td>SENS[1..4]:STAT:SCAL:X:RLEV</td>
</tr>
<tr>
<td>Sensor→Mode→Trace&amp;Statistics Windows→Graph Stats→Config...→Aperture (Cont)</td>
<td>SENS[1..4]:STAT:TIME</td>
</tr>
<tr>
<td>Sensor→Mode→Trace&amp;Statistics Windows→Graph Stats→Config...→Samples</td>
<td>SENS[1..4]:STAT:SAMP</td>
</tr>
<tr>
<td>Sensor→Mode→Trace&amp;Statistics Windows→Graph Stats→Config...→Mark’r/x</td>
<td>CALC[1..4]:STAT:MARK:HOR:POS:X</td>
</tr>
</tbody>
</table>
## Menu item in manual control vs. SCPI command in short form

<table>
<thead>
<tr>
<th>Menu item in manual control</th>
<th>SCPI command in short form</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sensor→Mode→Trace&amp;Statistics Windows→Graph Stats→Config...→Mark'ry</td>
<td>CALC[1..4]:STAT:MARK:VERT:POS:Y</td>
</tr>
<tr>
<td>Sensor→Mode→Trace&amp;Statistics Windows→Graph Display→Pulse</td>
<td>SENS:TRAC:MEAS ON SENS:TRAC:MEAS:AUTO ON</td>
</tr>
<tr>
<td>Sensor→Mode→Trace&amp;Statistics Windows→Graph Display→Pulse Pulse Width</td>
<td>SENS:TRAC:MEAS:PULS:DUR?</td>
</tr>
<tr>
<td>Sensor→Mode→Trace&amp;Statistics Windows→Graph Display→Pulse Pulse Period</td>
<td>SENS:TRAC:MEAS:PULS:PER?</td>
</tr>
<tr>
<td>Sensor→Mode→Trace&amp;Statistics Windows→Graph Display→Pulse Duty Cycle</td>
<td>SENS:TRAC:MEAS:PULS:DCYC?</td>
</tr>
<tr>
<td>Sensor→Mode→Trace&amp;Statistics Windows→Graph Display→Pulse Fall Time</td>
<td>SENS:TRAC:MEAS:TRAN:POS:OCC?</td>
</tr>
<tr>
<td>Sensor→Mode→Trace&amp;Statistics Windows→Graph Display→Pulse Stop Time</td>
<td>SENS:TRAC:MEAS:POW:PULS:TOP?</td>
</tr>
<tr>
<td>Sensor→Mode→Trace&amp;Statistics Windows→Graph Display→Pulse Pulse Top</td>
<td>SENS:TRAC:MEAS:POW:PULS:BAS?</td>
</tr>
<tr>
<td>Sensor→Mode→Trace&amp;Statistics Windows→Graph Display→Pulse Pulse Base</td>
<td>SENS:TRAC:MEAS:POW:AVG?</td>
</tr>
<tr>
<td>Sensor→Mode→Trace&amp;Statistics Windows→Graph Display→Pulse Trace Avg</td>
<td>SENS:TRAC:MEAS:POW:MAX?</td>
</tr>
<tr>
<td>Sensor→Mode→Trace&amp;Statistics Windows→Graph Display→Pulse Trace Peak</td>
<td>SENS:TRAC:MEAS:POW:MIN?</td>
</tr>
<tr>
<td>Sensor→Mode→Trace&amp;Statistics Windows→Graph Display→Pulse Trace Min</td>
<td>SENS:TRAC:MEAS:TRAN:POS:OVER?</td>
</tr>
<tr>
<td>Sensor→Mode→Trace&amp;Statistics Windows→Graph Display→Pulse Neg. Overshoot</td>
<td></td>
</tr>
<tr>
<td>Sensor→Mode→Trace&amp;Statistics Windows→Graph Config Pulse...,→</td>
<td>SENS:TRAC:MEAS:ALG</td>
</tr>
<tr>
<td>Sensor→Mode→Trace&amp;Statistics Windows→Graph Config Pulse...,→ Configure Algorithm</td>
<td>SENS:TRAC:MEAS:DEF:DUR:ERF</td>
</tr>
<tr>
<td>Sensor→Mode→Trace&amp;Statistics Windows→Graph Config Pulse...,→ High Ref Power</td>
<td>SENS:TRAC:MEAS:DEF:TRAN:LREF</td>
</tr>
<tr>
<td>Sensor→Mode→Trace&amp;Statistics Windows→Graph Config Pulse...,→ Low Ref Power</td>
<td>Measurements are always related to power</td>
</tr>
</tbody>
</table>
6 Remote Control - Commands

6.1 Notation

In the following sections, all commands implemented in the device are listed according to the command system and then described in detail. For the most part, the notation used complies with SCPI specifications. The commands are separated in high-level and low-level commands, where the high-level commands combine several low-level commands in one command.

**Numeric suffixes <n>**

If a command can be applied to multiple instances of an object, e.g. specific sensors, the required instances can be specified by a suffix added to the command. Numeric suffixes are indicated by angular brackets (<1...4>, <n>, <i>) and are replaced by a single value in the command. Entries without a suffix are interpreted as having the suffix 1.

**Optional keywords [ ]**

Some command systems permit certain keywords to be inserted into the header or omitted. These keywords are marked by square brackets in the description. The instrument must recognize the long command to comply with the SCPI standard. Some commands are considerably shortened by these optional mnemonics. Therefore, not only is there a short and a long form for the commands (distinguished here by lowercase and uppercase letters) but also a short form which is created by omitting optional keywords.

**Example:**

Command \[SENSe<[1]..4>:CORRection:GAIN2[:INPut][:MAGNitude] 1\] can be written as:

SENSe1:CORRection:GAIN2:INPut:MAGNitude 1
SENSe1:CORRection:GAIN2:INPut 1
SENSe1:CORRection:GAIN2 1
SENSe:CORRection:GAIN2 1
CORRection:GAIN2 1

**Parameters**

Parameters must be separated from the header by a "white space". If several parameters are specified in a command, they are separated by a comma (,). For a description of the parameter types, refer to chapter 5.7.5, "Parameters", on page 180.
Example:
Definition: OUTPut:AUDiobits <audiobits>
Command: OUTP:AUD 24

Special characters | and {}:

| A vertical bar in parameter definitions indicates alternative possibilities in the sense of "or". The effect of the command differs, depending on which parameter is used.
Example:
Definition: INITiate:CONTinuous ON | OFF
Command INITiate:CONTinuous ON starts the measurements
Command INITiate:CONTinuous OFF stops the measurements

{} Parameters in braces may be included in the command once, several times or not at all.

6.1.1 Parameter Types

|<NR1>| Stands for integers with sign.
Examples:
• 1
• -33
• 32767

|<NRf>| Stands for floating point numbers that can also be written in exponential notation.
Examples:
• 1
• 1.0
• -21.2345553e-6

<int_value>| Is an abbreviation for <NR1>|MINimum|MAXimum|DEFault.

<float_value>| Is an abbreviation for <NRf>|MINimum|MAXimum|DEFault.

<boolean>| Stands for ON|OFF|0|1, where ON and 1 are identical in meaning as are OFF and 0.

<string>| Stands for character strings that have to be within single or double quotes.
Examples:
• 'free text'
• "Sirius"


6.2 Common Commands to IEEE 488.2

The common commands are taken from the IEEE 488.2 (IEC 625–2) standard. Some commands have the same effect on different devices. The headers of these commands consist of an asterisk *** followed by three letters. Many common commands
refer to the status reporting system which is described in detail in chapter 6.13, "Status", on page 296.

Commands available in the R&S NRP2

*CLS.............................................................................................................................195
*ESE...............................................................................................................................195
*ESR?...............................................................................................................................196
*IDN?..............................................................................................................................196
*IST?...............................................................................................................................196
*OPC..............................................................................................................................196
*OPT?.............................................................................................................................197
*PRE..............................................................................................................................197
*PSC..............................................................................................................................197
*RCL..............................................................................................................................198
*RST..............................................................................................................................198
*SAV..............................................................................................................................204
*SRE..............................................................................................................................204
*STB?............................................................................................................................205
*TRG..............................................................................................................................205
*TST?............................................................................................................................205
*WAI..............................................................................................................................205

*CLS

CLear Status resets the

- status byte (STB)
- standard event register (ESR)
- EVENt part of the QUEUEstionable and the OPERation register
- Error / event queue

The command does not alter the ENABle and TRANsition parts of the registers.

Usage: 

Event

*ESE <value>

Setting command: *ESE

Event Status Enable sets the event status enable register to the specified value.

Query: *ESE?

The query form *ESE? returns the contents of the event status enable register in decimal form.

Parameters:

<Value> 0 to 255
*ESR? <value>

Event Status Read returns the contents of the event status register in decimal form (0 to 255) and subsequently sets the register to zero.

**Parameters:**

<value>

0 to 255

**Usage:**

Query only

*IDN?

IDEnification queries the instrument identification.

**Note:** The return string can be customized using SYSTem:IDN and SYSTem:IDN:AUTO commands

**Example:**

Return values

Rohde&Schwarz, NRP2, 10001, 07.03

The strings have the following meaning:

Rohde&Schwarz = manufacturer
NRP2 = instrument type
10001 = serial number
07.03 = firmware version

**Usage:**

Query only

*IST? <status_bit>

Individual STatus query returns the current value of the IST flag in decimal form. The IST flag is the status bit which is sent during a parallel poll (chapter 6.13.6, "IST Flag and Parallel Poll Enable Register (PPE)", on page 305

**Parameters:**

<status_bit>

0 | 1

**Usage:**

Query only

*OPC

Setting Command : *OPC

OPeration Complete sets bit 0 in the event status register after all preceding commands have been executed. This bit can be used to initiate a service request. *OPC must be sent at the end of a program message.

**Query:** *OPC?

OPeration Complete query returns a 1 when all previous commands have been processed. It is important that the timeout set on the IEC/IEEE bus is sufficiently long.
Since \texttt{*OPC?} waits until all previous commands are executed, "1" is returned in all cases. \texttt{*OPC?} basically functions like the \texttt{*WAI} command, but \texttt{*WAI} does not return a response. \texttt{*OPC?} is preferred to \texttt{*WAI} because with \texttt{*OPC?}, the execution of commands can be queried from a controller program before new commands are sent. This avoids an overflow of the input queue when too many commands are sent that cannot be executed.

Unlike \texttt{*WAI}, \texttt{*OPC?} must be sent at the end of a program message.

\textbf{OPT?}

\textbf{OPT}tion identification query returns a list of the options installed. The options are separated from each other by means of commas.

<table>
<thead>
<tr>
<th>Option</th>
<th>Response string</th>
</tr>
</thead>
<tbody>
<tr>
<td>R&amp;S NRP-B1</td>
<td>&quot;NRP-B1: Test generator installed&quot;</td>
</tr>
<tr>
<td>R&amp;S NRP-B2</td>
<td>&quot;NRP-B2: Second channel interface installed&quot;</td>
</tr>
<tr>
<td>R&amp;S NRP-B5</td>
<td>&quot;NRP-B5: Four channel interface installed&quot;</td>
</tr>
<tr>
<td>R&amp;S NRP-B6</td>
<td>&quot;NRP-B6: Sensor A/B rear socket&quot;</td>
</tr>
<tr>
<td>R&amp;S NRP-B7</td>
<td>&quot;NRP-B7: Test generator installed&quot;</td>
</tr>
</tbody>
</table>

Example: \texttt{*OPT?}

Device response:
"NRP-B1: Test Generator installed","NRP-B2: Second Channel Interface installed","NRP-B5: Four Channel Interface installed"

Usage: Query only

\textbf{*PRE <value>}

Setting command: \texttt{*PRE}

Parallel poll Register E\textbf{NABle} sets the parallel poll enable register to the specified value.

Query: \texttt{*PRE?}

The query form \texttt{*PRE?} returns the contents of the parallel poll enable register in decimal form.

Parameters:

\begin{itemize}
  \item \texttt{<Value>} 0 to 255
\end{itemize}

\textbf{*PSC <function>}

Setting command: \texttt{*PSC}

Power on Status C\textbf{lear} determines whether the contents of the ENABle registers are preserved or reset during power-up.
Query: *PSC?

The query form *PSC? reads out the contents of the power-on-status-clear flag. The response can be 0 or 1.

Parameters:
<Function> 0 | 1
0 Causes the contents of the status registers to be preserved. Thus a service request can be generated when switching on the instrument, if the status registers ESE and SRE are suitably configured.
1 Resets the registers.

*RCL <value>

ReCaLi calls the device state which has been stored with the *SAV command under the specified number. The effect of *RCL 0 to 19 is the same as if one of the setups 0 to 19 had been selected in manual control. *RCL 0 resets the device to the default state.

Parameters:
<Value> 1 to 19
1 Available recall numbers for device setups.

Usage: Event

*RST

ReSeT sets the instrument to a defined default status. The command essentially corresponds to command SYSTem:PRESet and to pressing (PRE)SET.

The following table documents the difference. SYSTem:PRESet acts like the frontpanel key (PRE)SET.

<table>
<thead>
<tr>
<th></th>
<th>INITIate:CONTinuous</th>
<th>SENSE:AVERage:TCONtrol</th>
</tr>
</thead>
<tbody>
<tr>
<td>*RST</td>
<td>OFF</td>
<td>REPeat</td>
</tr>
<tr>
<td>SYSTem:PRESet</td>
<td>ON</td>
<td>MOVing</td>
</tr>
</tbody>
</table>

The following table lists all preset values
### Table 6-2: Preset values

<table>
<thead>
<tr>
<th>Command</th>
<th>Preset and &quot;RST value&quot;</th>
<th>Remark</th>
</tr>
</thead>
<tbody>
<tr>
<td>CALC&lt;[1]..8&gt;:FEED[1..2]</td>
<td>&quot;POW:AVER&quot;</td>
<td>The calculate block processes average power values (&quot;Average&quot;).</td>
</tr>
<tr>
<td>CALC&lt;[1]..8&gt;:LIM:BEEP</td>
<td>OFF</td>
<td>No audible signal in case of limit violations.</td>
</tr>
<tr>
<td>CALC&lt;[1]..8&gt;:LIM:CLE:AUTO</td>
<td>OFF</td>
<td>No automatic reset of the limit monitoring function when a measurement is started.</td>
</tr>
<tr>
<td>CALC&lt;[1]..8&gt;:LIM:FAIL?</td>
<td>0</td>
<td>Limit violation.</td>
</tr>
<tr>
<td>CALC&lt;[1]..8&gt;:LIM:FCO?</td>
<td>0</td>
<td>Number of limit violations is reset.</td>
</tr>
<tr>
<td>CALC&lt;[1]..8&gt;:LIM:UPP:DATA</td>
<td>0 W or 0 DB</td>
<td>Upper limit value for measurements.</td>
</tr>
<tr>
<td>CALC&lt;[1]..8&gt;:LIM:UPP:STAT</td>
<td>OFF</td>
<td>No monitoring function for upper limit value.</td>
</tr>
<tr>
<td>CALC&lt;[1]..8&gt;:LIM:LOW:DATA</td>
<td>0 W or 0 DB</td>
<td>Lower limit value for measurements.</td>
</tr>
<tr>
<td>CALC&lt;[1]..8&gt;:LIM:LOW:STAT</td>
<td>OFF</td>
<td>No monitoring function for lower limit value.</td>
</tr>
<tr>
<td>CALC&lt;[1]..8&gt;:MATH</td>
<td>For command description see page 231</td>
<td>The calculate block returns the measured value of the sensor assigned to the primary channel.</td>
</tr>
<tr>
<td>CALC&lt;[1]..8&gt;:REL</td>
<td>0 DBM or 0 DB</td>
<td>-</td>
</tr>
<tr>
<td>CALC&lt;[1]..8&gt;:REL:POW</td>
<td>0 DBM</td>
<td>-</td>
</tr>
<tr>
<td>CALC&lt;[1]..8&gt;:REL:RAT</td>
<td>0 DB</td>
<td>-</td>
</tr>
<tr>
<td>CALC&lt;[1]..8&gt;:REL:STAT</td>
<td>OFF</td>
<td>Measurements are not converted into a reference value.</td>
</tr>
<tr>
<td>DISP:ILL</td>
<td>-</td>
<td>Display lighting remains unchanged.</td>
</tr>
<tr>
<td>DISP:MESS</td>
<td>OFF</td>
<td>Do not display messages.</td>
</tr>
<tr>
<td>DISP:MESS:TEXT</td>
<td>-</td>
<td>No change.</td>
</tr>
<tr>
<td>DISP:MESS:TYPE</td>
<td>MESS</td>
<td>Messages cannot be confirmed manually.</td>
</tr>
<tr>
<td>DISP:SEL</td>
<td>1</td>
<td>First window selected.</td>
</tr>
<tr>
<td>DISP:SIZE</td>
<td>NORM</td>
<td>Automatic window sizes.</td>
</tr>
<tr>
<td>DISP&lt;[1]..4&gt;</td>
<td>ON</td>
<td>OFF</td>
</tr>
<tr>
<td>DISP&lt;[1]..4&gt;:AVAL</td>
<td>NONE</td>
<td>No additional information on measured values displayed.</td>
</tr>
<tr>
<td>DISP&lt;[1]..4&gt;:FORM</td>
<td>DIG</td>
<td>Digital result display.</td>
</tr>
<tr>
<td>Command</td>
<td>Preset and *RST value</td>
<td>Remark</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------------</td>
<td>---------------------------------------------</td>
</tr>
<tr>
<td>DISP&lt;1..4&gt;:MET:LOW</td>
<td>-90 DBM, -120 DB</td>
<td>Lower limit value for analog result display.</td>
</tr>
<tr>
<td>DISP&lt;1..4&gt;:MET:UPP</td>
<td>70 DBM, 60 DB</td>
<td>Upper limit value for analog result display.</td>
</tr>
<tr>
<td>DISP&lt;1..4&gt;:NAME</td>
<td>&quot;&quot;</td>
<td>Text to be displayed in result window.</td>
</tr>
<tr>
<td>DISP&lt;1..4&gt;:RES</td>
<td>0.01</td>
<td>Measurement accuracy and display accuracy.</td>
</tr>
<tr>
<td>DISP:SEL</td>
<td>1</td>
<td>Selection of first result window.</td>
</tr>
<tr>
<td>DISP:SIZE</td>
<td>NORM</td>
<td>Automatic window sizes.</td>
</tr>
<tr>
<td>DISP&lt;1..4&gt;</td>
<td>ON</td>
<td>OFF</td>
</tr>
<tr>
<td>DISP&lt;1..4&gt;:TRAC:LOW</td>
<td>-120 DBM</td>
<td>Lower limit of power axis in Trace mode</td>
</tr>
<tr>
<td>DISP&lt;1..4&gt;:TRAC:UPP</td>
<td>30 DBM</td>
<td>Upper limit of power axis in Trace mode</td>
</tr>
<tr>
<td>DISP&lt;1..4&gt;:TSL</td>
<td>1</td>
<td>First timeslot</td>
</tr>
<tr>
<td>DISP&lt;1..4&gt;:UPD</td>
<td>NORM</td>
<td>Frequent display updates.</td>
</tr>
<tr>
<td>FORM</td>
<td>ASC</td>
<td>Measured data in ASCII format.</td>
</tr>
<tr>
<td>FORM:BORD</td>
<td>NORM</td>
<td>&quot;Big-Endian&quot; byte sequence of measured data, if FORMat REAL is selected.</td>
</tr>
<tr>
<td>INIT[1..4]:ALL]:CONT</td>
<td>ON</td>
<td>OFF</td>
</tr>
<tr>
<td>INIT[1..4]:ALL]:DIS</td>
<td>OFF</td>
<td>The settings in the MEMory command system will not be affected.</td>
</tr>
<tr>
<td>MEM:...</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>OUTP:REC1:FEED</td>
<td>&quot;CALC1&quot;</td>
<td>Analog outputs are fed by the first calculate block.</td>
</tr>
<tr>
<td>OUTP:REC2:FEED</td>
<td>&quot;CALC2&quot;</td>
<td>Analog outputs are fed by the second calculate block.</td>
</tr>
<tr>
<td>OUTP:REC[1..2]:LIM:LOW</td>
<td>-20 DBM or 0 DB</td>
<td>0 V equivalent at analog output.</td>
</tr>
<tr>
<td>OUTP:REC[1..2]:LIM:UPP</td>
<td>20 DBM or 10 DB</td>
<td>3 V equivalent at analog output.</td>
</tr>
<tr>
<td>OUTP:REC1:STAT</td>
<td>ON</td>
<td>Analog output active.</td>
</tr>
<tr>
<td>OUTP:REC2:STAT</td>
<td>OFF</td>
<td>Trigger input active.</td>
</tr>
<tr>
<td>OUTP:ROSC</td>
<td>OFF</td>
<td>Test generator is switched off.</td>
</tr>
</tbody>
</table>
## Remote Control - Commands

### Command Table

<table>
<thead>
<tr>
<th>Command</th>
<th>Preset and <code>*RST</code> value</th>
<th>Remark</th>
</tr>
</thead>
<tbody>
<tr>
<td>OUTP:TTL:ACT</td>
<td>LOW</td>
<td>OUTPut:TTL:LVOLTage is applied to the TTL output if a limit is violated.</td>
</tr>
<tr>
<td>OUTP:TTL:FAIL</td>
<td>HIGH</td>
<td>OUTPut:TTL:HVOLTage is applied to the TTL output if a limit is violated.</td>
</tr>
<tr>
<td>OUTP:TTL:FEED</td>
<td>“CALC1:LIM”</td>
<td>The TTL output is fed by the limit monitoring function of calculate block 1.</td>
</tr>
<tr>
<td>OUTP:TTL:HVOLT</td>
<td>3.3 V</td>
<td>High voltage at TTL output</td>
</tr>
<tr>
<td>OUTP:TTL:LVOLT</td>
<td>0.0 V</td>
<td>Low voltage at TTL output</td>
</tr>
<tr>
<td>SENS&lt;1..4&gt;:AC:RANG</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>SENS&lt;1..4&gt;:AC:RANG:AUT</td>
<td>ON</td>
<td>OFF</td>
</tr>
<tr>
<td>SENS&lt;1..4&gt;:AC:RANG:CLEV</td>
<td>&lt;NRf&gt;</td>
<td></td>
</tr>
<tr>
<td>SENS&lt;1..4&gt;:APER</td>
<td>&lt;NRf&gt;</td>
<td>Depending on sensor.</td>
</tr>
<tr>
<td>SENS&lt;1..4&gt;:AUXiliary</td>
<td>NONE</td>
<td>MINM</td>
</tr>
<tr>
<td>SENS&lt;1..4&gt;:AVER</td>
<td>ON</td>
<td>OFF</td>
</tr>
<tr>
<td>SENS&lt;1..4&gt;:AVER:COUN</td>
<td>&lt;NR1&gt;</td>
<td></td>
</tr>
<tr>
<td>SENS&lt;1..4&gt;:AVER:COUN:AUTO</td>
<td>ON</td>
<td>OFF</td>
</tr>
<tr>
<td>SENS&lt;1..4&gt;:AVER:COUN:AUTO:MTIME</td>
<td>&lt;NRf&gt;</td>
<td></td>
</tr>
<tr>
<td>SENS&lt;1..4&gt;:AVER:COUN:AUTO:RES</td>
<td>&lt;NRf&gt;</td>
<td></td>
</tr>
<tr>
<td>SENS&lt;1..4&gt;:AVER:COUN:AUTO:SLOT</td>
<td>&lt;NR1&gt;</td>
<td></td>
</tr>
<tr>
<td>SENS&lt;1..4&gt;:AVER:COUN:AUTO:NSR</td>
<td>&lt;NRf&gt;</td>
<td></td>
</tr>
<tr>
<td>SENS&lt;1..4&gt;:AVER:COUN:AUTO:TYPE</td>
<td>RES</td>
<td>NSR</td>
</tr>
<tr>
<td>SENS&lt;1..4&gt;:AVER:TCON</td>
<td>MOV</td>
<td>REP</td>
</tr>
<tr>
<td>SENS&lt;1..4&gt;:BAND:VID</td>
<td>&lt;string&gt;</td>
<td></td>
</tr>
<tr>
<td>SENS&lt;1..4&gt;:BWID:VID</td>
<td>&lt;string&gt;</td>
<td></td>
</tr>
<tr>
<td>SENS&lt;1..4&gt;:BUFF:SIZe</td>
<td>&lt;NR1&gt;</td>
<td></td>
</tr>
<tr>
<td>SENS&lt;1..4&gt;:BUFF:STAT</td>
<td>ON</td>
<td>OFF</td>
</tr>
<tr>
<td>SENS&lt;1..4&gt;:BURS:CHOP</td>
<td>ON</td>
<td>OFF</td>
</tr>
<tr>
<td>SENS&lt;1..4&gt;:BURS:DTOL</td>
<td>&lt;NRf&gt;</td>
<td></td>
</tr>
<tr>
<td>SENS&lt;1..4&gt;:CHOP</td>
<td>ON</td>
<td>OFF</td>
</tr>
<tr>
<td>SENS&lt;1..4&gt;:CORR:DCYC</td>
<td>&lt;NRf&gt;</td>
<td></td>
</tr>
<tr>
<td>Command</td>
<td>Preset and *RST value</td>
<td>Remark</td>
</tr>
<tr>
<td>---------</td>
<td>-----------------------</td>
<td>--------</td>
</tr>
<tr>
<td>SENS&lt;1..4&gt;:CORR:DCYC:STAT</td>
<td>ON</td>
<td>OFF</td>
</tr>
<tr>
<td>SENS&lt;1..4&gt;:CORR:FDOT</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>SENS&lt;1..4&gt;:CORR:FDOT:STAT</td>
<td>OFF</td>
<td></td>
</tr>
<tr>
<td>SENS&lt;1..4&gt;:CORR:OFFS</td>
<td>&lt;NRf&gt;</td>
<td></td>
</tr>
<tr>
<td>SENS&lt;1..4&gt;:CORR:OFFS:STAT</td>
<td>ON</td>
<td>OFF</td>
</tr>
<tr>
<td>SENS&lt;1..4&gt;:CORR:SPD:SEL</td>
<td>&lt;NR1&gt;</td>
<td></td>
</tr>
<tr>
<td>SERV&lt;1..4&gt;:DISP:OVER</td>
<td>OFF</td>
<td></td>
</tr>
<tr>
<td>SENS&lt;1..4&gt;:FREQ</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>SENS&lt;1..4&gt;:FUNC</td>
<td>&quot;POW:AVG&quot;</td>
<td></td>
</tr>
<tr>
<td>SENS&lt;1..4&gt;:TGAT&lt;1..4&gt;:MID:OFFS</td>
<td>&lt;NRf&gt;</td>
<td></td>
</tr>
<tr>
<td>SENS&lt;1..4&gt;:TGAT&lt;1..4&gt;:MID</td>
<td>ON</td>
<td>OFF</td>
</tr>
<tr>
<td>SENS&lt;1..4&gt;:TGAT&lt;1..4&gt;:MID:TIME</td>
<td>&lt;NRf&gt;</td>
<td></td>
</tr>
<tr>
<td>SENS&lt;1..4&gt;:TGAT&lt;1..4&gt;:OFFS:TIME</td>
<td>&lt;NRf&gt;</td>
<td></td>
</tr>
<tr>
<td>SENS&lt;1..4&gt;:TGAT:SEL</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>SENS&lt;1..4&gt;:TGAT&lt;1..4&gt;:TIME</td>
<td>&lt;NRf&gt;</td>
<td></td>
</tr>
<tr>
<td>SENS&lt;1..4&gt;:TSL:CHOP</td>
<td>ON</td>
<td>OFF</td>
</tr>
<tr>
<td>SENS&lt;1..4&gt;:TSL:COUNt</td>
<td>&lt;NRf&gt;</td>
<td></td>
</tr>
<tr>
<td>SENS&lt;1..4&gt;:TSL:MID:OFFS</td>
<td>&lt;NRf&gt;</td>
<td></td>
</tr>
<tr>
<td>SENS&lt;1..4&gt;:TSL:MID</td>
<td>ON</td>
<td>OFF</td>
</tr>
<tr>
<td>SENS&lt;1..4&gt;:TSL:MID:TIME</td>
<td>&lt;NRf&gt;</td>
<td></td>
</tr>
<tr>
<td>SENS&lt;1..4&gt;:TSL:WIDTh</td>
<td>&lt;NRf&gt;</td>
<td></td>
</tr>
<tr>
<td>SENS&lt;1..4&gt;:RANG</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>SENS&lt;1..4&gt;:RANG:AUT</td>
<td>ON</td>
<td>OFF</td>
</tr>
<tr>
<td>SENS&lt;1..4&gt;:RANG:CLEV</td>
<td>&lt;NRf&gt;</td>
<td></td>
</tr>
<tr>
<td>SENS&lt;1..4&gt;:RGAM</td>
<td>&lt;NRf&gt;</td>
<td></td>
</tr>
<tr>
<td>SENS&lt;1..4&gt;:RGAM:PHAS</td>
<td>&lt;NRf&gt;</td>
<td></td>
</tr>
<tr>
<td>SENS&lt;1..4&gt;:SAMP</td>
<td>FREQ1</td>
<td>FREQ2</td>
</tr>
<tr>
<td>SENS&lt;1..4&gt;:SGAM</td>
<td>&lt;NRf&gt;</td>
<td></td>
</tr>
<tr>
<td>SENS&lt;1..4&gt;:SGAM:CORR:STAT</td>
<td>ON</td>
<td>OFF</td>
</tr>
<tr>
<td>Command</td>
<td>Preset and *RST value</td>
<td>Remark</td>
</tr>
<tr>
<td>---------</td>
<td>-----------------------</td>
<td>--------</td>
</tr>
<tr>
<td>SEN$[1]..4$::SGAM:PHAS</td>
<td>&lt;NRf&gt;</td>
<td>Depending on sensor.</td>
</tr>
<tr>
<td>SEN$[1]..4$::SMO:STAT</td>
<td>ON</td>
<td>OFF</td>
</tr>
<tr>
<td>SEN$[1]..4$::STAT:OFFS</td>
<td>&lt;NRf&gt;</td>
<td>Depending on sensor.</td>
</tr>
<tr>
<td>SEN$[1]..4$::STAT:SAMP</td>
<td>&lt;NR1&gt;</td>
<td>Depending on sensor.</td>
</tr>
<tr>
<td>SEN$[1]..4$::STAT:SCAL:X:POIN</td>
<td>&lt;NR1&gt;</td>
<td>Depending on sensor.</td>
</tr>
<tr>
<td>SEN$[1]..4$::STAT:SCAL:X:RANG</td>
<td>&lt;NRf&gt;</td>
<td>Depending on sensor.</td>
</tr>
<tr>
<td>SEN$[1]..4$::STAT:SCAL:X:RE</td>
<td></td>
<td>Depending on sensor.</td>
</tr>
<tr>
<td>SEN$[1]..4$::STAT:TIME</td>
<td>&lt;NRf&gt;</td>
<td>Depending on sensor.</td>
</tr>
<tr>
<td>SEN$[1]..4$::TIM:EXCL:STARt</td>
<td>&lt;NRf&gt;</td>
<td>Depending on sensor.</td>
</tr>
<tr>
<td>SEN$[1]..4$::TIM:EXCL:STOP</td>
<td>&lt;NRf&gt;</td>
<td>Depending on sensor.</td>
</tr>
<tr>
<td>SEN$[1]..4$::TRAC:AVER</td>
<td>ON</td>
<td>OFF</td>
</tr>
<tr>
<td>SEN$[1]..4$::TRAC:AVER:COUN</td>
<td>&lt;NR1&gt;</td>
<td>Depending on sensor.</td>
</tr>
<tr>
<td>SEN$[1]..4$::TRAC:AVER:COUN: AUTO</td>
<td>OFF</td>
<td>Depending on sensor.</td>
</tr>
<tr>
<td>SEN$[1]..4$::TRAC:AVER:COUN: AUTO:MTIMe</td>
<td>&lt;NRf&gt;</td>
<td>Depending on sensor.</td>
</tr>
<tr>
<td>SEN$[1]..4$::TRAC:AVER:COUN: AUTO:RES</td>
<td>&lt;NRf&gt;</td>
<td>Depending on sensor.</td>
</tr>
<tr>
<td>SEN$[1]..4$::TRAC:AVER:COUN: AUTO:POIN</td>
<td>&lt;NR1&gt;</td>
<td>Depending on sensor.</td>
</tr>
<tr>
<td>SEN$[1]..4$::TRAC:AVER:COUN: AUTO:NSR</td>
<td>&lt;NRf&gt;</td>
<td>Depending on sensor.</td>
</tr>
<tr>
<td>SEN$[1]..4$::TRAC:AVER:COUN: AUTO:TYPE</td>
<td>RES</td>
<td>NSR</td>
</tr>
<tr>
<td>SEN$[1]..4$::TRAC:AVER:TCON</td>
<td>MOV</td>
<td>REP</td>
</tr>
<tr>
<td>SEN$[1]..4$::TRAC:OFFS:TIME</td>
<td>&lt;NRf&gt;</td>
<td>Depending on sensor.</td>
</tr>
<tr>
<td>SEN$[1]..4$::TRAC:POINt</td>
<td>&lt;NR1&gt;</td>
<td>Depending on sensor.</td>
</tr>
<tr>
<td>SEN$[1]..4$::TRAC:REAL</td>
<td>ON</td>
<td>OFF</td>
</tr>
<tr>
<td>SERV$[1]..4$::SERR</td>
<td>ON</td>
<td>OFF</td>
</tr>
<tr>
<td>SYST:BEEP:NOT:KEY</td>
<td>OFF</td>
<td>No key click.</td>
</tr>
<tr>
<td>SYST:BEEP:NOT:OVER</td>
<td>OFF</td>
<td>No warning on sensor overload.</td>
</tr>
<tr>
<td>SYST:ERR:EXT</td>
<td>OFF</td>
<td>No extended error message for SYST:ERR?</td>
</tr>
<tr>
<td>SYST&lt;[1]..4$::SPEed</td>
<td>NORM</td>
<td>Depending on sensor.</td>
</tr>
<tr>
<td>SYST:STAN:PWS</td>
<td>OFF</td>
<td>Window</td>
</tr>
</tbody>
</table>
## Remote Control - Commands

### Command Table

<table>
<thead>
<tr>
<th>Command</th>
<th>Preset and *RST value</th>
<th>Remark</th>
</tr>
</thead>
<tbody>
<tr>
<td>SYST:STAN:TRIG:SOUR</td>
<td>INT</td>
<td>Internal triggering.</td>
</tr>
<tr>
<td>TRIG:ALL:SYNC</td>
<td>OFF</td>
<td></td>
</tr>
<tr>
<td>TRIG[1..4]:ALL]:ATR</td>
<td>ON</td>
<td>OFF</td>
</tr>
<tr>
<td>TRIG[1..4]:ALL]:COUN</td>
<td>&lt;NR1&gt;</td>
<td>Depending on sensor.</td>
</tr>
<tr>
<td>TRIG[1..4]:ALL]:DELAY</td>
<td>&lt;NRf&gt;</td>
<td>Depending on sensor.</td>
</tr>
<tr>
<td>TRIG[1..4]:ALL]:DEL:AUTO</td>
<td>ON</td>
<td>OFF</td>
</tr>
<tr>
<td>TRIG[1..4]:ALL]:DTIM</td>
<td>&lt;NRf&gt;</td>
<td>Depending on sensor.</td>
</tr>
<tr>
<td>TRIG[1..4]:ALL]:HOLD</td>
<td>&lt;NRf&gt;</td>
<td>Depending on sensor.</td>
</tr>
<tr>
<td>TRIG[1..4]:ALL]:Hyst</td>
<td>&lt;NRf&gt;</td>
<td>Depending on sensor.</td>
</tr>
<tr>
<td>TRIG[1..4]:ALL]:LEV</td>
<td>&lt;NRf&gt;</td>
<td>Depending on sensor.</td>
</tr>
<tr>
<td>TRIG[1..4]:ALL]:MAST</td>
<td>ON</td>
<td>OFF</td>
</tr>
<tr>
<td>TRIG[1..4]:ALL]:SLOP</td>
<td>POS</td>
<td>NEG</td>
</tr>
<tr>
<td>TRIG[1..4]:ALL]:SOUR</td>
<td>IMM</td>
<td>HOLD</td>
</tr>
<tr>
<td>UNIT&lt;[1]..8&gt;:POW</td>
<td>DBM</td>
<td>Logarithmic result scaling.</td>
</tr>
<tr>
<td>UNIT&lt;[1]..8&gt;:POW:RAT</td>
<td>DB</td>
<td>Logarithmic result scaling.</td>
</tr>
</tbody>
</table>

### Usage:

**Event**

*SAV <value>*

SAV stores the current device state under the specified number.

**Parameters:**

<value> 1 to 19

Available storage numbers for device setups.

**Usage:**

**Event**

*SRE <value>*

**Setting command: *SRE**

Service Request Enable sets the service request enable register to the specified value.

Bit 6 (MSS mask bit) remains 0. This command determines under which conditions a service request is generated.

**Query: *SRE**

The query form *SRE? reads the contents of the service request enable register in decimal form. Bit 6 is always 0.

**Parameters:**

<value> 0 to 255
**STB?**

STatus Byte query reads out the contents of the status byte in decimal form.

Usage: Query only

---

**TRG**

TRIGger generates a BUS-trigger event. If the sensor is in the WAIT_FOR_TRG state and the source for the trigger is set to BUS (TRIG:SOUR BUS), the sensor enters the MEASURING state. *TRG invalidates all current measuring results. A query of measurement data following *TRG will thus always return the measured value determined in response to *TRG.

Table 6-3: Error messages:

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-211</td>
<td>Trigger ignored: No sensor is in the WAIT_FOR_TRG state.</td>
</tr>
<tr>
<td>-211</td>
<td>Trigger ignored: A sensor is in the WAIT_FOR_TRG state but the trigger source is not BUS.</td>
</tr>
</tbody>
</table>

Usage: Event

---

**TST? <error code>**

Self TeST query triggers the self test of the instrument and outputs an error code in decimal form.

Parameters:

<table>
<thead>
<tr>
<th>&lt;error code&gt;</th>
<th>0</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>no error</td>
<td>an error has occurred</td>
</tr>
</tbody>
</table>

Usage: Query only

---

**WAI**

WAIT to continue prevents the execution of new commands until one of the following criteria is met:

- All previous commands have been executed.
- A DCL command is received.
- The device is switched off and on again (power-on-reset).

Usage: Event
6.3 Overview of SCPI Command Systems

The SCPI commands are grouped in command systems according to their function. Only the most important functions are shown in the figures.

The commands are separated in high-level commands and low-level commands. The high-level measurement commands combine several low-level setting commands in one command, see chapter 6.4, "High-Level Measurement Commands (CONFigure, MEASure, READ and FETCH)", on page 208.

The individual commands are described in alphabetical order in the following chapters. The high-level measurement commands are put first.

![Fig. 6-1: Overview of SCPI command systems and their mutual interaction](image)

The figure above gives an overview of the SCPI command systems of the R&S NRP2. The measured values are forwarded to the SENSe block where they are processed and handed to the CALCulate blocks. The values from the SENSe block are not immediately made available to the user, but only after they have been processed in the CALCulate blocks. In the CALCulate blocks, the values of several sensors can be processed together before they are output. High-level commands may be used to configure SENSe and CALCulate blocks with a single command. This may considerably simplify operation of the R&S NRP2. The frequency-dependent correction tables for the measured values are managed by the MEMory command system.

<table>
<thead>
<tr>
<th>System</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABORt</td>
<td>Stops the current measurement</td>
</tr>
<tr>
<td>CALCulate</td>
<td>Processes the measured data</td>
</tr>
<tr>
<td>CALibrate</td>
<td>Calibrates the R&amp;S NRP2</td>
</tr>
<tr>
<td>CONFigure</td>
<td>Specifies measurement settings (high-level commands)</td>
</tr>
<tr>
<td>DISPlay</td>
<td>Configures the reading on the R&amp;S NRP2 display.</td>
</tr>
<tr>
<td>FETCH</td>
<td>Retrieves measurement results from the running measurement (high-level commands)</td>
</tr>
</tbody>
</table>
System | Function
---|---
**FORMat** | Sets the data format on the remote control interfaces.
**INITiate** | Starts measurement
**MEASurement** | Configures and starts a measurement (high-level commands)
**MEMORY** | Manages frequency correction tables
**OUTPUT** | Switches the test generator on/off and calibrates it.
**READ** | Starts measurement and retrieves measurement results (high-level commands)
**SENSe** | Configures sensors and determines the processing of the measured data in the sensors
**STATus** | Configures and queries the chapter 5.8.4, "Status Reporting System", on page 184.
**SYSTem** | Performs different system settings that affect the operation of the R&S NRP2.
**TRIGger** | Configures timing conditions for start of measurement
**UNIT** | Sets output unit of the measured values.

### 6.3.1 SENSE System

This command system is used for configuring the sensors and determines the processing of measured data in the sensors. The blocks have the following functions:

<table>
<thead>
<tr>
<th>SENSE Block</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>:RANGe</td>
<td>Shifts the range boundaries to increase the measurement accuracy.</td>
</tr>
<tr>
<td>CALibration</td>
<td>Is a command system of its own and responsible for sensor calibration.</td>
</tr>
<tr>
<td>:CORRection</td>
<td>Corrects measured values in three steps (fixed offset value, frequency-dependent offset value and duty cycle).</td>
</tr>
<tr>
<td>:FREQuency</td>
<td>Determines the timeslot in which power values are averaged.</td>
</tr>
<tr>
<td>:APERture</td>
<td>Determines a measurement mode.</td>
</tr>
<tr>
<td>:TIMing</td>
<td></td>
</tr>
<tr>
<td>:FUNCTION</td>
<td></td>
</tr>
</tbody>
</table>

*Fig. 6-2: SENSE system*
6.3.2 CALCulate System

Eight CALCulate blocks are available to process the data supplied by the sensors. These blocks process the results of up to 2 sensors (primary and secondary channel) together. A calculation function can be selected for this purpose with the aid of MATH:EXPRession. The result can then be correlated to a reference value (:RELative) before it is made available to the user by the :UNIT block. Measured values can be monitored with the :LIMit commands.

6.4 High-Level Measurement Commands (CONFigure, MEASure, READ and FETCH)

6.4.1 High-level measurement commands

The high-level measurement commands

- CONFigure,
- MEASure,
- READ
- FETCH

combine several low level setting commands and thus simplify programming of the R&S NRP2. The most convenient command is MEASure. This command configures sensors and calculate blocks, initiates a measurement and provides measurement results. The other commands perform only portions of these functions and thus allow the user to make specific modifications between the individual steps.
Strictly speaking, the **CONFigure** command is not a measurement command because it does not yield data and only configures a measurement. It differs from the other three high-level measurement commands as follows: a question mark at the end of the command provides information on current settings. With other commands, the question mark is compulsory and shows that the measured data is queried.

In general, the low level commands which are determining qualitative parameters such as measurement mode and calculation function are replaced by keywords in the command header.

**Example:**

Selection of measurement mode "T'slot" is performed by low level command

\[ \text{SENS}:\text{FUNCTION 'POWer:TSLot:AVG'} \]

or by all high level commands which contain TSLot in the header, e.g. **MEASure:TSLot:....** With high level command, in addition to selecting the measurement mode several presettings for this mode are performed.

Selection of the calculation function "Sum" is performed with low level command

\[ \text{CALCulate:MATH 'SENS1+SENS2'} \]

or by all high level commands which contain SUM in the header, e.g. **MEASure:TSLot:SUM**.

Quantitative parameters such as number of slots are set by means of a parameter list which is sent with the **MEASure** and **CONFigure** commands. The parameter list is specific for each measurement mode. Thus, a configuration that requires several low level commands is achieved by one high level command.

**Example:**

**MEASure:XTIMe:RAT? 312,5,(@1),(@2)**

replaces the low level commands

- TRIGger:SOURce EXT
- TRIGger:COUNt 1
- TRIGger:DE Lay:AUTO ON
- SENSE:AVERage ON
- SENSE:FUNCTION 'XTIMe:POWer'
- SENSE:TRACe:TIME 5
- SENSE:TRACe:POINts 312
- CALCulate:MATH '(SENS1+SENS2)'
- INITiate:CONTinuous OFF
- INITiate
- FETCH?
With the **FETCh** and **READ** commands, the parameter list is used to crosscheck the settings of the instrument with the settings given in the list. If the settings do not agree, command execution is aborted. **FETCh** and **READ** can also be used as low level commands. In this case, they only retrieve current the measurement result (**FETCh?**) or start a measurement and retrieve the measurement result (**READ?**).

**CONFigure:**

The **CONFigure:** commands define the calculation function and configure the associated sensors by means of the parameter list (see chapter 6.4.4, "Parameter list description", on page 212 for an overview of the parameters). A measurement is not started. A question mark at the end of the command provides information on the parameters transferred by the last **CONFigure** or **MEASure** command, respectively. Since the device settings can be changed after a **CONFigure**, the query does not return the current device setup. **CONFigure** is performed internally mostly by **SENSe** and **CALCulate** commands. One or several measurement channels are configured as follows:

<table>
<thead>
<tr>
<th>Command</th>
<th>Measurement mode:</th>
<th>ContAv</th>
<th>Burst</th>
<th>Timeslot</th>
<th>Trace/Statistics</th>
</tr>
</thead>
<tbody>
<tr>
<td>INIT:CONT</td>
<td></td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
</tr>
<tr>
<td>TRIG:SOUR</td>
<td></td>
<td>IMM</td>
<td>INT</td>
<td>EXT</td>
<td>EXT</td>
</tr>
<tr>
<td>TRIG:COUN</td>
<td></td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>TRIG:DEL:AUTO</td>
<td></td>
<td>ON</td>
<td>ON</td>
<td>ON</td>
<td>ON</td>
</tr>
<tr>
<td>SENS:AVER:COUN:AUTO</td>
<td></td>
<td>ON</td>
<td>ON</td>
<td>ON</td>
<td>-</td>
</tr>
<tr>
<td>SENS:AVER:COUN:AUTO:TYPE</td>
<td></td>
<td>ON</td>
<td>ON</td>
<td>ON</td>
<td>-</td>
</tr>
<tr>
<td>SENS:AVER:COUN:AUTO:SLOT</td>
<td></td>
<td>-</td>
<td>-</td>
<td>1</td>
<td>-</td>
</tr>
<tr>
<td>SENS:AVER:STAT</td>
<td></td>
<td>ON</td>
<td>ON</td>
<td>ON</td>
<td>ON</td>
</tr>
<tr>
<td>SENS:FUNCTION</td>
<td>'POWER:AVG'</td>
<td>'POWer: BURSt:AVG'</td>
<td>'POWer: TSLot:AVG'</td>
<td>'XTIME: POWER'</td>
<td></td>
</tr>
<tr>
<td></td>
<td>'POWer: BURSt:AVG'</td>
<td></td>
<td>'POWer: TSLot:AVG'</td>
<td></td>
<td>'XPOWer: CCDF'</td>
</tr>
<tr>
<td></td>
<td>'XTIME: POWER'</td>
<td></td>
<td></td>
<td></td>
<td>'XPOWer: PDF'</td>
</tr>
</tbody>
</table>

The configuration of the calculation function (**CALCulate:MATH** and **CALCulate:REL** commands) depends on the given high level command.

**FETCh:**?

The **FETCh:**? command returns the last valid measurement result. The command is only completed after a valid measurement has been performed.
In compliance with SCPI 1999.0, different results can be queried with \texttt{FETCh} without having to restart a measurement. This is the case if only the keywords for the calculation function (e.g. \texttt{:RATio:RELative}) is changed.

In all other cases, e.g. changing the measurement function, an SCPI error (-221, Setting conflict) is returned and the command aborted.

**Example:**

Valid command sequence:

\begin{verbatim}
FETCh:TSLot:SUM? 577us,8,0,0
FETCh:TSLot:SUM:RELative? 577us,8,0,0
\end{verbatim}

Invalid command sequence:

\begin{verbatim}
FETCh:BURSt:SUM? 0,0,0
FETCh:TSLot:SUM? 577us,8,0,0
\end{verbatim}

**READ...?**

The \texttt{READ...?} command starts a measurement without further configuration and returns the measurement result. The parameter list is compared to the current settings before the measurement is started. If the list does not agree, an SCPI error (-221, Setting conflict) is returned and the command is aborted. Apart from this check, \texttt{READ} corresponds to the program message \texttt{INIT:IMM; FETCh[1..8]:...?}.

**MEASure...?**

The \texttt{MEASure...?} command combines \texttt{CONFigure} and \texttt{READ}.

Refer to annex chapter A.4, "Programming Measurements", on page 379 for application examples to the high level measurement commands.

---

### 6.4.2 Basic Commands FETCh? and READ?

**FETCh?**

The command \texttt{FETCh?} without further keywords and parameter list has a special meaning. While omitting parameters of the parameter list normally means that default values are used and checked, the current measured value under \texttt{FETCh?} is supplied when it is valid. If a measured value is not yet available, processing is suspended until a valid result is available.

**Usage:**

Query only

**READ?**

The \texttt{READ?} command without further keywords and parameter list can be compared with \texttt{FETCh?.READ?} starts a measurement and returns a measured value without checking the current settings.
### 6.4.3 Syntactical Structure of High-Level Measurement Commands

The high-level measurement commands can be generally represented as follows:

\[
<head><meas\_mode>\,[calc\_function>][?] <parameter\_list>
\]

| `<head>`  | The `<head>` keywords select the high level command subsystem. Command keywords are:
|-----------|--------------------------------------------------|
|           | - `CONFigure[1]..8>
|           | - `FETCH[1]..8>
|           | - `MEASure[1]..8>
|           | - `READ[1]..8>

| `<meas\_mode>`  | The `<meas\_mode>` keywords select the measurement mode (ContAv, ContAv with data buffering, Burst, Timeslot, Trace, or Statistics, see also the low-level command `SENSe1..4>:FUnction[:ON]` on page 269). Command keywords are:
|-----------------|----------------------------------------------------------------------------------|
|                 | - `[:SCALar][:POWer][:AVG]` (ContAv mode)
|                 | - `[:SCALar][:POWer]:TSLot` (Timeslot mode)
|                 | - `[:SCALar][:POWer]:BURSt` (Burst mode)
|                 | - `:ARRay [:POWer][:AVG]` (ContAv with data buffering mode)
|                 | - `:XTIMe [:POWer]` (Trace mode)
|                 | - `:STATistics:CCDF` (Statistics mode)
|                 | - `:STATistics:PDF` (Statistics mode)

| `<calc\_function>`  | The `<calc\_function>` keywords select the calculation function, see also the low-level command `CALCulate[1]..8>:MATH[:EXPRession]` on page 231). If `<calc\_function>` is not specified, the measured value of the primary channel is output. Command keywords are:
|---------------------|----------------------------------------------------------------------------------|
|                     | - `:RELative`
|                     | - `:DIFFerence`
|                     | - `:DIFFerence:RELative`
|                     | - `:SUM`
|                     | - `:SUM:RELative`
|                     | - `:RATio`
|                     | - `:RATio:RELative`
|                     | - `:RLOSs`
|                     | - `:SWR`
|                     | - `:REFLection`

| `[]?`  | The `[]?` terminates the measurement commands which are always queries. Measurement commands are the `FETCH:...?, READ:...?` and `MEASurement:...?` commands.

| `<parameter\_list>`  | A list with parameters is sent with the high level command. The meaning of the parameters is determined by the `<meas\_mode>`, see chapter 6.4.4, "Parameter list description", on page 212.

### 6.4.4 Parameter list description

Six different parameter lists are used in the high end measurement commands. Which list is used depends on the selected measurement mode. The elements of these lists can be omitted starting at the end and working backward. They will then be replaced by their default values.
Parameter lists for the different measurement modes

- measurement mode ContAV:
  
  \[ [<\text{expected}\_\text{value}> [,<\text{resolution}>] ] [,<\text{source}\_\text{list}>] \]

- measurement mode T’slot:
  
  \(<\text{tslot}\_\text{width}>, <\text{no}\_\text{slots}>, <\text{start}\_\text{exclude}>, <\text{end}\_\text{exclude}>,
  [<\text{expected}\_\text{value}> [,<\text{resolution}>] ] [,<\text{source}\_\text{list}>] \]

- measurement mode Burst:
  
  \(<\text{dtolerance}>, <\text{start}\_\text{exclude}>, <\text{end}\_\text{exclude}>, [<\text{expected}\_\text{value}> [,<\text{resolution}>] ] [,<\text{source}\_\text{list}>] \]

- measurement mode ContAv (with data buffering)
  
  \(<\text{buffered}\_\text{size}>, [<\text{expected}\_\text{value}> [,<\text{resolution}>] ] [,<\text{source}\_\text{list}>] \]

- measurement mode Trace:
  
  \(<\text{scope}\_\text{size}>, <\text{capture}\_\text{time}>, [,<\text{source}\_\text{list}>] \)

- measurement mode Statistics:
  
  \(<\text{statistics}\_\text{size}>, <\text{capture}\_\text{time}>, [,<\text{source}\_\text{list}>] \)

The elements of the parameter lists have the following meaning:

Table 6-6: Description of the parameters in the parameter list in alphabetical order

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(&lt;\text{buffered}_\text{size}&gt;)</td>
<td>Value range: depending on sensor. Default value: depending on sensor. Unit: - Number of requested measured values. Corresponds to command: ([\text{SENSe}{1}..4}]:\text{POWer}[:\text{AVG}]:\text{BUFFER}:\text{SIZE}) on page 272.</td>
</tr>
<tr>
<td>(&lt;\text{capture}_\text{time}&gt;)</td>
<td>Value range: depending on sensor. Unit: S Default value: depending on sensor. Period within which measured data are captured in the Trace mode. Corresponds to command: ([\text{SENSe}{1}..4}]:\text{TRACe}:\text{TIME}) on page 293. Period within which measured data are captured in the STATistics mode. Corresponds to command: ([\text{SENSe}{1}..4}]:\text{STATistics}:\text{TIME}) on page 283.</td>
</tr>
<tr>
<td>(&lt;\text{dtolerance}&gt;)</td>
<td>Value range: depending on sensor. Unit: S Default value: depending on sensor. The length of a time interval in which the power level may drop below the trigger level without the end of a power pulse being detected. Corresponds to command: ([\text{SENSe}{1}..4}]:\text{POWer}:\text{BURSt}:\text{DTOLerance}) on page 274.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value range</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
</tr>
<tr>
<td>&lt;end_exclue&gt;</td>
<td>depending on sensor</td>
</tr>
<tr>
<td>&lt;expected_value&gt;</td>
<td>float_value</td>
</tr>
<tr>
<td>&lt;no_slots&gt;</td>
<td>depending on sensor</td>
</tr>
<tr>
<td>&lt;resolution&gt;</td>
<td>1</td>
</tr>
<tr>
<td>Example:</td>
<td>If &lt;resolution&gt; is set to 3 or 0.01, three significant points are assigned to the value when it is displayed on a linear scale. When a log scale is used, 2 places are displayed after the decimal point.</td>
</tr>
<tr>
<td>&lt;scope_size&gt;</td>
<td>depending on sensor</td>
</tr>
</tbody>
</table>
**6.4.5 Calculation functions - High level commands**

For high level commands, the calculation function is selected by the keyword in the command header.

For high level commands, the calculation function is selected by the keyword in the command header. The following calculation functions are available for calculating the primary channel (PC) and the secondary channel (SC). The primary and secondary channel are set by the parameter `<source_list>` in the parameter list.

The reference value for the calculation of relative values has to be set beforehand using one of the following commands:

- `CALCulate[1..8]:RELative::MAGNitude`
- `CALCulate[1..8]:RELative:AUTO`
### Table 6-7: One-channel functions \((<source_list> = (@n); n = 1,2,3,4)\).

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>-</code> PC</td>
<td>Yields the measured average power of the sensor assigned to the PC.</td>
</tr>
<tr>
<td>`:RELative` PC</td>
<td>The value measured in the PC is divided by the reference value.</td>
</tr>
</tbody>
</table>

For high level commands, the calculation function is selected by the keyword in the command header. The following calculation functions are available for calculating the primary channel (PC) and the secondary channel (SC). The primary and secondary channel are set by the parameter \(<source_list>\) in the parameter list.

### Table 6-8: Two-channel functions \((<source_list> = (@n),(@m); n = 1,2,3,4; m = 1,2,3,4)\)

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>`:DIFFerence` PC-SC</td>
<td>Yields the difference between the PC and SC. This means that two sensors must be specified in (&lt;source_list&gt;). This also applies to the following functions.</td>
</tr>
<tr>
<td>`:DIFFerence:` RELative PC-SC</td>
<td>The difference between the PC and SC is divided by the reference value.</td>
</tr>
<tr>
<td>`:SUM` PC+SC</td>
<td>Yields the sum of the PC and SC. The (&lt;source_list&gt;) must therefore contain two sensors. This also applies to the following functions.</td>
</tr>
<tr>
<td>`:SUM:` RELative PC+SC</td>
<td>The sum of the PC and SC is divided by the reference value.</td>
</tr>
<tr>
<td>`:RATio` PC SC</td>
<td>Yields the ratio of PC to SC.</td>
</tr>
<tr>
<td>`:RATio:` RELative (PC/SC)</td>
<td>The ratio of the PC and SC is divided by the reference value.</td>
</tr>
<tr>
<td>`:SWR` PC SC</td>
<td>If the forward power of a wave is measured in the PC and the reflected power in the SC, the measurement command yields the standing wave ratio. The output unit is set to &quot;One&quot; (UNIT:RAT ).</td>
</tr>
</tbody>
</table>
If the forward power of a wave is measured in the PC and the reflected/transmitted power in the SC, the calculate block yields the reflection coefficient/transmission factor of the DUT. The output unit is set to "One" (UNIT: RAT O).

$$\sqrt{SC / PC}$$

If the forward power of a wave is measured in the PC and the reflected or transmitted power in the SC, the calculate block yields the return loss/transmission loss of the DUT. This function principally yields the same result as the :RATio function. The only difference is the output unit which is automatically set to dB by means of this command (UNIT: RAT DB).

$$-20 \log_{10} \sqrt{SC / PC}$$

6.4.6 CONFigure commands

This chapter lists all CONFigure commands. For a description of the command syntax, the calculation functions and the parameter list see chapter 6.4.3, "Syntactical Structure of High-Level Measurement Commands ", on page 212, chapter 6.4.5, "Calculation functions - High level commands", on page 215, and chapter 6.4.4, "Parameter list description", on page 212.

CONFigure<[1]..8>[:SCALar][:POWer][:AVG]
CONFigure<[1]..8>[:SCALar][:POWer][:AVG]:RELative
CONFigure<[1]..8>[:SCALar][:POWer][:AVG]:DIFFerence
CONFigure<[1]..8>[:SCALar][:POWer][:AVG]:DIFFerence:RELative
CONFigure<[1]..8>[:SCALar][:POWer][:AVG]:SUM
CONFigure<[1]..8>[:SCALar][:POWer][:AVG]:SUM:RELative
CONFigure<[1]..8>[:SCALar][:POWer][:AVG]:RATio
CONFigure<[1]..8>[:SCALar][:POWer][:AVG]:RATio:RELative
CONFigure<[1]..8>[:SCALar][:POWer][:AVG]:SWR
CONFigure<[1]..8>[:SCALar][:POWer][:AVG]:REFLection
CONFigure<[1]..8>[:SCALar][:POWer][:AVG]:RLOSs
[<expected_value>[,<resolution>]],<source_list>

CONFigure commands for measurement mode ContAv.

CONFigure<[1]..8>[:SCALar][:POWer]:TSLot
CONFigure<[1]..8>[:SCALar][:POWer]:TSLot:RELative
CONFigure<[1]..8>[:SCALar][:POWer]:TSLot:DIFFerence
CONFigure<[1]..8>[:SCALar][:POWer]:TSLot:DIFFerence:RELative
CONFigure<[1]..8>[:SCALar][:POWer]:TSLot:SUM
CONFigure<[1]..8>[:SCALar][:POWer]:TSLot:SUM:RELative
CONFigure<[1]..8>[:SCALar][:POWer]:TSLot:RATio
CONFigure<[1]..8>[:SCALar][:POWer]:TSLot:RATio:RELative
CONFigure<[1]..8>[:SCALar][:POWer]:TSLot:SWR
CONFigure<1..8>:SCALar[:POWer]:TSLot:REFLection
CONFigure<1..8>:SCALar[:POWer]:TSLot:RLOSs <slot_width>, <no_slots>, <start_exclude>, <end_exclude>, [<expected_value> [<resolution>]]
[,<source_list>]
CONFigure commands for measurement mode T'Slot.

CONFigure<1..8>:SCALar[:POWer]:BURSt
CONFigure<1..8>:SCALar[:POWer]:BURSt:RELative
CONFigure<1..8>:SCALar[:POWer]:BURSt:DIFFerence
CONFigure<1..8>:SCALar[:POWer]:BURSt:DIFFerence:RELative
CONFigure<1..8>:SCALar[:POWer]:BURSt:SUM
CONFigure<1..8>:SCALar[:POWer]:BURSt:SUM:RELative
CONFigure<1..8>:SCALar[:POWer]:BURSt:RATio
CONFigure<1..8>:SCALar[:POWer]:BURSt:RATio:RELative
CONFigure<1..8>:SCALar[:POWer]:BURSt:SWR
CONFigure<1..8>:SCALar[:POWer]:BURSt:REFLection
CONFigure<1..8>:SCALar[:POWer]:BURSt:RLOSs <dtolerance>, <start_exclude>, <end_exclude>, [<expected_value> [<resolution>]]
[,<source_list>]
CONFigure commands for measurement mode Burst.

CONFigure<1..8>:ARRay[:POWer][:AVG]
CONFigure<1..8>:ARRay[:POWer][:AVG]:RELative
CONFigure<1..8>:ARRay[:POWer][:AVG]:DIFFerence
CONFigure<1..8>:ARRay[:POWer][:AVG]:DIFFerence:RELative
CONFigure<1..8>:ARRay[:POWer][:AVG]:SUM
CONFigure<1..8>:ARRay[:POWer][:AVG]:SUM:RELative
CONFigure<1..8>:ARRay[:POWer][:AVG]:RATio
CONFigure<1..8>:ARRay[:POWer][:AVG]:RATio:RELative
CONFigure<1..8>:ARRay[:POWer][:AVG]:SWR
CONFigure<1..8>:ARRay[:POWer][:AVG]:REFLection
CONFigure<1..8>:ARRay[:POWer][:AVG]:RLOSs <buffered_size>, [<expected_value>[,<resolution>]] [,<source_list>]
CONFigure commands for measurement mode ContAv with buffering.

CONFigure<1..8>:XTIMe[:POWer]
CONFigure<1..8>:XTIMe[:POWer]:RATio (<scope_size>), <capture_time> [,<source_list>]
CONFigure commands for measurement mode Trace.

CONFigure<5..8>:XTIMe[:POWer]:NONE
Measurement mode Trace only:
Deactivates trace 2. In contrast to trace 1 which is always active, trace 2 can be deactivated. Trace 2 is associated with CALCulate5..8 and therefore, also with CONFigure5..8 (see also chapter 6.5, "CALCulate (Configuration of Calculate Blocks)", on page 224).

Usage: Event

CONFigure<[1]..8>:STATistics:CCDF
CONFigure<[1]..8>:STATistics:PDF (<statistics_size>, <capture_time>
   [,<source_list>]
CONFigure commands for measurement mode Statistics.

6.4.7 Fetch commands

This chapter lists all FETCH commands. For a description of the command syntax, the calculation functions and the parameter list see chapter 6.4.3, "Syntactical Structure of High-Level Measurement Commands ", on page 212, chapter 6.4.5, "Calculation functions - High level commands", on page 215, and chapter 6.4.4, "Parameter list description", on page 212.

FETCH<[1]..8>[:SCALar][:POWer][:AVG]
FETCH<[1]..8>[:SCALar][:POWer][:AVG]:RELative
FETCH<[1]..8>[:SCALar][:POWer][:AVG]:DIFFerence
FETCH<[1]..8>[:SCALar][:POWer][:AVG]:DIFFerence:RELative
FETCH<[1]..8>[:SCALar][:POWer][:AVG]:SUM
FETCH<[1]..8>[:SCALar][:POWer][:AVG]:SUM:RELative
FETCH<[1]..8>[:SCALar][:POWer][:AVG]:RATio
FETCH<[1]..8>[:SCALar][:POWer][:AVG]:RATio:RELative
FETCH<[1]..8>[:SCALar][:POWer]:SWR
FETCH<[1]..8>[:SCALar][:POWer]:REFlection
FETCH<[1]..8>[:SCALar][:POWer][:AVG]:RLOSS [<expected_value>[,<resolution>]}
   [,<source_list>]
FETCH commands for measurement mode ContAv.
FETCh<1..8>[:SCALar]:POWer:TSLot:REFLection
FETCh<1..8>[:SCALar]:POWer:TSLot:RLOSs <tslot_width>, <no_slots>, <start_exclude>, <end_exclude>, [<expected_value> [,<resolution>]] [,<source_list>]
FETCh commands for measurement mode T'Slot.

FETCh<1..8>[:SCALar]:POWer:BURSt
FETCh<1..8>[:SCALar]:POWer:BURSt:RELative
FETCh<1..8>[:SCALar]:POWer:BURSt:DIFFerence
FETCh<1..8>[:SCALar]:POWer:BURSt:DIFFerence:RELative
FETCh<1..8>[:SCALar]:POWer:BURSt:SUM
FETCh<1..8>[:SCALar]:POWer:BURSt:SUM:RELative
FETCh<1..8>[:SCALar]:POWer:BURSt:RATio
FETCh<1..8>[:SCALar]:POWer:BURSt:RATio:RELative
FETCh<1..8>[:SCALar]:POWer:BURSt:SWR
FETCh<1..8>[:SCALar]:POWer:BURSt:REFLection
FETCh<1..8>[:SCALar]:POWer:BURSt:RLOSs <dtolerance>, <start_exclude>, <end_exclude>, [<expected_value> [,<resolution>]] [,<source_list>]
FETCh commands for measurement mode Burst.

FETCh<1..8>:ARRay[:POWer][:AVG]
FETCh<1..8>:ARRay[:POWer][:AVG]:RELative
FETCh<1..8>:ARRay[:POWer][:AVG]:DIFFerence
FETCh<1..8>:ARRay[:POWer][:AVG]:DIFFerence:RELative
FETCh<1..8>:ARRay[:POWer][:AVG]:SUM
FETCh<1..8>:ARRay[:POWer][:AVG]:SUM:RELative
FETCh<1..8>:ARRay[:POWer][:AVG]:RATio
FETCh<1..8>:ARRay[:POWer][:AVG]:RATio:RELative
FETCh<1..8>:ARRay[:POWer][:AVG]:SWR
FETCh<1..8>:ARRay[:POWer][:AVG]:REFLection
FETCh<1..8>:ARRay[:POWer][:AVG]:RLOSs (<buffered_size>), [<expected_value>[,<resolution>]] [,<source_list>]
FETCh commands for measurement mode ContAv with buffering.

FETCh<1..8>:XTIMe[:POWer]
FETCh<1..8>:XTIMe[:POWer]:RATio (<scope_size>), <capture_time> [,<source_list>]
FETCh commands for measurement mode Trace.

FETCh<1..8>:STATistics:CCDF
FETCh<1..8>:STATistics:PDF (<statistics_size>), <capture_time> [,<source_list>]
FETCh commands for measurement mode Statistics.
6.4.8 READ commands

This chapter lists all READ commands. For a description of the command syntax, the calculation functions and the parameter list see chapter 6.4.3, "Syntactical Structure of High-Level Measurement Commands ", on page 212, chapter 6.4.5, "Calculation functions - High level commands", on page 215, and chapter 6.4.4, "Parameter list description", on page 212.

READ<[1].8>:SCALar[:POWer][:AVG]
READ<[1].8>:SCALar[:POWer][:AVG]:RELative
READ<[1].8>:SCALar[:POWer][:AVG]:DIFFerence
READ<[1].8>:SCALar[:POWer][:AVG]:DIFFerence:RELative
READ<[1].8>:SCALar[:POWer][:AVG]:SUM
READ<[1].8>:SCALar[:POWer][:AVG]:SUM:RELative
READ<[1].8>:SCALar[:POWer][:AVG]:RATio
READ<[1].8>:SCALar[:POWer][:AVG]:RATio:RELative
READ<[1].8>:SCALar[:POWer][:AVG]:SWR
READ<[1].8>:SCALar[:POWer][:AVG]:REFLection
READ<[1].8>:SCALar[:POWer][:AVG]:RLOSs [<expected_value>, [<resolution>]]
READ commands for measurement mode ContAv.

READ<[1].8>:SCALar[:POWer]:TSLot
READ<[1].8>:SCALar[:POWer]:TSLot:RELative
READ<[1].8>:SCALar[:POWer]:TSLot:DIFFerence
READ<[1].8>:SCALar[:POWer]:TSLot:DIFFerence:RELative
READ<[1].8>:SCALar[:POWer]:TSLot:SUM
READ<[1].8>:SCALar[:POWer]:TSLot:SUM:RELative
READ<[1].8>:SCALar[:POWer]:TSLot:RATio
READ<[1].8>:SCALar[:POWer]:TSLot:RATio:RELative
READ<[1].8>:SCALar[:POWer]:TSLot:SWR
READ<[1].8>:SCALar[:POWer]:TSLot:REFLection
READ<[1].8>:SCALar[:POWer]:TSLot:RLOSs <tslot_width>, <no_slots>,
<start_exclude>, <end_exclude>, [<expected_value> [, <resolution>]]
[,<source_list>]
READ commands for measurement mode T'Slot.

READ<[1].8>:SCALar[:POWer]:BURSt
READ<[1].8>:SCALar[:POWer]:BURSt:RELative
READ<[1].8>:SCALar[:POWer]:BURSt:DIFFerence
READ<[1].8>:SCALar[:POWer]:BURSt:DIFFerence:RELative
READ<[1].8>:SCALar[:POWer]:BURSt:SUM
READ<[1].8>:SCALar[:POWer]:BURSt:SUM:RELative
READ<[1].8>:SCALar[:POWer]:BURSt:RATio
READ<[1].8>:SCALar[:POWer]:BURSt:RATio:RELative
READ<[1].8>:SCALar[:POWer]:BURSt:SWR
6.4.9 MEASurement commands

This chapter lists all MEASurement commands. For a description of the command syntax, the calculation functions and the parameter list see chapter 6.4.3, "Syntactical Structure of High-Level Measurement Commands ", on page 212, chapter 6.4.5, "Calculation functions - High level commands", on page 215, and chapter 6.4.4, "Parameter list description", on page 212.

MEASurement<1[.8]>[:SCALar][:POWer][:AVG]
MEASurement<1[.8]>[:SCALar][:POWer][:AVG]:RELative
MEASurement<1[.8]>[:SCALar][:POWer][:AVG]:DIFFerence
MEASurement<1[.8]>[:SCALar][:POWer][:AVG]:DIFFerence:RELative
MEASurement<1[.8]>[:SCALar][:POWer][:AVG]:SUM
MEASurement<1[.8]>[:SCALar][:POWer][:AVG]:SUM:RELative
MEASurement<1[.8]>[:SCALar][:POWer][:AVG]:RATio
MEASurement<1[.8]>[:SCALar][:POWer][:AVG]:RATio:RELative
MEASurement<[1]..8>[:SCALar][:POWer][:AVG]:SWR
MEASurement<[1]..8>[:SCALar][:POWer][:AVG]:REFlection
MEASurement<[1]..8>[:SCALar][:POWer][:AVG]:RLOSs
  [<expected_value> [, <resolution> ] ] [, <source_list> ]
MEASurement commands for measurement mode ContAv.

MEASurement<[1]..8>[:SCALar][:POWer]:TSLot
MEASurement<[1]..8>[:SCALar][:POWer]:TSLot:RELative
MEASurement<[1]..8>[:SCALar][:POWer]:TSLot:DIFFerence
MEASurement<[1]..8>[:SCALar][:POWer]:TSLot:DIFFerence:RELative
MEASurement<[1]..8>[:SCALar][:POWer]:TSLot:SUM
MEASurement<[1]..8>[:SCALar][:POWer]:TSLot:SUM:RELative
MEASurement<[1]..8>[:SCALar][:POWer]:TSLot:RATio
MEASurement<[1]..8>[:SCALar][:POWer]:TSLot:RATio:RELative
MEASurement<[1]..8>[:SCALar][:POWer]:TSLot:SWR
MEASurement<[1]..8>[:SCALar][:POWer]:TSLot:REFlection
MEASurement<[1]..8>[:SCALar][:POWer]:TSLot:RLOSs
  <tslot_width>, <no_slots>,
  <start_exclude>, <end_exclude>, [<expected_value> [, <resolution> ] ]
  [, <source_list> ]
MEASurement commands for measurement mode T'Slot.

MEASurement<[1]..8>[:SCALar][:POWer]:BURSt
MEASurement<[1]..8>[:SCALar][:POWer]:BURSt:RELative
MEASurement<[1]..8>[:SCALar][:POWer]:BURSt:DIFFerence
MEASurement<[1]..8>[:SCALar][:POWer]:BURSt:DIFFerence:RELative
MEASurement<[1]..8>[:SCALar][:POWer]:BURSt:SUM
MEASurement<[1]..8>[:SCALar][:POWer]:BURSt:SUM:RELative
MEASurement<[1]..8>[:SCALar][:POWer]:BURSt:RATio
MEASurement<[1]..8>[:SCALar][:POWer]:BURSt:RATio:RELative
MEASurement<[1]..8>[:SCALar][:POWer]:BURSt:SWR
MEASurement<[1]..8>[:SCALar][:POWer]:BURSt:REFlection
MEASurement<[1]..8>[:SCALar][:POWer]:BURSt:RLOSs <dtolerance>,
  <start_exclude>, <end_exclude>, [<expected_value> [, <resolution> ] ]
  [, <source_list> ]
MEASurement commands for measurement mode Burst.

MEASurement<[1]..8>:ARRay[:POWer][:AVG]
MEASurement<[1]..8>:ARRay[:POWer][:AVG]:RELative
MEASurement<[1]..8>:ARRay[:POWer][:AVG]:DIFFerence
MEASurement<[1]..8>:ARRay[:POWer][:AVG]:DIFFerence:RELative
MEASurement<[1]..8>:ARRay[:POWer][:AVG]:SUM
MEASurement<[1]..8>:ARRay[:POWer][:AVG]:SUM:RELative
MEASurement<[1]..8>:ARRay[:POWer][:AVG]:RATio
MEASurement<[1]..8>:ARRay[:POWer][:AVG]:RATio:RELative
MEASurement<[1]..8>:ARRay[:POWer][:AVG]:SWR
MEASurement<[1]..8>:ARRay[:POWer][:AVG]:REFLection
MEASurement<[1]..8>:ARRay[:POWer][:AVG]:RLOSs (<buffered_size>),
[<expected_value>[,.<resolution>]],[<source_list>]
MEASurement commands for measurement mode ContAv with buffering.

MEASurement<[1]..8>:XTIMe[:POWer]
MEASurement<[1]..8>:XTIMe[:POWer]:RATio (<scope_size>), <capture_time>
[<source_list>]
MEASurement commands for measurement mode Trace.

MEASurement<[1]..8>:STATistics:CCDF
MEASurement<[1]..8>:STATistics:PDF (<statistics_size>), <capture_time>
[<source_list>]
MEASurement commands for measurement mode Statistics.

6.5 CALCulate (Configuration of Calculate Blocks)

The calculate blocks calculating the measurement results from the sensor data are
configured with the CALCulate command. Eight blocks are available, each with two
input channels (primary and secondary channel). The available sensors (1 to 4,
depending on device configuration and connected sensors) can be assigned to the
channels. With the aid of a selectable function (CALC:MATH), the channels can be pro-
cessed together.

Suffix <1..8> behind the CALCulate key word denotes the CALCulate block. Each
CALCulate block is assigned a measurement window. The R&S R&S NRP2 can dis-
play up to four windows with measurement results.

In the digital "Dig" and digital/analog "D&A" mode CALCulate blocks 1 to 4 are asso-
ciated with the windows 1 to 4. In the graphical "Graph" mode, the CALCulate blocks
1 to 8 are associated with the measurement windows and the traces as follows:

<table>
<thead>
<tr>
<th>Calculate block</th>
<th>Window</th>
<th>Trace</th>
</tr>
</thead>
<tbody>
<tr>
<td>1...4</td>
<td>1...4</td>
<td>1</td>
</tr>
<tr>
<td>5...8</td>
<td>1...4</td>
<td>2</td>
</tr>
</tbody>
</table>

Suffix <1|2> behind the FEED key word word assigns a sensor to the primary or secon-
dary channel.
CALCulate<[1]..8>:LIMit:CLEar:AUTO ................................................................. 227
CALCulate<[1]..8>:LIMit:FAIL? ........................................................................ 228
CALCulate<[1]..8>:LIMit:FCOunt? ................................................................. 228
CALCulate<[1]..8>:LIMit:LOWer[:DATA] .................................................... 228
CALCulate<[1]..8>:LIMit:LOWer[:DATA]:POWer ...................................... 229
CALCulate<[1]..8>:LIMit:LOWer[:DATA]:RATio ......................................... 229
CALCulate<[1]..8>:LIMit:LOWer:STATe ..................................................... 229
CALCulate<[1]..8>:LIMit:STATe ................................................................. 229
CALCulate<[1]..8>:LIMit:UPPer[:DATA] .......................................................... 230
CALCulate<[1]..8>:LIMit:UPPer[:DATA]:POWer ..................................... 230
CALCulate<[1]..8>:LIMit:UPPer[:DATA]:RATio ......................................... 230
CALCulate<[1]..8>:LIMit:UPPer:STATe ..................................................... 230
CALCulate<[1]..8>:MATH[:EXPRession] ............................................................ 231
CALCulate<[1]..8>:MATH[:EXPRession]:CATalog? ........................................ 232
CALCulate<[1]..8>:MAXimum:DATA? ................................................................. 232
CALCulate<[1]..8>:MINimum:DATA? ................................................................. 232
CALCulate<[1]..8>:MEAN:DATA? ................................................................. 232
CALCulate<[1]..8>:PTPeak:DATA? ................................................................. 233
CALCulate<[1]..8>:RELative[:MAGNitude] .................................................... 233
CALCulate<[1]..8>:RELative[:MAGNitude]:AUTO ..................................... 233
CALCulate<[1]..8>:RELative:POWer[:MAGNitude] ..................................... 234
CALCulate<[1]..8>:RELative:RATio[:MAGNitude] ..................................... 234
CALCulate<[1]..8>:RELative:STATe ................................................................. 234
CALCulate<[1]..8]:SDEViation:DATA? ......................................................... 234
CALCulate<[1]..4>:STATistics:MARKer: HORIZontal:POSition[X][POWer] .......................................................... 235
CALCulate<[1]..4>:STATistics:MARKer:VERTical:DATA[:POWER]? ................... 235
CALCulate<[1]..4>:STATistics:POWer AVG:DATA? ...................................... 236
CALCulate<[1]..8>:TRACe:MARKer:XDELta .................................................. 236
CALCulate<[1]..8>:TRACe:MARKer:YDELta .................................................. 236
CALCulate<[1]..8>:TRACe:MARKer<[1]..2>:XPOSition ................ 236
CALCulate<[1]..8>:TRACe:MARKer<[1]..2>:YPOSition? .................................... 237

**CALCulate<[1]..8>:COUNt:DATA?**

Queries the number of measured values that are included when the mean value and standard deviation are calculated (in the above formulas referred to as N, see Mean value of all measured values and Standard deviation of all measured values).

**Usage:** Query only

**CALCulate<[1]..8>:DATA?**

With this command the current output value of a calculate block can be queried.

The unit is the current unit of the measured result.

**Possible Units:** W | DBM | DBUV | DPCT | DB | O

**Usage:** Query only
**CALCulate<1..8>:EXTRemes:RESet**

The R&S NRP2 stores the maximum and minimum values for each calculate block. The current measured value is stored with `CALC[1..8]:EXTR:RES` as the new minimum and maximum value. The extreme values can be queried with `CALC[1..8]:MIN:DATA?` and `CALC[1..8]:MAX:DATA?`.

**Usage:**

**Event**

**CALCulate<1..8>:FEED<1|2> <feed>**

The sensors connected with the calculate block via the primary and secondary channel can yield differently processed data: peak value, average value, peak-to-average value or even a measurement sequence, as is the case in the Trace mode. The `CALC:FEED` determines which of this data is to be processed by the calculate block. Depending on the measurement mode, the following settings are possible:

**Table 6-9: <string> values**

<table>
<thead>
<tr>
<th>Primary channel measurement mode</th>
<th>&lt;string&gt;</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>ContAv</td>
<td>&quot;POWer:AVERage&quot;</td>
<td>Average value</td>
</tr>
<tr>
<td></td>
<td>&quot;POWer:PEAK&quot;</td>
<td>Peak value</td>
</tr>
<tr>
<td></td>
<td>&quot;POWer:RANDom&quot;</td>
<td>Randomly selected value from the measurement interval</td>
</tr>
<tr>
<td>Burst</td>
<td>&quot;POWer:AVERage&quot;</td>
<td>Average value</td>
</tr>
<tr>
<td></td>
<td>&quot;POWer:PEAK&quot;</td>
<td>Peak value</td>
</tr>
<tr>
<td></td>
<td>&quot;POWer:RANDom&quot;</td>
<td>Randomly selected value from the measurement interval</td>
</tr>
<tr>
<td>Timeslot</td>
<td>&quot;POWer:AVERage&quot;</td>
<td>Average value</td>
</tr>
<tr>
<td></td>
<td>&quot;POWer:PEAK&quot;</td>
<td>Peak value</td>
</tr>
<tr>
<td></td>
<td>&quot;POWer:RANDom&quot;</td>
<td>Randomly selected value from the measurement interval</td>
</tr>
<tr>
<td>Timegate</td>
<td>&quot;POWer:AVERage&quot;</td>
<td>Average value</td>
</tr>
<tr>
<td></td>
<td>&quot;POWer:PEAK&quot;</td>
<td>Peak value</td>
</tr>
<tr>
<td></td>
<td>&quot;POWer:RANDom&quot;</td>
<td>Randomly selected value from the measurement interval</td>
</tr>
<tr>
<td>Trace</td>
<td>&quot;POWer:TRACe&quot;</td>
<td>Measurement sequence</td>
</tr>
<tr>
<td></td>
<td>&quot;POWer:PEAK:TRACe&quot;</td>
<td>Peak value of the samples per test point</td>
</tr>
<tr>
<td></td>
<td>&quot;POWer:RANDom:TRACe&quot;</td>
<td>Randomly selected value</td>
</tr>
<tr>
<td></td>
<td>&quot;POWer:AVERage ON SWeep[1..4]&quot;</td>
<td>Average value in time gate 1, 2, 3 or 4</td>
</tr>
<tr>
<td></td>
<td>&quot;POWer:PTAverage ON SWeep[1..4]&quot;</td>
<td>Peak-to-average value in time gate 1, 2, 3 or 4</td>
</tr>
<tr>
<td></td>
<td>&quot;POWer:PEAK ON SWeep[1..4]&quot;</td>
<td>Peak value in time gate 1, 2, 3 or 4</td>
</tr>
<tr>
<td>Statistic</td>
<td>&quot;CCDF:TRACe&quot;</td>
<td>CCDF</td>
</tr>
<tr>
<td></td>
<td>&quot;PDF:TRACe&quot;</td>
<td>PDF</td>
</tr>
</tbody>
</table>
Note:

Every measured value displayed in the R&S NRP2 (also every point of a trace) is averaged in the sensor via a series of samples. If a **RANDom** feed is selected, a random value is taken from these samples and forwarded to the base unit as a measured value. **PEAK** is the maximum of all samples in the measurement interval.

**Suffix:**

<{}><{}>

**Parameters:**

<feed> string

see table 6-9 <string> values.

*RST: "POWer:AVERage"

---

**CALCulate<{}>.8>:LIMit:BEEP** <beep>

Switches the acoustic warning for limit violations on or off.

**Parameters:**

<beep> ON | OFF

*RST: OFF

**Usage:** Setting only

---

**CALCulate<{}>.8>:LIMit:CLea[r][:IMMediate]**

Resets the limit monitoring state and the internal counter for limit violations.

**Usage:** Event

---

**CALCulate<{}>.8>:LIMit:CLea[r]:AUTO** <auto>

Automatically resets the limit monitoring state and the internal counter for limit violations if any of the following events occurs:

- **INITiate[:IMMediate] is executed**
- **INITiate:CONTInuous ON is executed**
- **MEASure? or MEASure:...? query is executed.**
- **READ? or READ:...? query is executed.**
Parameters:  
<auto>  
ON | OFF | ONCE  
ON  
automatic reset enabled  
OFF  
automatic reset disabled  
ONCE  
automatic reset is enabled only once for the next occurrence of the above events  
*RST: OFF

Usage:  
Event

CALCulate<[1]..8>:LIMit:FAIL?  
Queries whether upper or lower limits have been exceeded. The status is reset (0 = no limit violation) if one of the following events occurs:  
• The device is switched on  
• A reset is performed (*RST)  
• The CALCulate<[1]..8>:LIMit:CLEar command is sent.

Usage:  
Query only

CALCulate<[1]..8>:LIMit:FCOunt?  
Queries the number of limit violations that occurred. The counter is zeroed if one of the following events occurs:  
• The device is switched on  
• A reset is performed (*RST)  
• The CALCulate<[1]..8>:LIMit:CLEar command is sent.

Usage:  
Query only

CALCulate<[1]..8>:LIMit:LOWer[:DATA] <lower_limit>  
Sets a lower limit for the measured values. The R&S NRP2 can respond when the values drop below this limit (see other CALCulate<[1]..8>:LIMit commands).

Parameters:  
<lower_limit>  
float_value  
The value range depends on the current output unit of the calculate block's measured value, see table below.  
The parameter unit is determined according to table 6-11 Output unit of measured value of calculate block.  
*RST: 0 DBM or 0 DB  
Default unit: Default unit: see table referred to above.
### Table 6-10: Value ranges, depending on the unit

<table>
<thead>
<tr>
<th>Unit of measured value</th>
<th>W</th>
<th>DBM</th>
<th>DBUV</th>
<th>DPCT</th>
<th>DB</th>
<th>O</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value range</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>-9.99999E5</td>
<td>-120</td>
<td>-13.0103</td>
<td>-100</td>
<td>-200</td>
<td>-1E20</td>
<td></td>
</tr>
<tr>
<td>..</td>
<td>..</td>
<td>..</td>
<td>..</td>
<td>..</td>
<td>..</td>
<td>..</td>
</tr>
<tr>
<td>9.99999E5</td>
<td>90</td>
<td>196.897</td>
<td>999.99</td>
<td>200</td>
<td>1E20</td>
<td></td>
</tr>
</tbody>
</table>

**CALCulate<[1]..8>:LIMit:LOWer[:DATA]:POWer <lower_limit>**

Sets a lower limit for the measured power. The R&S NRP2 can respond when the values drop below this limit (see other CALCulate<[1]..8>:LIMit commands).

**Parameters:**

- **<lower_limit>**
  - float_value; units: W | DBM | DBUV
  - Range: -120 DBM to 90 DBM
  - *RST*: 0 DBM
  - Default unit: DBM

**CALCulate<[1]..8>:LIMit:LOWer[:DATA]:RATio <ratio>**

Sets a lower limit for the measured power ratios. The R&S NRP2 can respond when the ratios drop below this limit (see other CALCulate<[1]..8>:LIMit commands).

**Parameters:**

- **<ratio>**
  - float_value; units: DB | DBCT | O
  - Range: -200 DB to 200 DB
  - *RST*: 0 DB
  - Default unit: DB

**CALCulate<[1]..8>:LIMit:LOWer:STATE <state>**

Switches the monitoring function for the upper and lower limit on or off.

**Parameters:**

- **<state>**
  - ON | OFF
  - *RST*: OFF

**Usage:** Setting only

**CALCulate<[1]..8>:LIMit:STATe <state>**

Switches the monitoring function for the upper limit on or off.

**Parameters:**

- **<state>**
  - ON | OFF
  - *RST*: OFF

**Usage:** Setting only
CALCulate<[1]..8>:LIミt:UPPer[:DATA] <upper_limit>

Sets an upper limit for the measured values. The R&S NRP2 can respond when this limit is exceeded (see other CALCulate<[1]..8>:LIミt commands).

Parameters:
<upper_limit> float_value
The value range depends on the current output unit of the calculate block's measured value, as shown in table 6-10 Value ranges, depending on the unit.
The parameter unit is determined according to table 6-11 Output unit of measured value of calculate block.
*RST: 0 DBM or 0 DB
Default unit: see table referred to above.

CALCulate<[1]..8>:LIミt:UPPer[:DATA]:POWer <power>

Sets a upper limit for the measured power. The R&S NRP2 can respond when this limit is exceeded (see other CALCulate<[1]..8>:LIミt commands).

Parameters:
<power> float_value; units: DBM | W | DBUV
Range: -120 DBM to 90 DBM
*RST: 0 DBM
Default unit: DBM

CALCulate<[1]..8>:LIミt:UPPer[:DATA]:RATio <ratio>

Sets an upper limit for the measured power ratios. The R&S NRP2 can respond when this limit is exceeded (see other CALCulate<[1]..8>:LIミt commands).

Parameters:
<ratio> float_value, units: DB | DPCT | O
Range: -200 DB to 200 DB
*RST: 0 DB
Default unit: DB

CALCulate<[1]..8>:LIミt:UPPer:STATe <state>

Switches the monitoring function for the upper limit on or off.

Parameters:
<state> ON | OFF
*RST: OFF

Usage: Setting only
CALCulate<[1]..8>:MATH[:EXPRession] <string>

Selects a measurement function that processes one sensor or two together. The result of this calculation is made available as a measured value and can be queried with FETch<[1]..8>? or CALCulate<[1]..8>:DATA?.

The <string> parameter may assume the values given in the following table, n and m may assume 1, 2, 3 and 4. A sensor must be connected to the respective channel.

**Error messages:**

<table>
<thead>
<tr>
<th>Code</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>-151</td>
<td>&quot;Invalid string data&quot;: An invalid &lt;string&gt; parameter was transmitted.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>string</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;(SENS1)&quot;</td>
<td>The calculate block outputs the measured value of sensor A.</td>
</tr>
<tr>
<td>&quot;(SENS2)&quot;</td>
<td>The calculate block outputs the measured value of sensor B.</td>
</tr>
<tr>
<td>&quot;(SENS3)&quot;</td>
<td>The calculate block outputs the measured value of sensor C.</td>
</tr>
<tr>
<td>&quot;(SENS4)&quot;</td>
<td>The calculate block outputs the measured value of sensor D.</td>
</tr>
<tr>
<td>&quot;(SENSn-SENSm)&quot;</td>
<td>The calculate block outputs the difference between the measured values of sensor n and sensor m.</td>
</tr>
<tr>
<td>&quot;(SENSn+SENSm)&quot;</td>
<td>The calculate block outputs the sum of the measured values of sensor n and sensor m.</td>
</tr>
<tr>
<td>&quot;(SENSn /SENSm)&quot;</td>
<td>The calculate block outputs the quotient of the values measured by sensor n and sensor m.</td>
</tr>
</tbody>
</table>
| "SWR(SENSn,SENSm)" | 1 + \sqrt{SENSm / SENSn} 
\[ 1 - \sqrt{SENSm / SENSn} \]
If sensor n measures the forward power of a wave and sensor m the reflected power, the calculate block outputs the standing wave ratio of this wave. The output unit is set to percent (UNIT:RAT PCT). |
| "REFL(SENSn,SENSm)" | \[ SENSm / SENSn \]
If sensor n measures the forward power of a wave and sensor m the reflected/transmitted power, the calculate block outputs the reflection coefficient/transmission factor of a DUT. The output unit is set to percent (UNIT:RAT PCT). |
| "RLOS (SENSn,SENSm)" | −20 log_{10} \sqrt{SENSm / SENSn}
If sensor n measures the forward power of a wave and sensor m the reflected/transmitted power, the calculate block outputs the return loss/transmission loss of a DUT. This function principally supplies the same result as the (SENSn/SENSm) function. The difference is that the output unit is automatically set to dB. (UNIT:RAT DB). |
Parameters:
<string>

The *RST values depend on the selected channel:
CALC1:MATH: "(SENS1)",
CALC2:MATH: "(SENS2)",
CALC3:MATH: "(SENS3)",
CALC4:MATH: "(SENS4)",
CALC5:MATH: "(SENS1)",
...
CALC8:MATH: "(SENS1)".

CALCulate[1..8]:MATH[:EXPRession]:CATalog?

Lists all supported calculation functions. All functions are sent in the form of strings which are allowed as parameters for the CALCulate[1..8]:MATH:EXPRession command.

Usage: Query only

CALCulate[1..8]:MAXimum:DATA?
CALCulate[1..8]:MINimum:DATA?

Queries the maximum/minimum of all measured values that previously occurred in this calculate block.

The limit value is set to the current measured value when
- the device is switched on
- a reset is performed (*RST)
- the value is explicitly set to the current measured value using the command CALCulate[1..8]:EXTRemes:RESet.

The unit is the current unit of the measured result.

Possible Units: W | DBM | DBUV | DPCT | DB | O

Usage: Query only

CALCulate[1..8]:MEAN:DATA?

Queries the mean value of all measured values of the calculate block. The mean value is reset when the auxiliary values are reset. The following formula applies:

$$\bar{x} = \frac{1}{N} \sum_{i=1}^{N} x_i$$

Fig. 6-5: Mean value of all measured values

The unit is the current unit of the measured result.

Possible Units: W | DBM | DBUV | DPCT | DB | O
Usage: Query only

CALCulate<1..8>:PTPeak:DATA?
Queries the peak-to-peak distance (maximum to minimum) of the measured values of the calculate block.
The unit is the current unit of the measured result.
Possible Units: W | DBM | DBUV | DPCT | DB | O
Usage: Query only

CALCulate<1..8>:RELative[:MAGNitude] <value>
Determines a value that is used as a divisor (logarithmic subtraction) for all measured values of the calculate block in the \texttt{CALC:REL:STAT ON} state. The unit of this value is equal to the unit of the output value of the calculate block and is defined according to the following table:

<table>
<thead>
<tr>
<th>\texttt{CALC:MATH?}</th>
<th>\texttt{CALC:REL:STAT OFF}</th>
<th>\texttt{CALC:REL:STAT ON}</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;(SENSn)&quot;</td>
<td>DBM</td>
<td>W</td>
</tr>
<tr>
<td>&quot;(SENSn-SENSm)&quot;</td>
<td>DBM</td>
<td>W</td>
</tr>
<tr>
<td>&quot;(SENSn+SENSm)&quot;</td>
<td>DBM</td>
<td>W</td>
</tr>
<tr>
<td>&quot;(SENSn/SENSm)&quot;</td>
<td>DB</td>
<td>DPCT</td>
</tr>
<tr>
<td>&quot;SWR(SENSn,SENSm)&quot;</td>
<td>O</td>
<td>-</td>
</tr>
<tr>
<td>&quot;REFL(SENSn,SENSm)&quot;</td>
<td>O</td>
<td>-</td>
</tr>
<tr>
<td>&quot;RLOS(SENSn,SENSm)&quot;</td>
<td>DB</td>
<td>-</td>
</tr>
</tbody>
</table>

The value range depends on the current output unit of the calculate block's measured value, as shown in \texttt{table 6-10 Value ranges, depending on the unit.}

Parameters:
\texttt{<value>} float_value
*RST: 0 DBM or 0 DB
 Default unit: See table referred to above.

CALCulate<1..8>:RELative[:MAGNitude]:AUTO <auto>
Sets the current measured value as the reference value. When used as a setting command, this command can only be called by the parameter \texttt{ONCE}. \texttt{OFF} will be ignored. \texttt{OFF} is always returned in response to a query.

Error messages:

-230 "Data corrupt or stale": The current measured value is invalid.
Parameters:
<auto> OFF | ONCE
*RST: OFF

CALCulate[1..8]:RELative:POWer[:MAGNitude] <value>
Has the same direct effect as CALC:REL on the reference value for measured values that share the unit of a power.

Parameters:
<value> float_value, units: DBM | W
Range: 1e-18..1e18 W | -150..210 DBM
*RST: 0 DBM
Default unit: DBM

CALCulate[1..8]:RELative:RATio[:MAGNitude] <value>
Has the same direct effect as CALC:REL on the reference value for measured values that share the unit of a power ratio.

Parameters:
<value> float_value, units: DB | PCT
Range: -200..200 DB | 1e-18..1e22 PCT
*RST: 0 DB
Default unit: DB

CALCulate[1..8]:RELative:STATe <state>
Determines whether a reference value is used. If this command is called with ON, all results of the calculate block are divided by the reference value set with CALCulate[1..8]:RELative[:MAGNitude].

Parameters:
<state> ON | OFF
ON all results of the calculate block are divided by the reference value set with CALCulate[1..8]:RELative[:MAGNitude].
OFF a reference value is not used.
*RST: OFF

CALCulate[1..8]:SDEViation:DATA?
Queries the standard deviation \( \sigma \) of all measured values of the calculate block. The standard deviation is calculated together with the mean value and reset. The following formula applies:
Fig. 6-6: Standard deviation $\sigma$ of all measured values

The unit is the current unit of the measured result.

**Possible Units:** W | DBM | DBUV | DPCT | DB | O

**Usage:** Query only

---

**CALCulate<1..4>:STATistics:MARKer: HORIZontal:POSition[:X][:POWer]**

$<power>$

Is available with statistics measurements (CCDF and PDF). It sets the horizontally shiftable marker on the power axis. The absolute position is specified. The statistics measured value can then be read out with `CALC:STAT:MARK:HOR:DATA?` if the measurement at this position has a valid value.

**Parameters:**

$<power>$ float_value, units: DBM | DBUV | W

Default unit: DBM

---

**CALCulate<1..4>:STATistics:MARKer:HORIZontal:DATA?**

Is available with statistics measurements (CCDF and PDF). It returns the value of the statistics function at the position of the marker if the value is valid.

**Unit:** O

**Usage:** Query only

---

**CALCulate<1..4>:STATistics:MARKer:VERTical:POSition[:Y] $<position>$**

Is available with statistics measurements (CCDF and PDF). It sets the vertically shiftable marker on the statistics axis. The associated value on the power axis can then be read out with `CALC:STAT:MARK:VERT:DATA?` if such a value is available.

**Unit:** O

**Parameters:**

$<position>$ float_value

---

**CALCulate<1..4>:STATistics:MARKer:VERTical:DATA[:POWer]?**

Is available with statistics measurements (CCDF and PDF). It returns the absolute position of the marker on the power axis.

**Unit:** DBM
Fig. 6-7: Meaning of the marker commands for the Statistics mode

**Usage:** Query only

**CALCulate<1..4>:STATistics:POWer:AVG:DATA?**

Returns the average value of the power in the time window of a statistics measurement. The time window is defined with the sensor commands SENS:STAT:TIME, SENS:STAT:OFFS, SENS:STAT:MID:TIME and SENS:STAT:MID:OFFS:TIME.

**Units:** DBM | W | DBUV

**Usage:** Query only

**CALCulate<1..8>:TRACe:MARKer:XDELta?**

Is available with trace measurements. It returns the time difference of the two curve markers if the value is valid.

**Usage:** Query only

**CALCulate<1..8>:TRACe:MARKer:YDELta?**

Is available with trace measurements. It returns the power difference of the two curve markers if the value is valid. The unit depends on the trace function.

**Usage:** Query only

**Units:** W (for trace function SINGLE) | DB (for trace function RATIO)

**CALCulate<1..8>:TRACe:MARKer<1..2>:XPOSition**

Is available with trace measurements. It sets or returns the position of a curve marker on the time axis.
Unit: s
RST: 0 s

CALCulate<\[1\]..8>:TRACE:MARKer<\[1\]..2>:YPOSition?

Is available with trace measurements. It returns the position of a curve marker on the power axis if the value is valid. The unit depends on the trace function.

Units: W (for trace function SINGLE) | DB (for trace function RATIO)
Usage: Query only

6.6 CALibration

Suffix \[1\]..4 denotes the four sensors. Calibration can be performed for only one of the sensors using header CALibration<\[1\]..4>:... or for all sensors using header CALibration:ALL:....

CALibration<\[1\]..4>:DATA...............................................................................................237
CALibration<\[1\]..4>:ZERO:AUTO.....................................................................................237
CALibration:ALL:ZERO:AUTO.........................................................................................237
CALibration<\[1\]..4>:ZERO:FAST:AUTO........................................................................... 238
CALibration:ALL:ZERO:FAST:AUTO................................................................................238

CALibration<\[1\]..4>:DATA <data>
Read and write binary calibration data sets for the selected sensor.

Parameters:
<data> block_data

CALibration<\[1\]..4>:ZERO:AUTO <auto>
CALibration:ALL:ZERO:AUTO <state>
Performs zeroing using the signal at the sensor input(s). The sensor(s) must be disconnected from all power sources.

Error messages:

<table>
<thead>
<tr>
<th>Code</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>-231</td>
<td>&quot;Data questionable; ZERO ERROR&quot;: Signal at the input considerably deviates from 0 W.</td>
</tr>
<tr>
<td>-224</td>
<td>&quot;Illegal parameter value&quot;: The transfer parameter is a numeric value unequal 0 (corre- sponds to OFF).</td>
</tr>
</tbody>
</table>

The setting commands accept only the parameters ONCE, LFR and UFR, they start of zeroing; OFF and ON are ignored.

The queries return the value ON if a calibration is in progress, otherwise value OFF.
The parameters LFR (lower frequency range) and UFR (upper frequency range) limit zeroing to a lower and an upper frequency range, thus reducing the required time by half. These parameters are not accepted by all sensors. Before using them, you should consult the manual of the sensor concerned.

Another possibility to perform zeroing faster is to use the command CALibration<[1]..4>:ZERO:FAST:AUTO in the trace mode.

The commands are overlapping, i.e. other commands can be sent to the R&S NRP2 while one or more calibrations are running.

Zeroing is recommended if

- the temperature has varied by more than about 5 °C,
- the sensor has been replaced,
- no zeroing was performed in the last 24 hours,
- signals of very low power are to be measured, for instance, if the expected measured value is less than 10 dB above the lower measurement range limit.

Parameters:

- **<state>**: ON | OFF | ONCE | LFR | UFR
- **<CALibration>**: *RST: OFF

**CALibration<[1]..4>:ZERO:FAST:AUTO <state>**
**CALibration:ALL:ZERO:FAST:AUTO <state>**

Perform fast zeroing. However, the commands cannot be called unless the sensor(s) is(are) in the Trace mode. Since the commands are processed very quickly, they are not overlapping. The queries therefore always return OFF.

Error messages:

-224 **"Illegal parameter value":** The transfer parameter is a numeric value unequal 0 (corresponds to OFF).

Parameters:

- **<state>**: OFF | ONCE
- **<CALibration>**: *RST: OFF

### 6.7 DISPlay

The DISPlay command system is mainly used to configure the display of windows on the R&S NRP2. The WINDow commands are assigned to the calculate blocks 1 to 4. The values calculated from the sensor values by the respective calculate block with the aid of the measurement function are displayed.

Suffix [1]..4 denotes the number of the calculate block.
DISPlay:ERRorlist <state>
Displays ON or removes OFF a windows which contains the contents of the SCPI error queue. The queue may be deleted by pressing the DEL key.

Parameters:
<state>  ON | OFF
*RST:  OFF

DISPlay:ILLumination <state>
This command switches the backlighting ON or OFF. Backlighting is switched on again in case of a reset.

Note: DISP:ILL is identical to DISP:ENAB, see annex chapter A.5, "Compatibility Information", on page 401.
Parameters:

<state> ON | OFF
*RST: ON

**DISPLAY:MESSAGE[:STATE] <state>**

Displays a window containing a user-defined message. The message text is defined via **DISPLAY:MESSAGE:TEXT**. In addition, **DISPLAY:MESSAGE:TYPE** can select between two types of message windows. Calling the command with the **OFF** parameter is ignored if **DISPLAY:MESSAGE:TYPE QUERY** is set, because in this case a window must be closed by pressing the MENU key.

Parameters:

<state> ON | OFF
*RST: OFF

**DISPLAY:MESSAGE:TEXT:CLEar**

Deletes the stored text for user-defined messages.

Usage: Event

**DISPLAY:MESSAGE:TEXT[:DATA] <string>**

Defines the text that can be displayed in a message window. The text can contain ASCII characters from code 32 (" ") to code 126 ("~"). The string "n" is interpreted as a line break. Up to 4 lines (**DISPLAY:MESSAGE:TYPE MESS**) or up to 2 lines (**DISPLAY:MESSAGE:TYPE QUERY**) can be shown. The length of a line depends on the characters used, because a proportional font is used. Lines that are too long are cut off, which is indicated by "..." at the end of the line.

Usage: Event

**DISPLAY:MESSAGE:TYPE <message_type>**

Sets the mode for the expected response to user-defined message windows.

Parameters:

<message_type> QUERY | MESSAGE

**QUERY**

The message window must be closed by pressing the MENU key. Until then, the execution of remote control commands is blocked.

**MESSAGE**

Remote control command processing is immediately continued. The message window must be closed with command **DISPLAY:MESSAGE OFF** if it is no longer needed.

*RST: MESSAGE
DISPlay:PIXMap?

Supplies the display content as binary block data. The block data consists of a block data header (#577110) and the display content in Microsoft Windows (R) BMP format (version 3). A color depth of 8 bit per pixel is used.

Parameters:

- `<pixmap>`: block_data

Example:

DISP:PIXM?

returns:

#577110xxxxxx...x,

with x in binary format comprising an 8-bit BMP bitmap of the display content.

Usage: Query only

---

DISPlay:UPDATE <update_frequency>

Adjusts the update frequency of the measured values in the display. In case of discontinuities in the voltage progress at the analog outputs display updates may be suspended with DISP:UPD FREeze. The display won’t consume CPU time in this state.

Parameters:

- `<update_frequency>`: NORMal | SLOW | FREeze

*RST: NORMal

---

DISPlay[:WINDow]<[1]..4>:AVALue <avalue>

Determines which additional information about the measured values is shown in the display (right-hand side, next to the main measured values).
Parameters: <avalue>

NONE | NORMal | EXTRemes | STATistics

NONE
No additional information about the measured values is displayed.

NORMal
The display is a function of the SENS:FUNCTION of the measurement mode of the primary channel and the CALC:FEED setting.

Primary channel in the trace mode:
The top line displays the frequency of the primary channel. The two lower lines and the main measured value window display Average, Peak and PeakToAverage. CALC:FEED determines which of the three quantities is displayed in the main measured value window. The other two quantities are displayed on the right-hand side, below the frequency.

Primary channel not in the trace mode:
Only the frequency of the primary channel and, if applicable, the frequency of the secondary channel are displayed.

EXTReme
Minimum, maximum and peak-to-peak (maximum to minimum) of all measured values displayed since the last CALC:EXTR:RES, PowerOn or AuxVal Reset are shown (manual operation). With logarithmic units, the peak-to-peak value equals the quotient of the measured values converted into linear units.

STATistic
The mean value, the standard deviation and the number of all measured values displayed since the last CALC:EXTR:RES, PowerOn or AuxVal Reset are shown (manual operation) (see also CALCulate:....:DATA?).

*RST: NONE

DISPlay[:WINDow][1..4]:FORMat <display_mode>

Selects the display mode for measured data.
Parameters:
<display_mode>

DIGital | ANALog | GRAPhical

DIGital
Measured values are displayed in numeric format. If the primary channel is operated in Trace mode, the (scalar) measured values of the currently selected timegate are displayed here.

ANALog
Measured values are indicated by a marker on a scale. The values at the upper and lower scale end as well as the type of scaling (linear or logarithmic) are set with the following :METer commands.

GRAPhical
Measured values are plotted over time. This kind of presentation is possible only if the primary channel is operated in Trace mode.

*RST: DIGital

DISPlay:[WINDow][1]..4]:METer:AUTO <auto>
DISPlay:[WINDow][1]..4]:ANALog:AUTO <auto>

DISP:AUTO ONCE automatically determines scaling for the analog display. The upper and the lower limit value of the display is set as a function of the current measurement data. Only the ONCE parameter is permissible; a query always supplies the value OFF.

Parameters:
<auto>
ONCE | OFF

*RST: OFF

DISPlay:[WINDow][1]..4]:METer:LOWer <lower_limit>
DISPlay:[WINDow][1]..4]:ANALog:LOWer <lower_limit>

Sets the lower limit value of the analog scale.

The value range depends on the current output unit of the measured value of the window.

Table 6-12: Value range

<table>
<thead>
<tr>
<th>Unit of measured value</th>
<th>W</th>
<th>DBM</th>
<th>PCT</th>
<th>DB</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value range for &lt;float_value&gt;</td>
<td>1e-18..1e18</td>
<td>-150..210</td>
<td>1e-18..1e22</td>
<td>-200..200</td>
</tr>
</tbody>
</table>

Unit: See table 6-10 Value ranges, depending on the unit.

Parameters:
<lower_limit>

float_value

*RST: -90 DBM or -120 DB
DISPlay[:WINDow][1..4]:METer:LOWer:POWer <lower_power>
DISPlay[:WINDow][1..4]:ANALog:LOWer:POWer <lower_power>

Sets the lower limit value of the analog scale. This value is used if the unit of the measurement result is Watt, dBm or dBµV, i.e. the measurement result is a power.

Value range: See table 6-12 Value range.

Unit: DBM | W | DBUV

Parameters:
<lower_power> float_value
*RST: -90 DBM
Default unit: DBM

DISPlay[:WINDow][1..4]:METer:LOWer:RATio <lower_ratio>
DISPlay[:WINDow][1..4]:ANALog:LOWer:RATio <lower_ratio>

Sets the lower limit value of the analog scale. This value is used if the unit of the measurement result is dB, percent or the number 1, i.e. the measurement result is a power ratio.

Value range: See table 6-12 Value range.

Unit: DB | DPCT | O

Parameters:
<lower_ratio> float_value
*RST: -120 DB
Default unit: DB

DISPlay[:WINDow][1..4]:METer:UPPer <upper_limit>
DISPlay[:WINDow][1..4]:ANALog:UPPer <upper_limit>

Sets the upper limit value of the analog scale.

The value range depends on the current output unit of the measured value of the window.

Unit: See table 6-10 Value ranges, depending on the unit.

Parameters:
<upper_limit> float_value
*RST: 30 DBM or 60 DB

DISPlay[:WINDow][1..4]:METer:UPPer:POWer <upper_limit>
DISPlay[:WINDow][1..4]:ANALog:UPPer:POWer <upper_limit>

Sets the upper limit value of the analog scale. This value is used if the unit of the measurement result is Watt, dBm or dBµV, i.e. the measurement result is a power.

Value range: See table 6-10 Value ranges, depending on the unit.

Unit: DBM | W | DBUV
Parameters:
<upper_limit> float_value
*RST: 30 DBM
Default unit: DBM

DISPlay[:WINDow]<[1]..4>:METer:UPPer:RATio <upper_limit>
DISPlay[:WINDow]<[1]..4>:ANALog:UPPer:RATio <upper_limit>
Sets the upper limit value of the analog scale. This value is used if the unit of the measurement result is dB, percent or the number 1, i.e. the measurement result is a power ratio.

Value range: See table 6-10 Value ranges, depending on the unit.

Unit: DB | DPCT | O

Parameters:
<upper_limit> float_value
*RST: 60 DB
Default unit: DB

DISPlay[:WINDow]<[1]..4>:NAME <string>
Determines the string to be displayed in the titlebar of the respective window. The reset values depend on the window (<n> = 1, 2, 3 or 4).

Parameters:
<string> string
*RST: ""

Example:
DISP1:NAME "Power In"
DISP2:NAME "Power Out"
The measured values in the display are now visually assigned to the different test points in the test setup. (Input power in window 1, output power in window 2).

DISPlay[:WINDow]<[1]..4>:RESolution <resolution>
Specifies the number of significant places of the mantissa when the measurement result is displayed on a linear scale. The R&S NRP2 tries to adjust the averaging filter range so that the display noise decreases with increasing resolution. The values of the transfer parameter have the following meaning:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Linear scale of measurement result</th>
<th>Logarithmic scale of measurement result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1 significant place</td>
<td>No decimal place</td>
</tr>
<tr>
<td>0.1</td>
<td>2 significant places</td>
<td>1 decimal place</td>
</tr>
<tr>
<td>0.01</td>
<td>3 significant places</td>
<td>2 decimal places</td>
</tr>
<tr>
<td>0.001</td>
<td>4 significant places</td>
<td>3 decimal places</td>
</tr>
</tbody>
</table>
This command corresponds to the <resolution> option of the high-level measurement commands `CONFigure`, `FETCH`, `READ` and `MEASure`.

**Note:**
Automatic filter ranging must be switched on (`SENSe<1..4>:AVERage:COUNt:AUTO ON`). `DISP<1..8>:RES` has an effect on the setting `SENS<1..4>:AVERage:COUNt:AUTO:RES` of the sensors used in the measurement function (`CALC<1..8>:MATH`). However, the resolution setting of the sensors does not affect the resolution of values in the display.

**Error messages:**

<table>
<thead>
<tr>
<th>Code</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>-127</td>
<td>&quot;Invalid numeric data&quot;: An invalid number was specified for the resolution.</td>
</tr>
</tbody>
</table>

**Parameters:**

- `<resolution>`
  - 1 | 0.1 | 0.01 | 0.001
  - `lin` = Linear scale of measurement result
  - `log` = Logarithmic scale of measurement result
  - 1
    - `lin` = 1 significant place
    - `log` = No decimal place
  - 0.1
    - `lin` = 2 significant places
    - `log` = 1 decimal place
  - 0.01
    - `lin` = 3 significant places
    - `log` = 2 decimal places
  - 0.001
    - `lin` = 4 significant places
    - `log` = 3 decimal places
  - *RST:* 0.01

**Example:**

```
DISP:WIND1:RES 0.1
```

With a measured value of 123.456789 W, the first two places are free of noise and thus 120 W is displayed.

**DISPlay[:WINDow]:SELect <select_window>**

Selects a window.

**Parameters:**

- `<select_window>`
  - 1 | 2 | 3 | 4
  - *RST:* 1

**DISPlay[:WINDow]:SIZE <window_size>**

Sets the window size.
**Parameters:**

- **<window_size>**
  - **NORMal**
    - The window size is determined automatically and depends on the total number of open windows.
  - **ZOOMed**
    - The selected window ([DISP:WIND:SEL]) is set to maximum size, regardless of the number of visible windows. All other open windows are covered.
  - *RST: NORMal

**DISPlay:[WINDow]<[1..4]>[:STATE] <state>**

Opens or closes a window. When a window is closed the other windows are automatically expanded so that the free space is utilized. Likewise, open windows become smaller when a new one is opened.

**Parameters:**

- **<state>**
  - ON | OFF
  - *RST: ON (Window 1) | OFF (Window 2,3,4)

**DISPlay:[WINDow]<[1..4]>:TRACe:LOWer <lower_limit>**

Sets the lower limit for the power axis in the Trace mode. The value range depends on the unit.

*Table 6-13: The value range depends on the unit*

<table>
<thead>
<tr>
<th>Unit of measured value</th>
<th>W</th>
<th>DBM</th>
<th>DBUV</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value range</td>
<td>-999.999E3</td>
<td>-120</td>
<td>-13.010</td>
</tr>
<tr>
<td></td>
<td>999.999E3</td>
<td>90</td>
<td>136.990</td>
</tr>
</tbody>
</table>

**Unit:** DBM | W | DBUV

**Parameters:**

- **<lower_limit>**
  - float_value
  - *RST: -120 DB
  - Default unit: DBM

**DISPlay:[WINDow]<[1..4]>:TRACe:UPPer <upper_limit>**

Sets the upper limit for the power axis in the Trace mode.

**Value range:** See table 6-13 The value range depends on the unit.

**Unit:** DBM | W | DBUV
**Parameters:**
- `<upper_limit>` float_value
- *RST:* 30 DBM
- Default unit: DBM

**DISPlay[:WINDow]<[1]..4>:TSLot <timeslot>**
Sets the displayed timeslot, if the primary or secondary channel is operated in the Timeslot mode.

**Parameters:**
- `<timeslot>` int_value
- Range: depending on sensor
- *RST:* 1

### 6.8 FORMAT

The FORMAT command system sets the format of numeric data (measured values) that is exchanged between the remote control computer and the R&S NRP2 if high-level measurement commands are used.

**FORMAT[:READings]:BORDer <mode>**
Influences the order of bytes in 64-bit binary data.

**Parameters:**
- `<mode>` NORMal | SWAPped
  - **NORMal**
    - The 1st byte is the MSB (most significant byte), the 8th byte the LSB (least significant byte).
    - This fulfills the Big Endian convention (Big Endian: "the big end comes first").
  - **SWAPped**
    - The 1st byte is the LSB (least significant byte), the 8th byte the MSB (most significant byte).
    - This fulfills the Little Endian convention.
  - *RST:* NORMal

**FORMAT[:READings][:DATA] <type>**
Specifies whether numeric data is sent as block data in binary form (REAL) or as character strings in plain text (ASCII).
Parameters:

\(<\text{type}>\)  
ASCII | REAL  
*RST: ASCII

**FORMat:SREGister** <\text{format}>

Specifies which format is used for the return value of *STB?.

Parameters:

\(<\text{format}>\)  
ASCII | BINary | HEXadecimal | OCTal  
*RST: ASCII

### 6.9 MEMory

The MEMory system is used for storing device states (:STATe) and correction tables (:TABLE).

| MEMory:CATalog[:ALL]? | .......................................................... 250 |
| MEMory:CATalog:STATe? | .......................................................... 250 |
| MEMory:CATalog:TABLE? | .......................................................... 250 |
| MEMory:CLEar[:NAME] | .......................................................... 250 |
| MEMory:CLEar:TABLE | .......................................................... 251 |
| MEMory:FREE[:ALL]? | .......................................................... 251 |
| MEMory:FREE:STATe? | .......................................................... 251 |
| MEMory:FREE:TABLE? | .......................................................... 251 |
| MEMory:NSTates? | .......................................................... 251 |
| MEMory:STATe:CATalog? | .......................................................... 251 |
| MEMory:STATe:DEFINE | .......................................................... 252 |
| MEMory:STATe:MAP | .......................................................... 252 |
| MEMory:STATe:RESet? | .......................................................... 252 |

---

Stored data is not affected by an *RST command.
MEMory:CATalog[:ALL]?

Lists the names of all stored device states and correction tables. The length of the response depends on how many device states and tables are stored.

Return values:

\(<NR1>, <NR1> \\
\{,"<string>"\}\)

The first two values denote the length in bytes of the occupied RAM and of the RAM still available for storing states and tables. These values are followed by a string for each stored state and then for each stored table; this string again consists of two strings and a numeric value:

\(<string>, <type>, <NR1>\)

<string> gives the name of the stored data item, <type> the type (TABL or STAT) and <NR1> the length of the data item in bytes.

Example:

The response to query MEM:CAT? could be:

956,99044,"REFL,STAT,408","NRPZ21,TABL,432",
"SPLITTER1,TABL,116"

Usage:

Query only

MEMory:CATalog:STATe?

Only gives a list of stored device states and is otherwise identical with MEMory:CATalog[:ALL]?

Usage:

Query only

MEMory:CATalog:TABLe?

Only gives a list of stored correction tables and is otherwise identical with MEMory:CATalog[:ALL]?

Usage:

Query only

MEMory:CLEar[:NAME] <name>

Clears the content of the correction table or the stored device state with the designation <name>. The table is maintained but does not contain entries.
Notice: Possible data loss
This command cannot be cancelled. Cleared values are irretrievably lost.

Parameters:
<string>
Usage: Event

MEMory:CLEar:TABLE
This command may be used as an alternative to MEMory:CLEar[:NAME]
<string>. The content of the table currently selected with MEMory:TABLE:SELECT
<string> is cleared.

Caution: Possible data loss
This command cannot be cancelled. Cleared values are irretrievably lost.

Usage: Event

MEMory:FREE[:ALL]?
Returns the number of bytes available in memory for storing correction tables and
device states as well as the memory already used.

Usage: Query only

MEMory:FREE:STATe?
Returns the number of bytes available in memory for storing device states as well as
the memory already used for device states.

Usage: Query only

MEMory:FREE:TABLE?
Returns the number of bytes available in memory for storing device states as well as
the memory already used for device states.

Usage: Query only

MEMory:STATe:CATalog?
Returns a list of names of stored device states.
Return values:
<string>, 1...19
Usage: Query only

MEMory:STATe:DEFine <string>, 1...19
MEMory:STATe:MAP <string>
The value 0 to 19 are assigned to the memory locations of the device states, where the
memory location with the number 0 is the factory-set state and cannot be changed.
Names (<string>) can be assigned to these numbers with MEMory:STATe:DEFine
or MEMory:STATe:MAP (except for the factory-set state).
The command MEMory:CLear[:NAME] expects parameters that are actually strings
rather than the numbers of the memory locations. The default names of these memory
locations are "Setup 0" to "Setup 19". The name may contain the characters A to Z, a
to z, 0 to 9 and "_".
The query of this command returns the number of the memory location with the name
of <string>.
Parameters:
<string>, 1...19 maps the string on the selected memory location of the device
states

MEMory:STATe:RESet?
The command resets the names of the stored device states to factory default ("Setup 1"
etc.).
Usage: Query only

MEMory:TABLE:DATA? <f_n> {, <o_n>}
The command returns the content of the currently selected offset table. The answer
consists of an alternating comma separated list of frequencies (f_n, Hz) and offsets
(o_n, dB).
Return values:
<f_n> {, <o_n>} The answer consists of an alternating comma separated list of
frequencies (f_n) and offsets (o_n).
*RST: Tables are not changed in case of a *RST.
Example:
MEM:TABL:FREQ 50MHz,100MHz
MEM:TABL:GAIN 1,1.1
MEM:TABLE:DATA?
returned values:
5.000000E+07,1.000000,1.000000E+08,1.100000
Usage: Query only
MEMory:TABLE:DATA:POINTs?
The command returns the number of stored entries in the currently selected offset table.

Usage: Query only

MEMory:TABLE:FREQuency <NRf> {, <NRf>}
This command enters frequencies in the first column of the table selected with MEM:TABL:SEL. Existing data for frequencies will be overwritten. The number of frequencies should match the number of offset values. If the number of frequencies differs from the number of offset values, the shorter column length will be used.

SENS[<1..4>]:FREQ can be used to determine a frequency for which a correction factor is then defined by means of the offset table. If the exact frequency selected is not in the table, the values in the table are interpolated. If the selected frequency is outside the specified frequency range, the first or last offset value of the table is selected. Interpolation is linear in the units Hz and DB.

Parameters:
<NRf> {, <NRf>} Enters frequencies in the first column of the table selected with MEM:TABL:SEL

*RST: Tables are not changed in case of a *RST.
Default unit: Hz

MEMory:TABLE:FREQuency:POINTs?
Returns the number of entries (lines) in the table selected with MEM:TABL:SEL <name>.

Usage: Query only

MEMory:TABLE:GAIN[:MAGNitude] <NRf> {, <NRf>}
This command enters offset values in the second column of the table selected with MEM:TABL:SEL. Existing data for offset values will be overwritten. The number of frequencies should match the number of offset values. If the number of frequencies differs from the number of offset values, the shorter column length will be used.

A frequency can be determined with SENS[<1..4>]:FREQ, for which a correction factor is then calculated by means of the offset table. If the exact frequency selected is not in the table, the values in the table are interpolated. If the selected frequency is outside the specified frequency range, the first or last offset value of the table is selected. Interpolation is linear in the units Hz and DB.

Unit: DB | PCT
Parameters:
<NRf> {, <NRf>}
Enters offset values in the second column of the table selected with MEM:TABL:SEL.

*RST: Tables are not changed in case of a *RST.
Default unit: DB

**MEMory:TABLE:GAIN:POINts?**

Returns the number of entries (lines) in the table selected with MEM:TABL:SEL <string>.

Usage: Query only

**MEMory:TABLE:MAP <string>, 1...9**

The numbers 0 to 9 are permanently assigned to the memory locations for device states. Names (<string>) can be assigned to the numbers with MEM:TABLE:MAP. The MEM:CLE[:NAME], MEM:TABLE:MOVE and MEM:TABLE:SEL commands expect these names as parameters, not the numbers of the memory locations. By default the tables are assigned the names "Table 1" to "Table 10". The name can contain the characters "A" to "Z", "a" to "z", "0" to "9" and "_".

The query form of this command returns the number of the memory location with the name <map>.

Parameters:
<string>, 1...9 maps the string on the selected memory locations for device states.

**MEMory:TABLE:MOVE <string>,<string>**

This command allows tables to be renamed. The first parameter specifies the old name, the second the new name. No data is copied, i.e. only the name of the table changes.

**Example:**
MEM:TABLE:MOVE "Table 1","Test setup"
Renames the table "Table 1" into "Test setup".

Usage: Setting only

**MEMory:TABLE:RESet**

The command clears all tables for frequency dependent offset.

Usage: Event

**MEMory:TABLE:SELECT <name>**

Selects a table.
The following commands affect this table:

- **MEMory:CLEar[:NAME] <string>**
- **MEMory:CLEar:TABLE**
- **all MEMory:TABLE commands**

The selection is not changed in case of an *RST or a SYSTem:PRESet.*

**RST value:** none

**Error messages:**

```
-256 "File name not found": A table named <select> is not known.
```

### 6.10 OUTPut

The OUTPut system serves for generator configuration. The R&S NRP2 can be equipped with an optional RF test generator which produces a reference power of 1 mW at 50 MHz. Moreover, the analog outputs at the rear of the power meter can be configured.

```
OUTPut:RECorder<[1..2]>:FEED..................................................................................... 255
OUTPut:RECorder<[1..2]>:LIMit:LOWer........................................................................... 256
OUTPut:RECorder<[1..2]>:LIMit:LOWer:POWer.................................................................... 256
OUTPut:RECorder<[1..2]>:LIMit:LOWer:RATio....................................................................... 256
OUTPut:RECorder<[1..2]>:LIMit:UPPer............................................................................ 257
OUTPut:RECorder<[1..2]>:LIMit:UPPer:POWer................................................................ 257
OUTPut:RECorder<[1..2]>:LIMit:UPPer:RATio..................................................................... 257
OUTPut:RECorder<[1..2]>:[STATe]................................................................................. 258
OUTPut:ROSCillator:[STATe].................................................................................................. 258
OUTPut:TTL:ACTive............................................................................................................ 258
OUTPut:TTL:FAIL................................................................................................................ 258
OUTPut:TTL:FEED................................................................................................................ 259
OUTPut:TTL:HVOLtage......................................................................................................... 259
OUTPut:TTL:LVOLtage......................................................................................................... 259
OUTPut:TTL:[STATe]............................................................................................................. 260
OUTPut:TRIGger:[STATe]..................................................................................................... 260
```

**OUTPut:RECover<[1..2]>:FEED <calculate_block>**

Assigns a calculate block to one of the two analog outputs. On the basis of the set characteristic, the measured value is converted to a DC voltage that can be tapped at the appropriate output.

**Parameters:**

- `<calculate_block>`
  - "CALC1", "CALC2", "CALC3", "CALC4"
  - *RST: output 1: "CALC1"; output 2: "CALC2"
OUTPut:RECorder<[1]..2>:LIMit:LOWer <lower_limit>

Voltage

3.3 V

3.0 V

0.0 V

Fig. 6-8: Characteristic of analog outputs

Specifies the lower power limit of the characteristic for one of the two analog outputs. The unit corresponds to the output unit of the measured value.

Value range: See table 6-10 Value ranges, depending on the unit.

Units: table 6-11 Output unit of measured value of calculate block.

Note: The characteristic is linear in the selected unit of the measured value.

Parameters:

- `<lower_limit>`: float_value
- *RST*: -20 DBM or 0 DB

OUTPut:RECorder<[1]..2>:LIMit:LOWer:POWer <lower_limit>

Specifies the lower power limit of the characteristic for one of the two analog outputs if the associated calculate block returns a power (unit DBM, W or DBUV) as measured value (see figure 6-8 Characteristic of analog outputs).

Units: DBM | W | DBUV

Parameters:

- `<lower_limit>`: float_value
- Range: -120 DBM to 90 DBM
- *RST*: -20 DBM
- Default unit: DBM

OUTPut:RECorder<[1]..2>:LIMit:LOWer:RATio <lower_limit>

Specifies the lower power limit of the characteristic for one of the two analog outputs if the associated calculate block returns a power ratio (unit DB, DPCT or O) as the measured value (see figure 6-8 Characteristic of analog outputs).

Unit: DB | DPCT | O
Parameters:
<lower_limit> float_value
Range: -200 DB .. 200 DB
*RST: 0 DB
Default unit: DB

**OUTPut:RECorder<1..2>:LIMit:UPPer <upper_limit>**

Specifies the upper power limit of the characteristic for one of the two analog outputs (see figure 6-8 Characteristic of analog outputs). The unit corresponds to the output unit of the measured value.

**Value range:** See table 6-10 Value ranges, depending on the unit.

**Unit:** table 6-11 Output unit of measured value of calculate block.

Parameters:
<upper_limit> float_value
*RST: 20 DBM or 10 DB

**OUTPut:RECorder<1..2>:LIMit:UPPer:POWer <upper_limit>**

Specifies the upper power limit of the characteristic for one of the two analog outputs if the associated calculate block returns a power (unit DBM, W or DBUV) as the measured value (see figure 6-8 Characteristic of analog outputs).

**Unit:** DBM | W | DBUV

Parameters:
<upper_limit> float_value
Range: -120 DBM to 90 DBM
*RST: 20 DBM
Default unit: DBM

**OUTPut:RECorder<1..2>:LIMit:UPPer:RATio <upper_limit>**

Specifies the upper power limit of the characteristic for one of the two analog outputs if the associated calculate block returns a power ratio (unit DB, DPCT or O) as the measured value (see figure 6-8 Characteristic of analog outputs).

**Unit:** DB | DPCT | O

Parameters:
<upper_limit> float_value
Range: -200 DB .. 200 DB
*RST: 10 DB
Default unit: DB
OUTPut:RECorder<1..2>:STATe <state>
Switches the analog outputs (OUT1 and OUT2/TRIG on rear panel) ON or OFF. The magnitude of the output voltage (0 V to 3.3 V) depends on the measured power of the assigned calculate block (OUTP:REC:FEED) and the configuration of the characteristic (OUTP:REC:LIM). As in manual operation, this setting is coupled to other operating modes of the outputs. Only one mode can be active at any one time:

<table>
<thead>
<tr>
<th>Connector</th>
<th>Analog output (OUTP:REC)</th>
<th>TTL output (OUTP:TTL)</th>
<th>Off</th>
<th>Ext. Trigger In</th>
</tr>
</thead>
<tbody>
<tr>
<td>OUT1</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>-</td>
</tr>
<tr>
<td>OUT2/TRIG</td>
<td>x</td>
<td>-</td>
<td>-</td>
<td>x</td>
</tr>
</tbody>
</table>

Parameters:
<state> ON | OFF
*RST: output 1: ON; output 2: OFF

OUTPut:ROScillator[:STATe] <state>
The command switches the optional RF generator (ON) or (OFF).
Parameters:
<state> ON | OFF
*RST: OFF

OUTPut:TTL:ACTive <string>
Specifies whether the value set via OUTP:TTL:LVOL (LOW) or via OUTP:TTL:HVOL (HIGH) should be applied if the measured value causes a limit violation at the TTL output.
Parameters:
<string> LOW | HIGH
*RST: LOW

OUTPut:TTL:FAIL <mode>
Specifies the value which should be applied if the measured value causes a limit violation at the TTL output.
Note: The OUTP:TTL:ACT and OUTP:TTL:FAIL commands are identical, except for the opposite meaning of the parameters.
**Parameters:**

- **<mode>**
  - **HIGH**
    - The value set via `OUTP:TTL:LVOL` is applied if the measured value causes a limit violation at the TTL output.
  - **LOW**
    - The value set via `OUTP:TTL:HVOL` is applied if the measured value causes a limit violation at the TTL output.

- **RST:** HIGH

---

**OUTPut:TTL:FEED <calculate_block>**

Sets the calculate block whose limit handling controls the TTL voltage. If the measured value of this calculate block violates a limit and limit monitoring is active, the voltage specified in table 6-14 Voltage at TTL output (first line) is output.

**Parameters:**

- **<calculate_block>**
  - string
  - Range: "CALC1:LIM","CALC2:LIM","CALC3:LIM","CALC4:LIM"
  - **RST:** "CALC1:LIM"

---

**OUTPut:TTL:HVOLtage <high_voltage>**

Sets the high voltage for the TTL output.

**Parameters:**

- **<high_voltage>**
  - float_value
  - Range: 0 V to 3.3 V
  - **RST:** 3.3 V
  - Default unit: V

---

**OUTPut:TTL:LVOLtage <low_voltage>**

Sets the low voltage for the TTL output.

**Note:** The value for the lower TTL level may be greater than the value for the upper TTL level.

**Parameters:**

- **<low_voltage>**
  - float_value
  - Range: 0 V to 3.3 V
  - **RST:** 0 V
  - Default unit: V
OUTPut:TTL[:STATe] <state>

Activates/deactivates the TTL operating mode of the OUT1 connector (rear panel). The magnitude of the two possible output voltages can range from 0 V to 3.3 V (OUTP:TTL:HVOL and OUTP:TTL:LVOL). Refer to OUTPut:TTL[:STATe] on page 260 and figure 6-9 Voltage at TTL output to determine which voltage is available at the output.

Table 6-14: Voltage at TTL output

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Measured value violates limit</td>
<td>OUTP:TTL:LVOL</td>
<td>OUTP:TTL:HVOL</td>
</tr>
<tr>
<td>Measured value is within limit</td>
<td>OUTP:TTL:HVOL</td>
<td>OUTP:TTL:LVOL</td>
</tr>
</tbody>
</table>

Fig. 6-9: Voltage at TTL output

Parameters:

<state>       ON | OFF
*RST:       OFF

OUTPut:TRIGger[:STATe]

Switches the trigger output ON or OFF. The source of signals on the trigger bus can either be the (external) trigger input or a sensor in trigger master mode. The output needs to be switched to OFF before it can be switched ON again. Therefore, it is not possible to switch directly from OUTP:REC ON to OUTP:TRIG ON.

6.11 SENSE (Sensor Commands)

The commands of the SENSE group configure the power sensors with the exception of the trigger system. This includes the measurement modes (ContAv, Burst, Timeslot or Trace), the offset corrections and the filter settings.

Suffix [1]...4 denotes the sensor channel.
When the sensors are connected to the R&S NRP2, they inform the device about the SENSE and TRIGger commands supported and about the value ranges for parameters. This applies to both numeric and text parameters. For this reason, no fixed ranges are specified with these commands; the ranges can be obtained from the respective sensor manual.

[SENSe<1..4>]:AUXiliary.......................................................... 263
[SENSe<1..4>]:AVERage:COUNT............................................. 263
[SENSe<1..4>]:AVERage:COUNT:AUTO................................... 264
[SENSe<1..4>]:AVERage:COUNT:AUTO:TIME......................... 264
[SENSe<1..4>]:AVERage:COUNT:AUTO:RESolution.................. 264
[SENSe<1..4>]:AVERage:COUNT:AUTO:SLOT......................... 265
[SENSe<1..4>]:AVERage:COUNT:AUTO:NSRatio....................... 265
[SENSe<1..4>]:AVERage:COUNT:AUTO:TYPE.......................... 265
[SENSe<1..4>]:AVERage:RESet............................................ 266
[SENSe<1..4>]:AVERage[:STATE]........................................... 266
[SENSe<1..4>]:AVERage:TCONtrol......................................... 266
[SENSe<1..4>]:BANDwidth:VIDeo........................................... 266
[SENSe<1..4>]:BWIDth:VIDeo................................................. 266
[SENSe<1..4>]:BWIDth:VIDeo:LIST?....................................... 267
[SENSe<1..4>]:BWIDth:VIDeo:LIST?....................................... 267
[SENSe<1..4>]:CORRection:OFFSet........................................ 267
[SENSe<1..4>]:CORRection:OFFSet:STATe............................. 267
[SENSe<1..4>]:CORRection:DCYCle[:INPut][:MAGNitude]............. 267
[SENSe<1..4>]:CORRection:DCYCle:STATe............................. 268
[SENSe<1..4>]:CORRection:FDOffset[:INPut][:MAGNitude]?........... 268
[SENSe<1..4>]:CORRection:FDOTable[:SELect]........................ 268
[SENSe<1..4>]:CORRection:FDOTable:STATe.......................... 268
[SENSe<1..4>]:CORRection:SPDevice:SELect.......................... 269
[SENSe<1..4>]:CORRection:SPDevice:STATe.......................... 269
[SENSe<1..4>]:FREQuency[:CW].......................................... 269
[SENSe<1..4>]:FREQuency[:FIXed]........................................ 269
[SENSe<1..4>]:FUNCtion[:ON]............................................. 269
[SENSe<1..4>]:FUNCtion[:ON]............................................. 269
[SENSe<1..4>]:POWer[:AVG]:APERture................................ 272
[SENSe<1..4>]:POWer[:AVG]:BUFFER:SIZE............................ 272
[SENSe<1..4>]:POWer[:AVG]:BUFFER:STATe.......................... 272
[SENSe<1..4>]:POWer[:AVG]:RANGe...................................... 273
[SENSe<1..4>]:POWer[:AVG]:RANGe:AUTO............................. 273
[SENSe<1..4>]:POWer[:AVG]:RANGe:CLEVel............................ 273
[SENSe<1..4>]:POWer[:AVG]:SMoother:STATe.......................... 273
[SENSe<1..4>]:POWer:BURSt:DTOlerance.............................. 274
[SENSe<1..4>]:POWer:TGATE<1..4>[:EXCLude]:MID:OFFSet[:TIME]...... 274
[SENSe<1..4>]:POWer:TGATE[:EXCLude]:MID:STATe..................... 275
[SENSe<1..4>]:POWer:TGATE<1..4>[:EXCLude]:MID:TIME................ 275
[SENSe<1..4>]:POWer:TGATE<1..4>:OFFSet:TIME........................ 275
[SENSe<1..4>]:POWer:TGATE[:SELect].................................. 276
[SENSe<1..4>]:POWer:TGATE<1..4>:TIME................................ 276
[SENSe<1..4>]:POWer:TSLot:COUNT..................................... 277
[SENSe<1..4>]:POWer:TSLot[:EXCLude]:MID:OFFSet[:TIME]........... 277
[SENSe<1..4>]:[POWer]:TSLot[EXCLude]:MID[STATe] .................. 277
[SENSe<1..4>]:[POWer]:TSLot[EXCLude]:MID:TIME .................. 277
[SENSe<1..4>]:[POWer]:TSLot[AVG]:WIDTH ......................... 278
[SENSe<1..4>]:RGamma[MAGNitude] .................................. 278
[SENSe<1..4>]:RGamma:PHAse ......................................... 279
[SENSe<1..4>]:SAMPling ............................................... 279
[SENSe<1..4>]:SGamma[MAGNitude] .................................. 279
[SENSe<1..4>]:SGamma:PHAse ......................................... 279
[SENSe<1..4>]:SGamma:CORRection:STATe ......................... 280
[SENSe<1..4>]:STATistics:AVERage? ................................. 280
[SENSe<1..4>]:STATistics[EXCLude]:MID:OFFSet[TIME] ........... 280
[SENSe<1..4>]:STATistics[EXCLude]:MID:TIME ..................... 280
[SENSe<1..4>]:STATistics:PEAK? ..................................... 281
[SENSe<1..4>]:STATistics:OFFSET[TIME] ........................... 281
[SENSe<1..4>]:STATistics:SAMPles[MINimum] ...................... 281
[SENSe<1..4>]:STATistics:SCALE:X:MPWidth? ...................... 281
[SENSe<1..4>]:STATistics:SCALE:X:POINTS ....................... 282
[SENSe<1..4>]:STATistics:SCALE:X:RANGE ......................... 282
[SENSe<1..4>]:STATistics:SCALE:X:RELLevel ...................... 282
[SENSe<1..4>]:STATistics:TIME ..................................... 283
[SENSe<1..4>]:TIMing:EXCLude:STARt ............................. 283
[SENSe<1..4>]:TIMing:EXCLude:STOP ................................ 283
[SENSe<1..4>]:TRACe:AVERage[STATe] .............................. 284
[SENSe<1..4>]:TRACe:AVERage:COUNT ................................. 284
[SENSe<1..4>]:TRACe:AVERage:COUNT[AUTO] ....................... 284
[SENSe<1..4>]:TRACe:AVERage:COUNT[AUTO]:MTIMe .............. 285
[SENSe<1..4>]:TRACe:AVERage:COUNT[AUTO]:RESolution ......... 285
[SENSe<1..4>]:TRACe:AVERage:COUNT[AUTO]:POINt ............... 286
[SENSe<1..4>]:TRACe:AVERage:COUNT[AUTO]:NSRatio ............ 286
[SENSe<1..4>]:TRACe:AVERage[COUNT]:TYPE ....................... 286
[SENSe<1..4>]:TRACe:AVERage:TCNTrol ............................. 287
[SENSe<1..4>]:TRACe:MEASurement:ALGorithm .................... 287
[SENSe<1..4>]:TRACe:MEASurement:AUTO[STATe] .................. 287
[SENSe<1..4>]:TRACe:MEASurement:DEFine:DURation:REference .... 288
[SENSe<1..4>]:TRACe:MEASurement:DEFine:TRANSition:HREFERENCE .... 288
[SENSe<1..4>]:TRACe:MEASurement:DEFine:TRANSition:LREFERENCE .... 288
[SENSe<1..4>]:TRACe:MEASurement:POWer:AVG? ................... 288
[SENSe<1..4>]:TRACe:MEASurement:POWer:MAX? ................... 289
[SENSe<1..4>]:TRACe:MEASurement:POWer:MIN? ................... 289
[SENSe<1..4>]:TRACe:MEASurement:POWer:PULSe:BASE? ............ 289
[SENSe<1..4>]:TRACe:MEASurement:POWer:PULSe:TOP? ............. 289
[SENSe<1..4>]:TRACe:MEASurement:PULSe:DCYcle? ............... 289
[SENSe<1..4>]:TRACe:MEASurement:PULSe:DURation? .............. 289
[SENSe<1..4>]:TRACe:MEASurement:PULSe:PERiod? ................. 289
[SENSe<1..4>]:TRACe:MEASurement:PULSe:SEParation? .......... 290
[SENSe<1..4>]:TRACe:MEASurement:TRANSition:ESAMpling[AUTO]:STATe? .... 290
[SENSe<1..4>]:TRACe:MEASurement:TRANSition:NEGative:DURation? .... 290
[SENSe<1..4>]:TRACe:MEASurement:TRANSition:NEGative:OCCurrente? .... 290
[SENSe<1..4>]:TRACe:MEASurement:TRANSition:NEGative:OVERshoot? .... 290
[SENSe<1..4>]:TRACe:MEASurement:TRANSition:POSitive:DURation? .... 291
Activates the measurement of additional measured values that are determined together with the main measured value.

**Parameters:**

<mode>

- **NONE**
  
  No additional values are measured.

- **MINMax**
  
  By averaging the measured values in the sensors, extreme values are lost. Using `[SENSe<1..4>]:AUXiliary MINMax`, a sensor can be assigned to transmit to the R&S NRP2 the minima and maxima that occurred in the Trace mode together with the measured value. If `CALCulate:FEED "POWer:PEAK ON SWEep<1..4>"` is set, peak (instead of average) values are used for calculating.

- **RNDMax**
  
  In contrast to MINMax, instead of the Min value the value of a randomly selected sample is returned. All evaluations occur using these values instead of the average values.

*RST: depending on sensor

---

Sets the filter length i.e. the number of readings to be averaged for one measured value. The higher the count the lower the noise and the longer it takes to obtain a measured value.

**Parameters:**

<filter_length>

int_value

Range: depending on sensor

*RST: depending on sensor

Default unit: -
[SENSe[1]..4]:AVERage:COUNt:AUTO <state>

Can be used to automatically determine a value for the filter length
[SENSe[1]..4]:AVERage:COUNt. If the automatic switchover is activated with
the ON parameter, the sensor always defines a suitable filter length which can also be
queried via SENS[1]..4]:AVER:COUN?.

Parameters:
<state>          ON | OFF | ONCE
  ON
  Activates automatic switchover. The sensor always defines a
  suitable filter length which can also be queried via
  SENS[1]..4]:AVER:COUN?
  OFF
  Deactivates automatic switchover.
  ONCE
  The filter length is automatically detected during the next mea-
  surement and set to that value. Thereafter automatic filter length
detection is switched off. The setting can then be queried via
  SENS[1]..4]:AVER:COUN?

*RST:                depending on sensor

[SENSe[1]..4]:AVERage:COUNt:AUTO:MTIMe <mtime>

If the R&S NRP2 has to determine the filter length automatically, the filter length can
become large and thus also the measurement time.

An upper time limit can be set via SENS[1]..4]:AVER:COUN:AUTO:MTIME (maxi-
mum time). It should never be exceeded. Undesired long measurement times can thus
be prevented (in the SENS:AVER:COUN:AUTO:TYPE NSR mode) if the automatic filter
length switchover is on.

Parameters:
<mtime>          float_value, measurement time
  Range:          depending on sensor
  *RST:           depending on sensor
  Default unit:   S

[SENSe[1]..4]:AVERage:COUNt:AUTO:RESolution <resolution>

Defines the number of significant places for linear units and the number of decimal pla-
ces for logarithmic units which should be free of noise in the measurement result. This
setting is also performed by the command DISPlay[:WINDow]<[1]..4>: RESolution on page 245 that tries to set the sensors involved in the measurement
results accordingly. For further details, see chapter 4, "Instrument Functions",
on page 61.

The setting is only taken into account, if SENS:AVER:COUN:AUTO:TYPE is set to RES
and SENS:AVER:COUN:AUTO is ON.
However, SENS<[1]..4>:AVER:COUN:_AUTO:RES does not affect the DISPlay command. The parameters of the two commands are different but have the same meaning.

<table>
<thead>
<tr>
<th></th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
</tr>
</thead>
<tbody>
<tr>
<td>SENS&lt;[1]..4&gt;:AVER:COUN:_AUTO:RES</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DISP&lt;[1]..4&gt;:RES</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Parameters:

<<resolution>>

Parameter: int_value

Range: depending on sensor

*RST: depending on sensor

[SENSe<[1].4>:AVERage:COUNt:AUTO:SLOT <slot>]

Sets a timeslot whose measured value is used to automatically determine the filter length.

Parameters:

<slot> int_value

Range: depending on sensor

*RST: depending on sensor

[SENSe<[1].4>:AVERage:COUNt:AUTO:NSRatio <nsratio>]

Indicates the maximum noise ratio in the measurement result. Achieving the same result by filter length setting is attempted only if


Unit: DB | PCT

Parameters:

<nsratio> float_value

Range: depending on sensor

*RST: depending on sensor

Default unit: DB

[SENSe<[1].4>:AVERage:COUNt:AUTO:TYPE <mode>]

Selects a method by which the automatic filter length switchover can operate:
Remote Control - Commands

**SENSe (Sensor Commands)**

**Parameters:**

- **<mode>**
  - **RESolution**
    - Takes setting $\text{SENS}[1]..4]:\text{AVER}:\text{COUN}:\text{AUTO}:\text{RES}$ into account.
  - **NSR**
    - Takes setting $\text{SENS}[1]..4]:\text{AVER}:\text{COUN}:\text{AUTO}:\text{NSR}$ into account.

**<state>**

- **RST:** Depending on sensor

---

**[SENSe][1]..4]:AVERage:RESet**

Initializes the digital filter by deleting the stored measured values.

**Usage:** Event

---

**[SENSe][1]..4]:AVERage[:STATE] <state>**

Activates or deactivates the filter function of a sensor. If the filter is switched on, the individual measured values set with $\text{SENSe}[1]..4]:\text{AVERage}:\text{COUNT}$ are averaged. This reduces the impact of noise and helps to achieve measured values that are more stable.

**Parameters:**

- **<state>**
  - ON | OFF

**<state>**

**RST:** Depending on sensor

---

**[SENSe][1]..4]:AVERage:TCONtrol <mode>**

As soon as a new single value is determined, the filter window is advanced by one value so that the new value is taken into account by the filter and the oldest value is forgotten. $\text{[SENSe][1]..4]}:\text{AVERage}:\text{TCONtrl}$ (terminal control) then determines whether a new result is calculated immediately after a new measured value is available (MOVing) or only after an entire range of new values is available for the filter (REPeat).

**Note:**

In the MOVing mode, data from a point of time before the start of the current measurement can influence the measurement result if the data is still in the filter.

**Parameters:**

- **<mode>**
  - MOVing | REPeat

**<mode>**

**RST:** REPeat; (PRES) and SYST:PRES: MOVing

---

**[SENSe][1]..4]:BANDwidth:VIDeo <bandwidth>**

**[SENSe][1]..4]:BWIDth:VIDeo <bandwidth>**

Sets the video bandwidth for the Trace mode.
Parameters:  
<bandwidth>  
string  
Range:  "FULL", "5 MHz", "1.5 MHz", "300 kHz"  
*RST:  depending on sensor

[SENSe<[1]..4>]:BANDwidth:VIDeo:LIST?  
[SENSe<[1]..4>]:BWIDth:VIDeo:LIST?  
Provides a list of strings with permissible settings for  
the [SENSe<[1]..4>]:BWIDth:VIDeo command. Lists are not affected by the *RST  
command.  
Usage:  Query only

[SENSe<[1]..4>]:CORRection:OFFSet <offset_value>  
A fixed offset value can be defined for multiplying (logarithmically adding) the  
measured value of a sensor. If the parameters are specified without a unit, the unit set by  
UNIT:POW:RAT will be used.  
Unit: DB | PCT  
Parameters:  
<offset_value>  
float_value  
Range:  depending on sensor  
*RST:  depending on sensor  
Default unit: DB

[SENSe<[1]..4>]:CORRection:OFFSet:STATe <state>  
Switches the offset correction on or off.  
Parameters:  
<state>  
ON | OFF  
*RST:  depending on sensor

[SENSe<[1]..4>]:CORRection:DCYCle[:INPut][:MAGNitude] <magnitude>  
Informs the R&S NRP2 about the duty cycle of the power to be measured. The duty  
cycle correction is only applied in the ContAv mode where measurements are  
performed continuously without taking the timing of the signal into account.  
Parameters:  
<magnitude>  
float_value  
Range:  depending on sensor  
*RST:  depending on sensor  
Default unit: PCT
[SENSe<1..4>]:CORRection:DCYCle:STATe <state>

Switches duty cycle correction for the measured-value on or off.

Parameters:
<state>  
ON | OFF
*RST:  
depending on sensor

[SENSe<1..4>]:CORRection:FDOFfset[:INPut][:MAGNitude]? 

Queries the frequency dependent offset. The frequency-dependent measured-value correction is set by selecting a table with the [SENSe<1..4>]:CORRection:FDOTable[:SELect] and [SENSe<1..4>]:CORRection:FDOTable:STATe ON commands. The respective frequency-dependent correction factor is determined by means of the active tables (if necessary by interpolation) and can be queried with [SENSe<1..4>]:CORRection:FDOFfset[:INPut][:MAGNitude]? (frequency-dependent offset).

Unit: DB
Usage: Query only

[SENSe<1..4>]:CORRection:FDOTable[:SELect] <table_name>

The name of the current frequency-dependent offset table can be set or queried by the [SENSe<1..4>]:CORRection:FDOTable[:SELect] command. The R&S NRP2 can manage up to ten tables (MEMory commands). The frequency-dependent offset tables consist of two columns; the first containing the frequencies, the second the associated correction values. When the R&S NRP2 is informed about the signal frequency with command [SENSe<1..4>]:FREQuency[:CW|:FIXed] <float_value>, an appropriate correction factor is determined by means of the table. If the table was activated with [SENSe<1..4>]:CORRection:FDOTable:STATe[?] ON, the measurement result obtained by the sensor is multiplied by this factor.

Error messages:

-256 "File name not found": An invalid <string> parameter was transmitted.

Parameters:
<table_name>  
string
*RST:  
Settings are not changed in case of *RST.

[SENSe<1..4>]:CORRection:FDOTable:STATe <state>

Activates and deactivates the current frequency-dependent offset table. The current table is selected with the [SENSe<1..4>]:CORRection:FDOTable[:SELect] command. Only one table can be active at a time.
Several S-parameter tables can be stored in a sensor.

\[\text{SENSe}\{1\ldots4\}\text{]:CORRection:SPDevice:SELect }<\text{NR1}>\]

The \[\text{SENSe}\{1\ldots4\}\text{]:CORRection:SPDevice:STATe }<\text{ON}>\] command activates measured-value correction.

\[\text{SENSe}\{1\ldots4\}\text{]:CORRection:SPDevice:STATe }<\text{state}>\]

Informs the R&S NRP2 about the frequency of the power to be measured since this frequency is not automatically determined. The frequency is used to determine a frequency-dependent correction factor for the measurement results.

\[\text{SENSe}\{1\ldots4\}\text{]:FREQuency[:CW] }<\text{frequency}>\]
\[\text{SENSe}\{1\ldots4\}\text{]:FREQuency[:FIXed] }<\text{frequency}>\]

Sets the sensor to the selected measurement mode.

In remote control, the timing (\text{SENSe}:TIM:EXCL:STAR and \text{-}:STOP) and the trigger system of all measurement modes (except the Burst mode) are user-selectable.

\textbf{Note:}
To increase measurement accuracy, the sensors measure each signal twice in the Burst, Timeslot and Trace measurement modes (exception: in the Trace mode, with SENS:TRAC:REAL ON). As long as the trigger system is set to internal or external triggering, this is usually of no importance to the user. If TRIG:SOUR HOLD or BUS is used, however, then each measurement must be triggered twice (with *TRG or TRIG:IMM).

Error messages:

<table>
<thead>
<tr>
<th>Code</th>
<th>Error Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>24</td>
<td>&quot;Sensor mode not supported&quot;: A sensor does not support a measurement mode.</td>
<td></td>
</tr>
<tr>
<td>28</td>
<td>&quot;Sensor not idle&quot;: The sensor is not in the IDLE state.</td>
<td></td>
</tr>
<tr>
<td>-151</td>
<td>&quot;Invalid string data&quot;: An invalid parameter was transmitted for &lt;string&gt;.</td>
<td></td>
</tr>
</tbody>
</table>
Parameters:

<string>
"POWer:AVG"
ContAv
After a trigger event, the power is integrated over a time interval (averaging) set with SENS:POW:APER.

"POWer:TSLot:AVG"
Timeslot
The power is simultaneously measured in up to 26 time windows. The number of time windows is set with SENS:POW:TSL:COUN. The length of a time window is determined via SENS:POW:TSL:WIDT. The measurement result is represented by a vector that can contain up to 26 indices and contains the power of a time window at each index.

"POWer:TGATe:AVG"
Timegate
The Timegate mode is a pseudo-mode. It is used to determine accurate measured values in the gates defined with the aid of the Trace mode in manual operation. If one of the four gates is selected (SENS:TRAC:SEL), the sensor is internally put into the Timeslot mode and configured such that it determines the average power in this gate with high accuracy.

"POWer:BURSt:AVG"
Burst
In remote control, this measurement mode is very similar to the ContAv mode. The integration time is, however, not predefined but determined by the sensor with the aid of a burst detector. The start of a burst is detected when the measurement signal rises above the set trigger level. The end is set when the signal drops below the trigger threshold. SENS:POW:BURS:DTOL defines the time interval during which a signal drop below the trigger level is not interpreted as the end of the burst. In the Burst mode, the set trigger source is ignored and TRIG:SOUR INT is implicitly assumed.

"XPOWer:CCDF"
CCDF
The power in a settable time interval is measured and subsequently subjected to a statistical evaluation (CCDF). The measurement time is set using the SENS:STAT commands. The R&S NRP2 returns in response to READ? or FETCH? an array of density values which are spread over the power axis. The value range of the power axis is also set using the SENS:STAT:SCAL:X commands.

CDF
The CDF does not represent a separate mode in the sensor. It is calculated in the R&S NRP2 by way of the relation CDF = 1-CCDF.

"XPOWer:PDF"
Like "XPOWer:CCDF", except that a PDF is calculated instead of a CCDF.

"XTIMe:POWer"
A sequence of measurements is performed. The individual measured values are determined as in the ContAv mode. The length of an individual measurement is determined from the ratio of the total time (SENS:TRAC:TIME) and the number of individual test points (SENS:TRAC:POIN).

*RST: depending on sensor

[SENSe<[1..4]>::POWer::AVG::APERture <integration_time>]
Determines the integration time for a single measurement in the ContAv mode. To increase the measurement accuracy, this integration is followed by a second averaging procedure in a window with a selectable number of values. The filter window is configured with the [SENSe<[1..4]>::AVERage commands.

Parameters:
<integration_time> float_value
Range: depending on sensor
*RST: depending on sensor
Default unit: S

[SENSe<[1..4]>::POWer::AVG::BUFFER:SIZE <number>]
Sets the number of desired values for the buffered ContAv mode.

Parameters:
<number> int_value
Range: 1...400000
*RST: depending on sensor

[SENSe<[1..4]>::POWer::AVG::BUFFER:STATE <state>]
Switches on the buffered ContAv mode, after which data blocks rather than single measured values are then returned. In this mode a higher data rate is achieved than in the non-buffered ContAv mode.

The number of desired measured values is set with the SENSE<[1..4]>::POWer::ARR:SIZE command.

Parameters:
<state> ON | OFF
*RST: depending on sensor
[SENSe<[1]..4>][:POWer][:AVG]:RANGe <range>

Selects a measurement range in which the corresponding sensor is to perform a measurement. This setting will only become effective if SENS<[1]..4>:RANG:AUTO OFF is set.

Parameters:
<range> 0 | 1 | 2
*RST: depending on sensor

[SENSe<[1]..4>][:POWer][:AVG]:RANGe:AUTO <state>

Activates/deactivates the automatic selection of a measurement range.

Parameters:
<state> ON | OFF
*RST: depending on sensor

[SENSe<[1]..4>][:POWer][:AVG]:RANGe:CLEVel <level>

Sets the cross-over level. Shifts the transition ranges between the measurement ranges. This may improve the measurement accuracy for special signals, i.e. signals with a high crest factor.

Unit: DB | PCT

Parameters:
<clevel> float_value
Range: depending on sensor
*RST: depending on sensor
Default unit: DB

[SENSe<[1]..4>][:POWer][:AVG]:SMOothing:STATe <state>

Activates/deactivates digital lowpass filtering of the sampled video signal.

The problem of instable display values due to a modulation of a test signal described under SENS<[1]..4>:SAMP can also be eliminated by lowpass filtering of the video signal. The lowpass filter eliminates the variations of the display even in case of unperiodic modulation and does not require any other setting.

If modulation is periodic, setting the aperture time is the better method, since it allows shorter measurement times.

Parameters:
<state> ON | OFF
*RST: depending on sensor
[SENSe<[1].4>]:POWer]:BURSt:DTOLerance <tolerance>

The end of a burst (power pulse) is recognized when the signal level drops below the trigger level. Especially with modulated signals, this may also happen for a short time within a burst. To prevent the supposed end of the burst from being recognized too early or incorrectly at these positions, a time interval can be defined via SENS<[1].4>:BURS:DTOL (drop-out tolerance) in which the pulse end is only recognized if the signal level no longer exceeds the trigger level. This is shown in the figure below: The drop-out time, i.e. the time in which the signal remains below the trigger level, is shorter than the drop-out tolerance. The burst end is thus recognized correctly.

Fig. 6-10: Meaning of drop-out TOLerance

Parameters:
<tolerance> float_value
Range: depending on sensor
*RST: depending on sensor
Default unit: S

[SENSe<[1].4>]:POWer]:TGATe<[1].4>[:EXCLude]:MID:OFFSet[:TIME] <time interval>

Together with SENS:TGAT:MID:TIME, allows a time interval in a timegate to be blanked out. SENS:TGAT:MID:OFFS:TIME determines the distance from the start of the measurement to the start of the interval to be blanked out (see figure 6-11MID parameter in the Timegate mode).

Parameters:
<time interval> float_value
Range: depending on sensor
*RST: depending on sensor
Default unit: S
[SENSe<1..4>]:[POWer]:TGATe<1..4>:EXCLude:MID[:STATe] <state>

Activates/deactivates the blanking out of time intervals in the timegates, affects all gates.

Parameters:

<state>  
ON | OFF  
*RST: OFF

[SENSe<1..4>]:[POWer]:TGATe<1..4>:EXCLude:MID:TIME <time_interval>

Together with SENS:TGAT:MID:OFFS, allows a time interval in a timegate to be blanked out. SENS:TGAT:MID:TIME determines the distance from the start of the measurement to the start of the interval to be blanked out (see figure below).

Fig. 6-11: MID parameter in the Timegate mode

Parameters:

<time interval>  
float_value  
Range: depending on sensor  
*RST: depending on sensor  
Default unit: S

[SENSe<1..4>]:[POWer]:TGATe<1..4>:OFFSet:TIME <time>

Is used for configuring the Timegate mode. It specifies the start of one of the four gates (sweeps) relative to the delayed trigger point. If this value is negative, the gate starts before the trigger point. This is possible because the sensor stores samples of the measured powers and can thus transfer the start of a measurement to the past. In manual operation, the start and duration of the gates can also be defined graphically if the sensor is operated in the Trace mode.
Fig. 6-12: Timing parameters for the Timegate mode

Parameters:
<time> float_value
Range: depending on sensor
*RST: depending on sensor
Default unit: S

[SENSe<[1]..4>]:[POWer]:TGATe:SELe<ct> <time_gate>

Selects one of the four gates in which the average power is measured if the Timegate mode is selected.

Parameters:
<gate> 1 | 2 | 3 | 4
*RST: 1

[SENSe<[1]..4>]:[POWer]:TGATe<ct>[1]..4>:TIME <time>

Is used for configuring the Timegate mode. It specifies the duration of one of the four gates (sweeps) relative to the delayed trigger point. In manual operation, the start and duration of the gates can also be defined graphically if the sensor is operated in the Trace mode.

Parameters:
<time> float_value
Range: depending on sensor
*RST: depending on sensor
Default unit: S
**[SENSe<1..4>][:POWer]:TSLot:COUNt <number>**

Sets the number of simultaneously measured timeslots in the Timeslot mode (see figure 6-13 Timeslot parameters).

**Parameters:**
- `<number>`
  - **int_value**
  - **Range:** depending on sensor
  - **RST:** depending on sensor

**[SENSe<1..4>][:POWer]:TSLot[:EXCLude]:MID:OFFSet[:TIME] <time_interval>**

Together with **SENS:TSL:MID:TIME**, allows a time interval in the timeslots to be blanked out. **SENS:TSL:MID:OFFS:TIME** determines the distance from the start of the timeslots to the start of the interval to be blanked out (see figure 6-13 Timeslot parameters).

**Parameters:**
- `<time_interval>`
  - **float_value**
  - **Range:** depending on sensor
  - **RST:** depending on sensor
  - **Default unit:** S

**[SENSe<1..4>][:POWer]:TSLot[:EXCLude]:MID[:STATe] <state>**

Activates or deactivates the blanking out of time intervals in the timeslots. There is no direct command equivalent in the command groups of the power sensors. Instead, the length of the interval is set to zero.

**Parameters:**
- `<state>`
  - **ON | OFF**
  - **Range:** depending on sensor
  - **RST:** depending on sensor. If the *RST value of **SENS:TSL:MID:TIME** is zero, the *RST value of **SENS:TSL:MID:STAT** is OFF, otherwise it is ON.

**[SENSe<1..4>][:POWer]:TSLot[:EXCLude]:MID:TIME <time_interval>**

Together with **SENS:TSL:MID:OFFS:TIME**, allows a time interval in the timeslots to be blanked out. **SENS:TSL:MID:TIME** determines the length of the interval to be blanked out (see figure 6-13 Timeslot parameters).

**Parameters:**
- `<time_interval>`
  - **float_value**
  - **Range:** depending on sensor
  - **RST:** depending on sensor
  - **Default unit:** S
[SENSe<[1].4>]:POWer:TSLot:[AVG]:WIDTh <time>

Sets the length of the timeslot in the Timeslot mode (see figure below).

Parameters:

- `<time>`
  - float_value
  - Range: depending on sensor
  - *RST: depending on sensor
  - Default unit: S

[SENSe<[1].4>]:RGAMma[:MAGNitude] <magnitude>

The SENSe:RGAMma command group compensates for the reflection of the load at the signal output. Such a compensation is necessary if the VSWR exceeds a value of 1.05. Otherwise data sheet specifications for absolute accuracy cannot be met reliably.

To compensate for reflection, the magnitude of the reflection coefficient of the load with the SENSe:RGAMma:MAGNitude setting and the phase angle with the SENSe:RGAMma:PHASe setting must be transferred. To deactivate reflection compensation, SENSe:RGAMma:MAGNitude 0 must be set. Unlike with mismatch correction, there is no special activation/deactivation command. Reflection compensation should remain deactivated if the values measured for the load reflection coefficient are disputable.

Parameters:

- `<magnitude>`
  - float_value
  - Range: depending on sensor
  - *RST: depending on sensor

---

**Fig. 6-13: Timeslot parameters**

- Power
- Trigger event
- Trigger level
- Time
- T'Slot 1
- T'Slot 2
- T'Slot 3
- SENSe:TSLot:WIDTh
- SENSe:TSLot:COUNT 3
- SENSe:TSLot:MID:OFFS:TIME
- SENSe:TSLot:MID:TIME
- SENSe:TSLot:WIDTH
SENSe:R&GAMma:PHASe <phase_angle>

SENSe:RGAMma:PHASe defines the phase angle (in degrees) of the complex reflection factor of the load at the signal output.

Parameters:
- <phase_angle> float_value
  - Range: depending on sensor
  - *RST: depending on sensor
  - Default unit: only the unit degree is accepted

SENSe<[1]..4]>:SAMPling <sampling_rate>

If the signal to be measured has modulation sections just above the video bandwidth of the sensor used, measurement errors might be caused due to aliasing effects. In this case, the sampling rate of the sensor can be set to a safe lower value (FREQ2). However, the measurement time required to obtain noise-free results is extended compared to the normal sampling rate (FREQ1).

Parameters:
- <sampling_rate> FREQ1 | FREQ2
  - *RST: depending on sensor

SENSe<[1]..4]>:SGAMma[:MAGNitude] <magnitude>

The R&S NRP2 can perform a measured-value correction taking the complex reflection coefficient (source gamma) of the signal source into account. SENSe<[1]..4]>:SGAM:CORR:STAT ON must be set. The magnitude of the reflection coefficient is set with SENSe<[1]..4]>:SGAM[:MAGN].

Parameters:
- <magnitude> float_value
  - Range: depending on sensor
  - *RST: depending on sensor

SENSe<[1]..4]>:SGAMma:PHAS <phase>

The R&S NRP2 can perform a measured-value correction taking the complex reflection coefficient (source gamma) of the signal source into account. SENSe<[1]..4]>:SGAM:CORR:STAT ON must be set. The phase angle of the reflection coefficient is set with SENSe<[1]..4]>:SGAM:PHAS.

Parameters:
- <phase> float_value
  - Range: depending on sensor
  - *RST: depending on sensor
  - Default unit: degree
**[SENSe<1..4>]:SGAMma:CORRection:STATe <state>**

Activates/deactivates the measured-value correction of the reflection coefficient effect of the source gamma.

**Parameters:**
- `<state>`: ON | OFF
- *RST:* depending on sensor

**Usage:** Setting only

---

**[SENSe<1..4>]:STATistics:AVERage? <power_value>**

Returns the average power value calculated during a statistics measurement (CCDF/PDF).

**Unit:** DBM | W | DBUG

**Parameters:**
- `<power_value>`: float_value
  - Default unit: DBM

**Usage:** Query only

---

**[SENSe<1..4>]:STATistics[:EXCLude]:MID:OFFSet[:TIME] <time_interval>**

Together with SENS:STAT:MID:TIME, allows a time interval within the time window to be blanked out; in this interval, the data for the statistics is collected.
SENS:STAT:MID:OFFS determines the distance from the start of the measurement to the start of the interval to be blanked out (see also [SENSe<1..4>]:POWer[:TGATe<1..4>[:EXCLude]:MID:OFFSet[:TIME] on page 274).

**Parameters:**
- `<time_interval>`: float_value
  - Range: depending on sensor
  - *RST:* depending on sensor
  - Default unit: S

---

**[SENSe<1..4>]:STATistics[:EXCLude]:MID:TIME <time_interval>**

Together with SENS:STAT:MID:OFFS, allows a time interval within the time window to be blanked out; in this interval, the data for the statistics is collected.
SENS:STAT:MID:TIME determines the length of the interval to be blanked out (see also [SENSe<1..4>]:POWer[:TGATe<1..4>[:EXCLude]:MID:TIME on page 275).

**Parameters:**
- `<time_interval>`: float_value
  - Range: depending on sensor
  - *RST:* depending on sensor
  - Default unit: S
[SENSe<1..4>]:STATistics:PEAK?

Returns the peak power value calculated during a statistics measurement (CCDF/PDF).

Usage: Query only

[SENSe<1..4>]:STATistics:OFFSET[:TIME] <time_interval>

Determines, together with the SENS:STAT:TIME command, the time interval in which the power for the statistical evaluation is measured. SENS:STAT:OFFS determines the start of the interval relative to the (possibly delayed) trigger time (see also [SENSe<1..4>]:POWer:TGate<1..4>:OFFSET:TIME on page 275).

Parameters:

<time_interval> float_value
Range: depending on sensor
*RST: depending on sensor
Default unit: S

[SENSe<1..4>]:STATistics:SAMPLES[:MINimum] <minimum>

Determines the minimum number of samples to be included in the statistics. For this purpose, the filter length (which can only be set in powers of 2) is set such that the following inequality applies:

\[ N_{\text{fil}} \geq \frac{N_{\text{MinSamples}} \cdot \text{mpw}}{\text{dt}} \]

In this inequality, \( N_{\text{fil}} \) is the filter length (SENS:TRAC:AVER:COUN), \( \text{mpw} \) the time width of a sample and \( \text{dt} \) the length of the window in which the measurement is performed (SENS:STAT:TIME).

Parameters:

<minimum> int_value
*RST: 1e6

[SENSe<1..4>]:STATistics:SCALE:X:MPWidth?

Returns the minimum width of a sample on the power axis.

Parameters:

<mpwidth> float_value

Usage: Query only
**[SENSe<[1].4>]:STATistics:SCALe:X:POINts <number>**

Determines the number of samples on the power axis for the Statistics modes or returns the current setting. Due to the limited storage capacity of the R&S NRP2, the number is limited to 1024.

**Parameters:**

- `<number>`: int_value
- **Range:** 1 ... 1024

**[SENSe<[1].4>]:STATistics:SCALe:X:RANGe <range>**

Defines, together with the SENS:STAT:SCAL:X:RLEV command, the range on the power axis over which the statistics function (CCDF/PDF) is calculated (see figure 6-14: Setting the power axis for statistics measurements).

**Parameters:**

- `<range>`: float_value
- **Range:** depending on sensor
- **RST:** depending on sensor
- **Default unit:** DB

**[SENSe<[1].4>]:STATistics:SCALe:X:RLEV <rlevel>**

Defines, together with the SENS:STAT:SCAL:X:RANG command, the range on the power axis over which the statistics function (CCDF/PDF) is calculated (see figure below).

**Density/Distribution**

![Density/Distribution Diagram](attachment:image.png)

**Fig. 6-14: Setting the power axis for statistics measurements**

**Unit:** DBM | W | DBUV
**Parameters:**

- `<rlevel>`
  - float_value
  - Range: depending on sensor
  - *(RST):* depending on sensor
  - Default unit: DBM

**[SENSe<[1..4]>]:STATistics:TIME < time_interval>**

Determines, together with the `SENS:STAT:OFFS` command, the time interval in which the power for the statistical evaluation is measured. `SENS:STAT:TIME` determines the length of the interval (see also `[SENSe<[1..4]>]:POWer:TGATe<[1..4]>:TIME` on page 276).

**Parameters:**

- `<time_interval>`
  - float_value
  - Range: depending on sensor
  - *(RST):* depending on sensor
  - Default unit: S

**[SENSe<[1..4]>]:TIMing:EXCLude:STARt <exclude_start>**

Sets a time that is to be excluded at the beginning of the integration period.

**Parameters:**

- `<exclude_start>`
  - float_value
  - Range: depending on sensor
  - *(RST):* depending on sensor
  - Default unit: S

**[SENSe<[1..4]>]:TIMing:EXCLude:STOP <exclude_stop>**

Sets a time that is to be excluded at the end of the integration period. See figure 6-15 Effect of commands SENS<[1..4]>:TIM:EXCL:STAR and :STOP.

---

**User Manual 1173.9140.02 — 07**

**283**
Parameters:
<exclude_stop> float_value
Range: depending on sensor
*RST: depending on sensor

[SENSe<1..4>]:TRACe:AVERage[:STATe] <state>
Switches the filter function of a sensor on or off for the Trace mode. When the filter is switched on, the number of measured values set with [SENSe<1..4>]:AVERage:COUNT is averaged. This reduces the effect of noise so that more reliable results are obtained.
Parameters:
<state> ON | OFF
*RST: depending on sensor

[SENSe<1..4>]:TRACe:AVERage:COUNt <filter_length>
Sets the length of the filter for the Trace mode. The wider the filter, the lower the noise and the longer it takes to obtain a measured value.

Note:
Parameters:
<filter_length> The filter length can only be 1, 2, 4, 8, 16, ..., 2^n. If the entered filter length is not a power of two, the value is rounded to the next 2^n value without an error message.
Range: depending on sensor
*RST: depending on sensor

[SENSe<1..4>]:TRACe:AVERage:COUNt:AUTO <state>
Can be used to automatically determine a value for [SENSe<1..4>]:AVERage:COUNt for the trace mode.
**Parameters:**

<table>
<thead>
<tr>
<th>&lt;state&gt;</th>
<th>ON</th>
<th>OFF</th>
<th>ONCE</th>
</tr>
</thead>
</table>

**ON**
The automatic switchover is activated, the sensor always defines a suitable filter length which can also be queried via `SENS[1]..4]:AVER:COUN?`

**OFF**
The automatic switchover is deactivated.

**ONCE**
The automatic switchover is deactivated and the suitable filter length is then defined and set automatically. The setting can then be queried via `SENS[1]..4]:AVER:COUN?`

*RST:* depending on sensor

---

**[SENSe[1]..4]>:TRACe:AVERage:COUNt:AUTO:MTIMe <mtime>**

If the R&S NRP2 has to determine the filter length automatically in the Trace mode, the filter length can become large and thus also the time to fill the filter. An upper time limit (maximum time) can be set via `SENS[1]..4]:AVER:COUN:_AUTO:MTIME`. It should never be exceeded. Undesired long measurement times can thus be prevented (in the `SENS:AVer:COUN:_AUTO:TYPE NSR` mode) if the automatic filter length switchover is on.

**Parameters:**

<table>
<thead>
<tr>
<th>&lt;mtime&gt;</th>
<th>float_value</th>
</tr>
</thead>
</table>

**Range:** depending on sensor

*RST:* depending on sensor

Default unit: S

---

**[SENSe[1]..4]>:TRACe:AVERage:COUNt:AUTO:RESolution <resolution>**

Defines the number of significant places for the Trace mode for linear units and the number of decimal places for logarithmic units which should be free of noise in the measurement result. This setting is also performed by the command `DISPlay[:WINDow][1]..4]:RESolution` on page 245 which tries to set the sensors involved in the measurement result accordingly. For further details, see chapter 4, "Instrument Functions", on page 61.

However, `SENS[1]..4]>:AVER:COUN:_AUTO:RES` does not affect the `DISPlay` command. The parameters of the two commands are different but have the same meaning.

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><code>DISPlay[1]..4]&gt;:RES</code></td>
<td>1</td>
<td>0.1</td>
<td>0.01</td>
<td>0.001</td>
</tr>
</tbody>
</table>
Parameters:
<resolution>
1 | 2 | 3 | 4
Range: depending on sensor
*RST: depending on sensor

[SENSe<1..4>]:TRACe:AVerage:COUNT:AUTO:POINt <value>
Specifies the measured value in the Trace mode used for the automatic determination of the filter length.
Parameters:
<value>
int_value
Range: depending on sensor
*RST: depending on sensor

[SENSe<1..4>]:TRACe:AVerage:COUNT:AUTO:NSRatio <maximum_noise>
Indicates the maximum noise ratio in the measurement result for the Trace mode. The setting is taken into account only if SENs<1..4>:TRACe:AVER:COUNT:AUTO ON and SENs<1..4>:TRACe:AVER:COUNT:TYPE NSR are set.
Unit: DB | PCT
Parameters:
<maximum_noise>
float_value
Range: depending on sensor
*RST: depending on sensor
Default unit: DB

[SENSe<1..4>]:TRACe:AVerage:COUNT:AUTO:TYPE <trace_mode>
Selects the operating method for the automatic filter length in trace mode.
Parameters:
<trace_mode>
RESolution
Takes command SENs<1..4>:AVeR:COUNt:AUTO:RES into account.
NSR
Takes command SENs<1..4>:AVeR:COUNt:AUTO:NSR into account.
SENs<1..4>:AVeR:COUNt:AUTO:MTIM
*RST: depending on sensor
[SENSe<1..4>]:TRACe:AVERage:TCONtrol <terminal_control>

As soon as a new single value is determined, the filter window is advanced by one value so that the new value is taken into account by the filter and the oldest value is forgotten. [SENSe<1..4>]:AVERage:TCONtrol (terminal control) then determines in the Trace mode whether a new result will be calculated immediately after a new measured value is available (MOVing) or only after an entire range of new values is available for the filter (REPeat).

Parameters:
<terminal_control> MOVing | REPeat
*RST: REP; (PRES) and SYST:PRES:MOV;

[SENSe<1..4>]:TRACe:MEASurement:ALGorithm <algorithm>

Selects the analysis algorithm for detecting the pulse top and the pulse base power of a pulsed signal. These two power levels are fundamental for further signal analysis.

Parameters:
<algorithm> HISTogram
Computes the pulse levels by analyzing the histogram of the trace data. The pulse top level is taken on the mean value of all points representing the pulse top. Similarly the pulse base is determined from the points representing the pulse base.
Note: This algorithm is recommended for analyzing most of the pulse signals.
INTEgration
Computes the pulse as a reference top power by fitting a rectangle pulse of same energy into the pulse signal.
Note: Use this algorithm for pulse signals with modulation or when the pulse energy must be taken into account, e.g. when comparing the measurement result with a dual thermal power sensor.
PΕAK
Assigns the pulse peak power to the pulse top level.
*RST: depending on the sensor

[SENSe<1..4>]:TRACe:MEASurement:AUTO[:STATe] <state>

Switches on/off automatic transfer of the measured pulse parameters after each trace. This enables a synchronous display of the trace and the pulse data during a continuous measurement with INIT:CONT ON.

For pulse measurements, this settings has to be switched ON. See also SENS:TRAC:MEAS:STAT.

Parameters:
ystate> ON | OFF
*RST: depending on the sensor
[SENSe<1..4>]:TRACe:MEASurement:DEFine:DUratioN:REFeRence <ref_level>
Sets the medial reference level in terms of percentage of the pulse power amplitude. This level is used to define the pulse width, pulse start time and pulse stop time.
Unit: PCT | O
Parameters:
<ref_level> float_value
Range: depending on the sensor
*RST: depending on the sensor
Default unit: PCT

[SENSe<1..4>]:TRACe:MEASurement:DEFine:TRANsition:HREFeRence <href_level>
Sets the high reference level in terms of percentage of the pulse power amplitude. The "High Ref. Power" defines the end of the rising edge and the start of the falling edge of the pulse. These values are needed for measurement of the rise / fall time.
Unit: PCT | O
Parameters:
<ref_level> float_value
Range: depending on the sensor
*RST: depending on the sensor
Default unit: PCT

[SENSe<1..4>]:TRACe:MEASurement:DEFine:TRANsition:LREFeRence <lref_level>
Sets the low reference level in terms of percentage of the pulse power amplitude. The "Low Ref. Power" defines the start of the rising edge and the end of the falling edge of the pulse. These values are needed for measurement of the rise / fall time.
Unit: PCT | O
Parameters:
<ref_level> float_value
Range: depending on the sensor
*RST: depending on the sensor
Default unit: PCT

[SENSe<1..4>]:TRACe:MEASurement:POWer:AVG?
Returns the measured average power in the current trace.
Unit: WATT
Usage: Query only
[SENSe<[1]..4>]:TRACe:MEASurement:POWer:MAX?
Returns the measured maximum power in the current trace.
Unit: WATT
Usage: Query only

[SENSe<[1]..4>]:TRACe:MEASurement:POWer:MIN?
Returns the measured minimum power in the current trace.
Unit: WATT
Usage: Query only

[SENSe<[1]..4>]:TRACe:MEASurement:POWer:PULSe:BASE?
Returns the base power, computed in the pulse level analysis histogram of the current trace data.
Unit: WATT
Usage: Query only

[SENSe<[1]..4>]:TRACe:MEASurement:POWer:PULSe:TOP?
Returns the power of the first detected complete pulse of the current trace data, including rising and falling edges.
Unit: WATT
Usage: Query only

[SENSe<[1]..4>]:TRACe:MEASurement:PULSe:DCYCle?
Returns the duty cycle of the current trace data.
Unit: PCT
Usage: Query only

[SENSe<[1]..4>]:TRACe:MEASurement:PULSe:DURation?
Returns the pulse duration (pulse width) of the first detected pulse in the current trace.
Unit: S
Usage: Query only

[SENSe<[1]..4>]:TRACe:MEASurement:PULSe:PERiod?
Returns the time the pulse signal needs to complete one cycle.
Usage: Query only

[SENSe<1..4>]:TRACe:MEASurement:PULSe:SEParation?
Returns the time from "Stop Time" to "Start Time" of the first detected pulse.
Unit: S
Usage: Query only

[SENSe<1..4>]:TRACe:MEASurement:TRANSition:ESAMpling:AUTO[:STATe]?
Activates ON or deactivates OFF the equivalent sampling mode, which allows for high resolution measurements.
Parameters:
<state> ON | OFF
*RST: depending on the sensor
Usage: Query only

[SENSe<1..4>]:TRACe:MEASurement:TRANSition:NEGative:DURation?
Returns the fall time of the first detected pulse. The fall time is the time the signal requires to change from high to low level. High and low levels can be adjusted using the commands SENS:TRAC:MEAS:DEF:TRAN:HREF and SENS:TRAC:MEAS:DEF:TRAN:LREF.
Unit: S
Usage: Query only

[SENSe<1..4>]:TRACe:MEASurement:TRANSition:NEGative:OCCurrence?
Returns the stop point of the current pulse, i.e. the time when the signal passes through the medial reference level with falling edge. The medial level can be adjusted using the command SENS:TRAC:MEAS:DEF:DUR:REF.
Unit: S
Usage: Query only

[SENSe<1..4>]:TRACe:MEASurement:TRANSition:NEGative:OVERshoot?
Returns the amount of relative undershooting of the signal at the end of a pulse.
Unit: PCT
Usage: Query only
### [SENSe<[1]..4>]:TRACe:MEASurement:TRANSition:POSitive:DURation?

Returns the rise time of the first detected pulse. The rise time is the time the signal requires to change from low to high level. High and low levels can be adjusted using the commands `SENS:TRAC:MEAS:DEF:TRAN:HREF` and `SENS:TRAC:MEAS:DEF:TRAN:LREF`.

**Unit:** S  
**Usage:** Query only

### [SENSe<[1]..4>]:TRACe:MEASurement:TRANSition:POSitive:OCCurrence?

Returns the start point of the current pulse, i.e. the time when the signal passes through the medial reference level with rising edge. The medial level can be adjusted using the command `SENS:TRAC:MEAS:DEF:DUR:REF`.

**Unit:** S  
**Usage:** Query only

### [SENSe<[1]..4>]:TRACe:MEASurement:TRANSition:POSitive:OVERshoot?

Returns the amount of relative undershooting of the signal at the beginning of a pulse.

**Unit:** PCT  
**Usage:** Query only

### [SENSe<[1]..4>]:TRACe:MEASurement:TRANSition:SPERiod?

Returns the resolution of time-related pulse parameters in s. The respective value depends on the pulse measurement configuration and the measured signal.

**Unit:** O  
**Usage:** Query only

### [SENSe<[1]..4>]:TRACe:MEASurement[:STATe] <state>

Switches on/off automatic pulse measurements in the Trace mode. If pulse measurement is on, the sensor automatically determines the pulse parameters for the currently measured trace. For pulse measurements, also set `SENS:TRAC:MEAS:AUTO ON`.

**Parameters:**  
- `<state>`: ON | OFF  
- `*RST:`: depending on the sensor
[SENSe[1..4]::TRAcе:MID:OFFSet:TIME]

Defines an offset for pulse analysis on the time axis measured from the trigger event. In conjunction with SENS:TRAC:MEAS:TIME this command can be used to define a gate on a trace measurement, in which the pulse analysis shall be performed. If the gate spans the same time interval as the trace measurement, the first detected pulse will be analyzed. Using a gate, it is possible to investigate successive pulses.

Parameters:
<time>
  float_value
  Range: depending on the sensor
  *RST: depending on the sensor
  Default unit: S

[SENSe[1..4]::TRAcе:MID:TIME]

Defines the considered length for pulse analysis on the time axis. In conjunction with SENS:TRAC:MEAS:OFFS:TIME this command can be used to define a gate on a trace measurement, in which the pulse analysis shall be performed. If the gate spans the same time interval as the trace measurement, the first detected pulse will be analyzed. Using a gate, it is possible to investigate successive pulses.

Parameters:
<time>
  float_value
  Range: depending on the sensor
  *RST: depending on the sensor
  Default unit: S

[SENSe[1..4]::TRAcе:OFFSet:TIME <time>]

Determines the relative position of the trigger event in relation to the beginning of the Trace measurement sequence.

Parameters:
<time>
  float_value
  Range: depending on sensor
  *RST: depending on sensor
  Default unit: S

[SENSe[1..4]::TRAcе:POINts <points>]

Sets the number of desired values per Trace sequence.

Error messages:

28  "Sensor not idle": The sensor is not in the IDLE state.
Parameters:

```
int_value
Range: depending on sensor
*RST: depending on sensor
```

```
[SENSe<1..4>]:TRACe:REALtime <state>
```

In the default state (OFF), each measurement from the sensor is averaged. With
```
[SENSe<1..4>]:TRACe::REALtime ON
```
which may increase the measurement speed. With a higher measurement speed the
measured values of an individual measurement are immediately delivered.

Parameters:

```
<state>
ON | OFF
*RST: depending on sensor
```

```
[SENSe<1..4>]:TRACe:TIME <time>
```

Sets the time to be covered by the Trace sequence.

Parameters:

```
<time>
float_value
Range: depending on sensor
*RST: depending on sensor
Default unit: S
```

### 6.12 SERVice

The commands of the SERVice system are used for maintenance or test purposes.
They were implemented primarily to support device development. The numeric suffix
refers to the sensors.

Before commands of the SERVice system can be sent to a sensor, they must be
enabled via the SERVice:UNLock 1234 command.

```
SERVice<1..4>:CALibration:TEST?................................................................. 294
SERVice<1..4>:CALibration:TEMP.............................................................. 294
SERVice<1..4>:CALibration:TEMP:DATA?................................................. 294
SERVice:DISPLAY:OVERload....................................................................... 294
SERVice<1..4>:RCOunt.............................................................................. 295
SERVice<1..4>:RESULT............................................................................. 295
SERVice<1..4>:SERRors............................................................................. 295
SERVice<1..4>:UNLock.............................................................................. 295
```
SERVice<[1]..4>:CALibration:TEST? <NR1>
Tests the consistency of the calibration data set according to three criteria:

<table>
<thead>
<tr>
<th>If the following bit is set in &lt;nr1&gt;,</th>
<th>the following action is executed.</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 0</td>
<td>The serial number of the calibration data set is tested.</td>
</tr>
<tr>
<td>1 1</td>
<td>The checksum of the calibration data set is tested.</td>
</tr>
<tr>
<td>2 2</td>
<td>The header of the calibration data set is tested.</td>
</tr>
</tbody>
</table>

If an inconsistency of the data set is detected, the query returns a 1, otherwise a 0.

Parameters:
<NR1> int_value
Range: 0 to 255

Usage: Query only

SERVice<[1]..4>:CALibration:TEMP <state>
Initiates a temperature measurement of the sensor in question. The temperature can be queried with SERV:CAL:TEMP:DATA?.

Parameters:
<state> ONCE

Usage: Event

SERVice<[1]..4>:CALibration:TEMP:DATA?
Returns the temperature of the sensor in Kelvin if a temperature measurement was previously initiated by means of SERV:CAL:TEMP ONCE.

Usage: Query only

SERVice:DISPlay:OVERload <state>
Switches the sensor overload warning on/off.

Attention:
If the sensor is overloaded, it could be damaged! The warning should not be suppressed if you are not certain that the sensor is out of danger.

Parameters:
<state> ON | OFF
*RST: ON
SERVice<[1]..4>:RCOunt <nr1>
SERVice<[1]..4>:RESult <nr1>

Allows simulated measured values to be specified for test purposes. SERV:RCO specifies the number of SERV:RES pairs to follow. The first SERV:RES command specifies the measured value in watts, the second SERV:RES command determines how often the measured value should be obtained. The measurement sequences defined in this way are repeated until the sensor is disconnected from the R&S NRP2 and reconnected.

Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;nr1&gt;</td>
<td>int_value</td>
</tr>
<tr>
<td>*RST:</td>
<td>none. The simulation mode is not exited in the case of *RST. To again obtain real measured values, SERV:RCO 0 must be set.</td>
</tr>
</tbody>
</table>

Example:
The command sequence
SERV2:RCO 2
SERV2:RES 3
SERV2:RES 2
SERV2:RES 4
SERV2:RES 1
makes sensor 2 return the measured values 3 W, 3 W, 4 W, 3 W, 3 W, 4 W, ... from now on.

SERVice<[1]..4>:SERRors <state>

The sensors signal an error to the R&S NRP2 if samples are lost while a signal is sampled (sampling), as may be the case with high sampling rates. In such a case, the measurement is less accurate. Since this error is signaled as an SCPI error, smooth operation of a remote-control program may be disrupted. For this reason, sampling errors can be suppressed by means of SERVice<[1]..4>:SERRors OFF.

Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;state&gt;</td>
<td>ON</td>
</tr>
<tr>
<td>*RST:</td>
<td>The R&amp;S NRP2 BIOS setting is adopted.</td>
</tr>
</tbody>
</table>

SERVice<[1]..4>:UNLock <password>

Before other SERVice system commands are accepted, they must be enabled with SERV:UNL 1234.

Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;password&gt;</td>
<td>1234</td>
</tr>
</tbody>
</table>
6.13 STATUs

The status registers of the R&S NRP2 can be read and configured with commands of the STATus system.

The R&S NRP2 uses the following status registers:
- Standard Event Status Register (specified in IEEE 488.2. Reading and configuring with *ESR? and *ESE. This register is not handled by the STATus system.)
- Device Status Register
- Questionable Status Register
- Questionable Power Status Register
- Questionable Window Status Register
- Questionable Calibration Status Register
- Operation Status Register
- Operation Calibrating Status Register
- Operation Measuring Status Register
- Operation Trigger Status Register
- Operation Sense Status Register
- Operation Lower Limit Fail Status Register
- Operation Upper Limit Fail Status Register

Except for the Standard Event Status Register, each of these registers comprises five subregisters with which the function of the register can be configured.

These subregisters are called
- EVENt
- CONDition
- NTRansition
- PTRansition
- ENABle

The registers are 16 bits wide but only the lower 15 bits are used. This prevents problems with programs that cannot handle integers without sign.

The STATus system uses the following types of commands:

<table>
<thead>
<tr>
<th>Queries</th>
<th>return a decimal value between 0 and 32767 (=2^{15}-1).</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Configuration commands</strong></td>
<td>set the ENABle, PTRansition, NTRansition registers of a status register and thus determine the response of the register to status changes in the R&amp;S NRP2.</td>
</tr>
</tbody>
</table>
6.13.1 Queries

Table 6-15: Queries for status registers

<table>
<thead>
<tr>
<th>Command</th>
<th>Status register</th>
</tr>
</thead>
<tbody>
<tr>
<td>STATus:DEVice?</td>
<td>Device Status</td>
</tr>
<tr>
<td>STATus:OPERation?</td>
<td>Operation Status</td>
</tr>
<tr>
<td>STATus:OPERation:CALibrating[:SUMMary]?</td>
<td>Operation Calibrating</td>
</tr>
<tr>
<td>STATus:OPERation:LLFail[:SUMMary]?</td>
<td>Operation Lower Limit Fail</td>
</tr>
<tr>
<td>STATus:OPERation:ULFail[:SUMMary]?</td>
<td>Operation Upper Limit Fail</td>
</tr>
<tr>
<td>STATus:OPERation:MEASuring[:SUMMary]?</td>
<td>Operation Measuring</td>
</tr>
<tr>
<td>STATus:OPERation:SENSe[:SUMMary]?</td>
<td>Operation Sense</td>
</tr>
<tr>
<td>STATus:OPERation:TRIGger[:SUMMary]?</td>
<td>Operation Trigger</td>
</tr>
<tr>
<td>STATus:QUEStionable?</td>
<td>Questionable Status</td>
</tr>
<tr>
<td>STATus:QUEStionable:CALibration[:SUMMary]?</td>
<td>Questionable Calibration</td>
</tr>
<tr>
<td>STATus:QUEStionable:POWer[:SUMMary]?</td>
<td>Questionable Power</td>
</tr>
<tr>
<td>STATus:QUEStionable:WINDow[:SUMMary]?</td>
<td>Questionable Window</td>
</tr>
</tbody>
</table>

6.13.2 Configuration Commands

If the status register queries are extended by the character strings [:EVENt], :CONDition, :ENABle, :PTRansition or :NTRansition (without a question mark “?” at the end), the respective subregisters can be accessed. The enable and transition registers can also be set with these commands. The effect of the status reporting system can thus be adapted to user requirements. The parameters have the following meaning:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;status_register_summary_command&gt;</td>
<td>One of the status register queries from table 6-15 Queries for status registers to be used here (without a terminating question mark “?”).</td>
</tr>
<tr>
<td>&lt;NR1&gt;</td>
<td>Is a decimal value between 0 and 32767. The values DEFault, MINimum and MAXimum are not permissible.</td>
</tr>
</tbody>
</table>
| <non-decimal numeric> | Is a non-decimal value in one of the following formats, where the decimal value must be between 0 and 32767:  
  - binary (e.g. #b0111010101001110 or #B0111010101001110)  
  - hexadecimal (e.g. #h754e or #H754E)  
  - octal (e.g. #q72516 or #Q72516) |

<table>
<thead>
<tr>
<th>Command</th>
<th>Parameter</th>
<th>Remark</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;srsc&gt; = &lt;status_register_summary_command&gt;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;srsc&gt;[::EVENt]?</td>
<td></td>
<td>Query only</td>
</tr>
</tbody>
</table>
### Command Table

<table>
<thead>
<tr>
<th>Command</th>
<th>Parameter</th>
<th>Remark</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;srsc&gt;[:COND]ition?</code></td>
<td></td>
<td>Query only</td>
</tr>
<tr>
<td><code>&lt;srsc&gt;:ENABLE[?]</code></td>
<td>0..32767</td>
<td>&lt;non-decimal numeric&gt;</td>
</tr>
<tr>
<td><code>&lt;srsc&gt;:NTRansition[?]</code></td>
<td>0..32767</td>
<td>&lt;non-decimal numeric&gt;</td>
</tr>
<tr>
<td><code>&lt;srsc&gt;:PTRansition[?]</code></td>
<td>0..32767</td>
<td>&lt;non-decimal numeric&gt;</td>
</tr>
<tr>
<td>STATus:PRESet</td>
<td></td>
<td>table 6-32</td>
</tr>
</tbody>
</table>

The status reporting system stores all information about the current operating status of the device and errors that occur. The information is stored in the status registers and the error queue. The contents of the status registers and error queue can be queried via the IEC/IEEE bus. The information is hierarchically structured. The highest level is formed by the Status Byte Register (STB) defined by IEEE 488.2 and the associated Service Request Enable (SRE) register. The STB receives its information from the Standard Event Status Register (ESR) also defined by IEEE 488.2 and the associated Standard Event Status Enable (ESE) Register, as well as from the SCPI-defined Operation Status Register and the Questionable Status Register, which contain detailed information on the device, and from the Device Status Register.

The status reporting system also includes the IST flag (Individual STatus) and the Parallel Poll Enable Register (PPE) assigned to it. The IST flag, like the SRQ, combines the complete device status in a single bit. The PPE has the same function for the IST flag as the SRE has for the service request.

The output buffer (output queue) contains the messages the device returns to the controller. It is not part of the status reporting system but since it determines the value of the MAV bit in the STB it is also shown in [figure 6-17 Overview on structure of Status Reporting System.](#)

### 6.13.3 Structure of SCPI Status Register

Each SCPI register consists of five 16-bit registers which have different functions (see [figure 6-16 Standard SCPI status register](#)). The individual bits are independent of each other, i.e. each hardware status is assigned a bit number which is the same for all five registers. For instance, bit 4 of the operation status register is assigned to the hardware status "Measurement" in all five registers. Bit 15 (the most-significant bit) is set to zero in all registers. This prevents problems some controllers have with the processing of unsigned integers.
Summary bit of SCPI register, written into a bit of the STB or into the CONDition bit of a superordinate register.

States, events or summary bits of other registers

Logic AND of EVENT and ENABLE bits

Logic OR of all bits

Fig. 6-16: Standard SCPI status register

Table 6-16: Decimal value of individual bits in the SCPI status register

<table>
<thead>
<tr>
<th>Bit No.</th>
<th>Decimal value</th>
<th>Bit No.</th>
<th>Decimal value</th>
<th>Bit No.</th>
<th>Decimal value</th>
<th>Bit No.</th>
<th>Decimal value</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>1</td>
<td>4</td>
<td>16</td>
<td>8</td>
<td>256</td>
<td>12</td>
<td>4096</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>5</td>
<td>32</td>
<td>9</td>
<td>512</td>
<td>13</td>
<td>8192</td>
</tr>
<tr>
<td>2</td>
<td>4</td>
<td>6</td>
<td>64</td>
<td>10</td>
<td>1024</td>
<td>14</td>
<td>16384</td>
</tr>
<tr>
<td>3</td>
<td>8</td>
<td>7</td>
<td>128</td>
<td>11</td>
<td>2048</td>
<td>15</td>
<td>32768</td>
</tr>
</tbody>
</table>

Table 6-17: Standard SCPI status register

**CONDition register**
The CONDition register is directly written by the hardware or the summary bit of the next lower register. Its content reflects the current device status. This register can only be read; it cannot be written to or cleared. Reading the register does not change its contents.

**PTRansition register**
The Positive TRansition register acts as a transition filter. When a bit of the CONDition register changes from 0 to 1, the associated PTR bit determines whether the EVENT bit will be set to 1.
- PTR bit = 1: the EVENT bit is set.
- PTR bit = 0: the EVENT bit is not set.
This register can be written to and read. Reading the register does not change its contents.
### NTRransition register

The Negative TRansition register also acts as a transition filter. Upon transition of a bit of the CONDition register from 1 to 0, the associated NTR bit determines whether the EVENT bit is set to 1.

- **NTR bit = 1**: the EVENT bit is set.
- **NTR bit = 0**: the EVENT bit is not set.

This register can be written to and read. Reading the register does not change its contents.

With the aid of these two transition filter registers the user can define the status change of the CONDition register (none, 0 to 1, 1 to 0 or both) that is to be recorded in the EVENT register.

### EVENT register

The EVENT register reports whether an event has occurred since its last reading; it is the "memory" of the CONDition register. It only registers events that have been reported by the transition filters. The EVENT register is continuously updated by the device.

It can only be read by the user. Reading this register clears its contents.

This register is frequently referred to as the overall register.

### ENABle register

The ENABle register determines whether the associated EVENT bit influences the summary bit (see below). Each bit of the EVENT register is ANDed (symbol `&`) with the associated ENABle bit. The events of all logical operations of this register are ORed (symbol `+`) and passed on to the summary bit.

- **ENABle bit = 0**: the associated EVENT bit does not affect the summary bit.
- **ENABle bit = 1**: if the associated EVENT bit is "1", the summary bit is also set to "1".

This register can be written to and read as required. Reading the register does not change its contents.

### Summary bit

As stated above, the summary bit for each register is derived from the EVENT and ENABle registers. The result is entered into a bit of the CONDition register of the next higher register. The device automatically generates the summary bit for each register. An event may thus cause a service request through all hierarchical levels.

---

The Service Request Enable register (SRE) defined by IEEE488.2 can be viewed as the ENABle register of the STB. Accordingly, the ESE can be viewed as the ENABle register of the ESR.
Fig. 6-17: Overview on structure of Status Reporting System
Remote Control - Commands

Operation Calibrating Status Register

Sensor A calibrating
Sensor B calibrating
Sensor C calibrating
Sensor D calibrating

Operation Measuring Status Register

Sensor A measuring
Sensor B measuring
Sensor C measuring
Sensor D measuring

Operation Trigger Status Register

Sensor A waiting for trigger
Sensor B waiting for trigger
Sensor C waiting for trigger
Sensor D waiting for trigger

Operation Sense Status Register

Sensor A initializing
Sensor B initializing
Sensor C initializing
Sensor D initializing

Operation Lower Limit Fail Status Register

Window 1 Lower Limit Fail
Window 2 Lower Limit Fail
Window 3 Lower Limit Fail
Window 4 Lower Limit Fail
Window 5 Lower Limit Fail
Window 6 Lower Limit Fail
Window 7 Lower Limit Fail
Window 8 Lower Limit Fail

Operation Upper Limit Fail Status Register

Window 1 Upper Limit Fail
Window 2 Upper Limit Fail
Window 3 Upper Limit Fail
Window 4 Upper Limit Fail
Window 5 Upper Limit Fail
Window 6 Upper Limit Fail
Window 7 Upper Limit Fail
Window 8 Upper Limit Fail

Fig. 6-18: Operation Status Register
6.13.4 Description of Status Registers

In the following sections the SCPI status registers shown in figure 6-17, figure 6-18, figure 6-19 are described in detail:

- Status Byte (STB)
- Service Request Enable Register (SRE)
- Device Status Register
- Questionable Status Register
- Standard Event Status Register (ESR) with ENABle register (ESE)
- Operation Status Register
- Operation Calibrating Status Register
- Operation Measuring Status Register
- Operation Trigger Status Register
- Operation Sense Status Register
- Operation Lower Limit Fail Status Register
- Operation Upper Limit Fail Status Register
- Questionable Power Status Register
- Questionable Window Status Register
- Questionable Calibration Status Register
6.13.5 Status Byte (STB) and Service Request Enable Register (SRE)

The STB is already defined in IEEE 488.2. It gives a rough overview of the device status, collecting information from the lower-level registers. It is comparable with the CONDition register of a SCPI defined register and is at the highest level of the SCPI hierarchy. Its special feature is that bit 6 acts as the summary bit of all other bits of the Status Byte Register.

The status byte is read by the query *STB? or a serial poll. The SRE is associated with the STB. The function of the SRE corresponds to that of the ENABle register of the SCPI registers. Each bit of the STB is assigned a bit in the SRE. Bit 6 of the SRE is ignored. If a bit is set in the SRE and the associated bit in the STB changes from 0 to 1, a service request (SRQ) will be generated on the IEC/IEEE bus, which triggers an interrupt in the controller configured for this purpose, and can be further processed by the controller.

The SRE can be set by the command *SRE and read by the query *SRE?.

Table 6-18: Meaning of bits used in the status byte

<table>
<thead>
<tr>
<th>Bit No.</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Not used</td>
</tr>
</tbody>
</table>
| 1       | Device Status Register summary bit  
          Depending on the configuration of the device status register, this bit is set when a sensor is connected or disconnected, when an error has occurred in a sensor or when a key has been pressed. |
| 2       | Error Queue not empty  
          The bit is set if the error queue has an entry. If this bit is enabled by the SRE, each entry of the error queue will generate a service request. An error can thus be recognized and specified in detail by querying the error queue. The query yields a conclusive error message. This procedure is recommended since it considerably reduces the problems of IEC/IEEE-bus control. |
| 3       | Questionable Status Register summary bit  
          This bit is set if an EVENT bit is set in the QUESTIONable Status Register and the associated ENABLe bit is set to 1. A set bit denotes a questionable device status which can be specified in greater detail by querying the QUESTIONable Status Register. |
| 4       | MAV-Bit (Message available)  
          This bit is set if a readable message is in the output queue. This bit may be used to automate reading of data from the device into the controller. |
| 5       | ESB: Standard Event Status Register summary bit  
          This bit is set if one of the bits in the Standard Event Status Register is set and enabled in the Event Status Enable Register. Setting this bit denotes a serious error which can be specified in greater detail by querying the Standard Event Status Register. |
### 6.13.6 IST Flag and Parallel Poll Enable Register (PPE)

Similar to the SRQ, the IST flag combines the complete status information in a single bit. It can be queried by a parallel poll (see chapter 6.13.20.3, "Parallel Poll", on page 316) or by the \*IST? command.

The Parallel Poll Enable Register (PPE) determines which bits of the STB affect the IST flag. The bits of the STB are ANDed with the corresponding bits of the PPE; bit 6 is also used - in contrast to the SRE. The IST flag is obtained by ORing all results together.

The PPE can be set by the \*PRE command and read by the \*PRE? query.

### 6.13.7 Device Status Register

This register contains information on current device states (CONDition register) or states that occurred since the last query (EVENt register).

The register can be read by the queries STATus:DEVice:CONDition? or STATus:DEVice[:EVENt]?

#### Table 6-19: Meaning of bits used in the Device Status Register

<table>
<thead>
<tr>
<th>Bit No.</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Not used</td>
</tr>
<tr>
<td>1</td>
<td>Sensor A connected</td>
</tr>
<tr>
<td>2</td>
<td>Sensor B connected</td>
</tr>
<tr>
<td>3</td>
<td>Sensor A error</td>
</tr>
<tr>
<td></td>
<td>Sensor A is erroneous.</td>
</tr>
<tr>
<td>4</td>
<td>Sensor B error</td>
</tr>
<tr>
<td></td>
<td>Sensor B is erroneous.</td>
</tr>
<tr>
<td>5</td>
<td>Sensor A Front/Rear</td>
</tr>
<tr>
<td></td>
<td>Indicates whether sensor A is connected at the front (bit is not set) or rear (bit is set) of the device.</td>
</tr>
</tbody>
</table>
### 6.13.8 Questionable Status Register

This register contains information on questionable device states. Such states may occur when the device is not operated in compliance with its specifications. The register can be read by the queries `STATus:QUEStionable:CONDition?` or `STATus:QUEStionable[:EVENt]?`.

**Table 6-20: Meaning of bits used in the Questionable Status Register**

<table>
<thead>
<tr>
<th>Bit No.</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 to 2</td>
<td>Not used</td>
</tr>
<tr>
<td>3</td>
<td><strong>Questionable Power Status Register summary bit</strong>&lt;br&gt;Corresponds to the summary bit of the Questionable Power Status Register.</td>
</tr>
<tr>
<td>4</td>
<td><strong>Questionable Window Status Register summary bit</strong>&lt;br&gt;Corresponds to the summary bit of the Questionable Windows Status Register.</td>
</tr>
<tr>
<td>5 to 7</td>
<td>Not used</td>
</tr>
<tr>
<td>8</td>
<td><strong>Questionable Calibration Status Register summary bit</strong>&lt;br&gt;Corresponds to the summary bit of the Questionable Calibration Status Register.</td>
</tr>
</tbody>
</table>
### 6.13.9 Standard Event Status and Enable Register (ESR, ESE)

The ESR is already defined in the IEEE 488.2 standard. It is comparable to the EVENT register of an SCPI register. The Standard Event Status Register can be read out by the query `*ESR?`.

The ESE forms the associated ENABle register. It can be set by the command `*ESE` and read out by the query `*ESE?`.

#### Table 6-21: Meaning of bits used in the Standard Event Status Register

<table>
<thead>
<tr>
<th>Bit No.</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Operation Complete</td>
</tr>
<tr>
<td></td>
<td>When the <code>*OPC</code> command is received, this bit is set if all previous commands have been executed.</td>
</tr>
<tr>
<td>1</td>
<td>Not used</td>
</tr>
<tr>
<td>2</td>
<td>Query Error</td>
</tr>
<tr>
<td></td>
<td>This bit is set in either of the two following cases: the controller wants to read data from the device but has not sent a query, or it sends new commands to the device before it retrieves existing requested data. A frequent cause is a faulty query which cannot be executed.</td>
</tr>
<tr>
<td>3</td>
<td>Device-dependent Error</td>
</tr>
<tr>
<td></td>
<td>This bit is set if a device-dependent error occurs. An error message with a number between -300 and -399 or a positive error number denoting the error in greater detail will be entered in the error queue.</td>
</tr>
<tr>
<td>4</td>
<td>Execution Error</td>
</tr>
<tr>
<td></td>
<td>This bit is set if the syntax of a received command is correct but the command cannot be executed due to various marginal conditions. An error message with a number between -200 and -300 denoting the error in greater detail will be entered in the error queue.</td>
</tr>
<tr>
<td>5</td>
<td>Command Error</td>
</tr>
<tr>
<td></td>
<td>This bit is set if an undefined command or a command with incorrect syntax is received. An error message with a number between -100 and -200 denoting the error in greater detail will be entered in the error queue.</td>
</tr>
<tr>
<td>6</td>
<td>User Request</td>
</tr>
<tr>
<td></td>
<td>This bit is set upon pressing the [LOCAL] key, i.e. when the device is switched to manual control.</td>
</tr>
<tr>
<td>7</td>
<td>Power On</td>
</tr>
<tr>
<td></td>
<td>This bit is set when the device is switched on.</td>
</tr>
</tbody>
</table>
6.13.10 Operation Status Register

The CONDition register contains information on the operations currently being performed by the device, while the EVENT register contains information on the operations performed by the device since the last readout of the register.

These two registers can be read by the queries STATus:OPERation:CONDition? or STATus:OPERation[:EVENt]?.

<table>
<thead>
<tr>
<th>Bit No.</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Operation Calibrating Status Register summary bit</td>
</tr>
<tr>
<td></td>
<td>This bit is set if one of the sensors is being calibrated.</td>
</tr>
<tr>
<td>1 to 3</td>
<td>Not used</td>
</tr>
<tr>
<td>4</td>
<td>Operation Measuring Status Register summary bit</td>
</tr>
<tr>
<td></td>
<td>This bit is set if one of the sensors is performing a measurement.</td>
</tr>
<tr>
<td>5</td>
<td>Operation Trigger Status Register summary bit</td>
</tr>
<tr>
<td></td>
<td>This bit is set if a sensor is in the WAIT_FOR_TRG state, i.e. waiting</td>
</tr>
<tr>
<td></td>
<td>for a trigger event.</td>
</tr>
<tr>
<td>6</td>
<td>Not used</td>
</tr>
<tr>
<td>7 to 9</td>
<td>Not used</td>
</tr>
<tr>
<td>10</td>
<td>Operation Sense Status Register summary bit</td>
</tr>
<tr>
<td></td>
<td>This bit is set if a sensor is initialized.</td>
</tr>
<tr>
<td>11</td>
<td>Operation Lower Limit Fail Status Register</td>
</tr>
<tr>
<td></td>
<td>This bit is set if a displayed value has dropped below a lower limit</td>
</tr>
<tr>
<td></td>
<td>value.</td>
</tr>
<tr>
<td>12</td>
<td>Operation Upper Limit Fail Status Register</td>
</tr>
<tr>
<td></td>
<td>This bit is set if a displayed value has exceeded an upper limit value.</td>
</tr>
<tr>
<td>13 to 14</td>
<td>Not used</td>
</tr>
<tr>
<td>15</td>
<td>Bit 15 will never be used.</td>
</tr>
</tbody>
</table>

6.13.11 Operation Calibrating Status Register

The CONDition register contains information as to whether a sensor is currently being calibrated and, depending on the configuration of the transition register, the EVENT register indicates whether a calibration was started or completed since the last readout of this register. The Operation Calibration Status Register can be read by the following commands:

STATus:OPERation:CALibrating[:SUMMary]:CONDition?

STATus:OPERation:CALibrating[:SUMMary][:EVENt]?.

Table 6-22: Meaning of bits used in the Operation Status Register
6.13.12 Operation Measuring Status Register

The CONDition register contains information as to whether a measurement is being performed by a sensor and, depending on the configuration of the transition register, the EVENT register indicates whether a measurement was started or completed since the last readout of this register.

The Operation Measuring Status Register can be read by the following commands:

```
STATus:OPERation:MEASuring[:SUMMary]:CONDition?
STATus:OPERation:MEASuring[:SUMMary][:EVENt]?
```

Table 6-24: Meaning of bits used in the Operation Measuring Status Register

<table>
<thead>
<tr>
<th>Bit No.</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Not used</td>
</tr>
</tbody>
</table>
| 1       | Sensor A measuring  
Sensor A is performing a measurement. |
| 2       | Sensor B measuring  
Sensor B is performing a measurement. |
| 3       | Sensor C measuring  
Sensor C is performing a measurement. |
| 4       | Sensor D measuring  
Sensor D is performing a measurement. |
| 5 to 14 | Not used |
| 15      | Bit 15 will never be used. |

6.13.13 Operation Trigger Status Register

The CONDition register contains information as to whether a sensor is currently in the WAIT_FOR_TRG state, i.e. expecting a trigger event and, depending on the configuration of the transition register, the EVENT register indicates whether the
WAIT_FOR_TRG state was entered or quit by a sensor since the last readout of the register.

The Operation Trigger Status Register can be read by the following commands:

```
STATus:OPERation:TRIGger[:SUMMary]:CONDition?
STATus:OPERation:TRIGger[:SUMMary][:EVENt]?
```

<table>
<thead>
<tr>
<th>Bit No.</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Not used</td>
</tr>
<tr>
<td>1</td>
<td>Sensor A waiting for trigger&lt;br&gt;Sensor A is in the WAIT_FOR_TRG state and is waiting for a trigger event that will change it to the MEASURING state.</td>
</tr>
<tr>
<td>2</td>
<td>Sensor B waiting for trigger&lt;br&gt;Sensor B is in the WAIT_FOR_TRG state and is waiting for a trigger event that will change it to the MEASURING state.</td>
</tr>
<tr>
<td>3</td>
<td>Sensor C waiting for trigger&lt;br&gt;Sensor C is in the WAIT_FOR_TRG state and is waiting for a trigger event that will change it to the MEASURING state.</td>
</tr>
<tr>
<td>4</td>
<td>Sensor D waiting for trigger&lt;br&gt;Sensor D is in the WAIT_FOR_TRG state and is waiting for a trigger event that will change it to the MEASURING state.</td>
</tr>
<tr>
<td>5 to 14</td>
<td>Not used</td>
</tr>
<tr>
<td>15</td>
<td>Bit 15 will never be used.</td>
</tr>
</tbody>
</table>

### 6.13.14 Operation Sense Status Register

The CONDition register contains information as to whether a sensor is currently being initialized and, depending on the configuration of the transition register, the EVENT register indicates whether a sensor initialization was started or completed since the last readout of this register.

This status is assumed by a sensor if one of the following conditions is met:
- the supply voltage is switched on (power up)
- the sensor was just connected
- a reset was performed (*RST or SYSTem:PRESet)

The Operation Sense Status Register can be read by the following commands:

```
STATus:OPERation:SENSe[:SUMMary]:CONDition?
STATus:OPERation:SENSe[:SUMMary][:EVENt]?
```
### Table 6-26: Meaning of bits used in the Operation Sense Status Register

<table>
<thead>
<tr>
<th>Bit No.</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Not used</td>
</tr>
<tr>
<td>1</td>
<td>Sensor A initializing</td>
</tr>
<tr>
<td></td>
<td>Sensor A is being initialized.</td>
</tr>
<tr>
<td>2</td>
<td>Sensor B initializing</td>
</tr>
<tr>
<td></td>
<td>Sensor B is being initialized.</td>
</tr>
<tr>
<td>3</td>
<td>Sensor C initializing</td>
</tr>
<tr>
<td></td>
<td>Sensor C is being initialized.</td>
</tr>
<tr>
<td>4</td>
<td>Sensor D initializing</td>
</tr>
<tr>
<td></td>
<td>Sensor D is being initialized.</td>
</tr>
<tr>
<td>5 to 14</td>
<td>Not used</td>
</tr>
<tr>
<td>15</td>
<td>Bit 15 will never be used.</td>
</tr>
</tbody>
</table>

### 6.13.15 Operation Lower Limit Fail Status Register

The CONDITION register contains information as to whether a displayed value is currently below a configured lower limit and the EVENT register indicates whether a measured value dropped below a limit value since the last readout of the Operation Lower Limit Fail Status Register. Details of the behavior are defined by the transition register.

The limit value can be set with the command `CALC:LIM:LOW:DATA <float_value>`.

Command `CALC:LIM:LOW:STAT ON` configures the PTransition and NTransition registers so that the corresponding bit is set in the EVENT register when the displayed value drops below the limit.

The Operation Lower Limit Fail Status Register can be read by the following commands:

- `STATus:OPERation:LLIMit[:SUMMary]:CONDition?`
- `STATus:OPERation:LLIMit[:SUMMary][:EVENt]?`

### Table 6-27: Meaning of bits used in the Operation Lower Limit Fail Status Register

<table>
<thead>
<tr>
<th>Bit No.</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Not used</td>
</tr>
<tr>
<td>1</td>
<td>Window 1 Lower Limit Fail</td>
</tr>
<tr>
<td></td>
<td>The measured value returned by the first Calculate block drops below the lower limit value.</td>
</tr>
<tr>
<td>2</td>
<td>Window 2 Lower Limit Fail</td>
</tr>
<tr>
<td></td>
<td>The measured value returned by the second Calculate block drops below the lower limit value.</td>
</tr>
<tr>
<td>3</td>
<td>Window 3 Lower Limit Fail</td>
</tr>
<tr>
<td></td>
<td>The measured value returned by the third Calculate block drops below the lower limit value.</td>
</tr>
</tbody>
</table>
### Operation Upper Limit Fail Status Register

The CONDition register contains information as to whether a displayed value is currently above a configured upper limit and the EVENT register indicates whether a limit value was exceeded since the last readout of the Operation Upper Limit Fail Status Register. Details of the behavior are defined by the transition register. The limit value can be set with the command `CALC:LIM:UPP:DATA <float_value>`.

Command `CALC:LIM:UPP:STAT ON` configures the PTRansition and NTRansition registers so that the corresponding bit is set in the EVENT register when the displayed value exceeds the upper limit value.

The Operation Upper Limit Fail Status Register can be read by the commands:

```
STATus:OPERation:ULIMit[:SUMMary]:CONDition?
STATus:OPERation:ULIMit[:SUMMary][:EVENt]?
```

<table>
<thead>
<tr>
<th>Bit No.</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Not used</td>
</tr>
<tr>
<td>1</td>
<td>Window 1 Upper Limit Fail</td>
</tr>
<tr>
<td></td>
<td>The measured value returned by the first Calculate block exceeds the upper limit value.</td>
</tr>
<tr>
<td>2</td>
<td>Window 2 Upper Limit Fail</td>
</tr>
<tr>
<td></td>
<td>The measured value returned by the second Calculate block exceeds the upper limit value.</td>
</tr>
<tr>
<td>3</td>
<td>Window 3 Upper Limit Fail</td>
</tr>
<tr>
<td></td>
<td>The measured value returned by the third Calculate block exceeds the upper limit value.</td>
</tr>
</tbody>
</table>
### 6.13.17 Questionable Power Status Register

The CONDition register contains information as to whether the measured power values are questionable.

The Questionable Power Status Register can be read by the following commands:

```plaintext
STATus:QUESTionable:POWer[:SUMMary]:CONDition?
STATus:QUESTionable:POWer[:SUMMary][:EVENt]?
```

<table>
<thead>
<tr>
<th>Bit No.</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Not used</td>
</tr>
<tr>
<td>1</td>
<td>Sensor A Power</td>
</tr>
<tr>
<td></td>
<td>The measurement data of sensor A is corrupt.</td>
</tr>
<tr>
<td>2</td>
<td>Sensor B Power</td>
</tr>
<tr>
<td></td>
<td>The measurement data of sensor B is corrupt.</td>
</tr>
<tr>
<td>3</td>
<td>Sensor C Power</td>
</tr>
<tr>
<td></td>
<td>The measurement data of sensor C is corrupt.</td>
</tr>
<tr>
<td>4</td>
<td>Sensor D Power</td>
</tr>
<tr>
<td></td>
<td>The measurement data of sensor D is corrupt.</td>
</tr>
<tr>
<td>5</td>
<td>Sensor A please zero</td>
</tr>
<tr>
<td></td>
<td>The zero correction for sensor A is no longer correct and should be repeated.</td>
</tr>
<tr>
<td>6</td>
<td>Sensor B please zero</td>
</tr>
<tr>
<td></td>
<td>The zero correction for sensor B is no longer correct and should be repeated.</td>
</tr>
<tr>
<td>7</td>
<td>Sensor C please zero</td>
</tr>
<tr>
<td></td>
<td>The zero correction for sensor C is no longer correct and should be repeated.</td>
</tr>
</tbody>
</table>

---

**Table 6-29: Meaning of bits used in the Questionable Power Status Register**

<table>
<thead>
<tr>
<th>Bit No.</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Not used</td>
</tr>
<tr>
<td>1</td>
<td>Sensor A Power</td>
</tr>
<tr>
<td></td>
<td>The measurement data of sensor A is corrupt.</td>
</tr>
<tr>
<td>2</td>
<td>Sensor B Power</td>
</tr>
<tr>
<td></td>
<td>The measurement data of sensor B is corrupt.</td>
</tr>
<tr>
<td>3</td>
<td>Sensor C Power</td>
</tr>
<tr>
<td></td>
<td>The measurement data of sensor C is corrupt.</td>
</tr>
<tr>
<td>4</td>
<td>Sensor D Power</td>
</tr>
<tr>
<td></td>
<td>The measurement data of sensor D is corrupt.</td>
</tr>
<tr>
<td>5</td>
<td>Sensor A please zero</td>
</tr>
<tr>
<td></td>
<td>The zero correction for sensor A is no longer correct and should be repeated.</td>
</tr>
<tr>
<td>6</td>
<td>Sensor B please zero</td>
</tr>
<tr>
<td></td>
<td>The zero correction for sensor B is no longer correct and should be repeated.</td>
</tr>
<tr>
<td>7</td>
<td>Sensor C please zero</td>
</tr>
<tr>
<td></td>
<td>The zero correction for sensor C is no longer correct and should be repeated.</td>
</tr>
</tbody>
</table>
Bit No. | Meaning
--- | ---
8 | Sensor D please zero
The zero correction for sensor D is no longer correct and should be repeated.
9 to 14 | Not used
15 | Bit 15 will never be used.

The sensor power bit is set when error -230, "Data corrupt or stale", or -231, "Data questionable", occurs in the respective sensor.

### 6.13.18 Questionable Window Status Register

The CONDition register contains information as to whether the displayed data or the power calculated by the calculate blocks is questionable.

The Questionable Window Status Register can be read by the following commands:

- `STATus:QUEStionable:WINDow[:SUMMary]:CONDition?`
- `STATus:QUEStionable:WINDow[:SUMMary][:EVENt]?`

#### Table 6-30: Meaning of bits used in the Questionable Window Status Register

<table>
<thead>
<tr>
<th>Bit No.</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Not used</td>
</tr>
</tbody>
</table>
| 1 | Window 1 Power  
The measured values returned by Calculate block 1 are corrupt. |
| 2 | Window 2 Power  
The measured values returned by Calculate block 2 are corrupt. |
| 3 | Window 3 Power  
The measured values returned by Calculate block 3 are corrupt. |
| 4 | Window 4 Power  
The measured values returned by Calculate block 4 are corrupt. |
| 5 | Window 5 Power  
The measured values returned by Calculate block 5 are corrupt. |
| 6 | Window 6 Power  
The measured values returned by Calculate block 6 are corrupt. |
| 7 | Window 7 Power  
The measured values returned by Calculate block 7 are corrupt. |
| 8 | Window 8 Power  
The measured values returned by Calculate block 8 are corrupt. |
| 9 to 14 | Not used |
| 15 | Bit 15 will never be used. |
A bit is set if the error -231, "Data questionable", occurs in the respective calculate block.

6.13.19 Questionable Calibration Status Register

The EVENt register and the CONDition register contain information as to whether the zero offset of a sensor is still valid.

The Questionable Calibration Status Register can be read by the following commands:

```
STATus:QUEStionable:CALibration[:SUMMary]:CONDition?
STATus:QUEStionable:CALibration[:SUMMary][:EVENt]?
```

Table 6-31: Meaning of bits used in the Questionable Calibration Status Register

<table>
<thead>
<tr>
<th>Bit No.</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Not used</td>
</tr>
<tr>
<td>1</td>
<td>Sensor A Calibration</td>
</tr>
<tr>
<td></td>
<td>Zeroing of sensor A was not successful.</td>
</tr>
<tr>
<td>2</td>
<td>Sensor B Calibration</td>
</tr>
<tr>
<td></td>
<td>Zeroing of sensor B was not successful.</td>
</tr>
<tr>
<td>3</td>
<td>Sensor C Calibration</td>
</tr>
<tr>
<td></td>
<td>Zeroing of sensor C was not successful.</td>
</tr>
<tr>
<td>4</td>
<td>Sensor D Calibration</td>
</tr>
<tr>
<td></td>
<td>Zeroing of sensor D was not successful.</td>
</tr>
<tr>
<td>5 to 14</td>
<td>Not used</td>
</tr>
<tr>
<td>15</td>
<td>Bit 15 will never be used.</td>
</tr>
</tbody>
</table>

6.13.20 Use of Status Reporting System

For an efficient use of the status reporting system, the information it contains has to be transferred to the controller and further processed. There are various methods which are described in the following.

6.13.20.1 Service Request, Use of the Hierarchical Structure

Under certain conditions, the device may send a service request (SRQ) to the controller. This service request usually causes an interrupt at the controller to which the controller program can respond by suitable actions. As shown in figure 6-17 Overview on structure of Status Reporting System, an SRQ will always be triggered if one or several of the bits 2, 3, 4, 5 or 7 have been set in the Status Byte Register and enabled in the SRE. Each of these bits combines the information from another register, from the error queue or the output buffer. If the ENAble registers of the status registers are set accordingly, any bit in any status register will be able to trigger an SRQ. To utilize the
possibilities of the service request, all bits in the enable registers SRE and ESE should be set to "1".

Examples

See also figure 6-17 Overview on structure of Status Reporting System.

Use the *OPC command to generate an SRQ:
1. Set bit 0 (operation complete) in the ESE.
2. Set bit 5 (ESB) in the SRE.

The device generates an SRQ upon completion of its settings.

Informing the controller by an SRQ that a measurement has been completed:
1. Set bit 7 (summary bit of Status Operation Register) in the SRE.
2. Set bit 4 (measuring) in the ENABle register of the Status Operation Register.
3. Set bit 4 in the NTRansition register of the Status Operation Register to make certain that the transition of measuring bit 4 from 1 to 0 (end of measurement) is also recorded in the EVENt register.

The device generates an SRQ when the measurement is completed.

The SRQ is the only way for the device to become active of its own. Each controller program should set the device such that a service request is triggered in case of malfunctions. The program should respond accordingly to the service request.

6.13.20.2 Serial Poll

Like the *STB? command, the serial poll is used to query the status byte of a device. Querying is implemented by interface messages, however, and is therefore much quicker. The serial poll method has already been defined in the IEEE 488.1 standard, and used to be the only standard method of querying the Status Byte Register. This method also works with devices that conform neither to SCPI nor to IEEE 488.2. Serial poll is mainly used to obtain a quick overview of the device status of several devices connected to the IEC/IEEE bus.

6.13.20.3 Parallel Poll

In case of a parallel poll, up to eight devices are simultaneously requested by the controller to transmit one bit of information on the data line, i.e. to set the data line assigned to each device to logical 0 or 1. Analogously to the SRE register, which determines the conditions for generating an SRQ, a Parallel Poll Enable Register (PPE) is available which is ANDed bit-by-bit with the STB (taking into account bit 6). The results are ORed and the result is then sent (possibly in inverted format) to the controller as a response to a parallel poll. The result can also be read without a parallel poll by the query *IST?. 
The parallel poll mode is mainly used to quickly find out which of the many devices connected to the IEC/IEEE bus caused an SRQ. For this purpose, SRE and PPE must be set to the same value.

### 6.13.20.4 Queries

Each part of a status register can be read out by queries. The queries are specified in the description of the SCPI commands (command system STATus). The queries always yield a number representing the bit pattern of the queried register. This number is evaluated by the controller program.

Queries are mainly used after an SRQ to obtain detailed information about the cause of the SRQ.

### 6.13.20.5 Error Queue Query

Each error in the device causes an entry in the error queue. The entries in the error queue are error messages in plain text. If a sensor is connected, sensor-specific errors can be seen via manual control in the menu File(Error List or in remote control via "Error List...". Usually, the error queue is read with the SCPI query SYSTem:ERRor?.

Each SYSTem:ERRor? query is answered by an entry from the error queue. If there are no more error messages in the error queue, 0 = "No error" is returned by the device.

The error queue should be queried in the controller program after each SRQ since the queue entries provide a more precise description of the error cause than the status registers. In particular, in the test phase of a controller program the error queue should be queried at regular intervals since it also registers faulty commands from the controller to the device.

### 6.13.21 Initialization of the SCPI Status Registers

The commands *RST, *DCL and SYSTem:PRESet as well as powering on the device also affect the status reporting system. Initialization of device status, table 6-32, contains the various commands and events causing a reset of the status reporting system. None of the commands, with the exception of *RST and SYSTem:PRESet, affects the functional device settings. In particular, DCL does not clear the device settings.
### Table 6-32: Initialization of device status

<table>
<thead>
<tr>
<th>Effect</th>
<th>Result</th>
<th>Power On</th>
<th>DCL, SDC (Device Clear, Selected Device Clear)</th>
<th>*RST or SYSTem: PRESet</th>
<th>STATus: PRESet</th>
<th>*CLS</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>0</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Clear STB (Status Byte) and ESR (Standard Event Status Register)</td>
<td>--</td>
<td>yes</td>
<td>--</td>
<td>--</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>Clear SRE (Service Request Enable) and ESE (Standard Event Status Enable)</td>
<td>--</td>
<td>yes</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td></td>
</tr>
<tr>
<td>Clear PPE (Parallel Poll Enable)</td>
<td>--</td>
<td>yes</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td></td>
</tr>
<tr>
<td>Clear EVENt register</td>
<td>--</td>
<td>yes</td>
<td>--</td>
<td>--</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>Clear ENABLE register of all OPERation and QUESTIONable registers</td>
<td>--</td>
<td>yes</td>
<td>--</td>
<td>yes</td>
<td>--</td>
<td></td>
</tr>
<tr>
<td>Fill PTRansition register with &quot;1&quot;, delete NTRansition register</td>
<td>--</td>
<td>yes</td>
<td>--</td>
<td>yes</td>
<td>--</td>
<td></td>
</tr>
<tr>
<td>Clear error/event queue</td>
<td>yes</td>
<td>yes</td>
<td>--</td>
<td>--</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>Clear output queue</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>1)</td>
<td>1)</td>
<td>1)</td>
</tr>
<tr>
<td>Stop command processing (parser) and clear input queue</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>--</td>
<td>--</td>
<td>--</td>
</tr>
</tbody>
</table>

1): Any command sent to a non-empty output queue causes the error:

-410 "Query interrupted"

### 6.14 SYSTem

With the aid of the SYSTem command system, administrative device settings can be made and queried.

This includes:

- list of error messages
- IEC/IEEE-bus address
- resetting the R&S NRP2
- setting the date and time
- audible signals
- version numbers of hardware and software
- setting the system speed
SYSTem:BEEPer[:IMMediate]

Generates an audible signal via the built-in loudspeaker. The duration of the signal is set with SYST:BEEP:TIME. Frequency and volume cannot be changed. The signal is only output if it is not switched off with SYST:BEEP:STAT OFF.

Usage:

Event

SYSTem:BEEPer:NOTify:OVERload <state>

Determines if the R&S NRP2 shall emit an acoustic signal when the power at a sensor exceeds the power limit.

Parameters:

<table>
<thead>
<tr>
<th>&lt;state&gt;</th>
<th>ON</th>
<th>OFF</th>
</tr>
</thead>
<tbody>
<tr>
<td>*RST:</td>
<td></td>
<td>OFF</td>
</tr>
</tbody>
</table>
Usage: Event

SYS:BEep:NOTi:KEY <state>
Enables (ON) or disables (OFF) acoustic key clicks, respectively.
Parameters:
   <state> ON | OFF
   *RST: OFF

SYS:BEep:STOP
Stops the output of an audible signal.
Usage: Event

SYS:BEep:TIME <nrf>
Sets the length in milliseconds of the audible signal output with SYS:BEep.
Parameters:
   <nrf> int_value
   Range: 1...60
   *RST: This setting is not changed by *RST.
   Default unit: S

SYS:COMM:GPIB[:SELF]:ADDR <nr1>
Sets the address with which the R&S NRP2 can be addressed via the IEC/IEEE bus.
The address is factory-set to 20 and is not changed by a reset.
Parameters:
   <nr1> int_value
   Range: 0...30
   *RST: This setting is not changed by *RST.
Usage: Event

SYS:COMM:INET:MODE <mode>
Selects the mode for transmitting the special control sequences via ethernet according
to draft IEEE 1174.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>no control sequences (abbr.: 1174.0 mode)</td>
</tr>
<tr>
<td>1</td>
<td>the IEC/IEEE 488.1 mode (abbr.: 1174.1 mode)</td>
</tr>
<tr>
<td>2</td>
<td>the IEC/IEEE 488.2 mode (abbr.: 1174.2 mode)</td>
</tr>
</tbody>
</table>
### Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;state&gt;</code></td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td><em>RST:</em></td>
<td>This setting is not changed by *RST.</td>
<td></td>
</tr>
</tbody>
</table>

### Example Command

**SYSTem:COMMunicate:INET[:SELF]:ADDRess** `<ip1>,<ip2>,<ip3>,<ip4>`

Sets the IP address of the R&S NRP2.

Note: This command cannot be used, while VXI11 or Ethernet is in use.

Note: Choosing an invalid IP-Address may disturb the traffic on your LAN. If you are not sure how to configure these settings, please ask your network administrator.

**Parameters:**

- `<ip1>,<ip2>,<ip3>,<ip4>`
  - `int_values`  
  - The four parameter form the IP address `<ip1>.<ip2>.<ip3>.<ip4>`. For example, IP address `104.0.0.255` is entered as `SYSTem:COMMunicate:INET:ADDRess 104,0,0,255`.
  - **Range:** 0...255 for each part of the IP address
  - *RST:* This setting is not changed by *RST.

**Usage:**

Event

### Example Command

**SYSTem:COMMunicate:INET[:SELF]:GATEway:ADDRess** `<gwip1>,<gwip2>,<gwip3>,<gwip4>`

Sets the gateway address of your local subnet.

Note: This command cannot be used, while VXI11 or Ethernet is in use.

Note: Choosing an invalid Gateway-Address may disturb the traffic on your LAN. If you are not sure how to configure these settings, please ask your network administrator.

**Parameters:**

- `<gwip1...4>`
  - `int_value`  
  - **Range:** 0...255
  - *RST:* This setting is not changed by *RST.

**Usage:**

Event

### Example Command

**SYSTem:COMMunicate:INET[:SELF]:SUBNetmask:ADDRess** `<sm1>,<sm2>,<sm3>,<sm4>`

Sets the subnet mask of your local subnet.

Note: This command cannot be used, while VXI11 or Ethernet is in use.

Note: Choosing an invalid subnet mask address may disturb the traffic on your LAN. If you are not sure how to configure these settings, please ask your network administrator.
Parameters:

Parameters: <sm1...4> int_value

Range: 0...255

*RST: This setting is not changed by *RST.

Usage: Event

SYSTem:DATE <year>,<month>,<day>

Sets the date. Since the R&S NRP2 has no battery-backed clock, the date has to be reset if the clock was not set after the last power-on of the R&S NRP2.

The date is set in the format yyyy,(m)m,(d)d. This setting is not changed by *RST.

Table 6-33: Parameter range

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value range</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;year&gt;</td>
<td>2000 ... 2100</td>
</tr>
<tr>
<td>&lt;month&gt;</td>
<td>1 (January) ... 12 (December)</td>
</tr>
<tr>
<td>&lt;day&gt;</td>
<td>1 ... 31</td>
</tr>
</tbody>
</table>

SYSTem:IDN <string>

Determines the user defined return value for the *IDN query. The maximum string length is 128 characters.

SYSTem:IDN:AUTO <state>

Activates/deactivates return of the user-defined string for the *IDN query.

SYSTem:INFO? <string>

Returns information about the system. <string_value> is used to query a specific information item. If called without parameters, the command returns all available information in the form of a list of strings separated by commas. <string_value> can have the following values. No difference is made between upper-case and lower-case letters:

<table>
<thead>
<tr>
<th>&lt;string_value&gt;</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Manufacturer&quot;</td>
<td>Manufacturer of device</td>
</tr>
<tr>
<td>&quot;Type&quot;</td>
<td>Type (R&amp;S NRP2)</td>
</tr>
<tr>
<td>&quot;Stock Number&quot;</td>
<td>Order No. of R&amp;S NRP2</td>
</tr>
<tr>
<td>&quot;Serial&quot;</td>
<td>Serial number</td>
</tr>
<tr>
<td>&quot;HWVersion&quot;</td>
<td>Hardware version</td>
</tr>
<tr>
<td>&quot;SW Build&quot;</td>
<td>Firmware version</td>
</tr>
</tbody>
</table>
### SYSTem:ERRor?

This query returns error numbers and text from the error/event queue of the R&S NRP2. A specific error number with text is entered in the error/event queue for each error that occurs in the R&S NRP2. The queue functions according to the FIFO principle. The message entered first in the queue is also output first when a SYST:ERR? query is sent. Querying clears the message.

Up to 30 errors can be stored in the error/event queue. If further errors occur, the most recent error is overwritten by the message -350, "Queue overflow".

If the error/event queue is empty, the message 0, "No error" is returned as a response.

The queue is cleared by *CLS. It is not changed by *RST.

For further information on the error/event queue see chapter 6.13, "STATus", on page 296.

#### Usage:
Query only

### SYSTem:ERRor:EXTended[:STATe] <state>

SYST:ERR:EXT ON activates extended error messages (SYST:ERR?). The location of errors in the parsed command strings is also shown.

#### Parameters:

- `<state>`
  - ON | OFF
  - *RST: OFF*
**SYSTem:KEY <key_stroke>**

This command is used for testing purposes only and simulates a single stroke of an R&S NRP2 frontpanel key.

The key stroke to be simulated is described either in plain text (`<character_value>`) or by a key code (`<NR1>`), see following table.

*Table 6-34: Valid parameter values for the SYSTem:KEY command.*

<table>
<thead>
<tr>
<th>Simulated front-panel key</th>
<th>&lt;character_value&gt;</th>
<th>&lt;NR1&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Softkey toggle 1 left&quot;</td>
<td>SK1L</td>
<td>1</td>
</tr>
<tr>
<td>&quot;Softkey toggle 1 right&quot;</td>
<td>SK1R</td>
<td>2</td>
</tr>
<tr>
<td>&quot;Softkey toggle 2 left&quot;</td>
<td>SK2L</td>
<td>3</td>
</tr>
<tr>
<td>&quot;Softkey toggle 2 right&quot;</td>
<td>SK2R</td>
<td>4</td>
</tr>
<tr>
<td>&quot;Softkey toggle 3 left&quot;</td>
<td>SK3L</td>
<td>5</td>
</tr>
<tr>
<td>&quot;Softkey toggle 3 right&quot;</td>
<td>SK3R</td>
<td>6</td>
</tr>
<tr>
<td>&quot;Softkey toggle 4 left&quot;</td>
<td>SK4L</td>
<td>7</td>
</tr>
<tr>
<td>&quot;Softkey toggle 4 right&quot;</td>
<td>SK4R</td>
<td>8</td>
</tr>
<tr>
<td>&quot;Softkey toggle 5 left&quot;</td>
<td>SK5L</td>
<td>9</td>
</tr>
<tr>
<td>&quot;Softkey toggle 5 right&quot;</td>
<td>SK5R</td>
<td>10</td>
</tr>
<tr>
<td>&quot;Softkey toggle 6 left&quot;</td>
<td>SK6L</td>
<td>11</td>
</tr>
<tr>
<td>&quot;Softkey toggle 6 right&quot;</td>
<td>SK6R</td>
<td>12</td>
</tr>
<tr>
<td>(PRE)SET</td>
<td>PRESet</td>
<td>13</td>
</tr>
<tr>
<td>ZERO</td>
<td>ZERO</td>
<td>14</td>
</tr>
<tr>
<td>FREQ</td>
<td>FREQ</td>
<td>15</td>
</tr>
<tr>
<td>MODE</td>
<td></td>
<td></td>
</tr>
<tr>
<td>⊖ Power</td>
<td>POWer</td>
<td>17</td>
</tr>
<tr>
<td>DEL / 1 TRIG</td>
<td>DELete</td>
<td>18</td>
</tr>
<tr>
<td>⊗ MENU</td>
<td>ENTER</td>
<td>19</td>
</tr>
<tr>
<td>ESC / LOCAL</td>
<td>ESCape</td>
<td>20</td>
</tr>
<tr>
<td>⊖</td>
<td>UP</td>
<td>21</td>
</tr>
<tr>
<td>⊖</td>
<td>DOWN</td>
<td>22</td>
</tr>
<tr>
<td>⊖</td>
<td>LEFT</td>
<td>23</td>
</tr>
<tr>
<td>⊖</td>
<td>RIGHT</td>
<td>24</td>
</tr>
</tbody>
</table>

**Note:**

The R&S NRP2 can be switched off via remote control by means of the **SYSTem:KEY POWER** command.
Parameters:

<key_stroke> <NR1> | <character_value> (see table)

<NR1>
System will be switched off SYSTem:KEY 17

<character_value>
System will be switched off SYSTem:KEY POWER

Usage: Event

**SYSTem:LANGuage** <emulation>

Selects an emulation of a different command set. The R&S NRP2 is able to emulate different power meters by changing the remote command set. As the list of supported instruments is extended continuously, the emulations are documented in separate application notes.

Parameters:

<emulation> character_data

NRP | NRP2 | HP436A | HP437B | HP438A | E4418B | E4419B | N1911A | N1912A

Usage: Setting only

**SYSTem:OPT** <string>

Determines the user defined return value for the *OPT query. The maximum string length is 128 characters.

**SYSTem:OPT:AUTO** <state>

Activates/deactivates return of the user-defined string for the *OPT query.

**SYSTem:PRESet**

Resets the R&S NRP2 to default (*RST) values. No difference is made between reset and preset values (exceptions: INIT:CONT, SENS:AVER:TCON, and SENS:TRAC:AVER:TCON). For preset values see table 6-2.

Usage: Event

**SYSTem:REBoot**

Reboots the R&S NRP2.

Usage: Event
SYSTem:SENSor<[1].4>:INFO?

Returns information on a sensor. <string> is used to query a specific information item. If called without parameters, the command returns all available information in the form of a list of strings separated by commas. The permissible values for <string> depend on the sensor. For details refer to the documentation of the corresponding sensor.

Parameters:
<string> Range: depending on sensor

Usage: Query only

SYSTem:SENSor<[1].4>:REBoot

Performs a power down reset of the selected sensor.

Usage: Event

SYSTem:SENSor<[1].4>:RESet

From the point of view of the R&S NRP2 base unit, the sensors are stand-alone measuring devices. They communicate with the R&S NRP2 via a command set complying with SCPI.

SYST:SENS<[1].4>:RESet prompts the base unit to send an *RST to the sensor in question. Measurements in progress are interrupted.

Usage: Event

SYSTem:SENSor<[1].4>:TEST?

Performs a sensor test and returns a list of strings separated by commas. The contents of this test protocol is sensor-specific. For its meaning, please refer to the sensor documentation.

Usage: Query only

SYSTem:SPEed <state>

The data processing speed of the R&S NRP2 can be increased when FAST is selected. The display is switched off and the measured values are no longer displayed since the continuous update of the screen content requires computation time.

Parameters:
<string> Range: NORMal | FAST

*RST: NORMal
SYSTem:STANdard:CATalog?

Returns a list of stored standards containing a series of strings separated by commas. The strings can be used as parameters for the SYSTem:STANdard:PRESet <string> command.

Usage: Query only

SYSTem:STANdard:PRESet <string>

The R&S NRP2 can be easily configured for measuring standardized signals (e.g. mobile radio standards). For this purpose, the standards listed in the annex (chapter A. 3, "Standard Configurations", on page 368) are stored in the R&S NRP2. The SYST:STAN:PRES command sets the listed parameters and, if desired, also configures front-panel display windows (if SYST:STAN:PWs ON).

Parameters: <string>

The available standards and the associated strings can be queried with the SYSTem:STANdard:CATalog command.

*RST: <empty_string>

SYSTem:STANdard:PWSettings <state>

If SYST:STAN:PRES <string> is used, SYST:STAN:PWs (Preserve Window Settings) determines whether the window system is also configured with the calculate blocks (OFF) or whether exclusively sensor parameters are set (ON).

Parameters: <state>

ON | OFF

*RST: OFF

SYSTem:STANdard:TRIGger:SOURce <source>

If SYST:STAN:PRES <string> is used, this command determines whether the sensors are set to internal (INT) or external (EXT) triggering.

Parameters: <source>

INT | EXT

*RST: INT

SYSTem:TIME <hour>,<minute>,<second>

Sets the time. Since the R&S NRP2 has no battery-backed clock, the time has to be reset if the clock was not set after the last power-on of the R&S NRP2. (see also SYSTem:DATE on page 322).

The time is set in the format (h)h,(m)m,(s)s. This setting is not changed by *RST.
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value range</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;hour&gt;</td>
<td>0 to 24</td>
</tr>
<tr>
<td>&lt;minute&gt;</td>
<td>0 to 59</td>
</tr>
<tr>
<td>&lt;second&gt;</td>
<td>0 to 59</td>
</tr>
</tbody>
</table>

**SYSTem:VERSion?**

Returns a string that contains the current version number of the SCPI standard.

**Usage:** Query only

### 6.15 TRIGger

The trigger commands are used to configure the timing conditions for the start of a measurement.

When the sensors are connected to the R&S NRP2, they inform the device about the **SENSe** and **TRIGger** commands supported and about the value ranges for parameters. This applies to both numeric and text parameters. For this reason, no fixed ranges are specified with these commands; the ranges can be obtained from the respective sensor manual.

```
ABORt<1..4>............................................................................................................... 329
ABORt:ALL....................................................................................................................329
INIItiate<1..4>:CONTinuous.........................................................................................329
INIItiate:ALL:CONTinuous.............................................................................................329
INIItiate<1..4>:DISable................................................................................................330
INIItiate:ALL:DISable.................................................................................................330
INIItiate<1..4>[:IMMediate].........................................................................................330
INIItiate:ALL[:IMMediate]........................................................................................330
TRIGger:ALL:SYNChronize[:STATe]............................................................................330
TRIGger<1..4>[:ATRigger[:STATe].............................................................................331
TRIGger:ALL:ATRigger[:STATe]..................................................................................331
TRIGger<1..4>:COUNt..................................................................................................331
TRIGger:ALL:COUNt......................................................................................................331
TRIGger<1..4>:DELay..................................................................................................331
TRIGger:ALL:DELay.......................................................................................................331
TRIGger<1..4>:DELay:AUTO........................................................................................332
TRIGger:ALL:DELay:AUTO...........................................................................................332
TRIGger<1..4>:DTIMe..................................................................................................332
TRIGger:ALL:DTIMe......................................................................................................332
TRIGger<1..4>:HOLDoff............................................................................................... 333
TRIGger:ALL:HOLDoff....................................................................................................333
TRIGger<1..4>:HYSTeresis.........................................................................................333
TRIGger:ALL:HYSTeresis............................................................................................333
```
TRIGger<[1]..4>:IMMediate]
TRIGger:ALL:[IMMediate]
TRIGger<[1]..4>:LEVel
TRIGger:ALL:LEVel
TRIGger<[1]..4]:MASTER[:STATe]
TRIGger:ALL:MASTER[:STATe]
TRIGger<[1]..4]:SLOPe
TRIGger:ALL:SLOPe
TRIGger<[1]..4]:SOURce
TRIGger:ALL:SOURce
TRIGger<[1]..4]:SYNChronize[:STATe]

ABORT<[1]..4>
ABORT:ALL
Immediately sets the respective sensors to the IDLE state. Measurements in progress are interrupted. If INIT:CONT ON is set, a new measurement is immediately started since the trigger system is not influenced.

Usage:
Setting only

INITiate<[1]..4>:CONTinuous <state>
INITiate:ALL:CONTinuous <state>
Selects either single-shot or continuous (free-running) measurement cycles. In the course of a measurement cycle, a sensor passes through the IDLE, INITIATED, WAIT_FOR_TRG and MEASURING states before it is again set to the IDLE (INIT:CONT OFF) or the INITIATED (INIT:CONT ON) state. The settings are not changed when control is switched from manual to remote. INIT:CONT ON is set when remote control is switched back to manual control.

Parameters:
<state> ON | OFF
ON Continuous measurements are performed. If a measurement is completed, the respective sensors do not return to the IDLE state but are immediately set to INITIATED and then to WAIT_FOR_TRG.
OFF A measurement cycle is only performed once. After completion, the sensors remain in the IDLE state. INIT:CONT OFF has no effect when the sensor is already in the IDLE state. A measurement in progress is completed.

*RST: OFF
Pressing the PRESET key or sending the SYSTem:PRESet command sets the INITiate:ALL:CONTinuous command to ON.
INITiate<[1].4>:DISable <state>
INITiate:ALL:DISable <state>

This command prevents the execution of the INIT:IMM command for one or more sensors. It can thus suppress the start of a measurement for specific sensors if the INIT:ALL:IMM command is used.

Parameters:
<state> ON | OFF
*RST: OFF

INITiate<[1].4>:IMMediate
INITiate:ALL:IMMediate

This command starts a single-shot measurement. The respective sensor goes to the INITIATED state. The command is completely executed when the sensor returns to the IDLE state. The command is ignored when the sensor is not in the IDLE state or when continuous measurements are selected (INIT:CONT ON). The command is only fully executed when the measurement is completed and the trigger system has again reached the IDLE state. Besides CAL:ZERO:AUTO INIT is the only remote control command that permits overlapping execution. Other commands can be received and processed while the command is being executed.

Note:
INIT:IMM invalidates all previous measuring results. A FETCH? command following INIT will thus always return a new measurement result.

Usage: Event

Error messages:

<table>
<thead>
<tr>
<th>Error Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>28</td>
<td>&quot;Sensor not idle&quot;: The sensor is not in the IDLE state.</td>
</tr>
</tbody>
</table>

TRIGger:ALL:SYNChronize[:STATe] <state>

Using this command one can assure, that measurements with externally triggered sensors start synchronously. As the initiation of measurements in the sensors is serialized in the R&S NRP2 it is possible that a sensor is triggered before another sensor is initiated (if synchronization is off). Sensors to be synchronized are required to have the same TRIG:SLOP setting, otherwise a SCPI error -221, "Settings conflict" occurs on TRIG:ALL:SYNC ON.

Note:
TRIG:ALL:SYNC works only in conjunction with INIT:ALL.

Parameters:
<state> ON | OFF
*RST: OFF
Example: (synchronized measurement with 2 heads):
*RST
TRIG:ALL:SLOP POS
TRIG:ALL:SOUR EXT
TRIG:ALL:SYNC ON
INIT:ALL
FETCh1?; FETCh2?

TRIGger<[1]..4>:ATRigger[:STATe] <state>
TRIGger:ALL:ATRigger[:STATe] <state>

When TRIG:ATR is set to ON, the WAIT_FOR_TRG state is automatically exited when no trigger event occurs within a period that corresponds to the reciprocal of the display update rate.

Parameters:
<state>  ON | OFF
*RST:    depending on sensor

TRIGger<[1]..4>:COUNt <value>
TRIGger:ALL:COUNt <value>

Sets the number of measurement cycles to be performed when the measurement is started with INIT.

Parameters:
<value> int_value
Range:  depending on sensor
*RST:    depending on sensor
Default unit: 1

TRIGger<[1]..4>:DELay <delay>
TRIGger:ALL:DELay <delay>

Defines the delay between the trigger event and the beginning of the actual measurement (integration).

Parameters:
<delay> float_value
Range:  depending on sensor
*RST:    depending on sensor
Default unit: S
TRIGger<\[1..4]\>:DELay:AUTO <state>
TRIGger:ALL:DELay:AUTO <state>

TRIG:DEL:AUTO ON makes certain that a measurement is not started until the sensor has settled. To this end, the delay value is automatically determined. This is especially important when thermal sensors are used. The automatically determined delay is ignored if a longer period is set with TRIG<\[1..4]\>:DEL.

Parameters:

* <state> ON | OFF
* RST: depending on sensor

TRIGger<\[1..4]\>:DTIMe <dtime>
TRIGger:ALL:DTIMe <dtime>

If the trigger level has been underrun with internal triggering, it is sometimes useful to wait some time (drop-out time) before retriggering. The measurement of unwanted signal components can thus be suppressed. This setting parameter is used with pulsed GSM signals, for example, if only specific timeslots are to be measured.

The figure below shows the importance of the drop-out time. If the timeslots BF and DH are not to be measured, the drop-out time is set to a higher value than the period EB (GD). In this case, the trigger events B and D are ignored.

![Fig. 6-20: Significance of the drop-out time parameter](image)

A similar response is achieved with the SENSE:BURSt:DTOLerance command in the Burst mode. However, the Burst mode makes certain that a burst measurement is not discontinued too early, whereas TRIGger:DTIMe suppresses a new measurement that is performed too early.

Parameters:

* <dtime> float_value
* RST: depending on sensor
TRIGger<[1]..4>:HOLDoff <holdoff>
TRIGger:ALL:HOLDoff <holdoff>
Defines a period after a trigger event within which all further trigger events are ignored.

Parameters:
<holdoff> float_value
Range: depending on sensor
*RST: depending on sensor
Default unit: S

TRIGger<[1]..4>:HYSTeresis <value>
TRIGger:ALL:HYSTeresis <value>
This command is used to specify how far the signal level has to drop below the trigger level before a new signal edge can be detected as a trigger event. Thus, this command can be used to eliminate the effects of noise in the signal on the edge detector of the trigger system.

Unit: DB | PCT

Parameters:
<value> float_value
Range: depending on sensor
*RST: depending on sensor
Default unit: DB

TRIGger<[1]..4>[:IMMediate]
TRIGger:ALL[:IMMediate]
Performs triggering and makes sure that the sensor directly changes from the WAIT_FOR_TRG state to the MEASURING state irrespective of the selected trigger source (TRIG:SOUR). A trigger delay set with TRIG:DEL is ignored but not the automatic delay determined when TRIG:DEL:AUTO:ON is set. When the trigger source is HOLD, a measurement can only be started with TRIG.

Error messages:

-211 "Trigger ignored": The sensor is not in the WAIT_FOR_TRG state.

Usage: Event

TRIGger<[1]..4>:LEVEL <level>
TRIGger:ALL:LEVEL <level>
Determines the power a trigger signal must exceed (TRIG:SLOP POS) or fall short of (TRIG:SLOP NEG) before a trigger event is detected. This setting is only used for the trigger signal source (TRIG:SOUR INTernal).

Unit: DBM | W
Parameters:

<level> float_value
Range: depending on sensor
*RST: depending on sensor
Default unit: DBM

TRIGger<1..4>:MASTer[:STATE] <state>
Sets the selected sensor in trigger master state. If the trigger master detects an (internal) trigger event, it generates an external (hardware) trigger signal, which allows the synchronous triggering of other sensors. The trigger master must be not be set to external triggering, however, all other sensors have too be set to external triggering (TRIG:SOUR EXT). The trigger signal generated by the trigger master is routed via the connecting cable to the R&S NRP2 and from there distributed to the other sensors and the trigger output. Only one sensor can be trigger master at a time.

See also TRIG:SYNC

Parameters:

<state> ON | OFF
*RST: depending on sensor

TRIGger<1..4>:SLOPe <state>
TRIGger:ALL:SLOPe <state>
This command determines whether the rising (POSitive) or the falling (NEGative) edge of the signal is used for triggering.

Parameters:

<state> POSitive | NEGative
*RST: depending on sensor

TRIGger<1..4>:SOURce <state>
TRIGger:ALL:SOURce <state>
Sets the trigger signal source for the WAIT FOR TRG state.
Parameters:

<state>

BUS | EXTernal | HOLD | IMMediate | INTernal

**BUS**
The trigger event is initiated by TRIG:IMM or *TRG. In this case, the other trigger setting are meaningless.

**EXTernal**
Triggering is performed with an external signal applied to the trigger connector. The TRIG:SLOP command determines whether the rising or the falling edge of the signal is to be used for triggering. Waiting for a trigger event can be skipped by TRIG:IMM.

**HOLD**
A measurement can only be triggered when the command TRIG:IMM is executed.

**IMMediate**
The sensor does not remain in the WAIT_FOR_TRG state but immediately changes to the MEASURING state.

**INTernal**
The sensor determines the trigger time by means of the signal to be measured. When this signal exceeds (TRIG:SLOP POS) or fall short of (TRIG:SLOP NEG) the power set by TRIG:LEV, the measurement is started after the time set by TRIG:DEL. Similar to TRIG:SOUR EXT, waiting for a trigger event can also be skipped by TRIG:IMM.

**RST:** depending on sensor

---

**TRIGger<1..4>:SYNChronize[:STATe] <state>**

If set to ON, the command blocks the external trigger bus as long as the sensor is not in WAIT_FOR_TRIGGER state. It is usually used in combination with command TRIG:MAST and makes certain, that a new measurement will only be started after all sensors have completed their last measurement.

Parameters:

<state>

ON | OFF

**RST:** depending on sensor

---

### 6.16 UNIT

Commands of the UNIT system

UNIT<1..8>:POWer.................................................................................................................. 336
UNIT<1..8>:POWer:RATio........................................................................................................... 336
UNIT<1..8>:POWer \(<output\_unit>\)

Selects the output unit for the measured power values.

This setting also determines the unit for the parameters of the following commands:

- CALC:REL
- CALC:LIM:UPP
- CALC:LIM:LOW
- DISP:MET:UPP
- DISP:MET:LOW
- OUTP:REC:LIM:LOW
- OUTP:REC:LIM:UPP

Parameters:

\(<output\_unit>\)  DBM | W | DBUV

*RST:  DBM

UNIT<1..8>:POWer:RATio \(<output\_unit>\)

Selects the output unit for the measured power ratio values.

This setting also determines the unit for the parameters of the following commands:

- CALC:REL
- CALC:LIM:UPP
- CALC:LIM:LOW
- DISP:MET:UPP
- DISP:MET:LOW
- OUTP:REC:LIM:LOW
- OUTP:REC:LIM:UPP

Error messages:

If the compute function of the associated calculate block is :SWR, :RLOSS or :REFLection, then the unit cannot be changed and error message 26,"State not supported", is output.

Parameters:

\(<output\_unit>\)  DB | DPCT | O

*RST:  DB
7 Maintenance

Under normal operating conditions the R&S NRP2 does not require any regular maintenance except for occasional cleaning of the front panel. Make sure that the air vents are not obstructed.

**NOTICE**

**Instrument damage caused by cleaning agents**

Cleaning agents contain substances that may damage the instrument. For example, cleaning agents that contain a solvent may damage the front panel labeling, plastic parts, or the display.

Never use cleaning agents such as solvents (thinner, acetone, etc), acids, bases, or other substances.

The outside of the instrument can be cleaned sufficiently using a soft, lint-free dust cloth.

### 7.1 Sensor test

The sensor selftest is described in chapter 4.7.6.1, "Internal sensor selftest", on page 162.

### 7.2 Instrument selftest

The R&S NRP2 carries out a selftest during booting. This selftest is described in chapter 1.8.2, "Startup", on page 18.

### 7.3 Cleaning the exterior

To clean the exterior, use a soft, lint-free cloth and an alcohol-free solvent, e.g. a commercially available dishwashing liquid.

### 7.4 Storage

Please see data sheet for storage temperature range of the R&S NRP2.
8 Error Messages and Troubleshooting

8.1 Status and Error Messages in Manual Control

Special characters and symbols indicated on the display inform about the status of the power meter, see chapter 3.6.2, "Special symbols", on page 58.

Symbols especially used for indicating error are:

- **Limit Fail**
  The signal level is outside the set limit

- **?**
  A trigger event is required, but missing. To adjust the trigger settings, see chapter 4.2.6, "Trigger settings", on page 85.

Invalid settings for trace display are indicated by an error message in the info panel.

Example: trace function ‘Ratio’ is selected but only one channel is active

![Error Message Example](image)

A more detailed description of the error can be found in the “Trace Function” menu.
8.2 SCPI-Specific Error Messages

The list below contains error messages that may occur in the instrument. Negative error numbers are defined in the SCPI standard, positive error numbers identify device-specific errors.

The left column of the following table gives the error code. In the right column, the text of the error message displayed or entered in the error/event queue is printed in bold. An additional explanation is given below this text.

8.2.1 No error

<table>
<thead>
<tr>
<th>Error code</th>
<th>&quot;Error text returned upon queue query&quot;</th>
<th>Explanations</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>&quot;No error&quot;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>This message is displayed if the error queue is empty.</td>
<td></td>
</tr>
</tbody>
</table>

8.2.2 Command Error

Command errors; causes bit 5 in the ESR to be set.

<table>
<thead>
<tr>
<th>Error code</th>
<th>Error text returned upon queue query</th>
<th>Explanations</th>
</tr>
</thead>
<tbody>
<tr>
<td>-100</td>
<td>&quot;Command error&quot;</td>
<td>Command faulty or invalid.</td>
</tr>
<tr>
<td>-101</td>
<td>&quot;Invalid character&quot;</td>
<td>The command contains a character which is invalid for that type.</td>
</tr>
<tr>
<td>-102</td>
<td>&quot;Syntax error&quot;</td>
<td>The command is invalid.</td>
</tr>
<tr>
<td>-103</td>
<td>&quot;Invalid separator&quot;</td>
<td>Command contains an illegal character where a separator is expected.</td>
</tr>
<tr>
<td>-104</td>
<td>&quot;Data type error&quot;</td>
<td>Command contains an invalid data element.</td>
</tr>
<tr>
<td>-108</td>
<td>&quot;Parameter not allowed&quot;</td>
<td>The command contains too many parameters.</td>
</tr>
<tr>
<td>-109</td>
<td>&quot;Missing parameter&quot;</td>
<td>The command contains fewer parameters than required.</td>
</tr>
<tr>
<td>-111</td>
<td>&quot;Header separator error&quot;</td>
<td>The header contains an illegal delimiter.</td>
</tr>
<tr>
<td>-112</td>
<td>&quot;Program mnemonic too long&quot;</td>
<td>The header contains more than 12 characters.</td>
</tr>
<tr>
<td>Error code</td>
<td>Error text returned upon queue query</td>
<td>Explanations</td>
</tr>
<tr>
<td>------------</td>
<td>-------------------------------------</td>
<td>--------------</td>
</tr>
<tr>
<td>-113</td>
<td>&quot;Undefined header&quot;</td>
<td>The header is not defined for the device.</td>
</tr>
<tr>
<td>-114</td>
<td>&quot;Header suffix out of range&quot;</td>
<td>The header contains an illegal numeric suffix.</td>
</tr>
<tr>
<td>-120</td>
<td>&quot;Numeric data error&quot;</td>
<td>The command contains a faulty numeric parameter.</td>
</tr>
<tr>
<td>-121</td>
<td>&quot;Invalid character in number&quot;</td>
<td>A numeric contains an invalid character.</td>
</tr>
<tr>
<td>-123</td>
<td>&quot;Exponent too large&quot;</td>
<td>The magnitude of the exponent is larger than 32000.</td>
</tr>
<tr>
<td>-124</td>
<td>&quot;Too many digits&quot;</td>
<td>The numeric contains too many digits.</td>
</tr>
<tr>
<td>-127</td>
<td>&quot;Invalid numeric data&quot;</td>
<td></td>
</tr>
<tr>
<td>-128</td>
<td>&quot;Numeric data not allowed&quot;</td>
<td>The command contains a numeric data element in a position where it is not accepted.</td>
</tr>
<tr>
<td>-131</td>
<td>&quot;Invalid suffix&quot;</td>
<td>The suffix is invalid for this device. The suffix is the index that indexes the sensor with the \texttt{SENSe} commands (1-4), the \texttt{CALCulate} block with the high-level measurement commands (1-4) and the window with the \texttt{DISPlay} commands (1-4).</td>
</tr>
<tr>
<td>-134</td>
<td>&quot;Suffix too long&quot;</td>
<td>The suffix contains more than 12 characters.</td>
</tr>
<tr>
<td>-138</td>
<td>&quot;Suffix not allowed&quot;</td>
<td>A suffix is not allowed for this command or at this position in the command.</td>
</tr>
<tr>
<td>-141</td>
<td>&quot;Invalid character data&quot;</td>
<td>Either the character data element contains an invalid character or the particular element received is not valid for this command.</td>
</tr>
<tr>
<td>-144</td>
<td>&quot;Character data too long&quot;</td>
<td>The character data element contains too many characters.</td>
</tr>
<tr>
<td>-148</td>
<td>&quot;Character data not allowed&quot;</td>
<td>The character data element used is not allowed for this command or at this position of the command.</td>
</tr>
<tr>
<td>-151</td>
<td>&quot;Invalid string data&quot;</td>
<td>The command contains invalid string data.</td>
</tr>
<tr>
<td>-158</td>
<td>&quot;String data not allowed&quot;</td>
<td>The command contains a valid string data element at a position where it is not allowed.</td>
</tr>
<tr>
<td>-161</td>
<td>&quot;Invalid block data&quot;</td>
<td>The command contains invalid block data.</td>
</tr>
</tbody>
</table>
### ErrorMessages and Troubleshooting

**Error Messages and Troubleshooting**

<table>
<thead>
<tr>
<th>Error code</th>
<th>Error text returned upon queue query</th>
<th>Explanations</th>
</tr>
</thead>
<tbody>
<tr>
<td>-168</td>
<td>“Block data not allowed”</td>
<td>The command contains a legal block data element at a point where it is not allowed.</td>
</tr>
<tr>
<td>-171</td>
<td>“Invalid expression”</td>
<td>The command contains an invalid mathematical expression data element.</td>
</tr>
<tr>
<td>-178</td>
<td>“Expression data not allowed”</td>
<td>The command contains mathematical expression data at a point where they are not allowed.</td>
</tr>
</tbody>
</table>

### 8.2.3 Execution Error

Execution errors; cause bit 4 in the ESR register to be set

<table>
<thead>
<tr>
<th>Error code</th>
<th>Error text returned upon queue query</th>
<th>Explanations</th>
</tr>
</thead>
<tbody>
<tr>
<td>-200</td>
<td>“Execution error”</td>
<td>An error occurred upon command execution.</td>
</tr>
<tr>
<td>-203</td>
<td>“Command protected”</td>
<td>An attempt was made to execute a protected command.</td>
</tr>
<tr>
<td>-210</td>
<td>“Trigger error”</td>
<td>Error on triggering the device.</td>
</tr>
<tr>
<td>-211</td>
<td>“Trigger ignored”</td>
<td>A (^*\text{TRG}) or a triggering signal was ignored.</td>
</tr>
<tr>
<td>-213</td>
<td>“Init ignored”</td>
<td>A request for a measurement initialization was ignored as another measurement was already in progress.</td>
</tr>
</tbody>
</table>
| -214       | “Trigger deadlock”                    | A measurement could not be started or a result query could not be processed since the device would otherwise enter a deadlock state. This occurs under the following conditions:

1. TRIG:SOUR BUS::INIT::FETCh?: \(^*\text{TRG}\) or \(\text{TRIG:IMM}\) would be required for triggering but these commands cannot be executed since \(\text{FETCh}\)? blocks the entry. But \(\text{FETCh}\)? waits until the measured values are available.

2. \(\text{FETCh}\)? was called but no valid result was available and the trigger system of the sensor is \(\text{IDLE}\). \(\text{FETCh}\)? blocks the entry so that a measurement cannot be started with \(\text{INIT}\) either. |
| -220       | “Parameter error”                     | The command contains a faulty or invalid parameter. |
| -221       | “Settings conflict”                   | There is a setting conflict between two or more parameters. |
| -222       | “Data out of range”                   | A program data element is outside the legal range as defined by the device. |
### Error Codes and Troubleshooting

#### R&S® NRP2 User Manual 1173.9140.02 ─ 07

<table>
<thead>
<tr>
<th>Error code</th>
<th>Error text returned upon queue query</th>
<th>Explanations</th>
</tr>
</thead>
<tbody>
<tr>
<td>-223</td>
<td>&quot;Too much data&quot;</td>
<td>A valid parameter is received but it contains more data than the device can handle.</td>
</tr>
<tr>
<td>-224</td>
<td>&quot;Illegal parameter value&quot;</td>
<td>The parameter value is invalid.</td>
</tr>
<tr>
<td>-225</td>
<td>Out of memory</td>
<td>The device has insufficient memory to perform the required operation.</td>
</tr>
<tr>
<td>-226</td>
<td>&quot;Lists not same length&quot;</td>
<td>A list of offset values and frequencies has not the same length as an associated list of frequency and offset values.</td>
</tr>
<tr>
<td>-230</td>
<td>&quot;Data corrupt or stale&quot;</td>
<td>The data are incomplete or invalid.</td>
</tr>
<tr>
<td>-240</td>
<td>&quot;Hardware error&quot;</td>
<td>The command cannot be executed because of a hardware problem in the device.</td>
</tr>
<tr>
<td>-241</td>
<td>&quot;Hardware missing&quot;</td>
<td>The command cannot be executed because of missing device hardware.</td>
</tr>
</tbody>
</table>

#### SCPI-Specific Error Messages

**8.2.4 Device-Specific Errors**

Device-specific error; causes bit 5 to be set in the ESR register

<table>
<thead>
<tr>
<th>Error code</th>
<th>Error text returned upon queue query</th>
<th>Explanations</th>
</tr>
</thead>
<tbody>
<tr>
<td>-300</td>
<td>&quot;Device-specific error&quot;</td>
<td>Generic device-dependent error that cannot be defined more precisely.</td>
</tr>
<tr>
<td>-310</td>
<td>&quot;System error&quot;</td>
<td>Indicates that some system error has occurred. Please contact the R&amp;S service center.</td>
</tr>
<tr>
<td>-311</td>
<td>&quot;Memory error&quot;</td>
<td>An error was detected in the device's memory.</td>
</tr>
<tr>
<td>-314</td>
<td>&quot;Save/recall memory lost&quot;</td>
<td>Indicates that the nonvolatile data saved by the *SAV? command has been lost.</td>
</tr>
<tr>
<td>-315</td>
<td>&quot;Configuration memory lost&quot;</td>
<td>Indicates that nonvolatile configuration data saved by the device has been lost.</td>
</tr>
<tr>
<td>-330</td>
<td>&quot;Self-test failed&quot;</td>
<td>The self-test could not be executed.</td>
</tr>
<tr>
<td>-341</td>
<td>&quot;Zeroing failed&quot;</td>
<td>The zeroing of a sensor (CALibration:ZERO:AUTO ONCE) has failed. The most frequent cause for this error is a signal that is applied to the sensor input and prevents zeroing.</td>
</tr>
</tbody>
</table>
### 8.2.5 Query Errors

Query errors; cause bit 2 in the ESR register to be set

<table>
<thead>
<tr>
<th>Error code</th>
<th>Error text returned upon queue query</th>
<th>Explanations</th>
</tr>
</thead>
<tbody>
<tr>
<td>-400</td>
<td>“Query error”</td>
<td>Generic query error that cannot be defined more precisely.</td>
</tr>
<tr>
<td>-410</td>
<td>“Query INTERRUPTED”</td>
<td>The query was interrupted.</td>
</tr>
<tr>
<td></td>
<td><strong>Example:</strong></td>
<td>The query is followed by new data before the response was completely sent.</td>
</tr>
<tr>
<td>-420</td>
<td>“Query UNTERMINATED”</td>
<td>An incomplete query was received.</td>
</tr>
<tr>
<td>-430</td>
<td>“Query DEADLOCKED”</td>
<td>The query cannot be processed.</td>
</tr>
<tr>
<td>-440</td>
<td>“Query UNTERMINATED after indefinite response”</td>
<td>A query is received in the same program message after a query requesting an indefinite response.</td>
</tr>
</tbody>
</table>

### 8.2.6 Device-Dependent Errors

Device-dependent error; causes bit 5 to be set in the ESR register

<table>
<thead>
<tr>
<th>Error code</th>
<th>Error text returned upon queue query</th>
<th>Explanations</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>“Device-dependent error”</td>
<td>This error message is sent when the device cannot detect a more specific error.</td>
</tr>
<tr>
<td>2</td>
<td>“IEEE 1174 error (unknown emulation code)”</td>
<td>An invalid IEEE-1174 emulation mode was selected for the Ethernet link.</td>
</tr>
<tr>
<td>22</td>
<td>IEEE1174 mode 488.1 not allowed</td>
<td>Setting the IEEE 1174.1 mode is not permissible.</td>
</tr>
</tbody>
</table>
## Error Messages and Troubleshooting

### Error Messages

<table>
<thead>
<tr>
<th>Error code</th>
<th>Error text returned upon queue query</th>
<th>Explanations</th>
</tr>
</thead>
<tbody>
<tr>
<td>24</td>
<td>“Sensor mode not supported”</td>
<td>An attempt was made to set the sensor to a measurement mode which is not supported.</td>
</tr>
<tr>
<td>25</td>
<td>“Not supported”</td>
<td>A command is not supported (by the sensor).</td>
</tr>
<tr>
<td>26</td>
<td>“State not supported”</td>
<td>Attempt was made to set an invalid value. The permissible values for sensor-dependent commands can be declared as impermissible by a sensor depending on the context.</td>
</tr>
<tr>
<td>27</td>
<td>“Sensor not present”</td>
<td>A command could not be executed because the required sensor is not connected.</td>
</tr>
<tr>
<td>28</td>
<td>“Sensor not idle”</td>
<td>A command could not be executed because the respective sensor was not in the IDLE state at that time.</td>
</tr>
<tr>
<td>29</td>
<td>“Measurement aborted while waiting for data”</td>
<td>A measurement was aborted while the device was waiting for measurement results.</td>
</tr>
<tr>
<td>30</td>
<td>“No extremes available in this mode”</td>
<td>Extreme values (minimum, maximum und peak-to-peak values) are not calculated in the set measurement mode.</td>
</tr>
<tr>
<td>39</td>
<td>“Sensor removed while waiting for result”</td>
<td>A sensor was disconnected while the device was waiting for measurement results.</td>
</tr>
<tr>
<td>42</td>
<td>“Failed to initialize sensor”</td>
<td>A sensor could not be initialized.</td>
</tr>
<tr>
<td>43</td>
<td>“Error in receiving calibration data from sensor”</td>
<td>An error occurred in receiving calibration data from the sensor (command CALibration[1..4]:DATA?).</td>
</tr>
<tr>
<td>44</td>
<td>“Error in sending calibration data to sensor”</td>
<td>An error occurred in sending calibration data to the sensor (command CALibration[1..4]:DATA &lt;block_data&gt;).</td>
</tr>
<tr>
<td>45</td>
<td>“Command not supported by sensor”</td>
<td>Attempt was made to send a command to a sensor that does not support this command. This may depend on the current sensor status. The sensors can inform the R&amp;S NRP2 at any point which commands they support or do not support. This mainly concerns commands of the Sense and Trigger systems.</td>
</tr>
<tr>
<td>46</td>
<td>“Sensor failure: no command receipt”</td>
<td>A sensor did not acknowledge any command.</td>
</tr>
<tr>
<td>47</td>
<td>“Error in receiving battery data”</td>
<td>An error occurred in receiving battery data (command SYSTem:BATTery:STATus?).</td>
</tr>
<tr>
<td>48</td>
<td>“Error in sending battery data”</td>
<td>An error occurred in sending battery data (command SYSTem:BATTery:MODE &lt;block_data&gt;).</td>
</tr>
</tbody>
</table>
### Error Messages and Troubleshooting

#### Error code | Error text returned upon queue query | Explanations
--- | --- | ---
50 | "Fatal sensor error" | A sensor signalled a serious error. If the problem persists, please contact the R&S servicing center.
51 | "Overload" | A sensor signalled that the signal applied has exceeded the permissible maximum power. **CAUTION!** Sensor overload can destroy the electronic measurement system.
52 | "Overrange" | This error is signalled if a sensor detects that one of its measurement channels is over-ranged. The result is then probably incorrect. This error can occur if the automatic range function is deactivated (`SENSe:RANGe:AUTO OFF`) and the manually selected measurement channel is not suitable or the cross-over level (`SENSe:RANGe:AUTO:CLEVel`) was incorrectly selected.
53 | "Truncated measurement" | In the BurstAv mode, the samples for the power are stored in an internal buffer until the end of the power pulse is detected. If the buffer overflows the measurement is terminated and error 53 "Truncated measurement" is generated.
54 | "Sample error" | Samples were lost while sampling the signal applied. The measured value can thus be incorrect.
55 | "Sensor hardware error" | A sensor signalled an error in the sensor hardware. If the problem persists, please contact the R&S servicing center.
56 | "Filter truncated" | With the automatic filter function activated, a sensor tries to set the filter length such that the required accuracy is obtained. If the measurement time required for this exceeds the value set with `SENSe:AVERage:COUNt:AVTime` (max. time), the filter length is shortened such that a measurement does not last more than the max. time and error message 56 "Filter truncated" is generated.
57 | "Standard settings incomplete" | The R&S NRP2 can be configured for measuring standardized signals with `SYStem:STANdard:PRESet <string>`. This command sets a number of predefined parameters. If a sensor does not support a specific parameter (e.g. a measurement mode), execution error message 57 "Standard settings incomplete" is generated.

### 8.3 Bootmenu

The boot menu of the R&S NRP2 offers service and troubleshooting functions. It is password protected.

The start display indicates the "Bootmenu" button for a few seconds after power-on. The bootmenu requires a password.
1. To open the "Bootmenu", press the softkey to the right.

2. Enter the password.
   The password is 7396 and cannot be changed. After entering the last digit the R&S NRP2 automatically opens the boot menu.
8.3.1 Boot Menu

Fig. 8-4: Boot menu

- Select a function by using the respective softkey.

**System Info**
Opens the system info menu. This menu provides soft- and hardware information to the instrument, e.g. serial numbers, firmware version or ethernet address.

Fig. 8-5: Boot menu / System Info

**Service**
Opens the R&S NRP2 service menu, see chapter 8.3.2, "Service Menu", on page 349.

**Erase Nonvol-Data**
Deletes the non-volatile memory containing instrument settings.
This measure is recommended after the error message 'Sensor communication error' appears.
The device displays a warning message prior to deletion and requires confirmation of the deletion.
Fig. 8-6: Boot menu / Re-initializing non-volatile memory

By confirmation, the non-volatile memory is re-initialized completely.

Sample error message
Activates that an error message is displayed if a sample error occurs.

8.3.2 Service Menu

The R&S NRP2 offer various service functions to perform system tests that are not part of the selftest, to install / deinstall options or to configure the reference signal.

Fig. 8-7: Service menu

Options
Displays all options the instrument is equipped with.
In this window, you can activate (install) or deactivate options (uninstall). In addition, the network connection can be established.

**Display Test**
Checks whether inputs via the softkeys are correctly indicated.

Press some of the numbers shown on the right to check the correct display.
To exit press the "Exit" softkey, or the ESC key.

**Key Test**
Tests all hardkeys of the R&S NRP2 located at its front panel.
### Keyboard-Test
*(terminates, when all keys pressed)*

<table>
<thead>
<tr>
<th>Key 1L</th>
<th>Key 1R</th>
<th>MENU</th>
<th>DEL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sky2L</td>
<td>Sky2R</td>
<td>UP</td>
<td>RIGHT</td>
</tr>
<tr>
<td>Sky3L</td>
<td>Sky3R</td>
<td>LEFT</td>
<td>DOWN</td>
</tr>
<tr>
<td>Sky4L</td>
<td>Sky4R</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sky5L</td>
<td>Sky5R</td>
<td>ESC</td>
<td>FREQ</td>
</tr>
<tr>
<td>Sky6L</td>
<td>Sky6R</td>
<td>(P)RESET</td>
<td>ZERO</td>
</tr>
</tbody>
</table>

*Fig. 8-10: Service menu / Keyboard test*

Press each key once, in any order. Each time a key is pressed, the R&S NRP2 responds acoustically and marks the identified key. If you press a key more than once the instrument displays a warning message. This dialog box closes if you either have pressed all keys, or if you have not pressed any key within 15 seconds.

**Buzzer Test**
Tests the beeper (acoustic alarm).

**Power Ref Calibration**
Protected service function, see service manual.
A Annex

A.1 Volatile Mode

The R&S NRP2 provides a special operating mode, the Volatile Mode. This mode prohibits saving of changed settings in the nonvolatile memory. When activated, the current device configuration at the moment of activation is restored after each restart. Therefore, Volatile Mode is recommended, if on power down you want a defined setting regardless of any settings that were made either manually or by remote control.

The nonvolatile memory is not erased by default when Volatile Mode is activated. The current device configuration is maintained. Thus, you can use this mode to configure the R&S NRP2 for a measurement setup, that is always restored at boot time.

In addition, the R&S NRP2 can be reset to the factory default by erasing the nonvolatile memory.

A.1.1 Activating Volatile Mode

Volatile Mode is controlled by a menu in the bootloader. To activate the Volatile Mode:

1. Press the "Volatile Mode" button while the R&S NRP2 boots.

2. Enter the password. The default password is 0000.
3. Enable the "Volatile Mode" setting.

The Volatile Mode is activated. The current setting is used after each power on.

You can also reset the R&S NRP2 to factory default by erasing the nonvolatile memory.

A.1.2 Changing the Password

To change the password open the "Change Password" menu and enter the new password.

A.2 Remote control interfaces

This section covers hardware related topics on the remote control interfaces, like pin assignment of the GPIB bus interface.

For information on how to set up a remote control connection via the different interfaces, see chapter 5.2, "Connecting a Controller to the Base Unit", on page 170.

For information on how to configure the interfaces, see chapter 4.7.1, "Configuring the remote control interfaces", on page 145.

All other hardware interfaces are described in chapter 1.6, "Rear Panel Tour", on page 15
For specifications refer to the data sheet.

A.2.1 GPIB Bus Interface

A.2.1.1 Characteristics of the interface

- 8-bit parallel data transmission
- Bidirectional data transmission
- Three-wire handshake
- Data transmission rate up to 350 Kbyte/s
- Connection of up to 15 devices
- Max. length of connecting cables: 15 m (length of single cable: 2 m)
- Wired OR links when several devices are connected in parallel.

A.2.1.2 Pin assignment

![Pin assignment of GPIB-bus interface](image)

Fig. 1-1: Pin assignment of GPIB-bus interface

A.2.1.3 Bus lines

- Data bus with 8 lines DIO1 to DIO8:
  The transmission is bit-parallel and byte-serial in the ASCII/ISO code. DIO1 is the least significant bit, DIO8 the most significant bit.
- Control bus with five lines:
  - **IFC** (Interface Clear):
    IFC (Interface Clear) Active LOW resets the interfaces of the connected devices to the default state.
  - **ATN** (Attention):
    Active LOW indicates the transmission of interface messages; non-active HIGH indicates the transmission of device messages.
Remote control interfaces

- **SRQ (Service Request):**
  Active LOW enables a device to send a service request to the controller.

- **REN (Remote Enable):**
  Active LOW permits switchover to remote control.

- **EOI (End or Identify):**
  Has two functions in connection with ATN:
  - ATN = HIGH: active LOW marks the end of data transmission
  - ATN = LOW: active LOW triggers a parallel poll.

- **Handshake bus with three lines:**
  - **DAV (Data Valid):**
    Active LOW signals a valid data byte on the data bus.
  - **NRFD (Not Ready For Data):**
    Active LOW signals that one of the connected devices is not ready for data transfer.
  - **NDAC (Not Data Accepted):**
    Active LOW until the connected device has accepted the data on the bus.

### A.2.1.4 GPIB bus interface

Instruments which can be controlled via GPIB bus can be equipped with different interface functions. The interface function for the R&S NRP2 are listed in the following table.

<table>
<thead>
<tr>
<th>Control character</th>
<th>Interface function</th>
</tr>
</thead>
<tbody>
<tr>
<td>SH1</td>
<td>Source handshake</td>
</tr>
<tr>
<td>AH1</td>
<td>Acceptor handshake</td>
</tr>
<tr>
<td>L3</td>
<td>Listener function, Listen-Only mode, unaddressed for MSA and TPAS, recognizes END and EOS.</td>
</tr>
<tr>
<td>LE3</td>
<td>Extended Listener function, Listen-Only mode, unaddressed for MSA and TPAS, recognizes END and EOS.</td>
</tr>
<tr>
<td>T5</td>
<td>Talker function, capability to respond to serial poll, Talk-Only mode, unaddressed on MLA, sends END or EOS.</td>
</tr>
<tr>
<td>TE5</td>
<td>Extended talker function, capability to respond to serial poll, Talk-Only mode, unaddressed for MLA and LPAS, sends END or EOS.</td>
</tr>
<tr>
<td>SR1</td>
<td>Service request function</td>
</tr>
<tr>
<td>PP1</td>
<td>Remote parallel-poll function</td>
</tr>
<tr>
<td>PP2</td>
<td>Local parallel-poll function</td>
</tr>
<tr>
<td>RL1</td>
<td>Remote/local switchover function</td>
</tr>
<tr>
<td>DC1</td>
<td>Device clear</td>
</tr>
<tr>
<td>E2</td>
<td>3-state driver (open-collector driver during parallel poll)</td>
</tr>
</tbody>
</table>
A.2.1.5 Interface messages

Interface messages are transmitted to the device on data lines, where the ATN is set to active LOW. They are used for communication between the controller and the R&S NRP2.

Common commands

Common commands are in the code range 0x10 to 0x1F. They affect all devices on the bus without any addressing being required.

**Table 1-2: Common commands**

<table>
<thead>
<tr>
<th>Command</th>
<th>Effect on device</th>
</tr>
</thead>
<tbody>
<tr>
<td>DCL (Device Clear)</td>
<td>Aborts all commands and messages in progress. The TRIGGER system goes to the &quot;IDLE&quot; state, input and output queues are cleared, and the parser is reset and waits for the beginning of a new command. When INITiate:CONT ON is set, a new measurement is started. This command makes the device ready to receive commands.</td>
</tr>
<tr>
<td>IFC (Interface Clear)</td>
<td>Resets the interfaces to their initial condition.</td>
</tr>
<tr>
<td>LLO (Local Lockout)</td>
<td>Manual switchover to LOCAL is disabled. Local LockOut deactivates the front-panel keypad with the exception of the power key. In the LLO state, it is possible to return to the &quot;LOCAL&quot; mode only by remote control (GTL command) or switching the R&amp;S NRP2 off and on again.</td>
</tr>
<tr>
<td>SPE (Serial Poll Enable)</td>
<td>Ready for serial poll.</td>
</tr>
<tr>
<td>SPD (Serial Poll Disable)</td>
<td>End of serial poll.</td>
</tr>
<tr>
<td>PPU (Parallel Poll Unconfigure)</td>
<td>End of parallel poll query status.</td>
</tr>
</tbody>
</table>

Addressed commands

Addressed commands are in the code range 0x00 to 0x0F hex. They only affect devices addressed as a listener.

**Table 1-3: Addressed commands**

<table>
<thead>
<tr>
<th>Command</th>
<th>Effect on device</th>
</tr>
</thead>
<tbody>
<tr>
<td>SDC (Selected DeviceClear)</td>
<td>Interrupts processing of received commands and sets the command processing software to a defined initial state. This command does not change the device setting.</td>
</tr>
<tr>
<td>GTL (Go to Local)</td>
<td>Change to local mode (manual control).</td>
</tr>
<tr>
<td>PPC (Parallel Poll Configure)</td>
<td>Configures device for parallel poll.</td>
</tr>
</tbody>
</table>
A.2.2 Ethernet

For remote control via a TCP/IP-based LAN, the R&S NRP2 is fitted with a 10/100BaseT Ethernet interface. The female connector is located on the rear panel of the R&S NRP2. Via this interface, a controller can remote-control the R&S NRP2 by means of the power meter’s SCPI commands, using the VXI11 protocol (TCP/IP instrument protocol specification), version 1.0, released on July 17, 1995 by the VXIbus Consortium.

Fig. 1-2: Ethernet connector

A.2.2.1 VXI11 protocol

The VXI11 protocol uses ONC RPC (open network computing remote procedure calls), making it possible to call R&S NRP2 functions at the source code level as if they were running locally on the controller. The table below shows the relationships of the relevant protocol layers in the OSI reference model.

<table>
<thead>
<tr>
<th>Application</th>
<th>VXI11 Network Instrument</th>
</tr>
</thead>
<tbody>
<tr>
<td>Presentation</td>
<td>XDR (Data representation)</td>
</tr>
<tr>
<td>Session</td>
<td>ONC RPC</td>
</tr>
<tr>
<td>Transport</td>
<td>TCP</td>
</tr>
<tr>
<td>Network</td>
<td>IP</td>
</tr>
<tr>
<td>Data Link</td>
<td>Ethernet/802.3</td>
</tr>
<tr>
<td>Physical</td>
<td>10/100BASE-T</td>
</tr>
</tbody>
</table>

Fig. 1-3: The VXI11 protocol stack in the OSI reference model

A VXI11 remote-control connection consists of three channels (core, abort and interrupt), which can be used to set up as many links as desired. The concept of links makes it possible to connect a network instrument client in a controller with several logical devices in a host computer via a single VXI11 remote-control connection. A link is then set up to each logical device. It is also possible to set up several links to one logical device, provided that several servers are running on the network instrument host or a network instrument client is operated by several controllers. To prevent problems caused by several controllers simultaneously accessing one device, links can be locked. In this case, access via other links is not possible. An exception is an abort via the abort channel, which can be executed at any time and also aborts the execution of commands via other links.
### A.2.2.2 Connection setup

A socket connection is set up for each channel. All commands via the core or abort channel contain an ID that is used to assign the command to a link. The interrupt channel, which is also implemented using sockets, is shared by all links. Commands transmitted via this channel do not contain a link ID. The setup is handled by the network instrument client, which first requests the connections from the network instrument server's portmapper service at port 111. The portmapper subsequently activates the channel in the R&S NRP2 and tells the client at which ports channel services can be addressed. For this reason, it is important that any firewalls or routers between the client and the R&S NRP2 enable free access from the controller to the R&S NRP2 (core and abort channels) and vice versa (interrupt channel). As the ports for the channels are dynamically assigned, reliable information regarding the port numbers used cannot be provided.

### A.2.2.3 Remote control via VXI11

The following possibilities are suggested for remote-controlling the R&S NRP2 via VXI11:

- The simplest way to create remote-control programs is by using a virtual instruments software architecture (VISA) implementation and creating the remote-control programs under Visual Basic or C/C++. VISA implementations provide an application programming interface (API) that offers all necessary functions. Knowledge about VXI11 is helpful but not required. The VISA resource identifier used to identify a VXI11 device has the following format: TCPIP::<IP address>::INSTR The IP address is specified using the familiar dot notation (e.g. 89.10.65.59).
  - TCPIP::<IP address>::INSTR
The IP address is specified using the familiar dot notation (e.g. 89.10.65.59).

- Annex C of the TCP/IP Instrument Protocol Specification VXI11 contains an RPCL description of the protocol. The program rpcgen, which is included in any ONC RPC distribution, is used to generate stubs. Stubs can be inserted into separate C programs, where the functions from the table below can be called like ordinary library functions. This procedure requires RPC programming skills.

### Table 1-5: VXI11 protocol functions

<table>
<thead>
<tr>
<th>Function name</th>
<th>Channel</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>create_link()</td>
<td>core</td>
<td>Opens a link to a network instrument device. Socket connections are set up for the core and abort channels, but no interrupt channel.</td>
</tr>
<tr>
<td>destroy_link()</td>
<td>core</td>
<td>Destroys a link to a network instrument device.</td>
</tr>
<tr>
<td>device_write()</td>
<td>core</td>
<td>Transmits an IEEE488.2 or SCPI command as a string to a network instrument device.</td>
</tr>
<tr>
<td>device_read()</td>
<td>core</td>
<td>Reads responses from the network instrument device.</td>
</tr>
<tr>
<td>device_readstb()</td>
<td>core</td>
<td>Reads the status byte of the network instrument device.</td>
</tr>
<tr>
<td>device_trigger()</td>
<td>core</td>
<td>Initiates triggering in a network instrument device; equivalent to *TRG.</td>
</tr>
<tr>
<td>device_clear()</td>
<td>core</td>
<td>Initiates a device clear (DCL) in network instrument device. In the R&amp;S NRP2, DCL and abort cause the same actions. Since device_abort(), unlike device_clear(), runs via the abort channel, it is not serialized together with other commands, but directly accesses the device and is therefore preferable.</td>
</tr>
<tr>
<td>device_remote()</td>
<td>core</td>
<td>Puts the network instrument device in the remote mode.</td>
</tr>
<tr>
<td>device_local()</td>
<td>core</td>
<td>Puts the network instrument device in the local mode.</td>
</tr>
<tr>
<td>device_lock()</td>
<td>core</td>
<td>Local lockout (LLO). The keyboard of the network instrument device is locked.</td>
</tr>
<tr>
<td>device_unlock()</td>
<td>core</td>
<td>Undoes the LLO status.</td>
</tr>
<tr>
<td>device_docmd()</td>
<td>core</td>
<td>The network instrument device executes a command.</td>
</tr>
<tr>
<td>device_abort()</td>
<td>abort</td>
<td>The network instrument device aborts a running command; see device_clear().</td>
</tr>
<tr>
<td>create_intr_chan()</td>
<td>core</td>
<td>An interrupt channel to the network instrument device is set up.</td>
</tr>
<tr>
<td>destroy_intr_chan()</td>
<td>core</td>
<td>An existing interrupt channel to the network instrument device is destroyed.</td>
</tr>
<tr>
<td>device_enable_srq()</td>
<td>core</td>
<td>Activates/deactivates the transmission of service requests from the network instrument device to the network instrument controller.</td>
</tr>
<tr>
<td>device_intr_srq()</td>
<td>interrupt</td>
<td>This is the only function the network instrument device calls from the network instrument device. This function signals a service request (SRQ).</td>
</tr>
</tbody>
</table>
A.2.3 Ethernet interface

The R&S NRP2 has a 10/100BaseT Ethernet female connector for remote control via a LAN, based on TCP/IP. The female connector is located on the instrument rear. The interface enables a controller to operate the R&S NRP2 by remote control using the SCPI commands of the R&S NRP2. The commands of the IEC/IEEE 488.1 and IEC/IEEE 488.2 standards are partly emulated via special software commands. The remote control protocol for this interface is based on an IEC/IEEE draft protocol, described below.

A.2.3.1 IEC/IEEE 1174 draft


Example:
The special control sequence "&GTL" emulates the IEC/IEEE bus command GoTo Local.

All control characters defined in the IEC/IEEE 1174 draft are listed in table 1-6. This chapter describes how the control sequences can be used for remote control via RS-232-C or Ethernet.

The IEC/IEEE 1174 draft provides three different operating modes for transmitting the special control sequences. These modes can be set via remote control using the following command:

SYSTem:COMMunicate:INET:MODE 0 | 1 | 2

The parameter has the following meanings:

- 0: no control sequences (abbr.: 1174.0 mode)
- 1: the IEC/IEEE 488.1 mode (abbr.: 1174.1 mode)
- 2: the IEC/IEEE 488.2 mode (abbr.: 1174.2 mode)

The IEC/IEEE 1174.0 mode

The IEC/IEEE 1174.0 mode (raw socket communication) does not provide an emulation of the IEC/IEEE bus functionality.

- Special control commands like those used by the higher IEC/IEEE 1174.1 and 1174.2 modes are not provided.
- The & character is not doubled.
- The state change "local → remote" is achieved by receiving data.
- The state change "remote → local" is achieved by clearing down the connection (peer sockets).
The IEC/IEEE 1174.1 mode

To allow emulation of the IEC/IEEE 488.1 standard, special control characters that begin with an & character (0x26) are defined (table 1-6). The link (link 1 or link 2) via which the control sequences are to be transmitted and that (controller or measuring instrument) is allowed to transmit the control sequences are predefined.

This means the following for communications via RS-232-C and Ethernet in mode 1174.1:

- The special control sequences are permitted throughout the data stream. They are recognized and filtered out by the driver. In particular, the control sequences are also permitted within the block data and SCPI commands.
- To distinguish between the & character of the control sequences and the normal & character, the IEC/IEEE 1174.1 mode offers a double & mechanism: An & character that does not initiate any control sequence is transmitted twice. The direction of the transmission (device->controller, controller->device) is irrelevant. When received, double && characters have to be split in half to yield single & characters.
- The state changes "local ↔ remote" are achieved by receiving characters and by means of the special control sequences.

Summary:

- The state change from "local → remote" is achieved by receiving data and through special control characters.
- The state change from "remote → local" is achieved by clearing down the connection (peer sockets) and through special control characters.
- Simultaneous operation of the measuring instrument via local in the remote state can be achieved by using newly defined control characters (&GTM - GoTo Mixed).

The IEC/IEEE 1174.2 mode

The IEC/IEEE 1174.2 mode differs from the 1174.1 mode depending on where the special control sequences are permitted in the data stream.

- The special control sequences are only permitted outside block data and string data.
- The remote → local state changes are controlled by means of control sequences as set forth in the IEC/IEEE 1174.1 mode. The state changes are triggered by the reception of characters and by special control sequences.

Summary:

- The state change from "local → remote" is achieved by receiving data and through special control characters.
- The state change from "remote → local" is achieved by clearing down the connection (peer sockets) and by special control characters.
- Simultaneous operation of the measuring instrument via local in the remote mode can be achieved by using newly defined control characters (&GTM).
- There are no & characters outside of block data within SCPI commands. Doubling of the & characters is therefore not necessary in this mode. In the 1174.1 and 1174.2 modes, the special control sequences have a different device-internal...
behavior: In the 1174.2 mode, they are not filtered out by the driver, but are recognized by the parser like normal SCPI commands.

In this mode, the control sequences are to be terminated by `<CR><LF>` like SCPI commands.

### Table 1-6: Control sequences of the IEC/IEEE 1174 draft

<table>
<thead>
<tr>
<th>Control sequence</th>
<th>Transmitter</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>&amp;SRQ &lt;CR&gt;&lt;LF&gt;</td>
<td>Device</td>
<td>Service request</td>
</tr>
<tr>
<td>&amp;ddd &lt;CR&gt;&lt;LF&gt;</td>
<td>Device</td>
<td>Sends STB and RQS as a three-digit decimal value ddd (response to &amp;POL)</td>
</tr>
<tr>
<td>&amp;DCL &lt;CR&gt;&lt;LF&gt;</td>
<td>Device</td>
<td>Device clear acknowledge</td>
</tr>
<tr>
<td>&amp;LLO</td>
<td>Controller</td>
<td>Changes the remote-local state to local lockout</td>
</tr>
<tr>
<td>&amp;POL</td>
<td>Controller</td>
<td>Conducts a serial poll (measuring instrument responds with &amp;ddd CR LF)</td>
</tr>
</tbody>
</table>

### Additional Rohde & Schwarz control sequences

- **&GTM (go to mixed):**
  This control character changes the remote-local state to remote in the local state. This enables the instrument to be operated simultaneously via the front panel and via RS-232-C and Ethernet. The IEC/IEEE 1174 draft does not provide this simultaneous operation because the remote control state is automatically assumed when data is received.

- **&GTR (go to remote):**
  This control character changes the remote-local state to remote. The &GTR command allows a change to the remote state, even before data is received. The combination of the special control sequences &GTM and GTR allows switching over between the remote and local states.

- **&DCL (device clear):**
  The IEC/IEEE 1174 draft defines that a measuring instrument must emulate the IEC/IEEE 488.1 device clear function. In the case of RS-232-C, the device clear active state (DCAS) is achieved when a break signal is received. In the case of RS-232-C, a break is triggered by means of a hardware link. When remote control is available by TCP/IP via Ethernet, there is no break signal. To nevertheless permit the IEC/IEEE 488.1 device clear function, the two synonymous commands &DCL and &BRK are newly defined.

- **&ABO (abort):**
  An abort corresponds to an asynchronous device clear. This becomes necessary in order to clear a communications deadlock of link 1. If an asynchronous abort is performed, the input and output queues will be cleared.
Table 1-7: Additional control sequences:

<table>
<thead>
<tr>
<th>Control sequences</th>
<th>Transmitter</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>&amp;GTM</td>
<td>Controller</td>
<td>go to mixed</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Changes the remote-local state to local &amp; remote</td>
</tr>
<tr>
<td>&amp;GTR</td>
<td>Controller</td>
<td>go to remote</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Changes the remote-local state to remote</td>
</tr>
<tr>
<td>&amp;DCL</td>
<td>Controller</td>
<td>device clear</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Initiates a device clear</td>
</tr>
<tr>
<td>&amp;ABO</td>
<td>Controller</td>
<td>abort</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Asynchronous device clear</td>
</tr>
</tbody>
</table>

A.2.3.2 Architecture of the Ethernet interface

The R&S NRP2 offers a listener socket for connection queries. If the listener socket accepts a connection query, two related peer sockets will be created (link 1 and link 2) via which communications take place. The R&S NRP2 accepts the role of the server, and the remote control program is the client.

Link 1 is used to transmit the SCPI commands and the response data. Link 2 is reserved for service request messages (SRQ) and for an abort of the remote-control function being currently performed. Since the two links share the same IP address and port number, the sequence of the connection setup determines their allocation. Link 1 is the first accepted link and link 2 the second. In the 1174.0 mode, only the first link is used.

Program example for the Ethernet interface

This example is a simple Windows program that displays the programming with sockets.

```c
/************************************************************************
*************************************************************************

Remote control interfaces
```
#include <stdio.h>
#include <winsock2.h>

#define IP_ADDR "192.168.1.2" // IP address of NRP2
#define PORT_NO 3000 // Port number of NRP2
#define MAX_RECV 200 // Max response len

int main(int argc, char* argv[]) {
    int nRet;
    WSADATA wsaData;
    SOCKET soLink1;
    SOCKET soLink2;
    SOCKADDR_IN saDevice;
    char ResponseMessage[MAX_RECV];
    WORD wVersionRequired = MAKEWORD(2,2);

    //---------------------
    // Initialize WinSocket
    //---------------------
    nRet = WSAStartup(wVersionRequired, &wsaData);
    if (nRet)
    {
        /* INCLUDE FILES ***************************************************/
        /* LOCAL DEFINES ***************************************************/
        /* MAIN FUNCTION ***************************************************/
    }
}
printf("WinSocket initialization failed!\n");
    return(1);
}

//------------------
// Create Sockets
//------------------
soLink1 = socket(AF_INET, SOCK_STREAM, IPPROTO_TCP);
soLink2 = socket(AF_INET, SOCK_STREAM, IPPROTO_TCP);
if ((soLink1 == INVALID_SOCKET) || (soLink2 == INVALID_SOCKET))
{
    printf("Creation of Sockets failed.\n");
    return(1);
}

//---------------------------
// IP Address and Port of NRP2
//---------------------------
saDevice.sin_addr.s_addr = inet_addr(IP_ADDR);
saDevice.sin_port = htons((u_short) PORT_NO);
saDevice.sin_family = AF_INET;

//------------------
// Connecting Link 1
//------------------
nRet = connect(soLink1, (LPSOCKADDR) &saDevice, sizeof(SOCKADDR));
if (nRet)
{
    printf("Connecting of Link 1 failed.\n");
    return(1);
}

//------------------
// Connecting Link 2
//------------------
nRet = connect(soLink2, (LPSOCKADDR) &saDevice, sizeof(SOCKADDR));
if (nRet)
{
    printf("Connecting of Link 2 failed.\n");
    closesocket(soLink1);
    return(1);
}

//----------
// send *SRE
//----------
nRet = send(soLink1, "+sre 0\r\n", strlen("+sre 0\r\n"), 0);
if (nRet == 0)
{
    closesocket(soLink2);
closesocket(soLink1);
printf("Send *SRE failed.\n");
return(1);
} else {
    printf("Send *SRE was successfully.\n");
}

//-----------
// Send *IDN?
//-----------
nRet = send(soLink1, "*idn? \r\n ", strlen("*idn? \r\n "), 0);
if (nRet == 0) {
    closesocket(soLink2);
    closesocket(soLink1);
    printf("Send *IDN? failed.\n");
    return 1;
} else {
    printf("Send *IDN? was successfully.\n");
}

//-----------------------
// Receive *idn? Response
//-----------------------
nRet = recv(soLink1, ResponseMessage, MAX_RECV, 0);
if (nRet == 0) {
    closesocket(soLink2);
    closesocket(soLink1);
    printf("Receive *IDN? response message failed.\n");
} else {
    //------------
    // Show Answer:
    //------------
    ResponseMessage[nRet] = 0;
    printf("Response from NRP2: %s", ResponseMessage);
}

//--------------
// Disconnecting
//--------------
closesocket(soLink2);
closesocket(soLink1);

//----------------
// Remote control interfaces
A.2.4 USB interface

If the R&S NRP2 is connected to a controller via a USB 1.1 interface, it logs on as a USB test and measurement class (USBTMC) device, provided that USB is selected as a remote interface in the System(Remote USB menu. The USBTMC standard describes how IEEE 488.2-compatible communications can be implemented via USB.

As with remote control via VXI11, the use of VISA distribution with a USBTMC driver is recommended for remote control via USB. The VISA resource identifier used to identify a USBTMC device has the following format:

USB::<Vendor ID>::<Product ID>::<serial number>::<INSTR>

<table>
<thead>
<tr>
<th>&lt;Vendor ID&gt;</th>
<th>&lt;Product ID&gt;</th>
<th>&lt;Serial number&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td>0x0aad</td>
<td>0x001b</td>
<td>The serial number is a string that can be taken from the System(System Info menu, for example.</td>
</tr>
</tbody>
</table>

In addition, the VISA resource identifier appears on the R&S NRP2 display if the USB remote interface is selected.

A.3 Standard Configurations

The following tables list the settings that can be made when configuring the R&S NRP2 with the `SYST:STAN:PRES <string>` remote control command. The following values are provided for the `<string>` parameter.

- GSM/EDGE
- NADC/UPLINK
- NADC/DOWNLINK
- PDC/UPLINK
- PDC/DOWNLINK
- DECT
- WCDMA/3GPP FDD
- WCDMA/3GPP TDD DL
- WCDMA/3GPP TDD UL
- TD-SCDMA
- Bluetooth DH1
- Bluetooth DH3
The tables list only the sensor parameters. If System Standard: POW Settings OFF is set, the calculate blocks (CALCulate:...), the window system (DISPlay:...) and the output unit (UNIT:...) are also configured.

### Table 1-8: GSM/EDGE

<table>
<thead>
<tr>
<th>Sensor parameter</th>
<th>Remote control command in short form</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sensor Mode</td>
<td>SENS:FUNC</td>
<td>POX:XTIM</td>
</tr>
<tr>
<td>Aperture Time</td>
<td>SENS:APER</td>
<td>4.615 ms</td>
</tr>
<tr>
<td>Duty Cycle</td>
<td>SENS:DCYC</td>
<td>11.762 %</td>
</tr>
<tr>
<td>Duty Cycle Correction</td>
<td>SENS:DCYC:STAT</td>
<td>ON</td>
</tr>
<tr>
<td>Smoothing</td>
<td>SENS:SMO</td>
<td>OFF</td>
</tr>
<tr>
<td>Dropout Tolerance</td>
<td>SENS:BURST:DTOL</td>
<td>577 µs</td>
</tr>
<tr>
<td>Exclude Time Start</td>
<td>SENS:TIM:EXCL:STAR</td>
<td>20 µs</td>
</tr>
<tr>
<td>Exclude Time End</td>
<td>SENS:TIM:EXCL:STOP</td>
<td>30 µs</td>
</tr>
<tr>
<td>Number Of Timeslots</td>
<td>SENS:TSL:COUN</td>
<td>8</td>
</tr>
<tr>
<td>Timeslot Width</td>
<td>SENS:TSL:WIDT</td>
<td>577 µs</td>
</tr>
<tr>
<td>Timeslot Fence</td>
<td>SENS:TSL:MID</td>
<td>OFF</td>
</tr>
<tr>
<td>Timegate Offset</td>
<td>SENS:TGAT:OFFS:TIME</td>
<td>1: 20 µs</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2: 2.328 ms</td>
</tr>
<tr>
<td>Timegate Length</td>
<td>SENS:TGAT:TIME</td>
<td>1: 527 µs</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2: 527 µs</td>
</tr>
<tr>
<td>Timegate Fence</td>
<td>SENS:TGAT:MID</td>
<td>OFF</td>
</tr>
<tr>
<td>Trace Offset Time</td>
<td>SENS:TRAC:OFFS:TIME</td>
<td>-50 µs</td>
</tr>
<tr>
<td>Trace Capture Time</td>
<td>SENS:TRAC:TIME</td>
<td>5 ms</td>
</tr>
<tr>
<td>Trace Number Of Points</td>
<td>SENS:TRAC:POIN</td>
<td>261</td>
</tr>
<tr>
<td>Trace Realtime</td>
<td>SENS:TRAC:REAL</td>
<td>OFF</td>
</tr>
<tr>
<td>Trigger Delay</td>
<td>TRIG:DEL</td>
<td>0 s</td>
</tr>
<tr>
<td>Trigger Level</td>
<td>TRIG:LEV</td>
<td>-20 dBm</td>
</tr>
<tr>
<td>Trigger Source</td>
<td>TRIG:SOUR</td>
<td>INT</td>
</tr>
<tr>
<td>Trigger Slope</td>
<td>TRIG:SLOP</td>
<td>POS</td>
</tr>
<tr>
<td>Trigger Holdoff</td>
<td>TRIG:HOLD</td>
<td>27 ms</td>
</tr>
<tr>
<td>Trigger Dropout Time</td>
<td>TRIG:DTIM</td>
<td>0 s</td>
</tr>
<tr>
<td>Trigger Hysteresis</td>
<td>TRIG:HYST</td>
<td>3 dB</td>
</tr>
</tbody>
</table>
### Table 1-9: NADC/DOWNLINK

<table>
<thead>
<tr>
<th>Sensor parameter</th>
<th>Remote control command in short form</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sensor Mode</td>
<td>SENS:FUNC</td>
<td>POW:AVG</td>
</tr>
<tr>
<td>Aperture Time</td>
<td>SENS:APER</td>
<td>40 ms</td>
</tr>
<tr>
<td>Duty Cycle Correction</td>
<td>SENS:DCYC:STAT</td>
<td>OFF</td>
</tr>
<tr>
<td>Smoothing</td>
<td>SENS:SMO</td>
<td>OFF</td>
</tr>
<tr>
<td>Trigger Source</td>
<td>TRIG:SOUR</td>
<td>EXT</td>
</tr>
</tbody>
</table>

### Table 1-10: NADC/UPLINK

<table>
<thead>
<tr>
<th>Sensor parameter</th>
<th>Remote control command in short form</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sensor Mode</td>
<td>SENS:FUNC</td>
<td>POW:XTIM</td>
</tr>
<tr>
<td>Aperture Time</td>
<td>SENS:APER</td>
<td>40 ms</td>
</tr>
<tr>
<td>Duty Cycle</td>
<td>SENS:DCYC</td>
<td>16.267 %</td>
</tr>
<tr>
<td>Duty Cycle Correction</td>
<td>SENS:DCYC:STAT</td>
<td>ON</td>
</tr>
<tr>
<td>Smoothing</td>
<td>SENS:SMO</td>
<td>OFF</td>
</tr>
<tr>
<td>Dropout Tolerance</td>
<td>SENS:BURST:DTOL</td>
<td>3 ms</td>
</tr>
<tr>
<td>Exclude Time Start</td>
<td>SENS:TIM:EXCL:STAR</td>
<td>130 µs</td>
</tr>
<tr>
<td>Exclude Time End</td>
<td>SENS:TIM:EXCL:STOP</td>
<td>140 µs</td>
</tr>
<tr>
<td>Number Of Timeslots</td>
<td>SENS:TSL:COUN</td>
<td>6</td>
</tr>
<tr>
<td>Timeslot Width</td>
<td>SENS:TSL:WIDT</td>
<td>6.667 ms</td>
</tr>
<tr>
<td>Timeslot Fence</td>
<td>SENS:TSL:MID</td>
<td>OFF</td>
</tr>
<tr>
<td>Timegate Offset</td>
<td>SENS:TGAT:OFFS:TIME</td>
<td>1: 130 µs</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2: 20.130 ms</td>
</tr>
<tr>
<td>Timegate Length</td>
<td>SENS:TGAT:TIME</td>
<td>1: 6.390 ms</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2: 6.390 ms</td>
</tr>
<tr>
<td>Timegate Fence</td>
<td>SENS:TGAT:MID</td>
<td>OFF</td>
</tr>
<tr>
<td>Trace Offset Time</td>
<td>SENS:TRAC:OFFS:TIME</td>
<td>-500 µs</td>
</tr>
<tr>
<td>Trace Capture Time</td>
<td>SENS:TRAC:TIME</td>
<td>42 ms</td>
</tr>
<tr>
<td>Trace Number Of Points</td>
<td>SENS:TRAC:POIN</td>
<td>261</td>
</tr>
<tr>
<td>Trace Realtime</td>
<td>SENS:TRAC:REAL</td>
<td>OFF</td>
</tr>
<tr>
<td>Trigger Delay</td>
<td>TRIG:DEL</td>
<td>0 s</td>
</tr>
<tr>
<td>Trigger Level</td>
<td>TRIG:LEV</td>
<td>-30 dBm</td>
</tr>
<tr>
<td>Trigger Source</td>
<td>TRIG:SOUR</td>
<td>INT</td>
</tr>
<tr>
<td>Trigger Slope</td>
<td>TRIG:SLOP</td>
<td>POS</td>
</tr>
<tr>
<td>Trigger Holdoff</td>
<td>TRIG:HOLD</td>
<td>79 ms</td>
</tr>
</tbody>
</table>
### Table 1-11: PDC/DOWNLINK

<table>
<thead>
<tr>
<th>Sensor parameter</th>
<th>Remote control command in short form</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trigger Dropout Time</td>
<td>TRIG:DTIM</td>
<td>0 s</td>
</tr>
<tr>
<td>Trigger Hysteresis</td>
<td>TRIG:HYST</td>
<td>3 dB</td>
</tr>
</tbody>
</table>

### Table 1-12: PDC/UPLINK

<table>
<thead>
<tr>
<th>Sensor parameter</th>
<th>Remote control command in short form</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sensor Mode</td>
<td>SENS:FUNC</td>
<td>POW:AVG</td>
</tr>
<tr>
<td>Aperture Time</td>
<td>SENS:APER</td>
<td>40 ms</td>
</tr>
<tr>
<td>Duty Cycle</td>
<td>SENS:DCYC</td>
<td>16.25 %</td>
</tr>
<tr>
<td>Duty Cycle Correction</td>
<td>SENS:DCYC:STAT</td>
<td>ON</td>
</tr>
<tr>
<td>Smoothing</td>
<td>SENS:SMO</td>
<td>OFF</td>
</tr>
<tr>
<td>Trigger Source</td>
<td>TRIG:SOUR</td>
<td>EXT</td>
</tr>
<tr>
<td>Dropout Tolerance</td>
<td>SENS:BURST:DTOL</td>
<td>3 ms</td>
</tr>
<tr>
<td>Exclude Time Start</td>
<td>SENS:TIM:EXCL:STAR</td>
<td>125 µs</td>
</tr>
<tr>
<td>Exclude Time End</td>
<td>SENS:TIM:EXCL:STOP</td>
<td>135 µs</td>
</tr>
<tr>
<td>Number Of Timeslots</td>
<td>SENS:TSL:COUN</td>
<td>6</td>
</tr>
<tr>
<td>Timeslot Width</td>
<td>SENS:TSL:WIDTH</td>
<td>6.667 ms</td>
</tr>
<tr>
<td>Timeslot Fence</td>
<td>SENS:TSL:MID</td>
<td>OFF</td>
</tr>
</tbody>
</table>
| Timegate Offset        | SENS:TGAT:OFFS:TIME                  | 1: 125 µs  
                          |                                    | 2: 20.125 ms |
| Timegate Length        | SENS:TGAT:TIME                       | 1: 6.406 ms  
                          |                                    | 2: 6.406 ms |
| Timegate Fence         | SENS:TGAT:MID                        | OFF  |
| Trace Offset Time      | SENS:TRAC:OFFS:TIME                  | -500 µs |
| Trace Capture Time     | SENS:TRAC:TIME                       | 42 ms |
| Trace Number Of Points | SENS:TRAC:POIN                       | 261   |
| Trace Realtime         | SENS:TRAC:REAL                       | OFF  |
### Table 1-13: DECT

<table>
<thead>
<tr>
<th>Sensor parameter</th>
<th>Remote control command in short form</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trigger Delay</td>
<td>TRIG:DEL</td>
<td>0 s</td>
</tr>
<tr>
<td>Trigger Level</td>
<td>TRIG:LEV</td>
<td>-30 dBm</td>
</tr>
<tr>
<td>Trigger Source</td>
<td>TRIG:SOUR</td>
<td>INT</td>
</tr>
<tr>
<td>Trigger Slope</td>
<td>TRIG:SLOP</td>
<td>POS</td>
</tr>
<tr>
<td>Trigger Holdoff</td>
<td>TRIG:HOLD</td>
<td>79 ms</td>
</tr>
<tr>
<td>Trigger Dropout Time</td>
<td>TRIG:DTIM</td>
<td>0 s</td>
</tr>
<tr>
<td>Trigger Hysteresis</td>
<td>TRIG:HYST</td>
<td>3 dB</td>
</tr>
<tr>
<td>Sensor Mode</td>
<td>SENS:FUNC</td>
<td>POW:XTIM</td>
</tr>
<tr>
<td>Aperture Time</td>
<td>SENS:APER</td>
<td>10 ms</td>
</tr>
<tr>
<td>Duty Cycle</td>
<td>SENS:DCYC</td>
<td>3.7 %</td>
</tr>
<tr>
<td>Duty Cycle Correction</td>
<td>SENS:DCYC:STAT</td>
<td>ON</td>
</tr>
<tr>
<td>Smoothing</td>
<td>SENS:SMO</td>
<td>OFF</td>
</tr>
<tr>
<td>Dropout Tolerance</td>
<td>SENS:BURST:DTOL</td>
<td>416.7 µs</td>
</tr>
<tr>
<td>Exclude Time Start</td>
<td>SENS:TIM:EXCL:STAR</td>
<td>15 µs</td>
</tr>
<tr>
<td>Exclude Time End</td>
<td>SENS:TIM:EXCL:STOP</td>
<td>25 µs</td>
</tr>
<tr>
<td>Number Of Timeslots</td>
<td>SENS:TSL:COUN</td>
<td>24</td>
</tr>
<tr>
<td>Timeslot Width</td>
<td>SENS:TSL:WIDT</td>
<td>416.667 µs</td>
</tr>
<tr>
<td>Timeslot Fence</td>
<td>SENS:TSL:MID</td>
<td>OFF</td>
</tr>
<tr>
<td>Timegate Offset</td>
<td>SENS:TGAT:OFFS:TIME</td>
<td>1: 15 µs</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2: 5.015 ms</td>
</tr>
<tr>
<td>Timegate Length</td>
<td>SENS:TGAT:TIME</td>
<td>1: 348.055 ms</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2: 348.000 ms</td>
</tr>
<tr>
<td>Timegate Fence</td>
<td>SENS:TGAT:MID</td>
<td>OFF</td>
</tr>
<tr>
<td>Trace Offset Time</td>
<td>SENS:TRAC:OFFS:TIME</td>
<td>-200 µs</td>
</tr>
<tr>
<td>Trace Capture Time</td>
<td>SENS:TRAC:TIME</td>
<td>10.250 ms</td>
</tr>
<tr>
<td>Trace Number Of Points</td>
<td>SENS:TRAC:POIN</td>
<td>261</td>
</tr>
<tr>
<td>Trace Realtime</td>
<td>SENS:TRAC:REAL</td>
<td>OFF</td>
</tr>
<tr>
<td>Trigger Delay</td>
<td>TRIG:DEL</td>
<td>0 s</td>
</tr>
<tr>
<td>Trigger Level</td>
<td>TRIG:LEV</td>
<td>-30 dBm</td>
</tr>
<tr>
<td>Trigger Source</td>
<td>TRIG:SOUR</td>
<td>INT</td>
</tr>
</tbody>
</table>
### Table 1-14: WCDMA/3GPP FDD

<table>
<thead>
<tr>
<th>Sensor parameter</th>
<th>Remote control command in short form</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trigger Slope</td>
<td>TRIG:SLOP</td>
<td>POS</td>
</tr>
<tr>
<td>Trigger Holdoff</td>
<td>TRIG:HOLD</td>
<td>39.9 ms</td>
</tr>
<tr>
<td>Trigger Dropout Time</td>
<td>TRIG:DTIM</td>
<td>0 s</td>
</tr>
<tr>
<td>Trigger Hysteresis</td>
<td>TRIG:HYST</td>
<td>3 dB</td>
</tr>
</tbody>
</table>

### Table 1-15: WCDMA/3GPP TDD DL

<table>
<thead>
<tr>
<th>Sensor parameter</th>
<th>Remote control command in short form</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sensor Mode</td>
<td>SENS:FUNC</td>
<td>POW:AVG</td>
</tr>
<tr>
<td>Aperture Time</td>
<td>SENS:APER</td>
<td>10 ms</td>
</tr>
<tr>
<td>Duty Cycle Correction</td>
<td>SENS:DCYC:STAT</td>
<td>OFF</td>
</tr>
<tr>
<td>Smoothing</td>
<td>SENS:SMO</td>
<td>OFF</td>
</tr>
<tr>
<td>Filter</td>
<td>SENS:AVER:COUN:AUTO</td>
<td>OFF</td>
</tr>
<tr>
<td>Filter Length</td>
<td>SENS:AVER:COUN</td>
<td>16</td>
</tr>
<tr>
<td>Trigger Source</td>
<td>TRIG:SOUR</td>
<td>EXT</td>
</tr>
<tr>
<td>Dropout Tolerance</td>
<td>SENS:BURST:DTOL</td>
<td>666.667 µs</td>
</tr>
<tr>
<td>Exclude Time Start</td>
<td>SENS:TIM:EXCL:STAR</td>
<td>25 µs</td>
</tr>
<tr>
<td>Exclude Time End</td>
<td>SENS:TIM:EXCL:STOP</td>
<td>40 µs</td>
</tr>
<tr>
<td>Number Of Timeslots</td>
<td>SENS:TSL:COUN</td>
<td>15</td>
</tr>
<tr>
<td>Timeslot Width</td>
<td>SENS:TSL:WIDT</td>
<td>666.667 µs</td>
</tr>
<tr>
<td>Timeslot Fence</td>
<td>SENS:TSL:MID</td>
<td>OFF</td>
</tr>
<tr>
<td>Timegate Offset</td>
<td>SENS:TGAT:OFFS:TIME</td>
<td>1: 25 µs</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2: 5.358 ms</td>
</tr>
<tr>
<td>Timegate Length</td>
<td>SENS:TGAT:TIME</td>
<td>1: 601.667 µs</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2: 602 µs</td>
</tr>
<tr>
<td>Timegate Fence</td>
<td>SENS:TGAT:MID</td>
<td>OFF</td>
</tr>
<tr>
<td>Sensor parameter</td>
<td>Remote control command in short form</td>
<td>Value</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>--------------------------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>Trace Offset Time</td>
<td>SENS:TRAC:OFFS:TIME</td>
<td>-200 µs</td>
</tr>
<tr>
<td>Trace Capture Time</td>
<td>SENS:TRAC:TIME</td>
<td>10.250 ms</td>
</tr>
<tr>
<td>Trace Number Of Points</td>
<td>SENS:TRAC:POIN</td>
<td>261</td>
</tr>
<tr>
<td>Trace Realtime</td>
<td>SENS:TRAC:REAL</td>
<td>OFF</td>
</tr>
<tr>
<td>Trigger Delay</td>
<td>TRIG:DEL</td>
<td>0 s</td>
</tr>
<tr>
<td>Trigger Level</td>
<td>TRIG:LEV</td>
<td>-30 dBm</td>
</tr>
<tr>
<td>Trigger Source</td>
<td>TRIG:SOUR</td>
<td>INT</td>
</tr>
<tr>
<td>Trigger Slope</td>
<td>TRIG:SLOP</td>
<td>POS</td>
</tr>
<tr>
<td>Trigger Holdoff</td>
<td>TRIG:HOLD</td>
<td>19.9 ms</td>
</tr>
<tr>
<td>Trigger Dropout Time</td>
<td>TRIG:DTIM</td>
<td>0 s</td>
</tr>
<tr>
<td>Trigger Hysteresis</td>
<td>TRIG:HYST</td>
<td>3 dB</td>
</tr>
</tbody>
</table>

Table 1-16: WCDMA/3GPP TDD UL

<table>
<thead>
<tr>
<th>Sensor parameter</th>
<th>Remote control command in short form</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sensor Mode</td>
<td>SENS:FUNC</td>
<td>POW:XTIM</td>
</tr>
<tr>
<td>Aperture Time</td>
<td>SENS:APER</td>
<td>10 ms</td>
</tr>
<tr>
<td>Duty Cycle</td>
<td>SENS:DCYC</td>
<td>6.420 %</td>
</tr>
<tr>
<td>Duty Cycle Correction</td>
<td>SENS:DCYC:STAT</td>
<td>ON</td>
</tr>
<tr>
<td>Smoothing</td>
<td>SENS:SMO</td>
<td>OFF</td>
</tr>
<tr>
<td>Dropout Tolerance</td>
<td>SENS:BURST:DTOL</td>
<td>666.667 µs</td>
</tr>
<tr>
<td>Exclude Time Start</td>
<td>SENS:TIM:EXCL:STAR</td>
<td>15 µs</td>
</tr>
<tr>
<td>Exclude Time End</td>
<td>SENS:TIM:EXCL:STOP</td>
<td>40 µs</td>
</tr>
<tr>
<td>Number Of Timeslots</td>
<td>SENS:TSL:COUN</td>
<td>15</td>
</tr>
<tr>
<td>Timeslot Width</td>
<td>SENS:TSL:WIDT</td>
<td>666.667 µs</td>
</tr>
<tr>
<td>Timeslot Fence</td>
<td>SENS:TSL:MID</td>
<td>OFF</td>
</tr>
<tr>
<td>Timegate Offset</td>
<td>SENS:TGAT:OFFS:TIME</td>
<td>1: 15 µs</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2: 5.348 ms</td>
</tr>
<tr>
<td>Timegate Length</td>
<td>SENS:TGAT:TIME</td>
<td>1: 611.667 µs</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2: 612 µs</td>
</tr>
<tr>
<td>Timegate Fence</td>
<td>SENS:TGAT:MID</td>
<td>OFF</td>
</tr>
<tr>
<td>Trace Offset Time</td>
<td>SENS:TRAC:OFFS:TIME</td>
<td>-200 µs</td>
</tr>
<tr>
<td>Trace Capture Time</td>
<td>SENS:TRAC:TIME</td>
<td>10.250 ms</td>
</tr>
<tr>
<td>Trace Number Of Points</td>
<td>SENS:TRAC:POIN</td>
<td>261</td>
</tr>
<tr>
<td>Sensor parameter</td>
<td>Remote control command in short form</td>
<td>Value</td>
</tr>
<tr>
<td>------------------------</td>
<td>--------------------------------------</td>
<td>---------</td>
</tr>
<tr>
<td>Trace Realtime</td>
<td>SENS:TRAC:REAL</td>
<td>OFF</td>
</tr>
<tr>
<td>Trigger Delay</td>
<td>TRIG:DEL</td>
<td>0 s</td>
</tr>
<tr>
<td>Trigger Level</td>
<td>TRIG:LEV</td>
<td>-30 dBm</td>
</tr>
<tr>
<td>Trigger Source</td>
<td>TRIG:SOUR</td>
<td>INT</td>
</tr>
<tr>
<td>Trigger Slope</td>
<td>TRIG:SLOP</td>
<td>POS</td>
</tr>
<tr>
<td>Trigger Holdoff</td>
<td>TRIG:HOLD</td>
<td>19.9 ms</td>
</tr>
<tr>
<td>Trigger Dropout Time</td>
<td>TRIG:DTIM</td>
<td>0 s</td>
</tr>
<tr>
<td>Trigger Hysteresis</td>
<td>TRIG:HYST</td>
<td>3 dB</td>
</tr>
</tbody>
</table>

**Table 1-17: TD-SCDMA**

<table>
<thead>
<tr>
<th>Sensor parameter</th>
<th>Remote control command in short form</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sensor Mode</td>
<td>SENS:FUNC</td>
<td>POW:XTIM</td>
</tr>
<tr>
<td>Aperture Time</td>
<td>SENS:APER</td>
<td>5 ms</td>
</tr>
<tr>
<td>Duty Cycle</td>
<td>SENS:DCYC</td>
<td>13.250 %</td>
</tr>
<tr>
<td>Duty Cycle Correction</td>
<td>SENS:DCYC:STAT</td>
<td>ON</td>
</tr>
<tr>
<td>Smoothing</td>
<td>SENS:SMO</td>
<td>OFF</td>
</tr>
<tr>
<td>Timegate Offset</td>
<td>SENS:TGAT:OFFS:TIME</td>
<td>1: 20 μs</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2: 710 μs</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3: 835 μs</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4: 5.970 ms</td>
</tr>
<tr>
<td>Timegate Length</td>
<td>SENS:TGAT:TIME</td>
<td>1: 620 μs</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2: 30 μs</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3: 85 μs</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4: 620 μs</td>
</tr>
<tr>
<td>Timegate Fence</td>
<td>SENS:TGAT:MID</td>
<td>OFF</td>
</tr>
<tr>
<td>Trace Offset Time</td>
<td>SENS:TRAC:OFFS:TIME</td>
<td>-200 μs</td>
</tr>
<tr>
<td>Trace Capture Time</td>
<td>SENS:TRAC:TIME</td>
<td>10.250 ms</td>
</tr>
<tr>
<td>Trace Number Of Points</td>
<td>SENS:TRAC:POIN</td>
<td>261</td>
</tr>
<tr>
<td>Trace Realtime</td>
<td>SENS:TRAC:REAL</td>
<td>OFF</td>
</tr>
<tr>
<td>Trigger Delay</td>
<td>TRIG:DEL</td>
<td>0 s</td>
</tr>
<tr>
<td>Trigger Level</td>
<td>TRIG:LEV</td>
<td>-30 dBm</td>
</tr>
<tr>
<td>Trigger Source</td>
<td>TRIG:SOUR</td>
<td>INT</td>
</tr>
<tr>
<td>Trigger Slope</td>
<td>TRIG:SLOP</td>
<td>POS</td>
</tr>
<tr>
<td>Trigger Holdoff</td>
<td>TRIG:HOLD</td>
<td>19.9 ms</td>
</tr>
</tbody>
</table>
### Standard Configurations

<table>
<thead>
<tr>
<th>Sensor parameter</th>
<th>Remote control command in short form</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trigger Dropout Time</td>
<td>TRIG:DTIM</td>
<td>0 s</td>
</tr>
<tr>
<td>Trigger Hysteresis</td>
<td>TRIG:HYST</td>
<td>3 dB</td>
</tr>
</tbody>
</table>

#### Table 1-18: Bluetooth DH1

<table>
<thead>
<tr>
<th>Sensor parameter</th>
<th>Remote control command in short form</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sensor Mode</td>
<td>SENS:FUNC</td>
<td>POW:XTIM</td>
</tr>
<tr>
<td>Aperture Time</td>
<td>SENS:APER</td>
<td>1.25 ms</td>
</tr>
<tr>
<td>Duty Cycle</td>
<td>SENS:DCYC</td>
<td>29.28 %</td>
</tr>
<tr>
<td>Duty Cycle Correction</td>
<td>SENS:DCYC:STAT</td>
<td>ON</td>
</tr>
<tr>
<td>Smoothing</td>
<td>SENS:SMO</td>
<td>OFF</td>
</tr>
<tr>
<td>Dropout Tolerance</td>
<td>SENS:BURST:DTOL</td>
<td>366 µs</td>
</tr>
<tr>
<td>Exclude Time Start</td>
<td>SENS:TIM:EXCL:STAR</td>
<td>10 µs</td>
</tr>
<tr>
<td>Exclude Time End</td>
<td>SENS:TIM:EXCL:STOP</td>
<td>15 µs</td>
</tr>
<tr>
<td>Timegate Offset</td>
<td>SENS:TGAT:OFFS:TIME</td>
<td>1: 10 µs</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2: 660 µs</td>
</tr>
<tr>
<td>Timegate Length</td>
<td>SENS:TGAT:TIME</td>
<td>1: 341 µs</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2: 341 µs</td>
</tr>
<tr>
<td>Timegate Fence</td>
<td>SENS:TGAT:MID</td>
<td>OFF</td>
</tr>
<tr>
<td>Trace Offset Time</td>
<td>SENS:TRAC:OFFS:TIME</td>
<td>-30 µs</td>
</tr>
<tr>
<td>Trace Capture Time</td>
<td>SENS:TRAC:TIME</td>
<td>1.280 ms</td>
</tr>
<tr>
<td>Trace Number Of Points</td>
<td>SENS:TRAC:POIN</td>
<td>261</td>
</tr>
<tr>
<td>Trace Realtime</td>
<td>SENS:TRAC:REAL</td>
<td>OFF</td>
</tr>
<tr>
<td>Trigger Delay</td>
<td>TRIG:DEL</td>
<td>0 s</td>
</tr>
<tr>
<td>Trigger Level</td>
<td>TRIG:LEV</td>
<td>-30 dBm</td>
</tr>
<tr>
<td>Trigger Source</td>
<td>TRIG:SOUR</td>
<td>INT</td>
</tr>
<tr>
<td>Trigger Slope</td>
<td>TRIG:SLOP</td>
<td>POS</td>
</tr>
<tr>
<td>Trigger Holdoff</td>
<td>TRIG:HOLD</td>
<td>2.480 ms</td>
</tr>
<tr>
<td>Trigger Dropout Time</td>
<td>TRIG:DTIM</td>
<td>0 s</td>
</tr>
<tr>
<td>Trigger Hysteresis</td>
<td>TRIG:HYST</td>
<td>3 dB</td>
</tr>
</tbody>
</table>
### Table 1-19: Bluetooth DH3

<table>
<thead>
<tr>
<th>Sensor parameter</th>
<th>Remote control command in short form</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sensor Mode</td>
<td>SENS:FUNC</td>
<td>POW:XTIM</td>
</tr>
<tr>
<td>Aperture Time</td>
<td>SENS:APER</td>
<td>2.50 ms</td>
</tr>
<tr>
<td>Duty Cycle</td>
<td>SENS:DCYC</td>
<td>64.88 %</td>
</tr>
<tr>
<td>Duty Cycle Correction</td>
<td>SENS:DCYC:STAT</td>
<td>ON</td>
</tr>
<tr>
<td>Smoothing</td>
<td>SENS:SMO</td>
<td>OFF</td>
</tr>
<tr>
<td>Dropout Tolerance</td>
<td>SENS:BURST:DTOL</td>
<td>1.622 ms</td>
</tr>
<tr>
<td>Exclude Time Start</td>
<td>SENS:TIM:EXCL:STAR</td>
<td>10 µs</td>
</tr>
<tr>
<td>Exclude Time End</td>
<td>SENS:TIM:EXCL:STOP</td>
<td>15 µs</td>
</tr>
<tr>
<td>Timegate Offset</td>
<td>SENS:TGAT:OFFS:TIME</td>
<td>1: 10 µs</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2: 1.885 ms</td>
</tr>
<tr>
<td>Timegate Length</td>
<td>SENS:TGAT:TIME</td>
<td>1: 1.597 ms</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2: 351 µs</td>
</tr>
<tr>
<td>Timegate Fence</td>
<td>SENS:TGAT:MID</td>
<td>OFF</td>
</tr>
<tr>
<td>Trace Offset Time</td>
<td>SENS:TRAC:OFFS:TIME</td>
<td>-30 µs</td>
</tr>
<tr>
<td>Trace Capture Time</td>
<td>SENS:TRAC:TIME</td>
<td>2.530 ms</td>
</tr>
<tr>
<td>Trace Number Of Points</td>
<td>SENS:TRAC:POIN</td>
<td>261</td>
</tr>
<tr>
<td>Trace Realtime</td>
<td>SENS:TRAC:REAL</td>
<td>OFF</td>
</tr>
<tr>
<td>Trigger Delay</td>
<td>TRIG:DEL</td>
<td>0 s</td>
</tr>
<tr>
<td>Trigger Level</td>
<td>TRIG:LEV</td>
<td>-30 dBm</td>
</tr>
<tr>
<td>Trigger Source</td>
<td>TRIG:SOUR</td>
<td>INT</td>
</tr>
<tr>
<td>Trigger Slope</td>
<td>TRIG:SLOP</td>
<td>POS</td>
</tr>
<tr>
<td>Trigger Holdoff</td>
<td>TRIG:HOLD</td>
<td>4.980 ms</td>
</tr>
<tr>
<td>Trigger Dropout Time</td>
<td>TRIG:DTIM</td>
<td>0 s</td>
</tr>
<tr>
<td>Trigger Hysteresis</td>
<td>TRIG:HYST</td>
<td>3 dB</td>
</tr>
</tbody>
</table>

### Table 1-20: Bluetooth DH5

<table>
<thead>
<tr>
<th>Sensor parameter</th>
<th>Remote control command in short form</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sensor Mode</td>
<td>SENS:FUNC</td>
<td>POW:XTIM</td>
</tr>
<tr>
<td>Aperture Time</td>
<td>SENS:APER</td>
<td>3.75 ms</td>
</tr>
<tr>
<td>Duty Cycle</td>
<td>SENS:DCYC</td>
<td>76.533 %</td>
</tr>
<tr>
<td>Duty Cycle Correction</td>
<td>SENS:DCYC:STAT</td>
<td>ON</td>
</tr>
<tr>
<td>Smoothing</td>
<td>SENS:SMO</td>
<td>OFF</td>
</tr>
<tr>
<td>Dropout Tolerance</td>
<td>SENS:BURST:DTOL</td>
<td>2.870 ms</td>
</tr>
<tr>
<td>Sensor parameter</td>
<td>Remote control command in short form</td>
<td>Value</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>--------------------------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>Exclude Time Start</td>
<td>SENS:TIM:EXCL:STAR</td>
<td>10 µs</td>
</tr>
<tr>
<td>Exclude Time End</td>
<td>SENS:TIM:EXCL:STOP</td>
<td>15 µs</td>
</tr>
<tr>
<td>Timegate Offset</td>
<td>SENS:TGAT:OFFS:TIME</td>
<td>1: 10 µs</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2: 3.135 ms</td>
</tr>
<tr>
<td>Timegate Length</td>
<td>SENS:TGAT:TIME</td>
<td>1: 2.845 ms</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2: 351 µs</td>
</tr>
<tr>
<td>Timegate Fence</td>
<td>SENS:TGAT:MID</td>
<td>OFF</td>
</tr>
<tr>
<td>Trace Offset Time</td>
<td>SENS:TRAC:OFFS:TIME</td>
<td>-30 µs</td>
</tr>
<tr>
<td>Trace Capture Time</td>
<td>SENS:TRAC:TIME</td>
<td>3.780 ms</td>
</tr>
<tr>
<td>Trace Number Of Points</td>
<td>SENS:TRAC:POIN</td>
<td>261</td>
</tr>
<tr>
<td>Trace Realtime</td>
<td>SENS:TRAC:REAL</td>
<td>OFF</td>
</tr>
<tr>
<td>Trigger Delay</td>
<td>TRIG:DEL</td>
<td>0 s</td>
</tr>
<tr>
<td>Trigger Level</td>
<td>TRIG:LEV</td>
<td>-30 dBm</td>
</tr>
<tr>
<td>Trigger Source</td>
<td>TRIG:SOUR</td>
<td>INT</td>
</tr>
<tr>
<td>Trigger Slope</td>
<td>TRIG:SLOP</td>
<td>POS</td>
</tr>
<tr>
<td>Trigger Holdoff</td>
<td>TRIG:HOLD</td>
<td>7.480 ms</td>
</tr>
<tr>
<td>Trigger Dropout Time</td>
<td>TRIG:DTIM</td>
<td>0 s</td>
</tr>
<tr>
<td>Trigger Hysteresis</td>
<td>TRIG:HYST</td>
<td>3 dB</td>
</tr>
</tbody>
</table>

**Table 1-21: CDMA2000**

<table>
<thead>
<tr>
<th>Sensor parameter</th>
<th>Remote control command in short form</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sensor Mode</td>
<td>SENS:FUNC</td>
<td>POW:AVG</td>
</tr>
<tr>
<td>Aperture Time</td>
<td>SENS:APER</td>
<td>80 ms</td>
</tr>
<tr>
<td>Duty Cycle Correction</td>
<td>SENS:DCYC:STAT</td>
<td>OFF</td>
</tr>
<tr>
<td>Smoothing</td>
<td>SENS:SMO</td>
<td>OFF</td>
</tr>
<tr>
<td>Filter</td>
<td>SENS:AVER:COUN:AUTO</td>
<td>OFF</td>
</tr>
<tr>
<td>Filter Length</td>
<td>SENS:AVER:COUN</td>
<td>16</td>
</tr>
<tr>
<td>Trigger Source</td>
<td>TRIG:SOUR</td>
<td>EXT</td>
</tr>
</tbody>
</table>
A.4 Programming Measurements

A.4.1 Measuring with high-level commands

The R&S NRP2 is based on the instrument model defined in the SCPI 1999.0 standard. This model provides a number of logic blocks that can be configured via remote-control commands. The R&S NRP2 is provided with high-level measurement commands that automatically perform the most important settings and simplify measurements, thus making it unnecessary to completely configure these blocks for each measurement. Only the high-level commands are described, starting with the simplest command, which is expanded in the following sections.

Note the following for the syntax of commands: There is a short and a long form for the commands. The short form is normally used. However, commands are sometimes indicated in their long form so that their meaning is easier to understand. The R&S NRP2 makes no distinction between upper case and lower case letters; they are only used to distinguish between the short and long form.

A.4.1.1 The simplest measurement

The simplest way to obtain a measured value is to use the high-level measurement command

```
MEAS?,
```

which configures sensor 1 in the ContAv mode, starts a measurement and always outputs a result that is stored in the output queue.

The following settings are performed:

- INIT:CONT OFF
- TRIG:SOUR IMM
- TRIG:COUN 1
- TRIG:DEL:AUTO ON
- SENS:AVER:STAT ON
- SENS:AVER:COUN:AUTO ON
- SENS:AVER:COUN:AUTO:TYPE RES
- SENS:AVER:COUN:AUTO:RES 3
- CALC:MATH "(SENS1)"
- CALC:REL:STAT OFF

The command can also be used with a list of parameters, which are separated by a comma and allow the measurement accuracy and the addressed sensor to be selected:

```
MEAS? DEF, <resolution>, <source_list>
```

The first parameter should always assume the DEF value; it is ignored and is available only for reasons of compatibility.
The second parameter may assume the values 1, 2, 3 and 4. It specifies the number of places up to which the measurement result should be noise-free. With linear units, the setting corresponds to the number of significant places that are noise-free; with logarithmic units, 1, 2, 3 and 4 correspond to a resolution of 1, 0.1, 0.01 and 0.001 (number of decimal places). With a \(<\text{resolution}>\) of 3, two decimal places are thus noise-free with logarithmic display. The default setting is 3.

The third parameter selects a sensor. It has the syntax (@n), where n can assume the values 1 to 4. The default setting is (@1).

### A.4.1.2 Relative measurements

If the measurement results are to be output not as absolute values, but relative to a reference value, the keyword :RELative can be added to the measurement command. The result is then divided by a value that was previously set by means of \(\text{CALC:REL:POW} \) or \(\text{CALC:REL:AUTO ONCE}\).

\[\text{MEAS?} \quad \text{CALC:REL:AUTO ONCE} \quad \text{MEAS:REL?}\]

The first MEAS command determines the reference value, which is acquired and stored with \(\text{CALC:REL:AUTO ONCE}\). The second measurement command MEAS:REL? and all other MEAS:REL? commands will divide the absolute measured value by the stored reference value.

\(\text{CALC:REL:POW <float_value>}\) is used to define such a reference value.

\[\text{CALC:REL:POW 0 \, DBM} \quad \text{MEAS:REL?}\]

All measured values are then divided by 0 dBm (1 mW) prior to being transferred to the user.

The following section describes an extension of the MEAS command in which the result no longer carries a power unit, but represents a power ratio. The reference value also must have a power unit and be set with \(\text{CALC:REL:RAT}\). The R&S NRP2 stores the reference values for power values and power ratios independently of each other and automatically uses the correct reference value depending on the unit of the measurement result.

The \(\text{CALC:REL}\) command is available for entering the reference value. It assumes a numeric parameter whose unit is determined from the current device settings. This command is provided only for reasons of compatibility and should not be used unless avoidable.

### A.4.1.3 Processing the results of two sensors

The R&S NRP2 offers measurement commands for processing the results of two sensors. The calculated result can also be partly referenced to a stored reference value.
The measurement commands are obtained by adding one of the following keywords:

:DIFF (difference)
:DIFF:REL (difference with reference value)
:RAT (ratio)
:RAT:REL (ratio with reference value)
:SWR (standing wave ratio)
:RLOS (return loss)
:REFL (reflection coefficient)

The list of parameters is modified for these commands since two sensors have to be entered in the <source_list>.

Example:
MEAS:RAT DEF,3,(@1),(@4)

A CALCulate block is used for processing the measured values. Each CALCulate block has two input channels called the primary and secondary channel. In the above example, the primary channel is assigned sensor 1 and the secondary channel sensor 4 via the <source_list>. The measurement result is the ratio of the results from sensors 1 and 4.

Example:
MEAS:SWR DEF,2,(@1),(@2)

It is assumed that sensor 1 delivers the forward power of a wave and sensor 2 the reflected power of a wave. The measurement result represents the SWR of the two power values:

\[
P = \frac{1 + \sqrt{2/1}}{1 - \sqrt{2/1}}
\]

Note that the unit is automatically set to percent (refer to chapter A.4.1.5, "Selecting the output unit for measured values", on page 383)

### A.4.1.4 Selecting a measurement mode

Other MEAS commands are available for measurements to be performed in a mode other than the "ContAv" mode. The short form of these commands is obtained by adding a keyword for the measurement mode to keyword MEAS.

**Timeslot measurement:**
MEAS:TSLot? <tslot_width>,<no_slots>,<start_exclude>,<stop_exclude>

**BurstAv measurement:**
MEAS:BURSt? <dtolerance>,<start_exclude>,<stop_exclude>
Trace measurement:

MEAS:XTIMe? (<scope_size>),<capture_time>

Measurement in the ContAv mode with data buffering:

MEAS:ARRay?
<tslot_width>,<no_slots>,<start_exclude>,<stop_exclude>

In the Timeslot mode, the trigger source is set to EXTernal. In the "BurstAv" mode, it is not modified but ignored. Triggering in response to the signal is performed as if TRIGger:SOURce INTernal were set.

These commands have the specified parameters, whose meanings are explained in the operating manual. In addition, parameters DEF,<resolution>,<source_list> can be optionally specified as for the MEAS? command.

Example:
MEAS:TSLot? 577 us, 8, 18 us, 18 us
A timeslot measurement of a GSM signal is performed (8 timeslots with a length of 577 µs each). 18 µs at the beginning and the end of the timeslots are ignored. The measurement is carried out with sensor 1 (default). The instrument is triggered by an external signal, which must be routed to the R&S NRP2 rear panel via the trigger input. The measurement result is a list of 8 measured values separated by a comma for the timeslots.

Example:
MEAS:BURSt? 5 us, 10 us, 0 us, DEF, 3, (@2)
Sensor 2 measures in the BurstAv mode. Triggering (in response to a rising edge) is internal. At the beginning of the power pulse, 10 µs are ignored to avoid overshoots in the signal, which could distort the measurement result. If the power falls below the trigger level but does not exceed 5 µs (dropout time) the measurement will not be stopped. The measurement result is noise-free within the first 3 places and it is measured with sensor 2 (@2)).

Example:
MEAS:XTIMe? (256), 577 us
Within the next 577 µs, 256 measured values are recorded and displayed with respect to time in the same manner as with an oscilloscope in order to display the power characteristics. There is no triggering [TRIG:SOUR IMM]; the measurements are started after the command is received from the R&S NRP2. After a partial measurement has been completed, the next one is started. If the trigger source setting is to be changed, MEAS:XTIMe? must be replaced by the CONF:XTIMe and READ:XTIMe? commands, between which user-defined settings can be performed. Dividing MEAS? into the CONF and READ? commands is described further down. The measurement result is a list of 256 measured values separated by a comma.
Example:
MEAS:ARRay? (1000)
1000 measured values are recorded in the ContAv mode. After termination of the last measurement, the results are stored in the output queue. There is no triggering as in the ContAv mode. The measurement result is a list of 1000 measured values separated by a comma.

The keywords for processing two sensors can be added to the MEAS:TSL, MEAS:BURS and MEAS:ARRay commands, but the :SWR,:RLOS and :REFL functions are not available.

Example:
MEAS:TSL:RAT? 577 us, 8, 18 us, 18 us, DEF, 3, (@1), (@3)
The above timeslot example is extended to two sensors. The measurement result is a list of 8 measured values separated by a comma for the 8 timeslots; these values were obtained by division from the measured values of sensors 1 and 3.

A.4.1.5 Selecting the output unit for measured values

So far, no information has been given on the unit of the measured values. It is possible to modify the output unit of the measured values. A distinction is made as to whether the result represents a power or a power ratio. Relative measurements always deliver power ratios. This also applies to the :RATio,:SWR,:RLOS and :REFL functions. The units are set by means of the following commands:

UNIT:POWer DBM | W | DBUV
and
UNIT:RATio DB | DPCT | O

The default settings are DBM for power values and DB for power ratios.

<table>
<thead>
<tr>
<th>Physical unit</th>
<th>SCPI notation</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>dBm</td>
<td>DBM</td>
<td>Power in dB referenced to 1 mW: x / W = 10 log (x / (1 mW)) / dBm</td>
</tr>
<tr>
<td>Watt</td>
<td>W</td>
<td></td>
</tr>
<tr>
<td>dBµV</td>
<td>DBUV</td>
<td>Power in dB referred to (1 µV)^2 / 50 : x dBm (x + 107) dBµV</td>
</tr>
<tr>
<td>dB</td>
<td>DB</td>
<td></td>
</tr>
<tr>
<td>Δ%</td>
<td>DPCT</td>
<td>Deviation from 100% in %: x (%) = Δx + 100 %</td>
</tr>
<tr>
<td>1</td>
<td>O</td>
<td></td>
</tr>
</tbody>
</table>

When the :SWR,:RLOS and :REFL functions are used, the output unit, however, is implicitly set by the MEAS command:
### Measurement function

<table>
<thead>
<tr>
<th>Measurement function</th>
<th>Output unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>:SWR</td>
<td>0</td>
</tr>
<tr>
<td>:RLOS</td>
<td>DB</td>
</tr>
<tr>
<td>:REFL</td>
<td>0</td>
</tr>
</tbody>
</table>

The UNIT commands affect the parameters of the following commands: CALC:LIMit:UPPer, CALC:LIMit:LOWer, CALC:RELative, DISP:METer:UPPer and DISP:METer:LOWer.

#### A.4.1.6 Division of MEAS?

MEAS? can be divided into other high-level measurement commands.

<table>
<thead>
<tr>
<th>MEAS?</th>
<th>⇔</th>
<th>CONF [&lt;parameters list&gt;]</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>READ? [&lt;parameters list&gt;]</td>
</tr>
</tbody>
</table>

The CONF command configures the measurement, whereas READ? starts the measurement, and calculates and provides the result.

This division offers two advantages:
- The measurement has to be configured only once and several measurements (with several READ? commands) can be performed in succession. This means better performance as compared to measurements performed with MEAS?, since the time for configuring the measurement is only used once.
- After CONF, settings can be adapted to user's requirements by means of low-level commands (see below).

If a list of parameters is indicated for the READ command, it must correspond to the list for the preceding CONF command.

After a measurement has been completed, i.e. the data from the sensors is available, it is sometimes interesting to evaluate this data several times without starting a new measurement each time. Since this is not possible with the above commands, the READ? command can be replaced by the INIT and FETCH? commands.

<table>
<thead>
<tr>
<th>READ?</th>
<th>⇔</th>
<th>INIT</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>FETCH? [&lt;list of parameters&gt;]</td>
</tr>
</tbody>
</table>

FETCH? evaluates existing data if the data is valid. FETCH? may select another calculation function if the measurement can be evaluated with the available measured data.
Example:
The following sequence of commands provides the difference between measured values from sensors 1 and 2 by means of \texttt{FETCh:DIFF?}, which measure in the ContAv mode as the default setting.

\begin{verbatim}
CONF:DIFF
INIT:ALL
FETCh:DIFF?   \textsuperscript{*}Response: valid result
FETCh:RAT?    \textsuperscript{*}Response: valid result
FETCh:BURst?  \textsuperscript{*}Response: -221, "Settings conflict"
\end{verbatim}

The \texttt{FETCh:RAT?} command then delivers the ratios of the two measured values. This is possible without a new measurement, since the required data is available. The last \texttt{FETCh} command requires a result that was measured in the BurstAv mode. Such a measured value is not available and thus, this command will generate a SCPI error (-221, "Settings conflict").

\texttt{FETCh?} immediately delivers a measured value if a valid result is available. If no measured value is available, the R&S NRP2 waits for such a value and then answers the query. During this time, no other command should be sent to the R&S NRP2, since the query has to be answered first. If a command is sent to the R&S NRP2, the SCPI error -410, "Query interrupted", is output.

However, \texttt{FETCh?} should wait only if a measurement result is expected, since command processing is blocked if a command is not answered. If \texttt{FETCh?} is executed although no measured values are expected, the SCPI error -214, "Trigger deadlock", is output. This may occur if the trigger source is set to \texttt{BUS} or \texttt{HOLD} with low-level \texttt{TRIG:SOUR} and \texttt{FETCh? immediately follows INIT}.

Example

\begin{verbatim}
CONF
TRIG:SOUR BUS
INIT
FETCh?\textsuperscript{*}Response: -214, "Trigger deadlock",
*TRG or \texttt{GET} is not possible if \texttt{FETCh? is waiting.}
\end{verbatim}

A.4.2 Trigger state system

The accuracy of a result largely depends on how accurately the sequence of a measurement can be determined. The R&S NRP2 manages a trigger state system to SCPI 1999.0 for each sensor to define the exact start and stop time of a measurement. This system defines the sequence of a measurement cycle. 4 different device states are defined in the trigger state system implemented in the R&S NRP2.
The R&S NRP2 is in the idle state and performs no measurement. On power-up of the R&S NRP2, it is in the LOCAL mode and in the IDLE state. All connected sensors are set to \texttt{INIT:CONT ON} to allow measurements to be continuously displayed. Thus, the IDLE state is exited and the instrument is again in this state if \texttt{INIT:CONT OFF} is sent via the remote control.

**INITIATED**

This state is a transition state, which is exited immediately after it has been entered. It has been defined so as to allow the user to decide whether the next measurement cycle is to be immediately started (\texttt{INIT:CONT ON} or all cycles defined via \texttt{TRIG:COUNT} have not yet been processed) or the R&S NRP2 returns to the IDLE state. The state is only entered internally and is not noticed by the user.

**WAIT FOR TRG**

The R&S NRP2 waits for a trigger event. The source for this event is set via \texttt{TRIG:SOUR}. When the event defined in this way occurs, the enters the MEASURING state.

**MEASURING**

As long as the R&S NRP2 measures data, it remains in this state and exits it immediately after completion of the measurement.

---

**Fig. 1-5: Overview of basic relationships in the trigger state system**
The figure above shows the basic structure of the trigger system. It is possible to improve the sequence of measurement using the commands from the TRIGger command system.

### A.4.3 Logic relationship of command systems SENSe, CALCulate and UNIT

The following section provides an overview of the measurement procedure of the R&S NRP2. The commands are mentioned as examples. These commands are described in detail in chapter 6, "Remote Control - Commands", on page 193.

To perform measurements with the R&S NRP2, the user should have a good understanding of the trigger system and be familiar with the result processing. The measured values delivered by the sensors cannot be directly queried. As shown in figure below, the raw data is first determined in the sensors taking into account the SENSe settings. It is then transferred to the CALCulate blocks where the measured values of up to two sensors are processed and made available to the user in the unit defined by UNIT.

![Fig. 1-6: Processing of measured values in the R&S NRP2](image)

The high-level commands and the SENSe block allow indices to be specified. These indices refer to the connected sensors (indices 1 to 4) for the SENSe commands whereas the indices of the high-level commands select the CALCulate blocks (indices 1 to 8). Depending on the configuration of the first CALCulate block, FETCh? (same meaning as FETCh1?) may not deliver the measured value of sensor 1 in contrast to the above examples. After *RST, the first CALCulate block delivers the measured value of sensor 1 (CALC1:MATH "(SENS1)") and the second one the measured value of sensor 2, etc. (see SYSTem:PRESet on page 325).

### A.4.4 Measuring with low-level commands

Low-level commands allow the user to perform the most important modifications on the measurement configuration. In the present context, low-level commands are all com-
mands that do not belong to high-level commands. These are in particular the commands of the SENSE, TRIGGER and CALCULATE systems. Since the high-level commands combine different low-level commands, they allow a simpler configuration of measurements.

Each measurement configuration should begin with the *RST command, which sets the R&S NRP2 to a defined output state. The accurate settings are described in the documentation of remote control command SYSTem:PRESet.

The most important settings are listed below:

- **Continuous measurements are stopped** (INIT:CONT OFF)
- **Offset correction are deactivated** (SENSe:CORRection:OFFSet:STATe OFF, SENSE:CORRection:DCYCle:STATe OFF, SENSE:CORRection:FDOFfset:STATe OFF).
- **All other settings of the SENSE system depend on the sensor used and are specified in the corresponding manual.**
- **The first 4 CALCulate blocks are set to sensors 1 to 4** (CALCulate<n>:MATH "(SENSn)")
- **The values are measured as absolute values** (CALulate:RELative:STATe OFF).
- **Logarithmic units are used** (UNIT:POWer dBm and UNIT:RATio dB).

### A.4.4.1 The simplest measurement

The fastest way to obtain a result is to use the following sequence of commands

*RST
INIT
FETCh?

Normally, *RST will set the "ContAv" mode. The concept of smart-sensor technology provides that each sensor determines the reset values of the assigned SENSE and TRIGGER block. Thus, another mode than ContAv may come after *RST with future sensors. Information is provided in the operating manual of the sensor used.

INIT initiates the measurement. After *RST, the trigger system is set to "straight through" (TRIG:SOUR IMM) so that the trigger system state changes to MEASURING via INITIATED and WAIT FOR TRG. After the measurement has been completed, FETCh? delivers the result to the output queue from which it can be fetched.

### A.4.4.2 Configuration of the trigger system

**Trigger source**

After a measurement is started with INIT, the state WAIT FOR TRG is entered. This is a preliminary stage to the measurement, which has been initiated so that the measurement may start with high accuracy at a defined point in time. For this purpose, different sources can be defined for the trigger event, which triggers the measurement. In man-
ual operation, a trigger event is not expected in the "ContAv" mode. Since the measurement is to be performed continuously, the trigger source (TRIgger:SOURce) is set to IMMEDIATE.

If triggering needs to occur in response to a rising signal edge, the trigger system has to be configured with TRIG:SOUR INT and TRIG:SLOP POS:

**Example**

* RST
  TRIG:SOUR INT ’triggering in response to a signal edge
  TRIG:SLOP POS ’triggering in response to a rising signal edge
  INIT
  FETCH?

The settings of commands TRIG:SOUR and TRIG:SLOP are ignored in the "BurstAv" mode. In this mode the beginning and the end of the power pulse are automatically recognized. For this reason, the instrument always triggers INTERNAL even if TRIG:SOUR has a different setting.

If a trigger signal is to be routed to the instrument rear panel via the external trigger connector, the trigger source has to be configured with TRIG:SOUR EXT.

**Example**

* RST
  TRIG:SOUR EXT ’triggering in response to the edge of an external signal
  TRIG:SLOP POS ’triggering in response to a rising signal edge
  INIT
  FETCH?

TRIG:SOUR BUS can be set if measurements are to be started with *TRG or GET. This procedure is provided by standard IEEE 488.2, which stipulates that *TRG or GET can also be used to perform complete measurements. This includes the generation of an answer, the measurement result. In the R&S NRP2, *TRG does not have this meaning: *TRG only executes a trigger event and thus only causes the status transitions from WAIT FOR TRG to MEASURING. *TRG delivers no measurement result and has no effect if TRIG:SOUR is not set to BUS or if the instrument is not in the state WAIT FOR TRG. The latter situation applies, for example, if the R&S NRP2 is IDLE, i.e. INIT:CONT ON is not set nor was INIT executed.

**Delay, Holdoff**

Normally, the measurement immediately starts after the trigger event has been executed. This may not be desirable if the measurement is to be started before or after the trigger point. The start of the measurement with reference to the trigger point can be offset using the TRIG:DEL command. A negative sign means that the measurement begins before the trigger point. This is possible because the sensors store sampling values for a while and can use past values when the measurement is started. The command is also used when overshoots are to be ignored at the beginning of a power pulse.
Example

*RST
TRIG:SOUR INT 'triggering in response to a signal edge
TRIG:DEL 50 US 'starts measurement 50 µs after the trigger event
TRIG:HOLD 800 US 'starts next trigger event 800 µs 'after the trigger event at the earliest

INIT
FETCH?

Another way to modify the trigger system timing is to set a holdoff time (TRIG:HOLD). After a trigger event, all following trigger events are ignored if they occur within the holdoff time. This is to prevent signal components that have not yet decayed from causing triggering by mistake after the measurement has been completed. This makes sense especially with internal triggering ("BurstAv" mode).

Excluding and Fencing (Mid)

In the measurement modes Burst, Timeslot and Timegate, it is also possible to exclude time domains from the integration of the measured value at the beginning and the end of the measurement (SENS:TIM:EXCL:STARt and SENS:TIM:EXCL:STOP):

Example

*RST
SENS:FUNC "POW: BURS: AVG"
SENS:TIM:EXCL:STAR 10 US 'ignores 10 µs at the beginning of the measurement
SENS:TIM:EXCL:STOP 10 US 'ignores 10 µs at the end of the measurement
INIT
FETCH?
Moreover, in Timeslot and Timegate it is possible to exclude time domains also during measurement. (...[:EXCL]:MID:OFFS and ...[:EXCL]:MID:TIME).

**Example:**

GSM measurement: The average power in the fifth GSM slot is to be measured. The burst power fails by 50 µs and this range is to be excluded from the measurement.

Solution: A 50 µs-Fence is defined. The sample values in this interval are not included in the measurement:

```
*RST
SENS:FUNC "POW:TGAT:AVG"
SENS:TGAT:SEL 2                  'select second gate
SENS:TGAT2:OFFS 2.328 MS         'GSM measurement in the fifth GSM slot
SENS:TGAT2:TIME 527 US           'length of a GSM burst
SENS:TGAT2:MID ON                'activate Fence
SENS:TGAT2:MID:OFFS 2.528 MS     'exclude interval starts, 200 µs after slot start
SENS:TGAT2:MID:TIME 50 US        'exclude interval starts, 200 µs after slot start
INIT
FETCH?
```
Level, hysteresis and dropout time

With internal and external triggering (TRIG:SOUR INT | EXT), a trigger event is recognized when the level of a trigger signal exceeds a specific value. This value is the trigger level and can be set with TRIG:LEV. With internal triggering, the end of the measurement is recognized when the power level falls below the trigger level.

This is not desirable with modulated signals or short interruptions and also when the level just falls slightly below the trigger level:

- SENS:BURS:DTOL is used to define a time span during which the power to be measured in the "BurstAv" mode must remain below the trigger level so that the end of the burst can be detected.
- TRIG:HYST is used to specify a value in dB by which the signal must fall below the trigger level so that the end of a burst can be detected.

A.4.4.3 Configuration of sensor settings

The sensor settings are controlled by the SENSe command system. The sensors tell the basic unit which commands they understand and which parameters are allowed. As a result, the commands described below cannot be used for some sensors.

Selecting a measurement mode

The most important sensor-dependent setting is the selection of a measurement mode:

ContAv mode: SENS:FUNC "POW:AVG"

Continuous measurement with only one integration time specified (SENS:APER), within which the power is integrated as a measurement result.
**Timeslot mode:** `SENS:FUNC "POW:TSL:AVG"

After the trigger event, the power is measured in timeslots, the number of which is defined with `SENS:TSL:COUN`. The length of the timeslots is set with `SENS:TSL:WIDT`.

*RST
SENS:FUNC "POW:TSL:AVG"
SENS:TSL:WIDT 577 US
SENS:TSL:COUN 8
TRIG:SOUR EXT
INIT
FETCH?

**BurstAv mode:** `SENS:FUNC "POW:BURS:AVG"

Measurement of power pulses (bursts) with automatic detection of the beginning and end of pulses. The trigger source setting is ignored. As described above, the conditions for the detection of the pulse end can be set with commands `SENS:BURS:DTOL` and `TRIG:HYST`.

*RST
SENS:FUNC "POW:BURS:AVG"
SENS:BURS:DTOL 100 MS
TRIG:HYST 3 DB
INIT
FETCH?

**Trace mode:** `SENS:FUNC "XTIM:POW"

This mode is used to determine a large number of measured values in succession. The number of required measured values is set with "SENS:SWE:POI" and the total measurement time with `SENS:SWE:TIM`. Note that each measurement must be triggered separately. This point is a difference between the "Trace" mode and the "Timeslot" mode, in which it is only necessary to start the measurement for measuring the power in all timeslots.

*RST
SENS:FUNC "XTIM:POW"
SENS:SWE:POIN 256
SENS:SWE:TIM 600 US
TRIG:COUN 256

'change to IDLE state after the 256th measurement
INIT
FETCH?
Averaging/filters

The power values to be measured are sampled by the sensors. The sampling values then undergo two-stage filtering before they are made available as measured values.

The first filter stage is a time integration. The integration time is either set explicitly (ContAv mode: SENS:APER, Timeslot mode: SENS:TSL:WIDT and Trace mode: SENS:SWE:POIN and -:TIME) or determined automatically ("BurstAv mode").

Filtering (averaging) is the second filter stage, which is configured via the command path SENS:AVERage. These settings are used to obtain a stable (noise-free) result up to a required accuracy. This is done by means of a digital filter, which has a variable length: the longer the filter, the more stable the result.

Manual filter setting

The filter-length automatic mode is deactivated and the filter length is set in power-of-two numbers.

*RST
SENS:AVER:STAT ON          'activates filtering
SENS:AVER:COUN:AUTO OFF     'switches off filter-length automatic mode
SENS:AVER:COUN 4            'permanently sets filter length to 4
INIT
FETCH?

Automatic filter setting

SENS:AVER:COUN:AUTO:TYPE NSR | RES is used to select whether the noise component should remain below a specific threshold (NSR) or the measurement result should be stable up to a specific accuracy (RES). To avoid long measurement times, SENS:AVER:COUN:AUTO:MTIM can be used to specify a maximum measurement time. The maximum filter length is set such that the measurements do not exceed this time, even if the desired stability has not yet been obtained.

Example

*RST
SENS:AVER:STAT ON          'activates filtering
SENS:AVER:COUN:AUTO ON     'switches on filter-length automatic mode
SENS:AVER:COUN:AUTO:TYPE RES 'sets automatic mode to RESolution
SENS:AVER:COUN:AUTO:RES 3   'maintains 3 places noise-free in the result
INIT
FETCH?

Example

*RST
SENS:AVER:STAT ON          'activates filtering
SENS:AVER:COUN:AUTO ON     'switches on filter-length automatic mode
SENS:AVER:COUN:AUTO:TYPE NSR 'sets automatic mode to NSRatio
SENS:AVER:COUN:AUTO:NSR 0.01 DB 'maximum noise component in the result
SENS:AVER:COUN:AUTO:MTIM 10 S 'but does not measure more than 10 s
All intermediate pushed values delivered by the first filter stage are stored in the filter. The earliest measured value is ousted out of the filter, since the filter has only a limited length. `SENS:AVER:TCON MOV` | `REP` is used to set when the filter algorithm is to be applied to the filter. With the setting `MOVing`, a new measure value is calculated for each new intermediate measured value. This is the default setting in the LOCAL mode. `SENS:AVER:TCON REPeat` is set in the REMOTE mode. In this particular case, new measured values are calculated when all intermediate measured values have been replaced by new ones.

Changing from `SENS:AVER:TCON MOV` to `REP` in the LOCAL-REMOTE transition causes the update rate of measured values to be reduced, since the filter must be completely filled for each new measured value.

Measured-value corrections

The R&S NRP2 offers different options for correcting measured values in the instrument. These options all require an existing knowledge of the test setup or the time structure of the signal. Offsets in the result can be corrected globally and depending on the frequency, and it is possible to consider the duty cycle of a signal and the influence of the complex reflection coefficient ($\Gamma$) of the power source.

Global offset correction

All measured values are multiplied by a correction factor (logarithmically added).

```
*RST
SENS:CORR:OFFS:STAT ON       'global offset correction ON
SENS:CORR:OFFS 20 DB         'corrects result by +20 dB
INIT
FETCH?
```

Frequency-dependent offset correction

Two-column tables can be entered in which frequencies and correction values can be stored. A frequency-dependent correction value is determined by linear interpolation in the units Hz and dB using the signal frequency (defined with `SENS:FREQ`). The interpolated correction value can be queried with `SENS:FDOF?` for checking purposes.

Example

```
*RST
MEM:TABLE:MOVE "Table 1" "Splitter"   'renames first table
MEM:TABLE:SEL "Splitter"               'selects table
MEM:TABLE:CLEar                      'deletes selected table
MEM:TABLE:FREQ  0,1e4,5e4,1e5,1e9     'interpolation points on the frequency axis
MEM:TABLE:GAIN 3.1,3.1,3.0,2.9,2.9     'associated offset values
SENS:FREQ 900 MHZ                     'signal frequency
SENS:CORR:FDOT:STAT ON                'activates frequency-dependent offset correction
SENS:CORR:FDOT "Splitter"             'selects an offset table
```
This example assumes that a table called "Table 1" is available.

**Duty cycle**

If the duty cycle of a pulsed signal (SENS:DCYC) is reported to the R&S NRP2, the R&S NRP2 delivers the average power in the pulse.

**Example**

```
*RST
SENS:CORR:DCYC:STAT ON       'duty-cycle correction
SENS:CORR:DCYC 30 PCT        'duty cycle of 30%
INIT
FETCH?
```

**Reflection coefficient of the source (source gamma, Γ)**

Reflections at the power source may distort the result. If the reflection coefficient of the source is known, it can be specified for the measured-value correction via command path SENS:SGAM.

**Example**

```
*RST
SENS:SGAM:CORR:STAT ON       'considers the reflection coefficient of the source
SENS:SGAM:MAGN 0.01          'magnitude of the reflection coefficient
SENS:SGAM:PHAS 179           'phase angle of the reflection coefficient
INIT
FETCH?
```

### A.4.4.4 Configuration of CALCulate blocks

The function of the CALCulate blocks has already been explained. Its most important task is the calculation and provision of measurement results.

**Calculation function and relative measurement**

The calculation functions mentioned in connection with high-level commands are internally implemented via commands CALC:MATH and CALC:REL:STAT.

<table>
<thead>
<tr>
<th>Keyword for selecting a calculation function with high-level commands</th>
<th>Corresponding low-level commands (n,m=1,2,3,4)</th>
</tr>
</thead>
<tbody>
<tr>
<td>:DIFF</td>
<td>CALC:MATH &quot;(SENSn-SENSm)&quot;;REL:STAT OFF</td>
</tr>
<tr>
<td>:DIFF:REL</td>
<td>CALC:MATH &quot;(SENSn-SENSm)&quot;;REL:STAT ON</td>
</tr>
<tr>
<td>RAT</td>
<td>CALC:MATH &quot;(SENSn/SENSm)&quot;;REL:STAT OFF</td>
</tr>
</tbody>
</table>
### A.4.5 Statistics measurements

There are no high-level commands available for statistics measurements. The measurements must therefore be performed with the aid of the low-level commands.

Two basic types of measurements are conceivable:

- Measurement of a density/distribution curve versus power. An array of statistic values is returned.
- Measurement with the aid of markers. Scalar values at the marker positions are calculated. Either the power or the density/distribution value can be specified.

#### A.4.5.1 Measurement of a density/distribution curve

The sensor measures the power in a time interval that is determined by the SENS:STAT:OFFS and SENS:STAT:TIME commands. Triggering functions in a perfectly normal way, as with other measurements. In principle, the number of (power) samples considered could be set by means of filtering. The higher the filter value, the more samples are included in the statistics and the greater the measurement accuracy. However, the filter commands should not be used here, since the minimum number of samples can be set much more conveniently using the SENS:STAT:SAMP command.

By means of the measured powers, the statistics function determined with SENS:FUNC is now calculated. The power range is limited using the SENS:STAT:SCAL:X:RLEV and SENS:STAT:SCAL:X:RANG commands. The RANGE is divided into measurement intervals by specifying SENS:STAT:SCAL:X:POIN. You are therefore retrieve the measurement values in response to FETCh? SENS:STAT:SCAL:X:POIN.

```plaintext
*RST
UNIT:POWER:RATIO O                'output unit 1
TRIG:SOUR INT                     'trigger to a signal edge
```

---

**Keyword for selecting a calculation function with high-level commands**

<table>
<thead>
<tr>
<th>Calculation Function</th>
<th>Corresponding Low-Level Commands (n,m=1,2,3,4)</th>
</tr>
</thead>
<tbody>
<tr>
<td>:RAT:REL</td>
<td>RAT:REL (Ratio with reference value)</td>
</tr>
<tr>
<td></td>
<td>CALC:MATH &quot;((SENSn/SENSm))&quot;; REL:STAT ON</td>
</tr>
<tr>
<td>:SWR</td>
<td>SWR (Standing wave ratio)</td>
</tr>
<tr>
<td></td>
<td>CALC:MATH &quot;SWR(SENSn)&quot;; REL:STAT OFF</td>
</tr>
<tr>
<td>:RLOS</td>
<td>RLOS (Return loss)</td>
</tr>
<tr>
<td></td>
<td>CALC:MATH &quot;RLOS(SENSn)&quot;; REL:STAT OFF</td>
</tr>
<tr>
<td>:REFL</td>
<td>REFL (Reflection coefficient)</td>
</tr>
<tr>
<td></td>
<td>CALC:MATH &quot;REFL(SENSn)&quot;; REL:STAT OFF</td>
</tr>
</tbody>
</table>

**Example**

```plaintext
*RST
CALC:MATH "((SENS1/SENS2))"        'processes sensors 1 and 2
CALC:REL:STAT ON                   'relative measurement
CALC:REL 23 dB                     'sets reference value
INIT:ALL                           'starts measurements on all sensors
FETCh?                             
```
A.4.5.2 Selective measurement of individual statistics values

As in manual operation, marker measurements can also be performed by remote control. For this purpose, a remote-control command is used to set a value on the density/distribution axis or the power axis. Using another command, you can then read off the sought matching value.

Example:

The measurement is performed over a GSM frame (4.615 ms). First the CCDF of a GSM signal at −15 dBm is to be calculated. Subsequently the power value at which the CCDF is still 50% is of interest.

```
*RST
TRIG:SOUR INT  
TRIG:SLOP POS  
SENS:FUNC "XPOW:CCDF"  
SENS:STAT:OFFS 0  
SENS:STAT:TIME 4.615 MS  
SENS:STAT:SCAL:X:POIN 1024  
SENS:STAT:SCAL:X:RLEV -30  
SENS:STAT:SCAL:X:RANG 30  
SENS:STAT:SAMP 1E9  
READ?
CALC:STAT:MARK:HOR:DATA?  
CALC:STAT:MARK:VERT:POS:X 0.5  
CALC:STAT:MARK:VERT:DATA?  
```

A.4.6 Pulse Analysis Measurements

Pulse analysis measurements are always coupled to trace measurements. Thus, a trace measurement has to be set up and the pulse analysis algorithms have to be activated before the measurement is started. The sensors send the trace data together with the pulse measurement results.
The following example is intended for analysing a GSM/EDGE signal with the first slot used.

```
*rst
*cls
sens:trac:meas on                             'activate pulse measurements
sens:trac:meas:auto on                        'for sensor A.
sense:trace:meas:tran:esam:auto:state on   'enhanced accuracy for stable
                                            'periodic signals
sens:trac:meas:alg HIST               'select an algorithm for the pulse
detection analysis
meas:xtime? (100), 6 ms, (@1)         'perform a trace measurement

'Check the reference levels for
sens:trac:meas:def:dur:ref?           '- pulse duration
sens:trac:meas:def:tran:iref?         '- start of rising/end of falling edge
sens:trac:meas:def:tran:ref?          '- start / end of pulse top
sens:trac:meas:puls:dcyc?             'read duty cycle
sens:trac:meas:puls:dur?              'read pulse duration
sens:trac:meas:puls:per?              'read pulse period
sens:trac:meas:puls:sep?              'read pulse separation
sens:trac:meas:tran:neg:dur?          'read length of falling edge
sens:trac:meas:tran:neg:occ?          'read start time of falling edge
sens:trac:meas:tran:neg:over?         'read overshooting of falling edge
sens:trac:meas:tran:pos:dur?          'read length of rising edge
sens:trac:meas:tran:pos:occ?          'read start time of rising edge
sens:trac:meas:tran:pos:over?         'read overshooting of rising edge
sens:trac:meas:power:min?             'read minimum power in trace
sens:trac:meas:power:max?             'read maximum power in trace
sens:trac:meas:power:avg?             'read average power in trace
sens:trac:meas:power:puls:top?        'read mean power level of pulse top
sens:trac:meas:power:puls:base?       'read mean power level of pulse bottom
syst:err?                          'check for errors
```

### A.4.7 Synchronizing Measurements

Some sensors (e.g. R&S NRP-Z81/85/86) are able to generate signals on the (external) trigger bus, when an internal trigger was detected. This allows for synchronized measurements with multiple sensors.

One sensor has to be configured as trigger master (:TRIG:SOUR INT; :TRIG:MAST ON), while all other sensors are slaves with external trigger source (:TRIG:SOUR EXT).
In the following example, sensor B is configured for a trace measurement as trigger master. Sensor A acts as trigger slave and performs a ContAv measurement. Sensor A will be started first and immediately enter WAIT_FOR_TRIGGER state. It will remain in this state, until an external trigger occurs. Sensor B will start its measurement, after detecting an internal trigger. The internal trigger event will be duplicated to the external trigger bus with a delay of approximately 30 ns (R&S NRP-Z81/85/86).

```
*rst
*cls

conf1 DEF, 0.01, (@1)             'configure calcblock 1 with sensor 1 in ContAv mode
conf2:xtime (1024), 5 ms, (@2)    'configure calcblock 2 with sensor 2 in Trace mode
trig2:sour INT                    'Internal trigger source
trig2:master ON                   'sensor 2 is trigger master
trig1:sour EXT                    'sensor 1 is slave with external trigger source
init1:imm                         'start measurement on sensor 1
init2:imm                         'at last start trigger master sensor
fetch1?                           'get the measurement result of sensor A
fetch2?                           'get the measurement result of sensor B
syst:err?                         'check for errors
```

A.4.8 Optimization of measurement speed

The duration of a message can be reduced by making the following setting:

SYST:SPEed FAST

(deactivates screen content !!!)

The following settings also affect the measurement speed to a greater or lesser extent. Which of these settings are possible, however, depends on what is to be measured. For example, if measurement accuracy is important, filtering may also have to be activated, which can reduce the measurement speed. The length of the integration time also directly affects the measurement time and should therefore be kept as short as possible if a short measurement time is desired. Consequently, the following list can only serve as a guideline for minimizing the measurement time.

Example

```
SYST:SPEed FAST              'deactivates screen content
SENS:AVER:STAT OFF           'deactivates filtering of measured value
SENS:FUNC "POW:AVG"          'ContAv mode
SENS:BUFF:STAT OFF           'no buffered measurements
SENS:APER MIN                'integration time as short as possible
SENS:RANG:AUTO OFF           'automatic range selection OFF
SENS:CORR:OFFS:STAT OFF      'no global offset correction
SENS:CORR:DCYC:STAT OFF      'no duty cycle correction
SENS:CORR:FDOT:STAT OFF      'no frequency-dependent offset correction
SENS:SGAM:CORR:STAT OFF      'no measured-value correction for
                           'reflection coefficient of source
TRIG:DEL 0                   'no delay on triggering
```
TRIG:DEL:AUTO OFF       'no delay on triggering
CALC1:MATH "(SENS1)"    'only uses the first CALCulate block
CALC2:MATH "(SENS2)"
CALC3:MATH "(SENS2)"
CALC4:MATH "(SENS2)"
CALC5:MATH "(SENS2)"
CALC6:MATH "(SENS2)"
CALC7:MATH "(SENS2)"
CALC8:MATH "(SENS2)"

### A.5 Compatibility Information

This section contains information regarding the compatibility of the R&S NRP2 remote control commands with those of the "E4418B" and "E4419B" power meters from Agilent. The R&S NRP2 is largely downward-compatible to the above-mentioned instruments but offers additional capabilities.

<table>
<thead>
<tr>
<th>E4418B/E4419B command</th>
<th>Compatibility information</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONFigure?</td>
<td>Returns the current configuration. The R&amp;S NRP2 returns the last setting made with CONFigure, as specified by the SCPI standard.</td>
</tr>
<tr>
<td>CALCulate:GAIN</td>
<td>SENS:CORR:OFFS:STAT</td>
</tr>
<tr>
<td>CALCulate:PHOLd</td>
<td>Is implemented in the R&amp;S NRP2 and has the same effect as CALC:EXTR:RES.</td>
</tr>
<tr>
<td>CALLibration</td>
<td>Is not implemented in the R&amp;S NRP2.</td>
</tr>
<tr>
<td>:ECONtrl</td>
<td></td>
</tr>
<tr>
<td>:RCALibration</td>
<td></td>
</tr>
<tr>
<td>:RFACtor</td>
<td></td>
</tr>
<tr>
<td>DISPlay:ENABle[?]</td>
<td>Is implemented in the R&amp;S NRP2 and has the same effect as DISPlay:ILLuMination.</td>
</tr>
<tr>
<td>DISPlay:SCREen:FORMat</td>
<td>Is not implemented in the R&amp;S NRP2.</td>
</tr>
<tr>
<td>[:NUMeric[1]</td>
<td>2]</td>
</tr>
<tr>
<td>INITiate</td>
<td>The :SEQUence node is not implemented in the R&amp;S NRP2.</td>
</tr>
<tr>
<td>:CONTInuous:SEQUence[1]</td>
<td>2</td>
</tr>
<tr>
<td>:IMMediate:SEQUence[1]</td>
<td>2</td>
</tr>
<tr>
<td>MEMORY:TABLE:GAIN</td>
<td>Agilent specifies the values without a unit; the unit PCT (percent) is implicitly assumed. The units DB (dB), DPCT (Δ%) and O (unit 1) can be specified in the R&amp;S NRP2. The default unit is DB.</td>
</tr>
<tr>
<td>OUTPut:TRIGger:STATe</td>
<td>Is not implemented in the R&amp;S NRP2.</td>
</tr>
</tbody>
</table>
### E4418B/E4419B command

<table>
<thead>
<tr>
<th>Command</th>
<th>Compatibility Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>SENSE :R:CORREction:GAIN[x]?</td>
<td>Has the same effect as SENSE[1..2]:CORRection:CFACtor?</td>
</tr>
<tr>
<td>SENSE[1</td>
<td>2]:CORRection:GAIN2[?]</td>
</tr>
<tr>
<td>SENSE[1</td>
<td>2]:CORRection:LOSS2[?]</td>
</tr>
<tr>
<td>SENSE[1</td>
<td>2]:CORRection:GAIN3[?]</td>
</tr>
<tr>
<td>SENSE[1</td>
<td>2]:CORRection:GAIN4?</td>
</tr>
<tr>
<td>SENSE:SWEep:OFFSet:TIME[?]</td>
<td>Is implemented in the R&amp;S NRP2 and has the same effect as SENSE:TGATe:OFFSet:TIME[?].</td>
</tr>
<tr>
<td>SENSE:SWEep:TIME[?]</td>
<td>Is implemented in the R&amp;S NRP2 and has the same effect as SENSE:TGATe:TIME[?].</td>
</tr>
<tr>
<td>TRACe:STATe</td>
<td>Is not implemented in the R&amp;S NRP2.</td>
</tr>
<tr>
<td>TRACe:DATA?</td>
<td>Is not implemented in the R&amp;S NRP2 in this form. Data of the trace mode can only be queried via the high-level commands (FETCH?, READ?, MEAS?) and CALC:DATA?.</td>
</tr>
<tr>
<td>TRACe:UNIT?</td>
<td>The UNIT node is only globally available in the R&amp;S NRP2 and affects all measurement results (including trace data) and the unitless command parameters of the commands CALC:LIM:LOW, CALC:LIM:UPP, DISP:MET[:ANAL:LOW, DISP:MET[:ANAL:UPP, OUTP:REC:LIM:LOW and OUTP:REC:LIM:UPP.</td>
</tr>
</tbody>
</table>

The R&S NRP2 does not recognize any tables with frequency-dependent calibration values since the sensors have to be calibrated only once in production. For this reason, there is no compliance with CSET1. Tables with frequency-dependent offset correction values can be defined and addressed via :CSET2 (Agilent and R&S NRP2) or :FDOTable (R&S NRP2 only).
<table>
<thead>
<tr>
<th>E4418B/E4419B command</th>
<th>Compatibility information</th>
</tr>
</thead>
<tbody>
<tr>
<td>TRIGger[:SEQUence[1]</td>
<td>2]]</td>
</tr>
<tr>
<td>UNIT:POWer</td>
<td>The R&amp;S NRP2 recognizes the units W, DBM and DBUV.</td>
</tr>
<tr>
<td>UNIT:POWer:RATio</td>
<td>The R&amp;S NRP2 recognizes the units DB, DPCT and O.</td>
</tr>
</tbody>
</table>
List of Commands

[SENSe<1..4>]:AUXiliary.................................................. 263
[SENSe<1..4>]:AVERage:COUNt........................................... 263
[SENSe<1..4>]:AVERage:COUNt:AUTO.................................... 264
[SENSe<1..4>]:AVERage:COUNt:AUTO:MTIMe........................................ 264
[SENSe<1..4>]:AVERage:COUNt:AUTO:NSRatio......................... 265
[SENSe<1..4>]:AVERage:COUNt:AUTO:RESolution.......................... 264
[SENSe<1..4>]:AVERage:COUNt:AUTO:SLOT.............................. 265
[SENSe<1..4>]:AVERage:COUNt:AUTO:TYPE.................................. 265
[SENSe<1..4>]:AVERage:RESet........................................... 266
[SENSe<1..4>]:AVERage:TCOntrl........................................... 266
[SENSe<1..4>]:AVERage:STATe............................................ 266
[SENSe<1..4>]:BANDwidth:VIDeo......................................... 266
[SENSe<1..4>]:BANDwidth:VIDeo:LIST?.................................... 267
[SENSe<1..4>]:BWIDth:VIDeo.............................................. 266
[SENSe<1..4>]:CPRRection:DCYCle:STATe................................. 267
[SENSe<1..4>]:CPRRection:DCYCle:INPut[:MAGNitude].................... 268
[SENSe<1..4>]:CPRRection:FDOffset[:INPut[:MAGNitude]]?.............. 268
[SENSe<1..4>]:CPRRection:FDOffset:STATe.................................. 268
[SENSe<1..4>]:CPRRection:FDTable:STATe.................................. 268
[SENSe<1..4>]:CPRRection:FDTable[SELECT]............................... 268
[SENSe<1..4>]:CPRRection:OFFSet.......................................... 267
[SENSe<1..4>]:CPRRection:OFFSet:STATe................................... 267
[SENSe<1..4>]:CPRRection:SPDevice:SELECT................................ 269
[SENSe<1..4>]:CPRRection:SPDevice:STATe................................ 269
[SENSe<1..4>]:FREQency:[CW].............................................. 269
[SENSe<1..4>]:FREQency:[FIXed]............................................ 269
[SENSe<1..4>]:FREQency:[FNC]............................................. 269
[SENSe<1..4>]:FUNCTION:[ON]............................................. 269
[SENSe<1..4>]:RGAMma:PHASE........................................... 279
[SENSe<1..4>]:RGAMma[:MAGNitude]...................................... 278
[SENSe<1..4>]:SAMPling.................................................. 279
[SENSe<1..4>]:SGAMma:CORRection:STATe............................... 280
[SENSe<1..4>]:SGAMma:PHASE............................................ 279
[SENSe<1..4>]:SGAMma[:MAGNitude]...................................... 279
[SENSe<1..4>]:STATistics:AVERage?...................................... 280
[SENSe<1..4>]:STATistics:OFFSet[:TIME]................................ 281
[SENSe<1..4>]:STATistics:PEAK?.......................................... 281
[SENSe<1..4>]:STATistics:SAMPles:[MINimum].......................... 281
[SENSe<1..4>]:STATistics:SCALE:X:MPWidth?......................... 281
[SENSe<1..4>]:STATistics:SCALE:X:POINts............................... 282
[SENSe<1..4>]:STATistics:SCALE:X:RANGE................................ 282
[SENSe<1..4>]:STATistics:SCALE:X:RLEVel.............................. 282
[SENSe<1..4>]:STATistics:TIME............................................ 283
[SENSe<1..4>]:STATistics:EXCLude:MIOD:OFFSet[:TIME].................. 280
[SENSe<1..4>]:STATistics:EXCLude:MIOD:TIME........................ 280
[SENSe<1..4>]:TIMing:EXCLude:STARt.................................... 283
[SENSe<1..4>]:TIMing:EXCLude:STOP...................................... 283
[SENSe<1..4>]:TRACe:AVERage:COUNt..................................... 284
List of Commands

[RSENSe<1..4>]:POWer[:AVG]:BUFFer:SIZE ................................................................. 272
[RSENSe<1..4>]:POWer[:AVG]:BUFFer:STATe ......................................................... 272
[RSENSe<1..4>]:POWer[:AVG]:RANGe ................................................................. 273
[RSENSe<1..4>]:POWer[:AVG]:RANGe:AUTO ................................................................. 273
[RSENSe<1..4>]:POWer[:AVG]:RANGe:CLEVel ................................................................. 273
[RSENSe<1..4>]:POWer[:AVG]:SMOothing:STATe ......................................................... 273

*CLS ......................................................................................................................... 195
*ESE ......................................................................................................................... 195
*ESR? ....................................................................................................................... 196
*IDN? ....................................................................................................................... 196
*IST? ....................................................................................................................... 196
*OPC ....................................................................................................................... 196
*OPT? ....................................................................................................................... 197
*PRE ....................................................................................................................... 197
*PSC ....................................................................................................................... 197
*RCL ....................................................................................................................... 198
*RST ....................................................................................................................... 198
*SAV ....................................................................................................................... 204
*SRE ....................................................................................................................... 204
*STB? ....................................................................................................................... 205
*TRG ....................................................................................................................... 205
*TST? ....................................................................................................................... 205
*WA? ....................................................................................................................... 205

ABORt:ALL .......................................................................................................... 329
ABORt<1> .............................................................................................................. 329
CALCulate<1..4>:STATistics:MARKer: HORIZontal:POSITION[X][:POWer] .................. 235
CALCulate<1..4>:STATistics:MARKer:HORIZontal:DATA? ............................................. 235
CALCulate<1..4>:STATistics:MARKer:VERTical:DATA[:POWer]? .................................... 235
CALCulate<1..4>:STATistics:MARKer:VERTical:POSITION[Y] ........................................ 235
CALCulate<1..4>:STATistics:POWer:AVG:DATA? ....................................................... 236
CALCulate<1..4>:COUNT:DATA? ........................................................................... 225
CALCulate<1..4>:DATA? ...................................................................................... 225
CALCulate<1..4>:EXTRemes:RESet ...................................................................... 226
CALCulate<1..8>:FEED<1>[2] ............................................................................. 226
CALCulate<1..8>:LIMIT:BEEP ............................................................................. 227
CALCulate<1..8>:LIMIT:CLEar:AUTO ..................................................................... 227
CALCulate<1..8>:LIMIT:CLEar:IMMediate .............................................................. 227
CALCulate<1..8>:LIMIT:FAIL? .............................................................................. 228
CALCulate<1..8>:LIMIT:FCOunt? .......................................................................... 228
CALCulate<1..8>:LIMIT:LOWer:STATe ................................................................. 229
CALCulate<1..8>:LIMIT:LOWer:DATA ................................................................. 228
CALCulate<1..8>:LIMIT:LOWer[:DATA]:POWer ...................................................... 229
CALCulate<1..8>:LIMIT:LOWer[:DATA]:RATio ......................................................... 229
CALCulate<1..8>:LIMIT:STATe .............................................................................. 229
CALCulate<1..8>:LIMIT:UPPer:STATe ................................................................. 230
CALCulate<1..8>:LIMIT:UPPer[:DATA] ................................................................. 230
CALCulate<1..8>:LIMIT:UPPer[:DATA]:POWer ...................................................... 230
CALCulate<1..8>:LIMIT:UPPer[:DATA]:RATio ......................................................... 230
CALCulate<1..8>:MATH[:EXPRession] ..................................................................... 231
CALCulate<1..8>:MATH[:EXPRession]:CATalog? .................................................... 232
CONFigure<1..8>[SCALar][POWer]:TSLot:REFLection.................................................................218
CONFigure<1..8>[SCALar][POWer]:TSLot:RELative...............................................................217
CONFigure<1..8>[SCALar][POWer]:TSLot:RLOSs.................................................................218
CONFigure<1..8>[SCALar][POWer]:TSLot:SUM.................................................................217
CONFigure<1..8>[SCALar][POWer]:TSLot:SUM:RELative................................................217
CONFigure<1..8>[SCALar][POWer]:TSLot:SWR.................................................................217
CONFigure<1..8>[SCALar][POWer][AVG]:DIFFerence.........................................................217
CONFigure<1..8>[SCALar][POWer][AVG]:DIFFerence:RELative........................................217
CONFigure<1..8>[SCALar][POWer][AVG]:RATIO.....................................................................217
CONFigure<1..8>[SCALar][POWer][AVG]:RATio:RELative...................................................217
CONFigure<1..8>[SCALar][POWer][AVG]:REFLection.........................................................217
CONFigure<1..8>[SCALar][POWer][AVG]:RELative............................................................217
CONFigure<1..8>[SCALar][POWer][AVG]:RLOSs...............................................................217
CONFigure<1..8>[SCALar][POWer][AVG]:SUM.....................................................................217
CONFigure<1..8>[SCALar][POWer][AVG]:SUM:RELative....................................................217
CONFigure<1..8>[SCALar][POWer][AVG]:SWR.................................................................217
CONFigure<5..8>[XTIME][POWer]:NONE............................................................................218
DISPLAY:ERRorlist...........................................................................................................239
DISPLAY:ILumination.........................................................................................................239
DISPLAY:MESSage:TEXT:CLEar......................................................................................240
DISPLAY:MESSage:TEXT[DATA].....................................................................................240
DISPLAY:MESSage:TYPE.................................................................................................240
DISPLAY:MESSage[STATE]...............................................................................................240
DISPLAY:PIXMap?..............................................................................................................241
DISPLAY:UPDate...............................................................................................................241
DISPLAY:WINDow:SELECT...............................................................................................246
DISPLAY:WINDow:SIZE......................................................................................................246
DISPLAY:WINDow<1..4>[ANALog:AUTO].............................................................................243
DISPLAY:WINDow<1..4>[ANALog:LOWer]........................................................................243
DISPLAY:WINDow<1..4>[ANALog:LOWer:POWer]............................................................244
DISPLAY:WINDow<1..4>[ANALog:LOWer:RATio]..............................................................244
DISPLAY:WINDow<1..4>[ANALog:UPPer]...........................................................................244
DISPLAY:WINDow<1..4>[ANALog:UPPer:POWer].............................................................244
DISPLAY:WINDow<1..4>[ANALog:UPPer:RATio]...............................................................245
DISPLAY:WINDow<1..4>[AVALue]......................................................................................241
DISPLAY:WINDow<1..4>[FORMat]....................................................................................242
DISPLAY:WINDow<1..4>[METer:AUTO]..............................................................................243
DISPLAY:WINDow<1..4>[METer:LOWer]...........................................................................243
DISPLAY:WINDow<1..4>[METer:LOWer:POWer]...............................................................244
DISPLAY:WINDow<1..4>[METer:LOWer:RATio].................................................................244
DISPLAY:WINDow<1..4>[METer:UPPer]............................................................................244
DISPLAY:WINDow<1..4>[METer:UPPer:POWer]...............................................................244
DISPLAY:WINDow<1..4>[METer:UPPer:RATio].................................................................245
DISPLAY:WINDow<1..4>[NAME]......................................................................................245
DISPLAY:WINDow<1..4>[RESolution]...............................................................................245
DISPLAY:WINDow<1..4>[TRACe:LOWer]............................................................................247
DISPLAY:WINDow<1..4>[TRACe:UPPer]............................................................................247
DISPLAY:WINDow<1..4>[TSLot]........................................................................................248
DISPLAY:WINDow<1..4>[STATe].......................................................................................247
List of Commands

MEASurement[1..8]:SCALar[:POWer[:AVG]:REFlection.................................................................223
MEASurement[1..8]:SCALar[:POWer[:AVG]:RELative................................................................222
MEASurement[1..8]:SCALar[:POWer[:AVG]:RLOSs................................................................223
MEASurement[1..8]:SCALar[:POWer[:AVG]:SUM........................................................................222
MEASurement[1..8]:SCALar[:POWer[:AVG]:SUM:RELative........................................................222
MEASurement[1..8]:SCALar[:POWer[:AVG]:SWR.........................................................................223
MEMory:CATalog:STATe?.............................................................................................................250
MEMory:CATalog:TABLE?............................................................................................................250
MEMory:CATalog[:ALL]....................................................................................................................250
MEMory:CLEar:TABLE....................................................................................................................251
MEMory:CLEar[:NAME].....................................................................................................................250
MEMory:FRE:STATe?......................................................................................................................251
MEMory:FRE:TABLE?.....................................................................................................................251
MEMory:FRE[:ALL].........................................................................................................................251
MEMory:NS:STATe?.........................................................................................................................251
MEMory:STATe:CATalog?................................................................................................................251
MEMory:STATe:DEFine....................................................................................................................252
MEMory:STATe:MAP.......................................................................................................................252
MEMory:STATe:RESet?....................................................................................................................252
MEMory:TABLE:DATA:POINts?.....................................................................................................253
MEMory:TABLE:DATA?...................................................................................................................253
MEMory:TABLE:FREQuency............................................................................................................253
MEMory:TABLE:FREQuency:POINts?............................................................................................253
MEMory:TABLE:GAIN:POINts?......................................................................................................254
MEMory:TABLE:GAIN[:MAGNitude].............................................................................................254
MEMory:TABLE:MAP....................................................................................................................254
MEMory:TABLE:MOVE....................................................................................................................254
MEMory:TABLE:RESet....................................................................................................................254
MEMory:TABLE:SELect..................................................................................................................254
OUTPut:RECorder[1..2]:FEED.......................................................................................................255
OUTPut:RECorder[1..2]:LIMit:LOWer.............................................................................................256
OUTPut:RECorder[1..2]:LIMit:LOWer:POWER.............................................................................256
OUTPut:RECorder[1..2]:LIMit:LOWer:RATio................................................................................256
OUTPut:RECorder[1..2]:LIMit:UPPer.............................................................................................257
OUTPut:RECorder[1..2]:LIMit:UPPer:POWER.............................................................................257
OUTPut:RECorder[1..2]:LIMit:UPPer:RATio................................................................................257
OUTPut:RECorder[1..2]:[STATe]..................................................................................................258
OUTPut:ROSCillator[:STATe].........................................................................................................258
OUTPut:TRIgger[:STATe]................................................................................................................260
OUTPut:TTL:ACTive.......................................................................................................................258
OUTPut:TTL:FAIL.........................................................................................................................258
OUTPut:TTL:FEED........................................................................................................................259
OUTPut:TTL:HVOLtage..................................................................................................................259
OUTPut:TTL:LVOltage....................................................................................................................259
OUTPut:TTL[:STATE]......................................................................................................................260
READ?.............................................................................................................................................211
READ[1..8]:ARRay[:POWer[:AVG]:REFlection..............................................................................222
READ[1..8]:ARRay[:POWer[:AVG]:RELative................................................................................222
READ[1..8]:ARRay[:POWer[:AVG]:DIFFerence.............................................................................222
READ[1..8]:ARRay[:POWer[:AVG]:DIFFerence:RELative..............................................................222
READ[1..8]:ARRay[:POWer[:AVG]:RATio.................................................................
TRIGger<1..4>:DELay:AUTO...................................................................................................................... 332
TRIGger<1..4>:DTIMe.................................................................................................................................. 332
TRIGger<1..4>:HOLDoff..............................................................................................................................333
TRIGger<1..4>:HYSTeresis.......................................................................................................................333
TRIGger<1..4>:LEVEL.............................................................................................................................. 333
TRIGger<1..4>:MASTer[:STATe].................................................................................................................334
TRIGger<1..4>:SLOPe.............................................................................................................................. 334
TRIGger<1..4>:SOURce..............................................................................................................................334
TRIGger<1..4>:SYNChronize[:STATe]........................................................................................................335
TRIGger<1..4>:[:IMMediate].........................................................................................................................333
UNIT<1..8>:POWer......................................................................................................................................336
UNIT<1..8>:POWer:RATio...........................................................................................................................336
## Symbols

-151, "Invalid string data" .............................................................. 269
-211, "Trigger ignored" ................................................................. 333
-313, "Data corrupt or stale" ............................................................ 313
-314, "Data questionable" ............................................................. 313, 314
-254, 268, "File name not found" .................................................. 254, 268
-255, "Sensor mode not supported" .............................................. 255
-269, 292, 330, "Sensor not idle" ................................................... 269, 292, 330

### A

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>A/B</td>
<td>58</td>
</tr>
<tr>
<td>Absolute X-Scaling (statistics display)</td>
<td>140</td>
</tr>
<tr>
<td>Alarms</td>
<td>166</td>
</tr>
<tr>
<td>Algorithm (pulse)</td>
<td>129</td>
</tr>
<tr>
<td>Aperture</td>
<td>66</td>
</tr>
<tr>
<td>Aperture (statistics display)</td>
<td>140</td>
</tr>
<tr>
<td>Arranging windows</td>
<td>93</td>
</tr>
<tr>
<td>ATN</td>
<td>355</td>
</tr>
<tr>
<td>Attention</td>
<td>355</td>
</tr>
<tr>
<td>Auto</td>
<td></td>
</tr>
<tr>
<td>Sensor Range</td>
<td>84</td>
</tr>
<tr>
<td>Auto (pulse)</td>
<td>128</td>
</tr>
<tr>
<td>Auto (statistics display)</td>
<td>137</td>
</tr>
<tr>
<td>Auto Config</td>
<td>82</td>
</tr>
<tr>
<td>Auto filter</td>
<td>81</td>
</tr>
<tr>
<td>Auto filter mode</td>
<td>82</td>
</tr>
<tr>
<td>Auto Once</td>
<td>81</td>
</tr>
<tr>
<td>Analog Meter Scaling</td>
<td>96</td>
</tr>
<tr>
<td>Auto scaling</td>
<td>116</td>
</tr>
<tr>
<td>Aux</td>
<td>109</td>
</tr>
<tr>
<td>Average (gate)</td>
<td>122</td>
</tr>
<tr>
<td>Average (time slot)</td>
<td>133</td>
</tr>
<tr>
<td>Average power (gate)</td>
<td>103</td>
</tr>
<tr>
<td>Avg No</td>
<td>81</td>
</tr>
</tbody>
</table>

### B

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base</td>
<td></td>
</tr>
<tr>
<td>power</td>
<td>129</td>
</tr>
<tr>
<td>Beep</td>
<td>161</td>
</tr>
<tr>
<td>Bluetooth DHS</td>
<td>142</td>
</tr>
<tr>
<td>Boot Menu</td>
<td>348</td>
</tr>
<tr>
<td>Brightness</td>
<td>161</td>
</tr>
<tr>
<td>Burst Av</td>
<td>67</td>
</tr>
<tr>
<td>Burst Av mode</td>
<td>47</td>
</tr>
<tr>
<td>Buzzer test</td>
<td>351</td>
</tr>
</tbody>
</table>

### C

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Case-sensitivity</td>
<td>178</td>
</tr>
<tr>
<td>SCPI</td>
<td>178</td>
</tr>
<tr>
<td>CCDF</td>
<td>140</td>
</tr>
<tr>
<td>CDF</td>
<td>140</td>
</tr>
<tr>
<td>Channel (statistics display)</td>
<td>140</td>
</tr>
<tr>
<td>Closing windows</td>
<td>93</td>
</tr>
<tr>
<td>Command description</td>
<td>193</td>
</tr>
<tr>
<td>Config Fence</td>
<td>70</td>
</tr>
<tr>
<td>Config Gates</td>
<td>122</td>
</tr>
<tr>
<td>Config Grid</td>
<td>116</td>
</tr>
<tr>
<td>Config Pulse</td>
<td>127</td>
</tr>
<tr>
<td>Config</td>
<td>165</td>
</tr>
<tr>
<td>Cont Av mode</td>
<td>29</td>
</tr>
<tr>
<td>Cont(inuous) (statistics display)</td>
<td>137</td>
</tr>
<tr>
<td>ContAv</td>
<td>66</td>
</tr>
<tr>
<td>Control bus</td>
<td>355</td>
</tr>
<tr>
<td>Control sequences of the IEC/IEEE 1174 draft</td>
<td>363</td>
</tr>
<tr>
<td>Cursor</td>
<td>116, 122, 125, 127, 133</td>
</tr>
<tr>
<td>D</td>
<td></td>
</tr>
<tr>
<td>D&amp;A - digital and analog display mode</td>
<td>93</td>
</tr>
<tr>
<td>Data bus</td>
<td>355</td>
</tr>
<tr>
<td>Data Valid</td>
<td>355</td>
</tr>
<tr>
<td>DAV</td>
<td>355</td>
</tr>
<tr>
<td>Delay</td>
<td></td>
</tr>
<tr>
<td>Sensor Trigger</td>
<td>88</td>
</tr>
<tr>
<td>Dig - digital display mode</td>
<td>93</td>
</tr>
<tr>
<td>Display</td>
<td>116, 122, 125, 127, 133, 136</td>
</tr>
<tr>
<td>Display mode</td>
<td></td>
</tr>
<tr>
<td>pulse</td>
<td>126</td>
</tr>
<tr>
<td>Display symbols</td>
<td>58</td>
</tr>
<tr>
<td>Display test</td>
<td>350</td>
</tr>
<tr>
<td>Display update rate</td>
<td>161</td>
</tr>
<tr>
<td>Dropout</td>
<td>68</td>
</tr>
<tr>
<td>Sensor Trigger</td>
<td>88</td>
</tr>
<tr>
<td>Duty cycle</td>
<td>67, 128</td>
</tr>
<tr>
<td>E</td>
<td></td>
</tr>
<tr>
<td>End or Identify</td>
<td>355</td>
</tr>
<tr>
<td>EOI</td>
<td>355</td>
</tr>
<tr>
<td>Erase Nonvol-Data</td>
<td>348</td>
</tr>
<tr>
<td>Error</td>
<td></td>
</tr>
<tr>
<td>HW Error</td>
<td>167</td>
</tr>
<tr>
<td>Overload</td>
<td>166</td>
</tr>
<tr>
<td>Overrange</td>
<td>166</td>
</tr>
<tr>
<td>Sample Error</td>
<td>167</td>
</tr>
<tr>
<td>Trunc. Meas.</td>
<td>167</td>
</tr>
<tr>
<td>Error 'Invalid Settings'</td>
<td>339</td>
</tr>
<tr>
<td>Error List (file menu)</td>
<td>144</td>
</tr>
<tr>
<td>Error: Sensor communication error</td>
<td>348</td>
</tr>
<tr>
<td>Errors</td>
<td>166</td>
</tr>
<tr>
<td>Ethernet configuration</td>
<td>171</td>
</tr>
<tr>
<td>Ethernet interface</td>
<td>361</td>
</tr>
<tr>
<td>Ethernet MAC address</td>
<td>159</td>
</tr>
<tr>
<td>Eval</td>
<td>103, 106, 120</td>
</tr>
<tr>
<td>Excluded from Start / End (T’slot)</td>
<td>134</td>
</tr>
<tr>
<td>Expanding windows</td>
<td>93</td>
</tr>
<tr>
<td>Ext</td>
<td>58</td>
</tr>
<tr>
<td>External Trigger</td>
<td>143</td>
</tr>
<tr>
<td>F</td>
<td></td>
</tr>
<tr>
<td>Fail</td>
<td>154</td>
</tr>
<tr>
<td>Fall time</td>
<td>128</td>
</tr>
<tr>
<td>Fence</td>
<td>70</td>
</tr>
<tr>
<td>Filter</td>
<td>116</td>
</tr>
<tr>
<td>Filter averaging</td>
<td>79</td>
</tr>
<tr>
<td>Firmware version</td>
<td>159</td>
</tr>
<tr>
<td>Function</td>
<td>Page</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Gate (statistics display)</td>
<td>137</td>
</tr>
<tr>
<td>Gate (pulse)</td>
<td>128</td>
</tr>
<tr>
<td>Gate Avg No</td>
<td>119</td>
</tr>
<tr>
<td>Gate number</td>
<td>123</td>
</tr>
<tr>
<td>Gates Config dialog box</td>
<td>123</td>
</tr>
<tr>
<td>Getting started</td>
<td>23</td>
</tr>
<tr>
<td>Global</td>
<td>77</td>
</tr>
<tr>
<td>GPIB bus interface</td>
<td>355</td>
</tr>
<tr>
<td>GPIB bus interface functions</td>
<td>356</td>
</tr>
<tr>
<td>GPIB configuration</td>
<td>148</td>
</tr>
<tr>
<td>Graphically representing power versus time</td>
<td>43</td>
</tr>
<tr>
<td>GSM/EDGE</td>
<td>142</td>
</tr>
<tr>
<td>Hardware info (remote control)</td>
<td>197</td>
</tr>
<tr>
<td>Hardware Requirements</td>
<td>172</td>
</tr>
<tr>
<td>High reference power (pulse)</td>
<td>129</td>
</tr>
<tr>
<td>Holdoff</td>
<td>89</td>
</tr>
<tr>
<td>HW Error</td>
<td>97.3</td>
</tr>
<tr>
<td>Hysteresis</td>
<td>89</td>
</tr>
<tr>
<td>I/O 2 interface</td>
<td>155</td>
</tr>
<tr>
<td>IEC/IEEE 1174.0 mode</td>
<td>361</td>
</tr>
<tr>
<td>IFC</td>
<td>355</td>
</tr>
<tr>
<td>Initializing windows</td>
<td>93</td>
</tr>
<tr>
<td>Installed options (remote control)</td>
<td>197</td>
</tr>
<tr>
<td>Int. Master</td>
<td>86</td>
</tr>
<tr>
<td>Sensor Trigger</td>
<td>86</td>
</tr>
<tr>
<td>Interface</td>
<td>86</td>
</tr>
<tr>
<td>functions (GPIB bus)</td>
<td>356</td>
</tr>
<tr>
<td>Interface Clear</td>
<td>355</td>
</tr>
<tr>
<td>Interface messages, GPIB</td>
<td>357</td>
</tr>
<tr>
<td>Invalid Settings</td>
<td>339</td>
</tr>
<tr>
<td>IP address</td>
<td>149</td>
</tr>
<tr>
<td>IP Address (Manual / DHCP)</td>
<td>149, 151</td>
</tr>
<tr>
<td>Function test</td>
<td>18</td>
</tr>
<tr>
<td>Key</td>
<td>9</td>
</tr>
<tr>
<td>PRESET</td>
<td>198</td>
</tr>
<tr>
<td>Key Click</td>
<td>161</td>
</tr>
<tr>
<td>Key test</td>
<td>350</td>
</tr>
<tr>
<td>Keywords (optional)</td>
<td>193</td>
</tr>
<tr>
<td>Length of Fence</td>
<td>70</td>
</tr>
<tr>
<td>Length of Gate</td>
<td>71</td>
</tr>
<tr>
<td>Level</td>
<td>87</td>
</tr>
<tr>
<td>Sensor Trigger</td>
<td>87</td>
</tr>
<tr>
<td>Limit Fail</td>
<td>339</td>
</tr>
<tr>
<td>LIMIT FAIL</td>
<td>58</td>
</tr>
<tr>
<td>Low reference power (pulse)</td>
<td>129</td>
</tr>
<tr>
<td>Manual operation</td>
<td>49</td>
</tr>
<tr>
<td>Marker (Statistics display)</td>
<td>139</td>
</tr>
<tr>
<td>Marker Config</td>
<td>125</td>
</tr>
<tr>
<td>Marker Pos</td>
<td>126</td>
</tr>
<tr>
<td>Marker statistics display</td>
<td>136</td>
</tr>
<tr>
<td>Max Hold</td>
<td>120</td>
</tr>
<tr>
<td>Max. Power (Statistics display)</td>
<td>138</td>
</tr>
<tr>
<td>Measurement menu</td>
<td>97</td>
</tr>
<tr>
<td>Measuring av. burst power (Burst Av mode)</td>
<td>47</td>
</tr>
<tr>
<td>Measuring average power (Cont Av mode)</td>
<td>29</td>
</tr>
<tr>
<td>Memory expansions</td>
<td>159</td>
</tr>
<tr>
<td>Messages</td>
<td>166</td>
</tr>
<tr>
<td>Meter Scaling</td>
<td>96</td>
</tr>
<tr>
<td>Miscellaneous parameters for manual measurements</td>
<td>160</td>
</tr>
<tr>
<td>Mobile radio standards</td>
<td>142</td>
</tr>
<tr>
<td>Mode</td>
<td>86</td>
</tr>
<tr>
<td>Sensor Trigger</td>
<td>86</td>
</tr>
<tr>
<td>NDAC</td>
<td>355</td>
</tr>
<tr>
<td>Negative overshoot</td>
<td>129</td>
</tr>
<tr>
<td>No of Timeslots</td>
<td>69</td>
</tr>
<tr>
<td>Nominal Width</td>
<td>134</td>
</tr>
<tr>
<td>Noise Content</td>
<td>82</td>
</tr>
<tr>
<td>Nonvolatile RAM is empty or failure of EEPROM occurred</td>
<td>21</td>
</tr>
<tr>
<td>Not Data Accepted</td>
<td>355</td>
</tr>
<tr>
<td>Not Ready For Data</td>
<td>355</td>
</tr>
<tr>
<td>NRFD</td>
<td>355</td>
</tr>
<tr>
<td>Offset</td>
<td>84</td>
</tr>
<tr>
<td>Sensor Range</td>
<td>84</td>
</tr>
<tr>
<td>Offset tables</td>
<td>78</td>
</tr>
<tr>
<td>ON state</td>
<td>21</td>
</tr>
<tr>
<td>Operation Complete</td>
<td>196</td>
</tr>
<tr>
<td>Option</td>
<td>196</td>
</tr>
<tr>
<td>R&amp;S NRP-B1/B7, sensor check source</td>
<td>14, 158</td>
</tr>
<tr>
<td>R&amp;S NRP-B2, second sensor input (B)</td>
<td>15</td>
</tr>
<tr>
<td>R&amp;S NRP-B5, 3rd and 4th sensor inputs</td>
<td>17</td>
</tr>
<tr>
<td>R&amp;S NRP-B6, rear panel sensor inputs A and B</td>
<td>17</td>
</tr>
<tr>
<td>Options installed</td>
<td>159</td>
</tr>
<tr>
<td>Out1 interface</td>
<td>152</td>
</tr>
<tr>
<td>Overload</td>
<td>161, 166</td>
</tr>
<tr>
<td>Overrange</td>
<td>166</td>
</tr>
<tr>
<td>Overshoot</td>
<td>129</td>
</tr>
<tr>
<td>Parameter types</td>
<td>180</td>
</tr>
<tr>
<td>Pass</td>
<td>154</td>
</tr>
</tbody>
</table>
Index

Path 1 2 3 ........................................................................... 84
Sensor Range ................................................................. 84
PDF ............................................................................... 140
Peak (gate) ...................................................................... 122
Peak (time slot) ............................................................. 133
Peak power (gate) ......................................................... 103
Peak/Avg (gate) ............................................................ 122
Peak/Avg (time slot) ....................................................... 133
Pos Scale ...................................................................... 116, 122, 125, 127, 133
Positive overshoot ....................................................... 129
Power / div ................................................................. 117
Power / div (Statistics display) ...................................... 138
Power Ref ....................................................................... 158
Predefined settings ...................................................... 142
Preserve Window Settings ........................................... 143
Preset ........................................................................... 27
Preset values ................................................................ 199
Primary channel .......................................................... 120
Protocol functions VX111 .............................................. 360
Pulse
  duty cycle .................................................................. 128
  fall time ..................................................................... 128
  off time ...................................................................... 128
  period ......................................................................... 128
  power ......................................................................... 129
  rise time ..................................................................... 128
  start time ................................................................... 128
  stop time ..................................................................... 128
  width .......................................................................... 128
Pulse display mode ....................................................... 126
Putting into operation
  notes ........................................................................... 7
  unpacking the meter .................................................... 8
Q
Queries ........................................................................... 179
R
Ratio of peak power to average power (gate) .................. 103
Raw socket communication ......................................... 361
Rear panel ....................................................................... 15
Recall standard .......................................................... 143
Ref ................................................................................ 111
Ref Timeslot .................................................................. 112
Ref. Power ....................................................................... 117
Reference power (pulse) ............................................... 129
Reference value ........................................................... 111
Reflection coefficient .................................................. 84
Related to (pulse) .......................................................... 129
Relative .......................................................................... 111
Remote control ............................................................ 193
  sundamentals ................................................................ 169
Remote control interfaces .......................................... 354
Remote Enable ............................................................ 355
REN ................................................................................ 355
Report sensor selftest ................................................... 162
Report... ....................................................................... 164
Requirements ................................................................ 23
Reset filter ..................................................................... 81
Reset values .................................................................. 199
Resolution
digital display mode ................................................... 96
Rise time ........................................................................ 128
Rohde & Schwarz control sequences ......................... 363
RUN ............................................................................... 58
S
S Parameter Device ......................................................... 78
S/N ................................................................................. 58
Sample Error .................................................................. 167
Sample error message .................................................. 349
Samples (statistics display) .......................................... 140
Sampling rate ................................................................ 67
Save ............................................................................. 142
Scale tab (Statistics display) ......................................... 138
Secondary channel ...................................................... 120
Select setting .................................................................. 143, 142
Select standard setting ................................................ 143
Select Trace ... (gate) ....................................................... 123
Select Trace (pulse) ....................................................... 128
Seltest (remote control) ............................................... 205
Seltest sensor .................................................................. 162
Sensor
  Source Γ Correction ................................................... 85
  Source Γ Magnitude .................................................... 85
  Source Γ Phase .......................................................... 85
Sensor Check Source ..................................................... 158
Sensor communication error ...................................... 348
Sensor info ...................................................................... 159
Sensor Range
  Auto ............................................................................ 84
  Path 1 2 3 .................................................................. 84
  User def'd transition .................................................. 84
Sensor selftest ............................................................... 162
Sensor selftest report ................................................... 162
Sensor test with applied RF ........................................... 163
Sensor Trigger
  Delay ........................................................................... 88
  Dropout .................................................................... 88
  Holdoff .................................................................... 89
  Hysteresis ................................................................ 89
  Int. Master ................................................................. 86
Level ............................................................................. 87
Mode ............................................................................ 86
Slope ............................................................................. 87
Source ........................................................................... 86
Serial number ............................................................... 159
Service .......................................................................... 348
Service menu ............................................................... 149
Service Request ........................................................... 355
Set to defaults ............................................................. 165
Setting measurement functions ................................... 41
Setup Name .................................................................... 142
Slope
  Sensor Trigger ............................................................ 87
Slot (T'slot) .................................................................... 133
Smoothing of modulated signals .................................. 67
Socket communication ................................................ 361
Source
  Sensor Trigger ............................................................ 86
  Source Γ Correction ................................................... 85
  Sensor ....................................................................... 85
  Source Γ Magnitude .................................................... 85
  Source Γ Phase .......................................................... 85
  Sensor ....................................................................... 85
  Special characters ...................................................... 194
  SCPI ........................................................................... 355
  Special symbols ........................................................ 58
  SRQ ............................................................................ 355
### R&S®NRP2

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start / Length of Fence (Gate)</td>
<td>124</td>
</tr>
<tr>
<td>Start / Length of Fence (T'slot)</td>
<td>135</td>
</tr>
<tr>
<td>Start / Length of Gate</td>
<td>123</td>
</tr>
<tr>
<td>Start display</td>
<td>18</td>
</tr>
<tr>
<td>booting</td>
<td>18</td>
</tr>
<tr>
<td>function test</td>
<td>18</td>
</tr>
<tr>
<td>welcome screen</td>
<td>18</td>
</tr>
<tr>
<td>Start of Fence</td>
<td>70</td>
</tr>
<tr>
<td>Start of Gate</td>
<td>71</td>
</tr>
<tr>
<td>Start Time</td>
<td>117</td>
</tr>
<tr>
<td>Starting the meter</td>
<td>18</td>
</tr>
<tr>
<td>Stat's Config / Marker</td>
<td>139</td>
</tr>
<tr>
<td>Stat's Config / Scale tab</td>
<td>138</td>
</tr>
<tr>
<td>Statistics evaluation function</td>
<td>140</td>
</tr>
<tr>
<td>Statistics marker</td>
<td>136</td>
</tr>
<tr>
<td>Stock number</td>
<td>159</td>
</tr>
<tr>
<td>STOP</td>
<td>58</td>
</tr>
<tr>
<td>Stop time</td>
<td>128</td>
</tr>
<tr>
<td>subnet mask</td>
<td>149</td>
</tr>
<tr>
<td>Suffixes</td>
<td>193</td>
</tr>
<tr>
<td>Switching on/off</td>
<td>18</td>
</tr>
<tr>
<td>ON state</td>
<td>21</td>
</tr>
<tr>
<td>Switchover to Remote Control</td>
<td>172</td>
</tr>
<tr>
<td>Symbols on display</td>
<td>58</td>
</tr>
<tr>
<td>System Info</td>
<td>159, 348</td>
</tr>
<tr>
<td>System information</td>
<td>158, 58</td>
</tr>
<tr>
<td>Tgate Av</td>
<td>71</td>
</tr>
<tr>
<td>Table correction</td>
<td>77</td>
</tr>
<tr>
<td>Test at Power Ref</td>
<td>163</td>
</tr>
<tr>
<td>Test Limits</td>
<td>165</td>
</tr>
<tr>
<td>Test measurements</td>
<td>161</td>
</tr>
<tr>
<td>Test Report</td>
<td>162</td>
</tr>
<tr>
<td>Test report with applied RF</td>
<td>164</td>
</tr>
<tr>
<td>Time div</td>
<td>117</td>
</tr>
<tr>
<td>Timeslot</td>
<td>106</td>
</tr>
<tr>
<td>Analog Meter Scaling</td>
<td>97</td>
</tr>
<tr>
<td>Top</td>
<td>129</td>
</tr>
<tr>
<td>power</td>
<td>129</td>
</tr>
<tr>
<td>Trace</td>
<td>129</td>
</tr>
<tr>
<td>average</td>
<td>129</td>
</tr>
<tr>
<td>minimum</td>
<td>129</td>
</tr>
<tr>
<td>peak</td>
<td>129</td>
</tr>
<tr>
<td>Trace 1 / 2</td>
<td>119, 120</td>
</tr>
<tr>
<td>Trace 1 / 2 (statistics display)</td>
<td>140</td>
</tr>
<tr>
<td>Trace Avg No</td>
<td>119</td>
</tr>
<tr>
<td>Trace display mode</td>
<td>115</td>
</tr>
<tr>
<td>Trace Func ... (T'slot)</td>
<td>133</td>
</tr>
<tr>
<td>Trace function</td>
<td>120</td>
</tr>
<tr>
<td>Trace function settings</td>
<td>119</td>
</tr>
<tr>
<td>Trig</td>
<td>116</td>
</tr>
<tr>
<td>Trigger missing</td>
<td>339</td>
</tr>
<tr>
<td>Trunc. Meas.</td>
<td>167</td>
</tr>
<tr>
<td>USBTMC standard</td>
<td>148</td>
</tr>
<tr>
<td>User def'd transition</td>
<td>84</td>
</tr>
<tr>
<td>Sensor Range</td>
<td>84</td>
</tr>
<tr>
<td>V</td>
<td></td>
</tr>
<tr>
<td>Versions+Options (remote control)</td>
<td>196</td>
</tr>
<tr>
<td>Video BW</td>
<td>119</td>
</tr>
<tr>
<td>VISA resource identifier</td>
<td>368</td>
</tr>
<tr>
<td>VISA Resource Identifier</td>
<td>148</td>
</tr>
<tr>
<td>Voltage at the analog outputs</td>
<td>157</td>
</tr>
<tr>
<td>VXI11 protocol</td>
<td>358</td>
</tr>
<tr>
<td>VXI11 protocol functions</td>
<td>360</td>
</tr>
<tr>
<td>VXI11 settings</td>
<td>149</td>
</tr>
<tr>
<td>VXI11configuration</td>
<td>171</td>
</tr>
<tr>
<td>W</td>
<td></td>
</tr>
<tr>
<td>Warnings</td>
<td>166</td>
</tr>
<tr>
<td>Window Dig</td>
<td>96</td>
</tr>
<tr>
<td>resolution</td>
<td>96</td>
</tr>
<tr>
<td>Windows handling</td>
<td>36</td>
</tr>
<tr>
<td>Window name</td>
<td>145</td>
</tr>
<tr>
<td>Window size and type</td>
<td>57</td>
</tr>
<tr>
<td>X</td>
<td></td>
</tr>
<tr>
<td>X Marker (Statistics display)</td>
<td>139</td>
</tr>
<tr>
<td>Y</td>
<td></td>
</tr>
<tr>
<td>Y Division (Statistics display)</td>
<td>138</td>
</tr>
<tr>
<td>Y Marker (Statistics display)</td>
<td>139</td>
</tr>
<tr>
<td>Y Start (Statistics display)</td>
<td>138</td>
</tr>
<tr>
<td>Z</td>
<td></td>
</tr>
<tr>
<td>Zeroring</td>
<td>27</td>
</tr>
<tr>
<td>Zeroring failed</td>
<td>63</td>
</tr>
</tbody>
</table>

### User Manual 1173.9140.02 ─ 07